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Configurazione del sistema
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Posizione e funzione delle parti

Lato sinistro e lato anteriore

O O~NOUID W IN —

1. Gancio per metro a nastro

Il gancio del metro a nastro si trova sullo
stesso piano del sensore immagine. Per
misurare con precisione la distanza tra il
camcorder e il soggetto, utilizzare questo
gancio come punto di riferimento. Fissare
I'estremita di un metro a nastro a questo
gancio per misurare la distanza del soggetto.

2. Connettore mirino (pagina 20)

3. Apertura di ventilazione

[Nota]
Non coprire I'apertura di ventilazione.

4. Selettore TC IN/OUT (pagina 36, 120)

5. Connettore impugnatura di telecomando
(pagina 22)
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6. N (simbolo N-Mark) (pagina 62)

e Toccando il camcorder con uno smartphone
dotato della funzione NFC ¢ possibile
stabilire una connessione wireless.

Alcuni smartphone che supportano sistemi
di pagamento wireless potrebbero non
supportare la funzione NFC. Per ulteriori
informazioni, consultare il manuale per |'uso
dello smartphone.

e || protocollo di comunicazione
internazionale NFC (Near Field
Communication) consente la comunicazione
wireless tra dispositivi mentre si trovano a
breve distanza I'uno dall'altro.

7. Attacco impugnatura di telecomando
(pagina 22)

8. Pulsante dirilascio dell'impugnatura di
telecomando (pagina 22)

9. Antenna Wi-Fi

10. Spia di registrazione/tally (anteriore)
(pagina 35)

Lampeggia quando la capacita rimanente del

supporto di registrazione o della batteria &

bassa.

11. Selettore FOCUS (pagina 38)
12. Sensore immagine

13. Pulsante PUSH AUTO FOCUS
(pagina 42)
14. Contatti di segnale obiettivo

[Nota]
Non toccare direttamente con le mani.

15. Pulsante WB SET (impostazione
bilanciamento del bianco) (pagina 48)

16. Pulsante di sblocco obiettivo
(pagina 23)
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Lato destro (anteriore/superiore/inferiore)
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1. Pulsante Clip Flag (pagina 55, 73)
2. Selettore HOLD (pagina 103)

3. Pulsante START/STOP registrazione
(pagina 35)

Premere il pulsante START/STOP registrazione

per avviare la registrazione. Il LED ¢ illuminato

con luce rossa durante la registrazione.

[
Yoy

Lato destro (posteriore)
(pagina 6)

. Manopola ND VARIABLE (pagina 47)
. Selettore ND PRESET/VARIABLE

(pagina 47)

. Pulsanti su/giu ND FILTER POSITION

(pagina 47)
Indicatore ND CLEAR (pagina 47)

8. Pulsante ND VARIABLE AUTO

(pagina 47)
Premere il pulsante ND VARIABLE AUTO
per avviare la regolazione automatica della
densita del filtro ND. Il LED & illuminato con
luce verde quando é attivo.

19. Jack cuffie (pagina 35)
20.Selettore POWER (pagina 35)

9. Manopola multifunzione (pagina 51)
Premere durante la visualizzazione
dell'immagine nel mirino per visualizzare ed
interagire con il Direct Menu.

Durante la visualizzazione del menu nel
mirino, ruotare la manopola per spostare il
cursore verso l'alto o il basso e selezionare
voci di menu o impostazioni. Premere per
applicare la voce selezionata.

Quando non é visualizzato il menu, la
manopola puo essere utilizzata anche come
manopola programmabile.

10. Pulsante funzione IRIS (pagina 45)
11. Pulsante CANCEL/BACK (pagina 72)
12. Pulsante THUMBNAIL (pagina 71)

13. Pulsante MENU (pagina 14, 76)

Premere il pulsante MENU per visualizzare

la schermata di stato. Premere e mantenere
premuto il pulsante MENU per visualizzare il
menu completo. Premere il pulsante mentre

€ visualizzata la schermata di stato o la
schermata del menu completo per tornare alla
schermata precedente.

14. Pulsante funzione ISO/GAIN
(pagina 45)

15. Selettore ISO/GAIN (selezione guadagno)
(pagina 45)

16. Pulsante funzione WHT BAL
(bilanciamento del bianco) (pagina 48)

17. Selettore WHT BAL (selezione memoria
bilanciamento del bianco) (pagina 48)

18. Pulsante funzione SHUTTER
(pagina 46)
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Lato posteriore destro e slot schede
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1. Antenna Wi-Fi

2. Manopola AUDIO LEVEL (CH1)
(pagina 49)

3. Selettore CH1 (AUTO/MAN) (pagina 49)

4. Pulsanti programmabili ASSIGN da1a 3
(pagina 51)

5. Microfono interno (pagina 49)

Microfono di narrazione per la registrazione
dell'audio ambientale.

[Informazione]

Questo microfono viene disattivato quando & montata la
maniglia ed é attivo il microfono interno della maniglia
(pagina 7).

6. Pulsante DISPLAY (pagina 11)

Altoparlante incorporato (pagina 35)
8. Indicatore POWER (pagina 35)

9. Pulsante SLOT SELECT (selezione dello slot
per schede di memoria (A) o (B))
(pagina 35)

10. Selettore CH2 (AUTO/MAN) (pagina 49)

11. Manopola AUDIO LEVEL (CH2)
(pagina 49)

12. Indicatore di accesso A (pagina 27)

13. Slot scheda CFexpress Type A/SD (A)
(pagina 27)

14. Slot scheda CFexpress Type A/SD (B)
(pagina 27)

15. Indicatore di accesso B (pagina 27)
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Sezione maniglia, lato posteriore e connettore

1. Selettore HOLD della maniglia

(pagina 103)
Consente di disabilitare il funzionamento dei
comandi della maniglia.
[Informazione]
Puo essere configurato per agire anche soltanto sul
pulsante di START/STOP registrazione della maniglia.

2. Pulsante START/STOP registrazione della
maniglia

3. Microfono interno della maniglia

4. Slitta Multi-interface

® Multi
7 interface Shoe

Per informazioni dettagliate sulla gamma

di accessori utilizzabili con la slitta Multi-
interface, rivolgersi al proprio rappresentante
di vendita.

5. Manopola programmabile della maniglia
(pagina 51)

6. Levetta dello zoom della maniglia
(pagina 104)

7. Pulsanti programmabili ASSIGN 7 e 8
(pagina 51)

8. Selettore multiplo (pulsante direzionale
D-Pad a 8 posizioni e pulsante di
conferma)

9. Slitta accessori (pagina 7)

10. Fori filettati per il montaggio di accessori
(174 di pollice)

Compatibili con viti UNC 1/4-20 (lunghezza

max. 6 mm).

[Nota]
L'utilizzo di viti di lunghezza superiore a 6 mm potrebbe
danneggiare le parti esterne dell’apparecchio.

11. Spia di registrazione/tally (posteriore)
(pagina 35)

12. Pulsante BATT RELEASE (pagina 18)

13. Apertura ingresso aria

[Nota]
Non coprire I'apertura di ingresso dell‘aria.

14. Attacco pacco batteria (pagina 18)
15. Connettore USB-C (pagina 66)

16. Connettore INPUT2 (ingresso audio 2)
(pagina 49)

17. Connettore INPUT1 (ingresso audio 1)
(pagina 49)

18. Selettore INPUT2 (LINE/MIC/MIC+48V)
(pagina 49)

19. Selettore INPUT1 (LINE/MIC/MIC+48V)
(pagina 49)

20.Fori filettati per dispositivi esterni
Compatibili con viti M3 (lunghezza max.
4 mm).

[Nota]
L'utilizzo di viti di lunghezza superiore a 4 mm potrebbe
danneggiare la superficie esterna dell'apparecchio.

21. Connettore HDMI OUT (pagina 119)
22.Connettore SDI OUT (pagina 119)

23.Connettore TC IN/TC OUT (entrata/uscita
codice temporale) (pagina 120)

24.Connettore REMOTE
Per il collegamento a un accessorio generico
dotato di jack LANC.

25. Connettore USB/Multi (pagina 121)

26.Connettore DC-IN (jack c.c. standard)
(pagina 19)

Montaggio della slitta accessori

1 Sollevare il bordo anteriore della molla
della slitta e tirare la molla nella direzione
opposta a quella indicata dalla freccia
incisa sulla slitta stessa.

Molla della slitta
‘/\E
<
\ P
\ ‘f@
1
Slitta accessori

2 Posizionare la slitta accessori sulla sua
sede di montaggio, allineando le
sporgenze della slitta con il punti
corrispondenti della sede di montaggio,
quindi serrare le quattro viti.
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3 Inserire la molla della slitta nella direzione
della freccia in modo che la porzione a
forma di U si inserisca in fondo alla slitta.

Slitta accessori

Molla della
slitta

Rimozione della slitta accessori

Rimuovere la molla della slitta come descritto

al passo 1 del paragrafo “Montaggio della slitta
accessori”, svitare le quattro viti e rimuovere la
slitta accessori.

Montaggio della maniglia

Posizionare la maniglia allineandone il
connettore e le viti di fissaggio, quindi inserire
la maniglia e ruotare in senso orario le viti di
fissaggio per assicurare la maniglia al corpo
del camcorder.

E possibile serrare le due viti di fissaggio della
maniglia anche ruotandole in senso orario con
una chiave esagonale (4 mm).

[Nota]

Assicurarsi che le due viti di fissaggio della maniglia
siano saldamente serrate prima di utilizzare la maniglia.
Se le viti non sono saldamente serrate, la maniglia
potrebbe staccarsi dal camcorder.

Rimozione della maniglia

Per la rimozione, ripetere la procedura di
montaggio in senso inverso.

Montaggio del coperchietto di Lato superiore
protezione del connettore della maniglia
(in dotazione)

Quando si usa il camcorder senza la maniglia,
proteggere il connettore con il coperchietto di
protezione in dotazione.

[Informazione] 2
Al momento del montaggio della maniglia, riporre il
coperchietto di protezione nell'apposita sede sul lato

inferiore della maniglia stessa.

1. Connettore della maniglia

2. Fori filettati per il montaggio di accessori
(174 di pollice)

Compatibili con viti UNC 1/4-20 (lunghezza

max. 6 mm).

[Nota]

L'utilizzo di viti di lunghezza superiore a 6 mm potrebbe
danneggiare le parti esterne dell'apparecchio.

Protezione dei terminali del connettore

Montare il coperchietto sui connettori non
utilizzati per proteggere i terminali del
connettore.



9 1. Descrizione generale: Posizione e funzione delle parti

Lato inferiore
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1. Fori filettati di montaggio del treppiede
(174 poll., 3/8 poll.)

Compatibile con viti 1/4-20 UNC e 3/8-16

UNC. Consente il montaggio di un treppiede

(opzionale, vite di lunghezza max. 5,5 mm).

2. Apertura uscita aria

[Nota]
Non coprire I'apertura per 'uscita dell’aria.

Mirino

Per informazioni dettagliate sul montaggio del
mirino (in dotazione), vedere pagina 20.

11—
2—8
3z

U1 —

1. Pulsante PEAKING
2. Pulsante ZEBRA

3. Pulsante programmabile ASSIGN 9
(pagina 51)

4. Touchscreen

E possibile disabilitare il funzionamento
del touchscreen usando un pulsante
programmabile o il menu (pagina 10).

5. Selettore MIRROR

Impugnatura di telecomando

Per informazioni dettagliate sul montaggio
dell'impugnatura di telecomando (in
dotazione), vedere pagina 22.

Levetta dello zoom

. Pulsante programmabile ASSIGN 4

(pagina 51)

. Manopola programmabile

dell'impugnatura (pagina 51)

. Pulsante programmabile ASSIGN 6

(pagina 51)

. Levetta di rotazione dell'impugnatura

(pagina 22)

. Pulsante START/STOP registrazione

Selettore multiplo (pulsante direzionale
D-Pad a 8 posizioni e pulsante di
conferma)

. Pulsante programmabile ASSIGN 5

(pagina 51)
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Utilizzo del touchscreen

Precauzioni per I'utilizzo del
touchscreen

Il mirino dell’'unita € un pannello touchscreen

che puo essere utilizzato semplicemente

toccando le varie opzioni con un dito.

e [ sufficiente toccarlo leggermente con il
dito. Non esercitare forte pressione sul
pannello né toccarlo con oggetti taglienti o

appuntiti (unghie, penne a sfera, spilli, ecc.).

e Nelle circostanze descritte di sequito, il
touchscreen potrebbe non rispondere
correttamente al contatto. Si osservi inoltre
che tali azioni potrebbero dar luogo a
malfunzionamenti.

e Se sitocca con la punta delle unghie
delle dita

e Se si tocca mentre altri oggetti sono in
contatto con la sua superficie

e Se si tocca mentre € applicata una
pellicola adesiva di protezione o
un’etichetta

e Se si tocca mentre sono presenti gocce
di condensazione o d'acqua sulla sua
superficie

e Se sitocca con dita bagnate o sudate

Gesti del touchscreen

Configurazione del touchscreen

Tocco

Toccare leggermente un elemento, ad
esempio un’icona o una voce del menu, e
sollevare immediatamente il dito.

Trascinamento

Toccare lo schermo e spostare il dito mentre
rimane in contatto con lo schermo fino a
raggiungere la posizione desiderata, quindi
sollevare il dito.

Scorrimento rapido

Toccare lo schermo e trascinare il dito con un
gesto rapido verso l'alto, il basso, a sinistra o
a destra.

"~

[Informazione]

Se i contenuti si estendono oltre i bordi dello schermo,
e possibile scorrerli trascinandoli lentamente o con un
gesto rapido.

Il funzionamento del touchscreen puo essere
attivato o disattivato tramite la voce Touch
Operation (pagina 103) del menu Technical.
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Visualizzazione a schermo

Durante la ripresa (registrazione/standby) e la riproduzione, le informazioni sullo stato del
camcorder e le sue impostazioni sono sovraimposte all'immagine visualizzata nel mirino.

E possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY. Se nascoste,
verranno sempre visualizzate quando si eseguono operazioni con il Direct Menu (pagina 51).

E inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre

(pagina 97).

Informazioni visualizzate sullo schermo durante le riprese
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1. Indicatore di stato della rete (pagina 13)
Visualizza graficamente lo stato della
connessione di rete.

2. Indicatore di upload/indicatore file
rimanenti (pagina 68)

3. Indicatore della zona di messa a fuoco
(pagina 39)

Visualizza la zona di messa a fuoco per la

messa a fuoco automatica.

4. Indicatore modalita di registrazione, slot
A/B, intervallo di registrazione Interval
Rec (pagina 52)

Indicazione Significato
O®Rec Registrazione
Stby Standby registrazione

5. Indicatore di profondita di campo

6. Indicatore della modalita di scansione
dell'imager (pagina 25)

In caso di mancata corrispondenza fra le

dimensioni del cerchio immagine dell'obiettivo

e l'impostazione delle dimensioni immagine

effettive della modalita di scansione

dell'immagine viene visualizzata l'indicazione [1.

Quando Imager Scan Mode & impostata su FF,

verra visualizzata I'indicazione “C" nelle modalita

con un angolo di visuale pil stretto (cropping).

Il cropping ha luogo nelle modalita indicate di

seguito.

e Quando il formato di registrazione e
3840x2160 e la velocita fotogrammi di S&Q
Motion & 100 fps o 120 fps

e Quando Codec & impostato su RAW o
RAW & XAVC-I e il formato di uscita RAW &
3840x2160

7. Indicatore di stato dell'operazione di
uscita RAW (pagina 61)
Indica lo stato di uscita del segnale RAW.

8. Indicatore di stato della serie UWP-D
(pagina 13)

Quando ¢ collegato alla slitta MI configurata

per la trasmissione di audio digitale un

dispositivo della serie UWP-D, visualizza

I'intensita del segnale RF in forma grafica.

9. Indicatore della frequenza fotogrammi in
modalita di ripresa Slow & Quick Motion
(pagina 52)

10. Indicatore carica residua della batteria/
tensione DC IN (pagina 18)

11. Indicatore della modalita di messa a
fuoco (pagina 42)

Significato Indicazione
Modalita Focus Hold Focus Hold
Modalita MF MF
Modalita AF AF

Modalita AF con seguimento
in tempo reale

AF con rilevamento di viso/occhi (AF/®&/0nly/
/M)

Icona rilevamento viso/ ©

occhi

Icona AF rilevamento Only
viso/occhi

Icona viso da seguire ®
salvato

Icona AF in pausa durante [1]
AF con rilevamento viso/
occhi”

1) Visualizzata solo quando non é stato salvato nessun
viso da seguire e non é stato rilevato nessun viso,
oppure quando e stato salvato un viso da seguire, ma
tale viso non e stato rilevato.

12. Indicatore della posizione di messa a
fuoco
Indica la posizione di messa a fuoco.

13. Indicazione della posizione di zoom
(pagina 37)
Visualizza il valore di zoom nel campo da O
(grandangolo) a 99 (teleobiettivo) (se & montato
un obiettivo che supporta questa funzione).
Questa indicazione puo essere sostituita da
un indicatore a barra o dall'indicatore della
distanza di messa a fuoco (pagina 105).
Quando ¢ abilitata la funzione Clear Image
Zoom, vengono visualizzate sul display anche
le indicazioni elencate di seqguito.

Indicazione Significato
c® Clear Image Zoom abilitato
Valore di Quando é utilizzata la

ingrandimento  funzione Clear Image Zoom

14. Indicatore della modalita di
stabilizzazione dell'immagine

15. Indicatore dello stato di Rec Control
sull’'uscita SDI o HDMI (pagina 119)
Indica lo stato di uscita del segnale REC Control.

16. Indicatore della messa a fuoco
(pagina 38)

17. Indicatore dello spazio rimanente sui
supporti di memoria

Indicazione Significato

@ Montaggio in corso/stato di
montaggio
(scheda A)

EIB Montaggio in corso/stato di
montaggio
(scheda B)

E’P Montaggio in corso/stato di
montaggio
(scheda B)"

ErF’ Stato di montaggio (non

) registrabile)
(lampeggiante) (scheda B)"?
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1) Registrazione di soli dati proxy
2) Errore scheda, scheda piena, oppure altro errore
verificatosi all'inizio o durante la registrazione.

24 .Indicatore guadagno (pagina 45)
Visualizza il valore El in modalita Cine El
(pagina 25).

Se la scheda di memoria é protetta da scrittura Indicazione Significato
viene visualizzata I'icona (. @ Modalita auto
18. Indicatore modalita bilanciamento del H Modalita H di preset
bianco M Modalita M di preset
Indicazione Significato L Modalita L di preset
Modalita auto £ Modalita di
. - regolazione
Hold Modalita auto in pausa te(rgnporanea
W:P Modalita Preset Modalita di controllo
W:A Modalita memoria A Bokeh (pagina 55)
W:B Modalita memoria B

19. Indicatore della sincronizzazione con
codice temporale esterno o indicatore
dati temporali (pagina 35)

Visualizza “EXT-LK" quando l'apparecchio

€ sincronizzato sul codice temporale di un

dispositivo esterno.

20.Indicatore filtro ND (pagina 47)

Indicazione Significato

@ Modalita auto

Modalita di controllo Bokeh
(pagina 55)

21. Indicatore file di scena (pagina 58)

22.Indicatore valore di diaframma
Visualizza il valore di diaframma (valore F) se
€ montato un obiettivo che supporta questa
funzione.

23.Indicatore di avviso livello video

25.Visualizzazione nome clip (pagina 96)
Visualizza il nome del clip in corso di
registrazione o che verra registrato
successivamente.

26.Indicatore otturatore (pagina 46)

27. Indicatore modalita AE/livello AE
(pagina 45)

28.Indicatore di livellamento
Visualizza l'orizzontalita in incrementi di +1°
fino a un massimo di +15°.

29.Indicatore di livello audio
Indica il livello audio dei canali da CH1 a CH4.

30.Monitor segnale video (pagina 54)
Visualizza forma d’'onda, vettorscopio e
istogramma.

La linea arancione indica il valore impostato
del livello zebra.

In modalita Cine El (pagina 25), visualizza il
tipo di LUT del segnale monitorato.

31. Indicatore Base Sensitivity/indicatore
Base ISO (pagina 45)
Nella modalita Custom (pagina 25)
visualizza la sensibilita di base impostata
con Base ISO/Sensitivity nella schermata
Main Status oppure con ISO/Gain/El >Base
Sensitivity nel menu Shooting del menu
completo.
Nella modalita Cine El (pagina 25) visualizza
la sensibilita Base ISO impostata con Base
ISO/Sensitivity nella schermata Main Status
oppure con ISO/Gain/El >Base ISO nel menu
Shooting del menu completo.

32.Indicatore assistenza visualizzazione
gamma/LUT monitor

Visualizza lo stato della funzione di assistenza

per la visualizzazione gamma. La funzione di

assistenza visualizzazione gamma puo essere

attivata o disattivata assegnando Gamma

Display Assist a un pulsante programmabile

(pagina 51).

In modalita Cine El (pagina 25), visualizza

I'impostazione della LUT monitor

(pagina 84).

33.Indicatore del Look di base (pagina 58)
Visualizza I'impostazione del Look di base.
In modalita Cine El (pagina 25) visualizza

il segnale video da registrare sulle schede di
memoria (pagina 84).

34 .Indicatore stato proxy

Indicazione Significato

Presxy Registrazione proxy attiva

Proxy Ree Registrazione proxy

Proxy Rec Registrazione proxy non

(lampeggiante) ~ Pronta

PxChunk Registrazione proxy in
blocchi (chunk) attiva

PxChunk Rec Registrazione proxy in
blocchi (chunk)

PxChunk Ree Registrazione proxy in

(lampeggiante) blocchi (chunk) non pronta

35. Indicatore formato di registrazione
(codec) (pagina 86)

Visualizza il nome del formato di registrazione

sulle schede di memoria.

36.Indicatore formato di registrazione
(frequenza fotogrammi e metodo di
scansione)

37. Indicatore formato di registrazione
(dimensioni immagine) (pagina 86)

Visualizza le dimensioni immagine per la

registrazione sulle schede di memoria.

38.Pulsante di arresto AF con seguimento in
tempo reale (pagina 44)
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Informazioni visualizzate sullo schermo durante la riproduzione Indicazioni grafiche (icone)

Le seguenti informazioni vengono sovraimposte sull'immagine riprodotta.
Icone di indicazione della connessione di rete

1 2 3 4 5
(@xJPHW) Modalita di rete Stato della connessione Icona
Modalita punto di accesso In operazione come punto di accesso
2
oDt Errore nel funzionamento come punto AR
di accesso
Modalita stazione Connessione Wi-Fi B A B A
L'icona cambia in base all'intensita del
segnale (4 livelli)
Wi-Fi non connesso (anche mentre .
viene stabilita la connessione)
Errore di connessione Wi-Fi B
4 M
Tethering USB Tethering USB connesso @?
9 10 11 12 13 14 Tethering USB non connesso n-r
1. Indicatore di stato della rete 11. Visualizzazione nome clip Errore nel tethering USB U‘!:z
2. Indicatore di upload/indicatore file 12. Indicatore assistenza visualizzazione
rimanenti gamma Visualizzazione dell'icona della serie UNP-D
Numero del clip/numero totale di clip 13. Indicatore di livello audio
. . . Visualizza il livello di riproduzione dell’audio. Stato del trasmettitore Stato della ricezione Icona
4. Indicatore dello stato della riproduzione - — —
14. Indicatore Base Look Dispositivo spento Nessuna ricezione W
Indicatore formato di riproduzione ’ ==
(frequenza fotogrammi e metodo di Stato di trasmissione normale Ricezione WD:.:.:. W]dﬂl

scansione) (livello di ricezione (4 livelli))

6. Indicatore formato di riproduzione Stato del muting Ricezione (muting attivo) %jﬂ:
(dimensioni immagine)

Avvertimento della capacita rimanente  Ricezione W

7. Indicatore carica residua della batteria/ della batteria dl= (icona lampeggiante)
tensione DCIN Muting attivo e avvertimento della Ricezione M ) | i

8. Indicatore formato di riproduzione capacita rimanente della batteria (icona lampeggiante)
(codec)

9. Indicatore supporto
Se la scheda di memoria & protetta da scrittura
viene visualizzata I'icona (.

10. Visualizzazione dati temporali
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Schermata di stato

La schermata di stato consente di controllare
le impostazioni e lo stato del camcorder. Le
impostazioni delle voci contrassegnate con un
asterisco (*) sono modificabili.

E possibile interagire con la schermata di stato
toccando il touchscreen.

Per visualizzare la schermata di stato

e Premere il pulsante MENU.

[Informazione]

E possibile mostrare o nascondere le varie schermate

di stato mediante la voce Menu Page On/Off
(pagina 104) del menu Technical.

Per passare a un‘altra schermata di stato

e Ruotare la manopola multifunzione.

e Spostare il selettore multiplo verso l'alto o
verso il basso

e Trascinare la schermata di stato verso l'alto
o verso il basso.

Per chiudere la schermata di stato
® Premere il pulsante MENU.

Per modificare un'impostazione

Mentre & visualizzata la schermata di stato,
premere la manopola multifunzione o il
selettore multiplo per consentire la selezione
di una voce di impostazione contenuta in una
pagina. Selezionare il numero della pagina
desiderata e quindi premere per aprirla.

E possibile selezionare voci anche
semplicemente toccandole sul touchscreen.

[Nota]

E possibile impedire la modifica delle voci della
schermata di stato impostando su On la voce Menu
Settings >User Menu Only (pagina 104) del menu
Technical nel menu completo.

Schermata Main Status

Visualizza le funzioni principali del camcorder
e lo spazio libero sul supporto di memoria.

Schermata Camera Status

Visualizza lo stato di varie preconfigurazioni

del camcorder.

Schermata Audio Status

Visualizza le impostazioni di ingresso,

I'indicatore di livello audio e il volume di

Voce visualizzata

Descrizione

Voce visualizzata Descrizione

monitoraggio per ciascun canale.

S&Q Frame Rate*

Impostazioni relative alla
ripresa e alla frequenza
fotogrammi in modalita
Slow & Quick Motion

White Switch<B>

Impostazione del

Voce visualizzata Descrizione

Frequency/Scan*

Impostazioni frequenza di
sistema e metodo di
scansione

Imager Scan*

Modalita di scansione del
sensore immagine

Media Remain
(A)

Spazio libero rimanente sul
supporto di memoria dello
slot A

ND Filter Impostazione del filtro ND

ISO/Gain/El Impostazione ISO/Gain/
Exposure Index

Base ISO/ Impostazione di Base ISO/

Sensitivity* Base Sensitivity

Codec* Impostazione codec per la

registrazione

Media Remain (B)

Spazio libero rimanente sul
supporto di memoria dello
slot B

Scene File*

File di scena utilizzato e
relativa impostazione di File
ID

Base Look/LUT*

Impostazione Base Look/LUT

Shutter

Impostazione della velocita
o dell’angolo dell’'otturatore

Iris

Impostazione del diaframma

Video Format*

Dimensioni immagine per la
registrazione sule schede di
memoria

RAW Output
Format*

Dimensioni di immagine
dell’'uscita RAW

White Balance

Impostazione del
bilanciamento del bianco

bilanciamento del bianco CH1 Level Stato On/Off della
della memoria B Control regolazione automatica
White Switch<A> Impostazione del Level Meter Indicatore di livello audio
bilanciamento del bianco Source* Sorgente di ingresso
della memoria A Ref./Sens.* Livello di riferimento di
White Switch<P> Impostazione di Preset ingresso
White - - — Wind Impostazione del valore di
ND<Preset> Impostazione dei valori di Filter* riduzione del filtro antivento
Preset1, Preset2 e Preset3 del microfono
del filtro ND CH2 Level Stato On/Off della
150 / Gain’<L>* _ Impostazione I1SO/Gain"<L> Control regolazione automatica
IS0 / Gain?’<M>*  Impostazione ISO/Gain'<M> Level Meter Indicatore di livello audio
ISO / Gain’<H>*  Impostazione ISO/Gain'<H> Source* Sorgente di ingresso
Base ISO/ Impostazione di Base IS0/ Ref./Sens.* Livello di riferimento di
Sensitivity* Base Sensitivity ingresso
Zebral* Impostazione Zebral On/Off Wind Impostazione del valore di
e livello Filter* riduzione del filtro antivento
Zebra2* Impostazione Zebra2 On/Off del microfono
e livello CH3 Level Stato On/Off della
VF Gamma/ Categoria e curva di gamma Control* regolazione automatica
Gamma Level Indicatore di livello audio
Scene File* File di scena utilizzato e Meter*
relativa impostazione di File Source* Sorgente di ingresso
ID Ref./Sens.* Livello di riferimento di
1) Exposure Index quando Shooting Mode & impostata ingresso
su Cine El. Wind Impostazione del valore di
Filter* riduzione del filtro antivento

del microfono
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Voce visualizzata

Descrizione

Schermata di stato Project

CH4  Level Stato On/Off della . ) . o )
Control* regolazione automatica Visualizza I-e .|mposta2|on| di base relative al
Level Indicatore di livello audio progetto di ripresa.
Meter* Voce visualizzata Descrizione
Source* Sorgente di ingresso Frequency/Scan* Impostazioni frequenza di
Ref./Sens.* Livello di riferimento di sistema e metodo di
]ngresso scansione
Wind Impostazione del valore di Codec* Impostazione codec per la
Filter* riduzione del filtro antivento registrazione
del microfono Rec Function* Impostazione On/Off della
Audio Input Impostazione del livello di funzione di registrazione
Level* ingresso audio (volume speciale e impostazioni

master)

HDMI Output CH*

Impostazione canale audio
di uscita HDMI

Volume* Impostazione del volume
dell’altoparlante incorporato
o delle cuffie

Monitor CH* Impostazione di

monitoraggio del canale

principali

Simul Rec* Stato e impostazione On/Off
della funzione di
registrazione simultanea su
2 slot

Title Prefix Porzione del titolo del nome

del clip

Imager Scan*

Modalita di scansione del
sensore immagine

Video Format*

Dimensioni immagine per la
registrazione sule schede di
memoria

Picture Cache
Rec*

Attivazione (On/Off) e
impostazione delle
dimensioni della cache
immagine

Schermata Monitoring Status

Visualizza le impostazioni di uscita SDI e HDMI.

Voce visualizzata

Descrizione

Schermata Assignable Button Status

Visualizza le funzioni assegnate ai pulsanti

programmabili.

Number

Suffisso numerico del nome
del clip

Shooting Mode*

Impostazioni della modalita
diripresa

SDI Signal*  Dimensioni immagine di Voce visualizzata Descrizione
uscita 1 Funzione assegnata al
Info. Impostazione On/Off pulsante ASSIGN 1
Disp.* dell’emissione in uscita 2 Funzione assegnata al
delle informazioni pulsante ASSIGN 2
Color Impostazione dello spazio 3 Funzione assegnata al
Gamut* colore/Stato della LUT pulsante ASSIGN 3
monitor 4 Funzione assegnata al
HDMI Signal* Dimensioni immagine di pulsante ASSIGN 4
uscita 5 Funzione assegnata al
Info. Impostazione On/Off pulsante ASSIGN 5
Disp.* dell’emissione in uscita 6 Funzione assegnata al
delle informazioni pulsante ASSIGN 6
Color Impostazione dello spazio 7 Funzione assegnata al
Gamut*  colore/Stato della LUT pulsante ASSIGN 7
monitor -
8 Funzione assegnata al
Stream  Signal Dimensioni immagine di pulsante ASSIGN 8
uscita -
9 Funzione assegnata al
Info. Emissione in uscita delle pulsante ASSIGN 9
Disp. informazioni (Off (fisso)) Focus Hold Funzione assegnata al
Color Impostazione dello spazio Button pulsante Focus Hold
Gamut*  colore/Stato della LUT dell’'obiettivo
monitor Multi Function Funzione assegnata alla
VF Color Impostazione assistenza Dial manopola multifunzione
e e .
Gamut wsuahzza;mne gamma/. Grip Dial Funzione assegnata alla
Impostazione dello spazio .
manopola programmabile
colore/Stato della LUT dell'impugnatura
monitor ; -
Handle Dial Funzione assegnata alla

Base Look/LUT*

Impostazione Base Look/
LUT

RAW Output Dimensioni di immagine
Format* dell’'uscita RAW
Proxy Rec* Impostazione On/Off della

funzione di registrazione
proxy

Gamma Display
Assist*

Impostazione On/Off della
funzione di assistenza alla
visualizzazione gamma

manopola programmabile
della maniglia
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Schermata Battery Status

Visualizza informazioni sulla batteria e
la sorgente di alimentazione collegata al
connettore DC IN.

Schermata Media Status

Visualizza la capacita rimanente e il tempo
di registrazione rimanente dei supporti di
registrazione.

Voce visualizzata Descrizione

Voce visualizzata Descrizione

Detected Battery Tipo di batteria

Remaining Capacita rimanente (%)
Charge Count Numero di ricariche
Capacity Capacita rimanente (Ah)
Voltage Tensione batteria (V)
Manufacture Data di fabbricazione della
Date batteria

Video Light Visualizza la capacita
Remaining rimanente della batteria

della luce video.

Power Source Sorgente di alimentazione
Supplied Voltage Tensione fornita dalla

sorgente di alimentazione

Informazioni Visualizza l'icona della
scheda A scheda quando ¢ inserito un
supporto di registrazione
nello slot A.
Indicatore Visualizza la capacita
capacita rimanente del supporto di
rimanente registrazione inserito nello
scheda A slot A come percentuale su
una barra.
Tempo di Visualizza il tempo stimato
registrazione di registrazione rimanente
rimanente sul supporto di registrazione
scheda A inserito nello slot A in minuti
nelle condizioni di
registrazione attuali.
Informazioni Visualizza l'icona della
scheda B scheda quando e inserito un
supporto di registrazione
nello slot B.
Indicatore Visualizza la capacita
capacita rimanente del supporto di
rimanente registrazione inserito nello
scheda B slot B come percentuale su
una barra.
Tempo di Visualizza il tempo stimato
registrazione di registrazione rimanente
rimanente sul supporto di registrazione
scheda B inserito nello slot B in minuti

nelle condizioni di
registrazione attuali.

Schermata Network Status

Visualizza lo stato della connessione di rete.

Voce visualizzata Descrizione

Voce visualizzata Descrizione

Destination
Directory

Directory di destinazione sul
server di destinazione del
trasferimento dei file

Wireless LAN Impostazioni e stato della
connessione wireless

Wired LAN Impostazioni e stato della
connessione della LAN
cablata

Modem Impostazioni della

connessione wireless e stato
della connessione tramite
tethering USB

Schermata File Transfer Status

Visualizza informazioni sul trasferimento di file.

Voce visualizzata Descrizione

Auto Upload Stato On/Off della funzione
Auto Upload

Auto Upload Stato On/Off/Chunk della

(Proxy) funzione Auto Upload

(Proxy)

Total Transfer
Progress

Avanzamento complessivo
del trasferimento dei
processi

Default Upload Nome del server di

Server destinazione di Auto Upload
(Proxy)
Job Status Numero dei processi

rimanenti e numero totale
dei processi

(Remain / Total)

Current File Avanzamento del
Transfer Progress trasferimento del file attuale

Current Nome del file in corso di
Transferring File  trasferimento

Name

Server Address Indirizzo del server di

destinazione del
trasferimento dei file
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Utilizzo delle schermate di impostazione di tipo touchscreen

Elementi dello schermo

D Audio .
Pulsante Set (applica)

INPUT1
MIC +48V

INPUT2 Simbolo indicante
MIC +48V

I'impostazione attuale
Int MIC

INPUT2 m Cursore di selezione

MIC +48V d_ell’impostazio_ne
HDMI Output CH (riquadro arancione)

CH1 "l“ .

CH2 "l“
CH3
I
CH4
<

CH1/CH2

Opzioni selezionabili

Modalita di utilizzo

1 Toccare una voce di impostazione. 2 Trascinare o dare un colpetto con il dito
D Audio 3/13 per scorrere e selezionare il valore
desiderato.

D Audio CH4 Input Sel.

CH1 i INPUT1
I““ MIC +48V
CH2 i INPUT2
LU 5 | miC +48v

Set

CH i INPUTA
““I u i 5 MIC +48V
CH2 i INPUT2
““I ' T H MIC +48V

CH3 i Int MIC
S [T

[ i Int MIC
5| 1 _

oo i | §
o/ 1 I

MG

0dB

-50dB Off

udio Input Level |[HDMI Output C qhime Monitor CH

99 CH1/CH2 CH1/CH2

CH4 i INPUT2
A] ““I ' MIC +48V
Audio Input Level |[HDMI Output CH ‘olume
99 CH1/CH2 0

Tocco

Vengono visualizzate le opzioni di
selezione del valore.

Scorrimento rapido

3 Toccare il pulsante Set o il cursore di
selezione del valore.
Il valore viene applicato e il display ritorna
alla schermata precedente.

[Informazioni]

e Premere il pulsante CANCEL/BACK per ritornare al
valore precedente.

o E possibile utilizzare anche la manopola
multifunzione o il selettore multiplo.

e Se si desidera, le operazioni touchscreen possono
essere disabilitate (pagina 103).
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2. Operazioni preliminari

Alimentazione

E possibile utilizzare un pacco batteria o
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i
seguenti pacchi batterie e adattatori CA Sony.

Utilizzo del pacco batteria

Per montare un pacco batteria, inserirlo fino
in fondo nell'apposita sede (pagina 7),

quindi spingerlo verso il basso per bloccarlo in
posizione.

Pacchi batteria agli ioni di litio
BP-U35 (in dotazione)

BP-U60

BP-U60T

BP-U70

BP-U90

BP-U100

Caricabatterie

BC-CU1 (in dotazione)
BC-U1A

BC-U2A

Adattatore CA (in dotazione)

[ATTENZIONE]
Non conservare i pacchi batteria in luoghi
esposti alla luce solare diretta o a fiamme
libere, oppure in cui siano presenti elevate
temperature.

Per rimuovere un pacco batteria, farlo scorrere
verso l'alto mantenendo premuto il pulsante
BATT RELEASE (pagina 7), quindi estrarlo

dalla sua sede.

[Note]

e Per I'alimentazione dalla rete elettrica, utilizzare
I'adattatore CA fornito.

e Spostare sempre il selettore POWER su Off prima
di rimuovere o montare un pacco batteria o un
adattatore CA. Se viene rimosso o montato con il
selettore POWER su On, in alcuni casi il camcorder
potrebbe non avviarsi. Se il camcorder non si avvia,
spostare il selettore POWER su Off e disconnettere
temporaneamente il pacco batteria o I'adattatore
CA, quindi attendere 30 secondi circa e riconnettere
il pacco batteria o I'adattatore CA. (Se il camcorder
¢ alimentato dal pacco batteria, I'adattatore CA puo
essere connesso senza problemi anche se il selettore
POWER si trova nella posizione On).

Pulsante BATT
RELEASE

[Note]

e Prima di montare un pacco batteria, caricarlo con il
caricabatterie specifico BC-CU1, BC-U1A o BC-U2A.

e |l pacco batteria potrebbe non ricaricarsi
completamente se si cerca di ricaricarlo mentre &
caldo (ad esempio, subito dopo I'uso).

Controllo della capacita rimanente

Durante la ripresa o la riproduzione con
un pacco batteria, la capacita rimanente
della batteria viene visualizzata nel mirino
(pagina 11).

Significato

91%-100%

71%-90%

a = |A
SRel
I@ES

V//] 51%-70%

31%-50%

11%-30%

U\

0%-10%

Il camcorder indica la capacita rimanente
calcolando il tempo disponibile con il pacco
batteria sulla base del consumo e delle
condizioni d'uso attuali.

Se il livello di carica del pacco batteria
diventa insufficiente

Se il livello di carica rimanente del pacco
batteria scende al di sotto di un determinato
valore durante I'utilizzo (stato Low Battery),
viene visualizzato il messaggio di batteria
prossima all'esaurimento e la spia di
registrazione/tally comincia a lampeggiare.
Se il livello di carica rimanente si abbassa
ulteriormente fino a raggiungere un livello
al quale & impossibile continuare I'utilizzo
dell'apparecchio (stato Battery Empty), viene
visualizzato il messaggio di batteria esaurita.
Sostituire il pacco batteria esaurito con uno
carico.

Modifica dei livelli di avviso

Per impostazione predefinita di fabbrica, il
livello Low Battery € impostato al 10% della
carica completa della batteria, mentre il livello

Battery Empty & impostato sul 3%. E possibile
modificare i valori dei livelli di avviso con
I'opzione Camera Battery Alarm (pagina 105)
nel menu Technical del menu completo.

Carica di un pacco batteria con il
caricabatterie in dotazione (BC-CU1)

1 Collegare I'adattatore CA (in dotazione) al
caricabatterie, quindi collegare il cavo di
alimentazione (in dotazione) alla sorgente
di alimentazione di rete.

2 Inserire la batteria spingendola nella
direzione indicata dalla freccia.
La spia CHARGE si illumina con luce
arancione e la carica ha inizio.

Spia CHARGE

— Adattatore CA

?0— Cavo di alimentazione
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Spia CHARGE (arancione)
Illuminata: Carica in corso
Lampeggiante: Errore nella ricarica o
temperatura fuori da intervallo
consentito. Carica interrotta.
e Quando la batteria & completamente carica,
la spia CHARGE del caricabatterie si spegne.
e Utilizzare esclusivamente batterie originali
Sony.

Tempo diricarica

Tempo approssimativo necessario per
la ricarica completa di un pacco batteria
completamente scarico, in minuti.

Pacco batteria Tempo di carica
completa

BP-U35 120 minuti

[Nota]

La batteria comincia a scaricarsi anche se viene lasciata
connessa al caricabatterie mentre il caricabatterie non &
connesso all’adattatore CA.

Alimentazione CA

Collegando il camcorder a una sorgente di
alimentazione di rete, € possibile utilizzarlo
senza doversi preoccupare di ricaricare il
pacco batteria.

Cavo di
alimentazione Connettore DCIN

l [I:’
Adattatore CA
Collegare I'adattatore CA al connettore DC
IN del camcorder, quindi collegare il cavo di

alimentazione (in dotazione) alla sorgente di
alimentazione di rete.

Se la tensione fornita dall'adattatore CA
si abbassa

Se, durante |'utilizzo, la tensione fornita
dall’adattatore CA scende al di sotto di un
determinato valore (stato DC Low Voltage1),
viene visualizzato un messaggio che segnala
I'abbassamento della tensione dell’adattatore
CA e la spia di registrazione/tally comincia a
lampeggiare.

Se la tensione di uscita dell’adattatore CA
scende al di sotto di un valore che impedisce
il funzionamento corretto (stato DC Low
Voltage2), viene visualizzato un messaggio
che segnala che la tensione di uscita
dell'adattatore CA & insufficiente.

In questo caso, I'adattatore CA puo essere
difettoso. Controllare I'adattatore CA secondo
il caso.

Modifica delle tensioni di avviso

Per impostazione predefinita, il livello DC Low
Voltagel & impostato su 16,5V e il livello DC
Low Voltage2 & impostato su 15,5 V. E possibile
modificare i valori dei livelli di avviso con
I'opzione Camera DC IN Alarm (pagina 105)

del menu Technical.

Adattatore CA

e Non collegare né utilizzare un adattatore CA
in uno spazio ristretto, ad esempio fra una
parete e un mobile.

e Collegare I'adattatore CA alla presa
di corrente di rete piu vicina. In caso
di problemi durante |'uso, estrarre
immediatamente la spina dalla presa di
corrente.

e Non cortocircuitare le parti metalliche dello
spinotto dell’'adattatore CA. Questo ne
causerebbe il guasto.

e | a batteria non puo essere ricaricata mentre
€ montata sul camcorder, anche se &
connesso l'adattatore CA.

e Per scollegare I'adattatore CA dall’unita,
assicurarsi di afferrarne solo lo spinotto ed
estrarlo senza ruotarlo. Non tirare il cavo per
evitare possibili malfunzionamenti.
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Montaggio degli accessori

Montaggio di un microfono (in
vendita separatamente)

Inserire il microfono nel portamicrofono.

2 Collegare il cavo del microfono al
connettore INPUT1 o al connettore INPUT2.

INPUT1  INPUT2

3 Collocare il cavo del microfono nel
fermacavo come mostrato in figura.

Portamicrofono

Fermacavi

[Informazioni]

e Se non é possibile assicurare saldamente il microfono
nel portamicrofono, utilizzare il distanziale fornito con
il microfono stesso.

e Con certi obiettivi, & possibile che I'estremita anteriore
del microfono risulti visibile nell'immagine ripresa dal
camcorder. Regolare la posizione del microfono.

Montaggio del mirino

[Nota]
Montare e smontare il mirino solo mentre il camcorder
€ spento.

Montaggio del mirino sulla sezione
anteriore della maniglia

1 Inserire I'adattatore del morsetto di
montaggio nell'attacco del mirino della
maniglia ((®), quindi ruotare in senso
orario la vite (in dotazione) per fissarlo in
posizione (@).

L'adattatore del morsetto di montaggio
puo essere montato in qualsiasi posizione
in incrementi di 45°, ma si consiglia di
montarlo nella posizione in cui si trova
immediatamente sopra la vite.

Vite
Adattatore del morsetto
di montaggio del mirino

2 Montare il morsetto del mirino
sull’'adattatore del morsetto di montaggio
del mirino (®), quindi ruotare in senso
orario la manopola di bloccaggio per
fissarlo in posizione (®).

[Nota]

Quando si utilizza un mirino, € importante che la
manopola di bloccaggio sia saldamente serrata. Se la
manopola di bloccaggio non e saldamente serrata, il
mirino potrebbe cadere.

3 Allineare l'indicatore A presente sul
camcorder con il corrispondente
indicatore ¥ sul connettore del mirino,
quindi inserire il cavetto.

Prima di inserire il connettore, controllare
che l'indicatore V¥ si trovi sul lato esterno.

4 Collocare il cavo nel fermacavo come
mostrato in figura.

Fermacavi
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Montaggio del mirino sulla sezione
posteriore della maniglia

Per il montaggio del mirino, sono disponibili
due punti di montaggio sulla sezione
posteriore della maniglia (D) e due punti di
montaggio sul lato posteriore del camcorder
(®). Montare il mirino come descritto nella
sezione “Montaggio del mirino sulla sezione
anteriore della maniglia”.
=
[% @

=

Regolazione della posizione del mirino

Inclinare il mirino verso l'alto, verso il basso, in
avanti o indietro fino ad ottenere I'angolazione
desiderata.

Usando il selettore MIRROR, € possibile
invertire I'immagine quando questa viene
osservata, ad esempio, dal lato anteriore del
camcorder.

@ OO

[Informazione]

Quando il camcorder non é utilizzato o durante
il trasporto, e consigliabile proteggere il mirino
spostandolo sulla posizione mostrata in figura.

Rimozione del mirino

Allentare la manopola di bloccaggio del mirino
e ripetere la procedura di montaggio in senso
inverso.

Montaggio del paraluce del mirino

1 Aprire le clip metalliche del paraluce del
mirino.

2 Agganciare la clip metallica presente sulla
parte superiore del paraluce al
corrispondente gancio situato sul lato
superiore del mirino, quindi agganciare la
clip metallica della parte inferiore del
paraluce al gancio sul lato inferiore del

mirino.
(e
. |
Agganci @

3 Bloccare il paraluce del mirino in posizione
spingendo in direzione della freccia la
piastrina di bloccaggio situata nella parte
inferiore del paraluce del mirino.

Piastrina di
bloccaggio

Apertura del paraluce del mirino

Per aprire il paraluce del mirino sollevarlo
tirandolo dal centro del lato inferiore.

[Nota]
Spostare il mirino afferrandone sempre solo il corpo.
Non afferrare il paraluce del mirino.

Rimozione del paraluce del mirino

Sganciare il gancio del paraluce del mirino e
rimuovere il paraluce dal mirino.
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Montaggio dell'impugnatura di
telecomando

[Nota]
Montare e smontare I'impugnatura di telecomando solo
mentre il camcorder e spento.

1 Collegare il cavetto al connettore
dell'impugnatura di telecomando.

2 Allineando l'attacco di montaggio
dell'impugnatura di telecomando del
camcorder con l'indicatore di montaggio
presente sull'impugnatura ((»), inserire
I'impugnatura sul camcorder e ruotarla
lentamente in senso antiorario (®).

Al blocco in posizione si percepira uno
scatto.

Indicatore

[Nota]

Se il montaggio non riesce correttamente, riprovare a
inserire I'impugnatura di telecomando senza forzare né
I'impugnatura né il camcorder.

3 Inserire il cavetto collegato al punto 2
nell’apposita scanalatura di guida
presente sull'impugnatura di
telecomando, come illustrato in figura.

[Nota]

Se il cavetto non € inserito nella scanalatura, spostando
I'angolazione dell'attacco dell'impugnatura si
potrebbero esercitare sul cavetto tensioni eccessiva,
oppure il cavetto potrebbe rimanere intrappolato nel
meccanismo di rotazione.

Regolazione dell'angolazione
dell'impugnatura di telecomando

L'angolazione dell'impugnatura di
telecomando puo essere regolata nella
posizione piu comoda per il proprio stile di
ripresa.

Ruotata verso il retro (massimo 83°).

Spostare la levetta di rotazione
dell'impugnatura nella posizione mostrata
in figura e ruotare I'impugnatura
mantenendo premuta la levetta.

Sollevare il dito dalla levetta di rotazione
dell'impugnatura in prossimita della
posizione desiderata.

Continuare a spostare leggermente
I'impugnatura fino a percepire lo scatto e
il blocco in posizione.

Una volta bloccata I'impugnatura nella
posizione desiderata, la levetta di
rotazione dell'impugnatura torna nella
sua posizione originale.

[Note]
e Dopo averne cambiato la posizione, controllare
sempre che I'impugnatura sia saldamente bloccata.
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e Non é possibile regolare I'angolazione oltre le Rimozion I'im n I [Informazione] . ;o .
posizioni consentite. Non esercitare una forza ozione de pug atura Sia il punto di montaggio dell'impugnatura del Montagg|0 de” Ob|ett|V0
eccessiva per lo spostamento dell'impugnatura. camcorder che il corrispondente punto di montaggio
[Nota] sull'impugnatura consentono il montaggio di una
H Per la rimozione dell'impugnatura, appoggiare sempre rosetta. ATTENZIONE
Come afferrare l Impugnatura (metOdO il camcorder su una superficie piana, ad esempio un Per informazioni dettagliate sull'acquisto di rosette, E\I | . ] I'obietti ivolt il sol
CO”SlgllatO) tavolo. rivolgersi al proprio rivenditore Sony. onlasciare FobIetlvo Mvolto verso 1l sofe.
1 - Lato camcorder: 4-546-932- (opzione) La luce solare diretta condotta dalle ottiche
Non esiste una regola fissa che stabilisce come Scollegare il cavetto dal connettore - Lato impugnatura: 4-547-089- (opzione) dell'obiettivo pud mettersi a fuoco all'interno
. . dell'impugnatura di telecomando. - Viti di fissaggio* del camcorder e causare incendi
afferra?re I'impugnatura. !I §eguente esemplo,. Lato camcorder: 7-627-556- (opzione)
tuttavia, mostra una posizione che consente il 2 _ _ Lato impugnatura: 7-627-556- (opzione) [Note]
facile azionamento dei vari comandi. Mantenendo premuto il pulsante di * Ciascuna rosetta richiede quattro viti di fissaggio (i e Montare e smontare I'obiettivo solo mentre il
rilascio dell'impugnatura di telecomando, relativi fori sono indicati con cerchi nel diagramma ca.mcqrde'r'é spento. o N
. ruotare I'impugnatura in senso orario fino seguente). L'utilizzo di viti diverse da quelle e Gli obiettivi sono componenti di elevata precisione.
Utilizzo del pUISante ASSIGN 5 o del selettore al distacco pug specificate potrebbe danneggiare componenti esterni Non appoggiare mai un obiettivo su una superficie
multiplo ~ dell'apparecchio. con il suo innesto rivolto verso il basso. Montare

sempre I'apposito coperchietto di protezione fornito.

[Informazione]

Per informazioni dettagliate sugli obiettivi supportati dal
camcorder, contattare il rappresentante dell'assistenza
tecnica Sony.

Montaggio di un obiettivo con innesto

Lato Lato
camcorder impugnatura E-mount

‘ P

CA B

A: Azionare la manopola programmabile
dell'impugnatura con il dito indice.

B: Azionare il selettore multiplo e il pulsante
ASSIGN 5 con il pollice. Pulsante di rilascio dell'impugnatura di
C: Afferrare saldamente I'impugnatura con il telecomando

dito medio, I'anulare e il mignolo.

1 Rimuovere i coperchietti di protezione dal
corpo del camcorder e dall'obiettivo.

Utilizzo dello zoom

A: Azionare la levetta dello zoom con I'indice
e il medio.

B: Afferrare saldamente I'impugnatura con il
pollice.

C: Afferrare saldamente I'impugnatura con
I'anulare e il mignolo.
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2 Per montare I'obiettivo, allineare con il
camcorder I'indicatore (bianco)
sull'innesto dell’'obiettivo, inserire con
attenzione Il'obiettivo nell’innesto, quindi
ruotare l'obiettivo in senso orario.

Al blocco in posizione si percepira uno
scatto.

Indicatori di allineamento (bianco)

[Nota]
Non premere il pulsante di rilascio dell’obiettivo durante
I'inserimento di un obiettivo.

Montaggio di un obiettivo con innesto
A-mount

Per poter montare un obiettivo con innesto
A-mount, & necessario montare prima
I'apposito adattatore (opzionale).

[Nota]

Quando si utilizza un obiettivo con innesto A-mount,
il diaframma & impostato manualmente e la messa a
fuoco & impostata su MF.

Rimozione dell'obiettivo

Per rimuovere I'obiettivo, procedere come
descritto di seguito.

1 Mantenendo premuto il pulsante di
rilascio dell'obiettivo, ruotare I'obiettivo in
senso antiorario sostenendolo con la
mano.

2 Estrarre I'obiettivo dal corpo

dell'apparecchio.

[Note]

e Durante la rimozione, allineare I'indicatore di innesto
sulla ghiera di blocco obiettivo con I'indicatore di
innesto del camcorder.

e Afferrare saldamente I'obiettivo con la mano per
impedirne la caduta.

e Se non viene montato un altro obiettivo
immediatamente, montare sempre il coperchietto di
protezione del corpo.

Regolazioni del diaframma con obiettivi
con selettore Auto Iris

e Quando il selettore Auto Iris dell'obiettivo
€ impostato su AUTO, il diaframma viene
regolato automaticamente ma puo
essere anche regolato manualmente dal
camcorder.

e Quando il selettore Auto Iris dell'obiettivo
e impostato su MANUAL, il diaframma
puo essere regolato solo usando la
ghiera dell’'obiettivo stesso. Le eventuali

regolazioni del diaframma dal camcorder
non hanno alcun effetto.

Regolazioni della messa a fuoco con
obiettivi con selettore di messa a fuoco

e Quando il selettore della messa a fuoco
dell'obiettivo & impostato su AF/MF
o AF, la messa a fuoco viene regolata
automaticamente ma puo essere anche
regolata manualmente con un telecomando.

e Quando il selettore della messa a fuoco
dell'obiettivo & impostato su MF, la messa a
fuoco puo essere regolata sia mediante la
ghiera dell’'obiettivo che manualmente con
un telecomando.

[Nota]

Quando si utilizza un obiettivo con innesto A-mount,
potrebbe non essere possibile eseqguire la regolazione
manuale con un telecomando.

e Quando il selettore della messa a fuoco
dell'obiettivo & impostato su Full MF, la
messa a fuoco puo essere eseqguita solo
usando la ghiera dell’'obiettivo. Le eventuali
regolazioni della messa a fuoco dal
camcorder non hanno alcun effetto.

Montaggio di un treppiede

Usare gli attacchi filettati di montaggio del
treppiede sul camcorder quando si monta
un treppiede. L'utilizzo dell'attacco treppiede
sull’'obiettivo potrebbe causare danni.
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Configurazione delle operazioni di base del camcorder

Quando il camcorder viene acceso per la prima
volta o se la batteria di backup si & scaricata
completamente, nel mirino viene visualizzata
la schermata delle impostazioni iniziali.
Impostare la data e I'ora dell'orologio interno
in questa schermata.

Time Zone

Time Zone imposta il fuso orario, ovvero la
differenza con I'ora UTC (Coordinated Universal
Time). Impostare questo valore secondo il caso.

Impostazione della data e dell'ora

Utilizzare il selettore multiplo (pagina 7)

o la manopola multifunzione (pagina 5)

per selezionare voci e impostazioni, quindi
premere il pulsante di conferma del selettore
multiplo per confermare le impostazioni e
avviare l'orologio.

In sequito, dopo la chiusura della schermata di
impostazione, & possibile modificare data, ora
e fuso orario servendosi dell'opzione Clock Set
(pagina 111) del menu Maintenance.

[Note]

e Se le impostazioni di data e ora sono andate
perse perché la batteria di backup si e scaricata
completamente a seguito di un lungo periodo
di tempo in cui il camcorder e rimasto senza
alimentazione (senza pacco batteria o alimentazione
DC IN), verra nuovamente visualizzata la schermata
delle impostazioni iniziali quando si riaccende
nuovamente il camcorder.

e Mentre é visualizzata la schermata delle impostazioni
iniziali non e possibile eseguire alcuna operazione
(ad eccezione dello spegnimento) fino a quando non
si siano completate tutte le impostazioni di questa
schermata.

e |l camcorder € dotato di una batteria ricaricabile
interna che consente la memorizzazione di data, ora e
altre impostazioni anche quando ¢ spento.

Prima di iniziare le riprese, & necessario
configurare il funzionamento di base del
camcorder secondo l'applicazione specifica
nella schermata di stato Project.

[aStby DCIN19.5 vV

4 4/10

Sk e
Custom(709)

Vid:

nat RAW Output Format

3840x2160P

Pic

Title Prefix Number

000_ 0001

Modalita di ripresa

Sono disponibili due modalita di ripresa: la
modalita “Custom”, che consente la creazione
dell'immagine in sito con la massima
flessibilita, e la modalita “Cine EI”, in cui il
camcorder viene utilizzato in maniera analoga
a una macchina cinematografica a pellicola,
sviluppando poi le riprese in sede di post
produzione.

Impostare la modalita di ripresa con Shooting
Mode (pagina 15) nella schermata di stato
Project.

[Informazione]

La modalita di ripresa pud essere impostata anche con

Base Setting >Shooting Mode (pagina 86) nel menu
Project del menu completo.

Modalita Custom

In modalita di ripresa Custom € possibile

selezionare lo standard video utilizzato.

Lo standard video pu0 essere impostato con

Base Setting >Target Display (pagina 86) nel

menu Project del menu completo.

e SDR(BT.709): Ripresa con lo standard di
broadcast HD

e HDR(HLG): Ripresa con lo standard di
broadcast 4K di prossima generazione
Per informazioni dettagliate, vedere pagina

58.

Modalita Cine El

Quando la modalita di ripresa & impostata su
Cine El, selezionare lo spazio colore di base
per il segnale di registrazione e per il segnale
di uscita. Lo spazio colore selezionato qui & lo
spazio colore dell’uscita video quando MLUT e
impostato su Off.

E possibile impostare lo spazio colore

desiderato mediante Cine El Setting >Color

Gamut (pagina 87) nel menu Project del

menu completo.

e S-Gamut3.Cine/SLog3: Gamme di colore
per il cinema digitale di facile regolazione
(DCI-P3).

e S-Gamut3/SLog3: Gamma di colore Sony
molto ampia che copre lo spazio colore
ITU-R BT.2020.

Per informazioni dettagliate, vedere pagina

60.

[Note]
e La modalita Cine El presenta le seguenti limitazioni:
e Funzioni che non possono essere regolate
automaticamente (tracking)
- Bilanciamento del bianco
- Guadagno
- Otturatore
e Funzioni che non possono essere configurate
- Sensibilita 1ISO/guadagno (impostata sulla
sensibilita ISO di base (fissa))
- Impostazioni menu Paint/Look (eccetto Base
Look)
- File di scena (disabilitato)
e Le funzioni indicate di seguito sono disponibili solo in
modalita Cine El (pagina 60).
e Exposure Index
e Monitor LUT

Frequenza di sistema

Impostare la frequenza di sistema con
Frequency/Scan (pagina 15) nella
schermata di stato Project. Dopo la
selezione, il camcorder potrebbe riavviarsi
automaticamente, a seconda del valore
selezionato.

[Informazione]

La frequenza di sistema puo essere impostata anche con
Rec Format >Frequency (pagina 86) nel menu Project

del menu completo.

[Nota]
Non ¢ possibile cambiare la frequenza di sistema
durante la registrazione o la riproduzione.

Modalita di scansione imager

Le dimensioni di immagine effettive e la
risoluzione del sensore immagini possono
essere impostate secondo le proprie esigenze.
Impostare la modalita di scansione con Imager
Scan (pagina 15) nella schermata di stato
Project.

e FF: Formato Full Frame.

e S35: Formato Super 35mm.

[Informazione]

La modalita di scansione pud essere impostata anche
con Rec Format >Imager Scan Mode (pagina 86) nel
menu Project del menu completo.

[Note]

e Non é possibile cambiare la modalita di scansione
dell'imager durante la registrazione o la riproduzione.

e Se impostata su S35, il formato video é limitato a
1920x1080.
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Codec

Impostare il codec con Codec (pagina 15)
nella schermata di stato Project.

[Informazione]

Il codec puo essere impostato anche con Rec Format
>Codec (pagina 86) nel menu Project del menu
completo.

[Nota]
Non e possibile cambiare il codec durante la
registrazione o la riproduzione.

Formato video

E possibile scegliere il formato video per le
registrazioni. Impostare il formato video con
Video Format (pagina 15) nella schermata

di stato Project.

[Informazione]

Il formato video puo essere impostato anche con Rec
Format >Video Format (pagina 86) nel menu Project
del menu completo.

[Note]

e Non & possibile cambiare il formato video durante la
registrazione o la riproduzione.

e |n base alle impostazioni del formato video,
potrebbero essere presenti limitazioni relative al
segnale fornito dai connettori SDI OUT e HDMI OUT.
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Utilizzo di schede di memoria

Il camcorder registra audio e video su schede di memoria CFexpress Type A (disponibili
separatamente) o schede di memoria SDXC (disponibili separatamente) inserite negli
appositi slot. Le schede di memoria sono utilizzate anche per la registrazione proxy, per la
memorizzazione e il caricamento di impostazioni, nonché per I'aggiornamento o upgrade del
software.

Informazioni sulle schede di memoria CFexpress Type A

Utilizzare con il camcorder le schede di memoria Sony CFexpress Type A* indicate in “Supporti di
memoria consigliati” (pagina 28).
Per informazioni dettagliate sull’utilizzo di supporti di memoria di altri fabbricanti, fare

riferimento alle relative istruzioni per I'uso o consultare le informazioni del fabbricante.
* Indicate semplicemente come “schede CFexpress” nel presente documento.

Informazioni sulle schede di memoria SDXC

Utilizzare con il camcorder le schede di memoria SDXC* indicate in “Supporti di memoria
consigliati” (pagina 28).
* Indicate semplicemente come “schede SD" nel presente documento.
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Supporti di memoria consigliati

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e Recording.

Si: Funzionamento supportato
No: il funzionamento corretto non € garantito

Formato di registrazione CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
RAW Out & 4096x2160 Modalita normale 59.94P Si No No No No No No Si
XAVC Class300 50P Si No No No No No No Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
24P Si No No No No No Si Si
23.98P Si No No No No No Si Si
3840x2160 Modalita normale 59.94P Si No No No No No No Si
Class300 50P Si No No No No No No Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No Si Si
S&Q (max. 60fps) 59.94P Si No No No No No No Si
50P Si No No No No No No Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No Si
S&Q (100fps, 120fps) 59.94P Si No No No No No No No
50P Si No No No No No No No
29.97P Si No No No No No No No
25P Si No No No No No No No
23.98P Si No No No No No No No
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Formato di registrazione CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 4096x2160 Modalita normale 59.94pP Si No No No No No No Si
Class300 50P Si No No No No No No Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
24P Si No No No No No Si Si
23.98P Si No No No No No Si Si
S&Q (max. 60fps) 59.94P Si No No No No No No Si
50P Si No No No No No No Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
24P Si No No No No No No Si
23.98P Si No No No No No No Si
3840x2160 Modalita normale 59.94P Si No No No No No No Si
Class300 50P Si No No No No No No Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No Si Si
S&Q (max. 60fps) 59.94P Si No No No No No No Si
50P Si No No No No No No Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No Si
S&Q (100fps, 120fps) 59.94P Si No No No No No No No
50P Si No No No No No No No
29.97P Si No No No No No No No
25P Si No No No No No No No
23.98P Si No No No No No No No
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Formato di registrazione CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 1920x1080 Modalita normale 59.94pP Si No No No No No Si Si
Class100 50P Si No No No No No Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No Si No Si Si Si
S&Q (max. 60fps) 59.94P Si No No No No No Si Si
50P Si No No No No No Si Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No Si Si
S&Q (100fps, 120fps) 59.94P Si No No No No No No Si
50P Si No No No No No No Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No Si
S&Q (150fps, 180fps) 59.94P Si No No No No No No No
50P Si No No No No No No No
29.97P Si No No No No No No No
25P Si No No No No No No No
23.98P Si No No No No No No No
S&Q (200fps, 240fps) 59.94P Si No No No No No No No
50P Si No No No No No No No
29.97P Si No No No No No No No
25P Si No No No No No No No
23.98P Si No No No No No No No
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Formato di registrazione CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-L 3840x2160 Modalita normale 59.94P Si No No Si No Si Si Si
420 50P Si No No Si No Si Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No Si No Si Si Si
S&Q (max. 60fps) 59.94P Si No No Si No Si Si Si
50P Si No No Si No Si Si Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No No Si
S&Q (100fps, 120fps) 59.94P Si No No No No No Si Si
50P Si No No No No No Si Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No No
1920x1080 Modalita normale 59.94P Si No No Si No Si Si Si
HD50 50P Si No No Si No Si Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No Si No Si Si Si
S&Q (max. 60fps) 59.94P Si Si Si Si Si Si Si Si
50P Si Si Si Si Si Si Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No Si No Si Si Si
S&Q (100fps, 120fps) 59.94P Si No No Si No Si Si Si
50P Si No No Si No Si Si Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No Si Si
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Formato di registrazione CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-L 1920x1080 S&Q (150fps, 180fps) 59.94P Si No No No No No Si Si
HD50 50P Si No No No No No Si Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No Si
S&Q (200fps, 240fps) 59.94P Si No No No No No Si Si
50P Si No No No No No Si Si
29.97P Si No No No No No No Si
25P Si No No No No No No Si
23.98P Si No No No No No No Si
1920x1080 Modalita normale 59.94P Si Si Si Si Si Si Si Si
HD35 50P Si Si Si Si Si Si Si Si
29.97P Si Si Si Si Si Si Si Si
25P Si Si Si Si Si Si Si Si
23.98P Si Si Si Si Si Si Si Si
S&Q (max. 60fps) 59.94P Si Si Si Si Si Si Si Si
50P Si Si Si Si Si Si Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No Si No Si Si Si
S&Q (100fps, 120fps) 59.94P Si No No Si No Si Si Si
50P Si No No Si No Si Si Si
29.97P Si No No Si No Si Si Si
25P Si No No Si No Si Si Si
23.98P Si No No No No No Si Si
S&Q (150fps, 180fps) 59.94P Si No No Si No Si Si Si
50P Si No No Si No Si Si Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No Si Si
S&Q (200fps, 240fps) 59.94P Si No No Si No Si Si Si
50P Si No No Si No Si Si Si
29.97P Si No No No No No Si Si
25P Si No No No No No Si Si
23.98P Si No No No No No No Si
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Inserimento di una scheda di memoria

1 Aprire il coperchietto della sezione slot
schede.

2 Inserire una scheda di memoria.
e Per le schede CFexpress, I'etichetta e
rivolta a sinistra.
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® Per le schede SD, I'etichetta e rivolta a

destra con I'angolo tagliato in basso.
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Angolo tagliato
L'indicatore di accesso (pagina 6) si

illumina di rosso, quindi diventa verde se

la scheda é utilizzabile.

[Nota]

Qualora l'indicatore di accesso lampeggi
continuamente in rosso senza diventare verde,
provare a spegnere momentaneamente il
camcorder, quindi rimuovere e reinserire la scheda
di memoria.

3 Chiudere il coperchietto.

[Note]

e La scheda di memoria, lo slot e i dati di immagine
contenuti sulla scheda potrebbero subire danni se la
scheda venisse forzata nello slot con I'orientamento
errato.

e Per la registrazione su schede CFexpress Type A o
SD contenute nei due slot A e B, € necessario che
entrambe le schede inserite siano di tipo adatto al
formato della registrazione.

Espulsione di una scheda di memoria

Aprire il coperchietto della sezione slot schede
ed esercitare una leggera pressione sulla
scheda di memoria per espellerla.

[Note]

e Se il camcorder viene spento o la scheda viene rimossa
durante I'accesso alla scheda, non ¢ possibile garantire
I'integrita dei dati contenuti sulla scheda. Tutti i dati
registrati sulla scheda potrebbero essere danneggiati.
Assicurarsi sempre che l'indicatore di accesso sia
illuminato in verde o spento prima di spegnere il
camcorder o rimuovere la scheda di memoria.

e Se sirimuove una scheda di memoria
immediatamente dopo la registrazione, € possibile

che sia calda. Questo tuttavia non indica un problema.

Formattazione (inizializzazione) di
schede di memoria

Se viene inserita una scheda di memoria non
formattata o formattata con altre specifiche, il

mirino visualizza il messaggio “Media Needs
to be Formatted”.

Formattare la scheda come descritto di
seguito.

1 Selezionare Format Media (pagina 96)
nel menu TC/Media del menu completo.

2 Selezionare Media(A) (slot A) o Media(B)
(slot B), quindi selezionare il metodo di
formattazione desiderato (Full Format o
Quick Format).

Viene visualizzato un messaggio di

conferma.

e Full Format: Inizializza completamente
il supporto di memoria, compresa
la regione contenente i dati e le
informazioni di gestione dei dati.

® Quick Format: Inizializza solamente le
informazioni di gestione dei dati del
supporto di memoria.

3 Selezionare Execute.

Durante la formattazione ¢ visualizzato un
messaggio e l'indicatore di accesso si
illumina di rosso.

Al termine della formattazione, viene
visualizzato un messaggio per confermare
che I'operazione ¢ stata completata.
Premere la manopola multifunzione per
chiudere il messaggio.

[Note]

e La formattazione di una scheda di memoria elimina
tutti i dati che contiene, comprese le registrazioni
video e i file di setup.

e A seconda della durata, potrebbero essere visualizzati
messaggi anche durante il processo di formattazione.

Se la formattazione non riesce

Non & possibile formattare schede di memoria
non supportate dal camcorder.

Viene visualizzato un messaggio di
avvertimento. Seguire le istruzioni e sostituire

la scheda con una scheda di memoria
supportata.

Utilizzo di una scheda formattata con
questo camcorder nello slot di un altro
dispositivo

Eseguire il backup di tutti i dati registrati sulla
scheda, quindi riformattare la scheda nel
dispositivo in cui deve essere utilizzata.

Controllo del tempo di
registrazione rimanente

Durante la ripresa (registrazione/standby), &
possibile monitorare la capacita rimanente
sulla scheda di memoria di ciascuno slot
mediante gli indicatori di capacita rimanente
degli slot A e B visualizzati nel mirino

(pagina 11).

Il tempo di registrazione rimanente ¢ calcolato
sulla base della capacita rimanente della
scheda di ciascuno slot e del formato video
corrente (bit rate di registrazione) ed ¢ indicato
in minuti.

Tempi di sostituzione delle schede di
memoria

e Quando il tempo di registrazione rimanente
totale sulle due schede di memoria scende
al di sotto di 5 minuti, viene visualizzato
il messaggio “Media Near Full”, la spia di
registrazione/tally comincia a lampeggiare
e viene emesso un segnale acustico di
avvertimento sull’uscita cuffie.

Sostituire con una scheda con spazio libero
sufficiente.

e Se si prosegue con la registrazione fino
a esaurire completamente lo spazio
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disponibile, appare il messaggio “Media
Full” e la registrazione si arresta.
[Nota]

Una scheda di memoria consente la registrazione di un
massimo di 600 clip circa.

Ripristino delle schede di
memoria

Qualora si verifichi un errore su una scheda di
memoria, la scheda dovra essere ripristinata
prima di poter essere nuovamente utilizzata.
Se si inserisce una scheda di memoria che
deve essere ripristinata, lo schermo del
mirino visualizza un messaggio che chiede di
confermare il ripristino.

Ripristino di una scheda di memoria

Ruotare la manopola multifunzione

(pagina 5) per selezionare Execute, quindi
premere la manopola multifunzione.
Durante la formattazione lo schermo
visualizza un messaggio e la percentuale (%)
di avanzamento dell’'operazione. L'indicatore
di accesso ¢ inoltre illuminato in rosso.

Al termine del ripristino viene visualizzato un
messaggio di conferma.

Se il ripristino non riesce

e Non é possibile ripristinare schede di
memoria su cui sono presenti errori di
memoria. Viene visualizzato un messaggio
di avvertimento. Seguire le istruzioni e
sostituire la scheda la scheda di memoria.

e | e schede di memoria che contengono
errori di memoria potrebbero diventare
nuovamente utilizzabili se riformattate.

® |n alcuni casi, potranno essere ripristinati
solo alcuni clip e non altri. | clip ripristinati
possono essere riprodotti normalmente.

[Note]

e Peril ripristino dei supporti, utilizzare sempre lo
stesso camcorder utilizzato per registrarli.

e Questo camcorder non consente di ripristinare
supporti registrati con apparecchi diversi o con
camcorder di versione diversa (anche se dello stesso
modello).

e | clip di durata inferiore a 2 secondi non possono
essere ripristinati.
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Operazioni di base

Di sequito si descrive la procedura per
eseguire una semplice ripresa di base.

1 Montare i dispositivi necessari e
controllare che l'alimentazione sia
presente.

2 Inserire almeno una scheda di memoria.

3 Spostare il selettore POWER sulla
posizione ON.
L'indicatore POWER si illumina e
I'immagine proveniente dal camcorder
appare sul mirino.

4 Premere il pulsante START/STOP
registrazione (pagina 5).
La spia di registrazione/tally si accende e
la registrazione ha inizio.

5 Per arrestare la registrazione, premere di
nuovo il pulsante START/STOP
registrazione.

La registrazione si arresta e il camcorder
entra in modalita STBY (standby).

[Nota]

Se si preme il pulsante START/STOP registrazione nei
primi secondi immediatamente dopo l'accensione

del camcorder, la spia di registrazione/tally si illumina
per indicare che il camcorder si trova in stato di
registrazione. Ciononostante, a seconda del formato

di registrazione selezionato, potrebbero essere
necessari alcuni secondi prima dell’avvio effettivo della
registrazione sul supporto.

Passaggio da una scheda di
memoria all'altra

Quando sono inserite due schede di
memoria, premere il pulsante SLOT SELECT
(pagina 6) per passare da una scheda
all'altra.

La registrazione passa automaticamente
alla seconda scheda di memoria appena
immediatamente prima dell’esaurimento
completo dello spazio sulla prima scheda
(registrazione relay). E possibile eseguire
registrazioni continuate ininterrottamente
sostituendo ogni volta la scheda di memoria
piena con una nuova.

[Note]

e Non é possibile passare da una scheda all‘altra
durante la riproduzione. Non ¢ inoltre possibile la
riproduzione continuata di un clip che si estende su
entrambe le schede di memoria dei due slot A e B.

e Se nel secondo slot & inserita una scheda di memoria
registrabile su cui vengono registrati solo dati proxy,
la registrazione non passera all'altra scheda.

Clip (dati registrati)

Quando si arresta la registrazione, il video,
I'audio e i dati accessori dall’inizio alla fine
della registrazione vengono salvati come un
unico “clip” sulla scheda di memoria.

Nome dei clip

I nome dei clip registrati dal camcorder viene
assegnato automaticamente utilizzando il
formato impostato tramite la voce Clip Name
Format (pagina 96) nel menu TC/Media del
menu completo.

Durata massima dei clip

Fino a 6 ore per clip.

La durata massima di una registrazione
continua ¢ identica alla durata massima di
un clip. Se il tempo di registrazione del clip
supera la lunghezza massima consentita,

viene creato automaticamente un nuovo clip e
la registrazione continua. Il nuovo clip apparira
sulla schermata delle miniature come un clip
separato.

Nella funzione di registrazione relay, vengono
registrati piu clip in successione I'uno dopo
I'altro. In questa modalita, la registrazione si
arresta automaticamente dopo circo 24 ore.

[Note]

e Non espellere una scheda di memoria mentre
€ in corso la registrazione su di essa. Durante la
registrazione, sostituire schede di memoria solo negli
slot il cui indicatore di accesso non & illuminato.

e Quando la capacita rimanente sulla scheda di
memoria su cui viene eseguita la registrazione
diventa inferiore a un minuto ed é presente una
scheda di memoria registrabile nell'altro slot, viene
visualizzato il messaggio “Will Switch Slots Soon”. Il
messaggio scompare dopo il passaggio all‘altro slot.

e Laregistrazione relay puo non essere possibile se
la registrazione viene avviata quando la capacita
rimanente della scheda di memoria & inferiore a un
minuto. Per consentire il funzionamento corretto
della registrazione relay, controllare che la capacita
rimanente sulla scheda di memoria sia superiore a un
minuto prima di iniziare la registrazione.

e | video creati con la funzione di registrazione relay
del camcorder non possono essere riprodotti senza
interruzione sul camcorder.

e Per unire insieme video creato con la funzione di
registrazione relay del camcorder, utilizzare il software
“Catalyst Browse".

Monitoraggio audio

L'audio registrato pud essere monitorato
tramite le cuffie.

Collegando delle cuffie al relativo jack
(pagina 5) e possibile monitorare

I'audio durante la registrazione. L'audio
di riproduzione (pagina 72) puo essere
monitorato sia tramite I'altoparlante
incorporato (pagina 6) che le cuffie.

Il volume dell’audio di monitoraggio

puo essere regolato mediante Volume
(pagina 14) nella schermata Audio

Status o mediante Audio Output >Volume
(pagina 101) nel menu Audio del menu
completo.

Il canale da monitorare pud essere selezionato
mediante Monitor CH (pagina 14) nella
schermata Audio Status o mediante Audio
Output >Monitor CH (pagina 101) nel menu
Audio del menu completo.

Specifica dei dati temporali

Impostazione del codice temporale

Impostare il codice temporale da registrare
con la voce Timecode (pagina 95) del menu
TC/Media del menu completo.

Impostazione dei bit utente

E possibile aggiungere all'immagine
registrata un numero esadecimale a 8 cifre
come bit utente. Il bit utente puo essere
anche impostato sull’'ora corrente. Eseguire
I'impostazione con Users Bit (pagina 95) nel
menu TC/Media.

Visualizzazione dei dati temporali

Specificare il codice temporale da visualizzare
mediante I'opzione TC Display (pagina 95)
>Display Select del menu TC/Media.
Premendo un pulsante programmabile
(pagina 51) a cui & assegnata la funzione
DURATION/TC/U-BIT, & possibile visualizzare
in sequenza il codice temporale, i bit utente e
la durata.
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Commutazione entrata/uscita del codice
temporale

Il selettore TC IN/OUT (pagina 4) consente

di scegliere se il codice temporale deve essere
ricevuto in entrata 0 emesso in uscita.

Per informazioni dettagliate, vedere pagina
120.

Rivedere una registrazione (Rec
Review)

E molto semplice rivedere sullo schermo
I'ultimo clip registrato (revisione della
registrazione).

[Nota]

La funzione Rec Review non & supportata se il formato
video é stato modificato dopo la registrazione del clip.

Metodo di revisione della registrazione

Assegnare in anticipo la funzione Rec Review
a uno dei pulsanti programmabili.

Mentre la registrazione € arrestata, premere
il pulsante programmabile (pagina 51) a

cui € assegnata la funzione Rec Review. La

riproduzione dell’ultimo clip registrato si avvia.

Il clip viene riprodotto fino alla fine e il
camcorder esce dalla funzione Rec Review e
torna alla modalita di STBY (standby).

Per arrestare Rec Review

Premere il pulsante programmabile a cui e
assegnata la funzione Rec Review oppure
premere il pulsante CANCEL/BACK.

Impostazioni della revisione della
registrazione

E possibile impostare la posizione di avvio
della riproduzione su una delle seguenti
opzioni tramite la voce Rec Review
(pagina 103) del menu Technical.

e Ultimi 3 secondi del clip

e Ultimi 10 secondi del clip

e |nizio del clip

[Informazione]

Per rivedere un determinato clip dopo aver registrato
vari clip, premere il pulsante THUMBNAIL per visualizzare
la schermata delle miniature, quindi selezionare il clip
desiderato.
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Azionamento dello zoom

Il camcorder consente di regolare lo zoom in
base alle condizioni di ripresa.

Se & montato un obiettivo con zoom
motorizzato, € possibile azionare lo
zoom utilizzando la levetta dello zoom
dell'impugnatura di telecomando o della
maniglia. La velocita di zoom varia in base alla
pressione applicata alla levetta.
Il camcorder ¢ dotato di una funzione di zoom
che utilizza una metodologia di elaborazione
del segnale denominata Clear Image Zoom.
Quando Clear Image Zoom e attivato, diventa
possibile eseguire zoom anche con obiettivi a
focale fissa. Questa funzione consente anche
di estendere il campo di zoom oltre al campo
ottico fisicamente disponibile su obiettivi con
zoom motorizzato.
Il rapporto massimo di zoom offerto da Clear
Image Zoom varia a seconda della risoluzione
di registrazione.
e Con risoluzione di registrazione QFHD/4K:
1,5%
e Con risoluzione di registrazione HD: 2x

Selezione del tipo di zoom

Selezionare il tipo di zoom mediante Zoom
>Zoom Type (pagina 103) nel menu Technical
del menu completo.

| tipi di zoom disponibili varieranno in base al
tipo di obiettivo montato sul camcorder.

Obiettivo Impostazione Zoom Type

montato  Qptical Zoom  On(Clear Image
Only Zoom)

Obiettivo L'azionamento Clear Image

a focale dello zoom Zoom &

fissa / tramite la levetta supportato.

zoom non é

manuale  disponibile.

Obiettivo Impostazione Zoom Type

montato  QOptijcal Zoom  On(Clear Image
Only Zoom)

Obiettivo ~ Solo zoom ottico Sono disponibili

con zoom sia zoom ottico

motorizzato che Clear Image

Zoom.
[Note]
e (Clear Image Zoom non ¢ disponibile nei casi descritti
di seguito.

- Quando S&Q Motion >Frame Rate (pagina 84)
nel menu Shooting del menu completo ha un
valore superiore a 60fps.

- Quando Rec Format >Codec (pagina 86) nel
menu Project del menu completo & impostato su
RAW o su un‘opzione che include RAW.

e Seviene azionato il selettore SERVO/MANUAL
dell'obiettivo, I'ingrandimento di Clear Image Zoom
viene reimpostato su 1x.

e Quando viene eseguita la messa a fuoco automatica
Push (AF-S) mentre viene utilizzata la funzione Clear
Image Zoom, la messa a fuoco automatica da priorita
all'area al centro dello schermo.

Impostazione dello zoom della
maniglia

Lo zoom della maniglia pud essere impostato
mediante la voce Handle Zoom (pagina 104)
nel menu Technical del menu completo.

Impostazione della direzione della
ghiera dello zoom

Su alcuni obiettivi con innesto E-mount, €
possibile invertire la direzione di rotazione
della ghiera dello zoom.

La direzione di rotazione puo essere
selezionata mediante Lens >Zoom Ring

Direction (pagina 104) nel menu Technical
del menu completo.
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Regolazione della messa a fuoco

Il camcorder consente di regolare la messa a
fuoco automaticamente o manualmente in
base alle condizioni di ripresa.

Regolazione manuale della messa
a fuoco (Manual Focus)

Per regolare manualmente la messa a fuoco,

spostare il selettore FOCUS (pagina 4) su

“MAN".

Questo consente di regolare la messa a fuoco

manualmente secondo le condizioni di ripresa.

La messa a fuoco manuale ¢ utile per le

seguenti tipologie di soggetti:

e Soggetti sull’altro lato di una finestra
coperta di goccioline d'acqua

e Soggetti con un basso contrasto rispetto
allo sfondo

e Soggetti piu lontani in presenza di soggetti
vicini

[Informazione]

Nei seguenti casi, & possibile utilizzare la funzione

di messa a fuoco automatica anche se viene

principalmente utilizzata la messa a fuoco manuale.

e Quando la sensibilita al cambiamento del soggetto AF
& impostata su 1(Locked)

e Quando il selettore FOCUS si trova sulla posizione “"AF”

e Ruotando la ghiera della messa a fuoco (AF Assist,
pagina 42)

Messa a fuoco toccando lo schermo
(Spot Focus)

Nella modalita di messa a fuoco manuale, &
possibile specificare la posizione di messa a
fuoco desiderata semplicemente toccando lo
schermo in tal punto.

Per utilizzare la funzione di messa a fuoco
spot, impostare Focus >Touch Function in MF
(pagina 84) nel menu Shooting su Spot
Focus.

Toccando sullo schermo la posizione in cui
si desidera effettuare la messa a fuoco, lo
schermo visualizza un indicatore di messa a
fuoco spot.

AF

[Informazioni]

e Mentre ¢ attiva, & possibile disattivare
momentaneamente la modalita di messa a fuoco
spot e attivare invece la messa a fuoco automatica
premendo un pulsante programmabile (pagina 51)

a cui é stata assegnata la funzione Push AF/Push MF.

La messa a fuoco ritorna alla modalita manuale non
appena si rilascia il pulsante.

e La funzione Spot Focus non é attiva se l'obiettivo
impostato per la messa a fuoco manuale.

e Non é possibile specificare una posizione di messa
a fuoco spot mentre la messa a fuoco & ingrandita
oppure quando Touch Operation (pagina 103) nel
menu Technical € impostata su Off.

Utilizzo della funzione di messa a fuoco
automatica temporanea (Push Auto
Focus (AF))

Quando la voce Focus >Push AF Mode
(pagina 84) del menu Shooting del menu
completo & impostata su AF, premere il
pulsante PUSH AUTO FOCUS (pagina 4)
mentre ¢ attiva la modalita di messa a fuoco
manuale per eseguire la messa a fuoco
automatica.

La messa a fuoco avviene nell’'area di messa
a fuoco impostata tramite Focus >Focus Area
(pagina 84) nel menu Shooting del menu
completo.

La messa a fuoco ritorna alla modalita
manuale non appena si rilascia il pulsante.

Questa funzione ¢ utile quando si desidera
spostare lentamente la messa a fuoco da un
soggetto a un altro durante la messa a fuoco
manuale.

[Informazione]

La stessa operazione & eseguibile anche mediante un
pulsante programmabile (pagina 51) a cui € stata
assegnata la funzione Push AF/Push MF.

[Nota]
La funzione Push Auto Focus non ¢ attiva se l'obiettivo
impostato per la messa a fuoco manuale.

Utilizzo della funzione di messa a fuoco
automatica Single-Shot (Push Auto
Focus (AF-S))

Impostare Focus >Push AF Mode

(pagina 84) nel menu Shooting del menu

completo su Single-shot AF(AF-S), quindi

impostare I'area di messa a fuoco con Focus
>Focus Area(AF-S) (pagina 84) nel menu

Shooting del menu completo.

Premere il pulsante PUSH AUTO FOCUS mentre

¢ attiva la modalita di messa a fuoco manuale

per eseguire rapidamente la messa a fuoco
automatica. La messa a fuoco si arresta al
rilascio del pulsante.

Lo stato della messa a fuoco e segnalato

dall'indicatore della messa a fuoco.

e On: La messa a fuoco e fissa nella posizione
di messa a fuoco.

e Lampeggiante: Soggetto non a fuoco. Dato
che la messa a fuoco non e automatica,
cambiare la composizione e le impostazioni
di messa a fuoco per mettere a fuoco il
soggetto.

La messa a fuoco ritorna alla modalita

manuale non appena si rilascia il pulsante.

Questa capacita e utile quando si desidera

mettere a fuoco rapidamente il soggetto

prima di avviare la ripresa.

[Informazioni]

e La stessa operazione & eseguibile anche mediante un
pulsante programmabile (pagina 51) a cui & stata
assegnata la funzione Push AF/Push MF.

e La modalita Push AF Mode pu0 essere assegnata
anche a un pulsante programmabile (pagina 51).

e La funzione Focus Area(AF-S) pud anche essere
assegnata a un pulsante programmabile
(pagina 51).

e [ possibile scegliere se visualizzare o meno il riquadro
dell'area di messa a fuoco mediante I'opzione Display
On/Off >Focus Area Ind.(AF-S) (pagina 97) del
menu Monitoring del menu completo.

e Durante I'ingrandimento della messa a fuoco,
la messa a fuoco si adatta alla posizione di
visualizzazione ingrandita.

[Note]

e La funzione Push Auto Focus non ¢ attiva se
I'obiettivo & impostato per la messa a fuoco manuale.

e |l riquadro dell’area di messa a fuoco € sempre visibile
quando si utilizza il pulsante DISPLAY.

e Mentre é attiva la funzione Clear Image Zoom, non &
possibile impostare la posizione del riquadro Focus
Area(AF-S). Durante I'esecuzione della messa a fuoco
automatica Push AF-S, la messa a fuoco automatica
da priorita all'area al centro dello schermo.

Messa a fuoco con vista ingrandita
(Focus Magnifier)

Per impostazione predefinita, la funzione
Focus Magnifier x3/x6 e assegnata al pulsante
ASSIGN 4 dell'impugnatura di telecomando
e al pulsante ASSIGN 7 della maniglia
(pagina 51).

Premere il pulsante ASSIGN 4 oppure il
pulsante ASSIGN 7 per attivare la funzione
Focus Magnifier del mirino ed ingrandire

il centro dell'immagine di tre volte circa.
Premere nuovamente il pulsante per
aumentare l'ingrandimento a sei volte circa.
Questa funzione é utile per controllare la
messa a fuoco.

Premere nuovamente il pulsante per tornare
alla schermata normale.

Durante I'ingrandimento della messa a
fuoco, € possibile spostare la zona ingrandita
utilizzando il selettore multiplo (pagina 7).
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Premere il selettore multiplo per tornare al
centro dell'immagine.

Se viene utilizzata la funzione Push Auto Focus
(AF) durante l'ingrandimento della messa a
fuoco, la messa a fuoco avviene all'interno
dell’area di messa a fuoco impostata tramite
Focus >Focus Area (pagina 84) nel menu
Shooting del menu completo.

Se viene utilizzata la funzione Push Auto
Focus (AF-S) durante l'ingrandimento della
messa a fuoco, la messa a fuoco si adatta alla
posizione di visualizzazione ingrandita.

[Note]

e L'ingrandimento della messa a fuoco non ingrandisce
I'immagine registrata né I'immagine fornita sull'uscita
SDI/HDMI.

Durante l'ingrandimento della messa a fuoco, il
pulsante MENU non ¢ attivo e sono disabilitate anche
altre funzionalita.

Allo spegnimento del camcorder, il riquadro
ingrandito torna al centro dello schermo.

Regolazione automatica della
messa a fuoco (Auto Focus)

Il camcorder utilizza un sistema di messa a
fuoco tramite rilevamento di fase per la messa
a fuoco automatica ad alta velocita e tramite
contrasto per la messa a fuoco di precisione.
La combinazione di questi due metodi di
messa a fuoco automatica consente di
ottenere contemporaneamente rapidita e
precisione.

Per regolare automaticamente la messa a
fuoco, spostare su "“AUTO" il selettore FOCUS
del camcorder (pagina 4). Se I'obiettivo

€ dotato di un selettore di messa a fuoco,
spostarlo nella posizione “AF/MF" o "AF". Se
il selettore si trova nelle posizioni “Full MF”

o “MF" non é possibile eseguire la messa a
fuoco dal camcorder (pagina 24).

[Informazione]

Quando Focus >AF Assist (pagina 84) nel menu
Shooting del menu completo & impostato su On, rimane
possibile eseguire la regolazione della messa a fuoco
tramite la ghiera di messa a fuoco dell'obiettivo anche
durante la messa a fuoco automatica.

[Note]

e E necessario che sia montato un obiettivo che
supporta la funzione di messa a fuoco automatica.

e In base alle condizioni di ripresa potrebbe non essere
possibile ottenere la massima precisione.

e Non é possibile regolare automaticamente la messa a
fuoco su un obiettivo con innesto A-mount.

Impostazione della zona di messa a
fuoco automatica e della sua posizione
(Focus Area)

E possibile impostare la zona di rilevamento
per la messa a fuoco automatica mediante

la voce Focus >Focus Area (pagina 84) nel
menu Shooting del menu completo.

Flexible Spot:

Mette a fuoco una posizione specificata
dell'immagine.

Quando ¢ selezionata questa opzione,
specificare la posizione utilizzando il selettore
multiplo (pagina 7).

Per tornare alla posizione centrale, premere e
mantenere premuto il selettore multiplo.

AF
r A
L .l

Zone:

Cerca automaticamente una posizione

di messa a fuoco all'interno della zona
specificata.

Quando ¢ selezionata questa opzione,
specificare la posizione utilizzando il selettore
multiplo (pagina 7).

Per tornare alla posizione centrale, premere e
mantenere premuto il selettore multiplo.

AF
r il
L J
Wide:

Cerca il soggetto su un ampio angolo
dell'immagine durante la messa a fuoco. Non
viene visualizzato nessun riquadro.

AF

[Informazione]

La stessa operazione & eseguibile anche mediante un
pulsante programmabile (pagina 51) a cui & stata
assegnata la funzione Focus Area.

E possibile scegliere se visualizzare o meno il riquadro
dell’area di messa a fuoco mediante I'opzione Display
On/Off >Focus Area Indicator (pagina 97) nel menu
Monitoring del menu completo.

[Nota]
Il riquadro dell’area di messa a fuoco & sempre visibile
quando si utilizza il pulsante DISPLAY.

Modifica rapida della zona di messa a
fuoco (Focus Setting)

E possibile modificare rapidamente la
posizione e le dimensioni della zona di

messa a fuoco automatica durante le riprese
assegnando Focus Setting a un pulsante
programmabile (pagina 51).

L'operazione varia a seconda
dell'impostazione della zona di messa a fuoco.

Quando Focus >Focus Area (pagina 84) nel
menu Shooting del menu completo &

impostata su Flexible Spot 0 Zone

Per spostare I'area di messa a fuoco,

premere il pulsante programmabile a cui &
stata assegnata la funzione Focus Setting

e regolarne le dimensioni con il selettore
multiplo (pagina 7).

Per riportare I'area di messa a fuoco sulla sua
posizione centrale durante la regolazione della
posizione, premere il selettore multiplo.

Per modificare le dimensioni della zona di
messa a fuoco, premere e mantenere premuto
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il pulsante programmabile a cui & stata
assegnata la funzione Focus Setting.

Dopo averne impostato le dimensioni,
spostare I'area di messa a fuoco sulla
posizione desiderata premendo il selettore
multiplo.

Al termine, premere il pulsante programmabile
a cui é stata assegnata la funzione Focus
Setting per tornare alla schermata iniziale.

Quando Focus >Focus Area (pagina 84) nel
menu Shooting del menu completo &

impostata su Wide

E possibile modificare solamente le
dimensioni della zona di messa a fuoco
premendo e mantenendo premuto il pulsante
programmabile a cui & stata assegnata la
funzione Focus Setting. Prima di poterne
spostare la posizione, & necessario impostare
il tipo su Flexible Spot o Zone.

[Informazioni]

e Impostando Focus >Push AF Mode (pagina 84)
nel menu Shooting del menu completo su Single-
shot AF(AF-S) e spostando il selettore FOCUS
(pagina 4) sulla posizione MF, & possibile
cambiare la posizione dell’area di messa a fuoco
Focus Area(AF-S) (pagina 84).

e Quando ¢ possibile spostare la posizione dell’area
di messa a fuoco, il relativo riquadro & visualizzato in
arancione.

Spostamento del riquadro dell'area di
messa a fuoco tramite touchscreen (area
di messa a fuoco Touch)

Per spostare la posizione dell'area di messa
a fuoco, premere il pulsante programmabile
(pagina 51) a cui & assegnato Focus Setting
per visualizzarne il riquadro in arancione,
quindi spostarla con il touchscreen.

Toccare lo schermo per spostare I'area di
messa a fuoco, centrandola sul punto che

e stato toccato. Trascinare I'area di messa a
fuoco con il dito per spostarla nella posizione
desiderata sullo schermo (pagina 10).

[Informazione]

E possibile abilitare e disabilitare I'uso del touchscreen
per la messa a fuoco sulla schermata di ripresa
utilizzando un pulsante programmabile a cui &
assegnato Focus Setting.

Toccare un punto qualsiasi dello schermo

b

L'area di messa a fuoco si sposta
centrandosi sulla posizione toccata.

b

Trascinare I'area di messa a fuoco con il dito
per spostarla nella posizione desiderata sullo
schermo.

—

[Note]
e Se si tocca una posizione o si trascina I'area di messa
a fuoco su una posizione al di fuori del campo
disponibile impostato, I'area di messa a fuoco viene
impostata sul bordo superiore, inferiore, sinistro o
destro di tale campo.
e Questa funzione non é disponibile nei casi descritti
di seguito.
- Quando Touch Operation (pagina 103) nel menu
Technical del menu completo € impostata su Off
- Quando l'area di messa a fuoco non é visualizzata
oppure & visualizzata in grigio

Regolazione dell'azione di messa a
fuoco automatica (Velocita di transizione
AF, Sensibilita al cambiamento del
soggetto AF)

Velocita di transizione AF

La voce Focus >AF Transition Speed

(pagina 84) del menu Shooting del menu
completo consente di impostare la velocita

di azionamento del sistema di messa a

fuoco automatica in caso di movimento del
soggetto.

Se impostata su una velocita piu bassa,
quando il soggetto messo a fuoco si sposta,

la messa a fuoco segue il soggetto in maniera
piu graduale, consentendo la ripresa di
immagini di grande impatto.

Se impostata su una velocita piu alta, la messa
a fuoco seleziona il soggetto piu rapidamente.
Questa impostazione ¢ ideale per la ripresa

di documentari che richiedono una rapida
messa a fuoco in quanto il soggetto viene
immediatamente messo a fuoco non appena
entra nel campo di ripresa.
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E a fuoco il soggetto pil lontano

Hinin

Durante il cambiamento:
1(Slow): Il cambiamento della
messa a fuoco avviene
lentamente

7(Fast): Il cambiamento della
messa a fuoco avviene
rapidamente

\V

E a fuoco il soggetto pil vicino

e —
s

Sensibilita al cambiamento del soggetto AF

E possibile impostare la sensibilita al
cambiamento del soggetto mediante la voce
Focus >AF Subj. Shift Sens. (pagina 84) nel
menu Shooting del menu completo.

Se impostata su una sensibilita piu bassa, la
messa a fuoco non cambia immediatamente
anche se un altro soggetto si dovesse spostare
di fronte al soggetto originariamente messo a
fuoco. Se impostata su una sensibilita piu alta,
la messa a fuoco cambia immediatamente per
dare la precedenza al soggetto che si sposta
di fronte.

[Informazione]

Se AF Speed/Sens. € assegnata a un pulsante
programmabile, le barre di livello per la regolazione dei
valori vengono visualizzate nel seguente ordine ad ogni
pressione del pulsante, consentendo di modificare le
impostazioni di velocita di transizione AF e di sensibilita
al cambiamento del soggetto AF:

Velocita di transizione AF — Sensibilita al cambiamento
del soggetto AF — Nessuna indicazione ...

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

[ mmm

La messa a fuoco del nuovo soggetto
avviene rapidamente

La messa a fuoco del nuovo soggetto
avviene lentamente
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Selezione manuale del soggetto della
messa a fuoco (AF Assist)

Quando Focus >AF Assist (pagina 75) nel menu

Shooting del menu completo € impostato su

On, rimane possibile mettere manualmente

a fuoco un soggetto ruotando la ghiera di

messa a fuoco dell’'obiettivo anche durante la

messa a fuoco automatica.

Dopo aver completato la messa a fuoco del

soggetto con la ghiera di messa a fuoco

dell’'obiettivo, la funzione di messa a fuoco

automatica continua a mantenere a fuoco il

soggetto messo a fuoco manualmente (messa

a fuoco automatica assistita).

Lo spostamento della messa a fuoco su un

soggetto diverso dopo I'azionamento della

ghiera di messa a fuoco sara leggermente piu

difficile, indipendentemente dall'impostazione

di Focus >AF Subj. Shift Sens. (pagina 84)

nel menu Shooting del menu completo.

La messa a fuoco automatica assistita (AF

Assist) viene annullata nei seguenti casi:

® Quando il soggetto messo a fuoco con la
ghiera di messa a fuoco dell’'obiettivo non &
piu visibile.

e Quando si passa alla messa a fuoco
manuale.

e Quando viene avviata la funzione di messa a
fuoco automatica con seguimento in tempo
reale

[Informazioni]

o E possibile annullare rapidamente la messa a fuoco
automatica assistita anche premendo un pulsante
programmabile (pagina 51) a cui sono assegnate le
funzioni Push AF/Push MF.

e La funzione di messa a fuoco automatica con
seguimento in tempo reale si arresta quando viene
utilizzata la ghiera di messa a messa a fuoco.

e In modalita Face/Eye Only AF, la messa a fuoco
automatica mette a fuoco il viso pil vicino alla
posizione di messa a fuoco della ghiera di messa a
fuoco.

Messa a fuoco manuale temporanea
(Push Manual Focus)

Premere il pulsante PUSH AUTO FOCUS
(pagina 4) mentre ¢ attiva la modalita di
messa a fuoco automatica per eseqguire la
messa a fuoco manuale.

La messa a fuoco ritorna alla modalita

automatica non appena si rilascia il pulsante.

Questo consente di interrompere
momentaneamente la messa a fuoco
automatica ed eseguire la messa a fuoco
manuale quando un elemento che non ¢ il
soggetto della ripresa attraversa il campo
di visuale della ripresa davanti al soggetto
desiderato.

[Informazione]

La stessa operazione € eseguibile anche mediante un
pulsante programmabile (pagina 51) a cui & stata
assegnata la funzione Push AF/Push MF.

Seguimento con la funzione di
rilevamento del viso e degli occhi
(Face/Eye Detection AF)

Il camcorder € in grado di individuare, seguire
e mettere a fuoco automaticamente il viso e
gli occhi dei soggetti all'interno dell’area di
messa a fuoco.

Questa funzione e disponibile solo quando

la messa a fuoco & in modalita AF o durante
Push Auto Focus.

Quando vengono rilevati visi, lo schermo
mostra riquadri di rilevamento del viso e degli
occhi di colore grigio. Se la messa a fuoco
automatica e possibile, i riquadri diventano di
colore bianco e si awvia il sequimento. Quando
vengono rilevati occhi e viene eseguita la
messa a fuoco, il riquadro di rilevamento di
viso e occhi appare sugli occhi del soggetto.
Se vengono rilevate piu persone, il soggetto
principale € determinato automaticamente.

[Informazioni]

e Quando la zona di messa a fuoco € impostata su
Zone o Flexible Spot e, nella zona di messa a fuoco
specificata, si sovrappongono visi o occhi, i riquadri
di rilevamento viso/occhi sono visualizzati in colore
bianco e il camcorder mette a fuoco i visi e gli occhi
contenuti in tali riquadri.

e Quando viene utilizzato Push Auto Focus (AF-S), i
riquadri di rilevamento viso/occhi dei visi e degli
occhi messi a fuoco sono visualizzati in verde.

Impostare I'azione di messa a fuoco
automatica con rilevamento viso o degli occhi
desiderata tramite Focus >Face/Eye Detection
AF (pagina 84) nel menu Shooting.

Face/Eye Only AF:

Il camcorder rileva il viso e gli occhi dei
soggetti (persone) e segue e mette a fuoco
solo tale viso o occhi. Finché il camcorder non
rileva un viso o degli occhi, la funzione AF
viene temporaneamente sospesa e appare

sullo schermo l'icona di pausa di messa a
fuoco automatica modalita Face/Eye Only AF
[ (pagina 11). Questa modalita & efficace
quando si desidera seguire e mantenere
automaticamente a fuoco solo il viso e gli
occhi del soggetto.

Face/Eye Priority AF:

Il camcorder rileva il viso o gli occhi dei
soggetti (persone) e da priorita al sequimento
e alla messa a fuoco del viso o degli occhi. Se
non vengono rilevati visi o occhi, la messa a
fuoco avviene in modalita AF (impostazione
predefinita).

Off:
La funzione di AF con rilevamento del viso o
degli occhi ¢ disabilitata.

[Note]

e Mentre ¢ attiva la funzione di Push Auto Focus, viene
sempre attivata Face/Eye Priority AF, anche mentre &
selezionata Face/Eye Only AF.

e Quando il selettore FOCUS si trova in posizione MAN,
la funzione di AF con rilevamento del viso o degli
occhi é disabilitata (eccetto durante Push Auto Focus).

e Se sispegne il camcorder mentre é selezionata
Face/Eye Only AF, alla successiva riaccensione verra
automaticamente ripristinata la modalita Face/Eye
Priority AF.

Nascondere i riquadri di rilevamento del
viso o degli occhi

E possibile scegliere se visualizzare o meno
i riquadri di rilevamento del viso o degli
occhi con la voce Display On/Off >Face/Eye
Detection Frame (pagina 97) del menu
Monitoring del menu completo.

[Nota]

| visi e gli occhi messi a fuoco con la funzione Push Auto
Focus (AF-S) sono identificati mediante riquadri verdi, a
meno che tali riquadri non siano stati disattivati con il
pulsante DISPLAY oppure I'opzione Face/Eye Detection
Frame sia impostata su Off.
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Selezione della modalita AF con
rilevamento del viso o degli occhi
tramite un pulsante programmabile

Assegnare Face/Eye Detection AF a un
pulsante programmabile (pagina 51).
Premendo ripetutamente tale pulsante,
diventa possibile passare in sequenza da
una modalita AF con rilevamento del viso o
degli occhi all'altra, passando da Face/Eye
Priority AF, a Face/Eye Only AF, a Off, quindi
nuovamente a Face/Eye Priority AF, ecc.

Impostazione con Direct Menu

La modalita operativa AF con rilevamento
del viso o degli occhi pu0 essere selezionata
anche con Direct Menu (pagina 51).

Seguimento di un soggetto
specificato (Realtime Tracking AF)

Il camcorder consente di mantenere

la messa a fuoco su un determinato

soggetto toccandolo sullo schermo oppure
selezionandone il riquadro di rilevamento del
viso corrispondente.

Il sequimento si avvia non appena viene
selezionato il soggetto desiderato e lo
schermo visualizza un riquadro di seguimento
bianco.

[Informazioni]

e |l seguimento ha luogo sull'intera area dell'immagine,
indipendentemente dall'impostazione dell’area di
messa a fuoco.

e Quando Focus >Touch Function in MF (pagina 84)
nel menu Shooting & impostato su Tracking AF, la
messa a fuoco automatica con seguimento in tempo
reale & supportata anche quando la messa a fuoco si
trova in modalita MF.

In base alla modalita operativa della funzione
di AF con rilevamento del viso o degli occhi,
avranno luogo, per quanto riguarda il soggetto
del seguimento, le azioni indicate di seguito.

Face/Eye Only AF, Face/Eye Priority AF:
Consente la messa a fuoco e il sequimento di
un soggetto specificato.

Se il soggetto da seguire &€ una persona e se il
camcorder ne rileva il viso o gli occhi, la messa
a fuoco avviene sul viso o sugli occhi rilevati.
Se il camcorder rileva il viso o gli occhi del
soggetto del seguimento, ne salva il viso.
L'icona ¢ indica che & stato salvato un viso da
seguire (pagina 11).

[Nota]

Se la funzione di AF con seguimento viene avviata

durante la messa a fuoco manuale, il viso del soggetto
del seguimento non viene salvato.

Off:

Messa a fuoco e seguimento del soggetto
specificato.

Il rilevamento del viso o degli occhi non ha
luogo, anche se il soggetto del seguimento &
una persona.

[Nota]

La funzione Realtime Tracking AF non é attiva se
I'obiettivo & impostato per la messa a fuoco manuale.

Awvio della messa a fuoco automatica
con seguimento in tempo reale

Il seguimento si avvia non appena viene
specificato un determinato soggetto da
seguire.

Specifica toccando lo schermo

Con il camcorder in uno degli stati indicati di

seguito, toccare il soggetto da sequire:

e Quando la messa a fuoco & in modalita
MF oppure durante la messa a fuoco
manuale Push e Focus >Touch Function
in MF (pagina 84) nel menu Shooting &
impostato su Tracking AF

e Quando la messa a fuoco € in modalita
AF oppure durante la messa a fuoco
automatica Push (AF)

[Nota]

Non & possibile specificare un soggetto toccandolo sullo
schermo se Touch Operation (pagina 103) nel menu
Technical e impostato su Off.

Specifica tramite la selezione del riquadro di

rilevamento del viso

Utilizzando il selettore multiplo (pagina 7),
spostare il cursore di selezione del viso
(sottolineatura arancione) sul soggetto da
seguire, quindi premere il selettore multiplo.

Altri riquadri di
rilevamento del
viso (grigi)

Riquadro di
seguimento

Cursore di selezione del viso (arancione)

[Informazioni]

e In modalita di messa a fuoco automatica con
seguimento in tempo reale é possibile cambiare il
soggetto da seguire.

e Premendo un pulsante programmabile (pagina 51)
a cui e assegnata la funzione Focus Magnifier durante
la messa a fuoco automatica con seguimento in
tempo reale, la messa a fuoco viene ingrandita
mantenendo lo stato del seguimento. Durante
I'ingrandimento della messa a fuoco, tuttavia, non €
possibile specificare il soggetto da seqguire.

[Nota]

Durante la messa a fuoco manuale non e possibile
avviare il seguimento tramite la selezione del riquadro di
rilevamento del viso.
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Arresto della messa a fuoco automatica
con seguimento in tempo reale

Arresto toccando lo schermo

Toccare il pulsante [OIE5¢ (arresto messa a
fuoco automatica con seguimento in tempo
reale) in alto a sinistra sul touchscreen.

[Informazioni]

e |amessa a fuoco automatica con seguimento in
tempo reale si arrestera nei casi descritti di seguito:

- Quando vengono azionati il selettore FOCUS o il
selettore AUTO/MAN dell'obiettivo.

- Quando viene selezionata una modalita di messa a
fuoco diversa.

- Quando viene eseguita I'assistenza alla messa a
fuoco automatica.

- Quando viene modificata I'impostazione dell'area
di messa a fuoco o I'azione di messa a fuoco
automatica con rilevamento viso o degli occhi.

- Quando viene premuto un pulsante
programmabile a cui € assegnata la funzione Push
AF/Push MF.

- Quando il soggetto da seguire non & presente nella
schermata della ripresa o se il soggetto rimane
fuori fuoco per diversi secondi.

e Se & stato salvato un viso da seguire (I'icona “$2" (viso
da seguire salvato) e visualizzata sullo schermo), la
messa a fuoco automatica con seguimento in tempo
reale riprendera non appena il viso da seguire salvato
entra nell’area dell'immagine. Per eliminare dalla
memoria il viso da seguire, uscire dalla modalita di
messa a fuoco automatica con seguimento in tempo
reale come descritto sopra.
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E possibile regolare la luminosita variando
opportunamente i valori di diaframma,
guadagno, velocita dell'otturatore, nonché

regolando il livello di luce mediante i filtri ND.

E anche possibile effettuare tali regolazioni
automaticamente.

Il livello ottimale di regolazione automatica
della luminosita puo essere impostato
mediante I'opzione Auto Exposure

(pagina 81) >Level del menu Shooting del
menu completo. La funzione Auto Exposure
Level pud essere assegnata anche a un
pulsante o una manopola programmabile
(pagina 51).

[Nota]

I guadagno non ¢ regolabile in modalita Cine El.

La sensibilita di base é fissa. Inoltre, non & possibile
regolare automaticamentg la luminosita mediante
la velocita dell'otturatore. E supportata invece la

regolazione automatica della luminosita tramite
diaframma e filtro ND.

Selezione della sensibilita di base
(Base Sensitivity)

Il camcorder utilizza due tipologie di
sensibilita di base.

Nella modalita Custom, & possibile impostare
la sensibilita di base su High o Low mediante
Base ISO/Sensitivity nella schermata Main
Status (pagina 14) o nella schermata
Camera Status (pagina 14) oppure

con la voce ISO/Gain/El >Base Sensitivity
(pagina 80) nel menu Shooting del menu
completo.

Nella modalita Cine El, & possibile impostare
il valore ISO di base su ISO 12800 o ISO

800 mediante Base ISO/Sensitivity nella
schermata Main Status (pagina 14) o nella
schermata Camera Status (pagina 14)
oppure mediante ISO/Gain/El >Base I1SO
(pagina 80) nel menu Shooting del menu
completo.

Si consiglia di selezionare Low o ISO 800 in
condizioni di illuminazione normali oppure
High o ISO 12800 in condizioni di scarsa
iluminazione.

* Configurabile anche nella schermata di stato.

[Informazione]

Le funzioni Base ISO e Base Sensitivity possono
essere assegnate anche a un pulsante programmabile
(pagina 51).

Regolazione del diaframma

E possibile regolare la luminosita regolando il
diaframma.

Regolazione automatica del diaframma

Questa funzione regola la luminosita in base
al soggetto. E necessario che sia montato

un obiettivo che supporta la funzione di
regolazione automatica del diaframma.

1 Se € montato un obiettivo con selettore
Auto Iris, impostarlo su AUTO.

2 Mantenere premuto il pulsante funzione
IRIS (E) per visualizzare il Direct Menu
(pagina 51), quindi selezionare Auto.

[Informazione]
La funzione Auto Iris puo essere assegnata anche a
un pulsante programmabile (pagina 51).

[Nota]

Il diaframma non puo essere regolato
automaticamente su un obiettivo con innesto
A-mount.

Regolazione manuale del diaframma

1 Mantenere premuto il pulsante funzione
IRIS (E) per visualizzare il Direct Menu
(pagina 51), quindi selezionare Manual.

2 Premere il pulsante funzione IRIS (E) per
visualizzare il valore del diaframma su uno
sfondo bianco.

3 Ruotare la manopola multifunzione per

regolare il valore.

[Informazioni]

e Se sidesidera, & possibile utilizzare la
manopola multifunzione come manopola IRIS
di regolazione del diaframma (pagina 51)
assegnando ad essa la funzione IRIS.

e E possibile anche assegnare la funzione IRIS a
una manopola programmabile (pagina 51).

Regolazione automatica temporanea

Premendo il pulsante programmabile

(pagina 51) a cui € assegnata la funzione

Push Auto Iris, il camcorder esegue la
regolazione automatica del diaframma mentre
il pulsante rimane premuto.

Il diaframma ritorna all'impostazione
precedente non appena si rilascia il pulsante.

[Note]

o Se il selettore Auto Iris dell’'obiettivo € impostato su
MANUAL, le funzioni Auto Iris e Push Auto Iris del
camcorder non hanno effetto. Non hanno effetto
nemmeno le regolazioni manuali del diaframma sul
camcorder.

e La funzione Push Auto Iris non puo essere eseguita se
Iris > Bokeh Control (pagina 81) nel menu Shooting
e impostato su On.

Regolazione del guadagno

In modalita Custom é possibile regolare la
luminosita regolando il guadagno.

Regolazione automatica del guadagno

Mantenere premuto il pulsante funzione
ISO/GAIN (H) per visualizzare il Direct Menu
(pagina 51), quindi selezionare Auto.

[Informazioni]

e [ possibile ottenere lo stesso risultato impostando
Auto Exposure (pagina 81) >AGC nel menu
Shooting su On.

e Lafunzione AGC pu0 essere assegnata anche a un
pulsante programmabile (pagina 51).

Regolazione manuale del guadagno

La regolazione del guadagno ¢ utile per
regolare I'esposizione mentre si utilizza
un valore di diaframma fisso oppure se si
desidera evitare 'aumento del guadagno
generato dalla funzione AGC.

1 Mantenere premuto il pulsante funzione
ISO/GAIN (H) per visualizzare il Direct
Menu (pagina 51), quindi selezionare
Manual.
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2 Spostare il selettore ISO/GAIN (I) suH, Mo L.

[Informazioni]

o E possibile modificare il valore preimpostato
delle varie posizioni del selettore mediante 1SO/
Gain<L>/<M>/<H> (pagina 14) nella schermata
Camera Status o mediante ISO/Gain/El >ISO/
Gain<H>/<M>/<L> (pagina 80) nel menu Shooting
del menu completo.

e E possibile anche assegnare la funzione Push AGC
a un pulsante programmabile per attivare AGC
momentaneamente mantenendo premuto tale
pulsante.

[Nota]

La funzione Push AGC non puo essere eseguita se Iris
> Bokeh Control (pagina 81) nel menu Shooting del
menu completo € impostato su On.

Regolazione fine del guadagno

1 Premere il pulsante funzione ISO/GAIN (H)
per visualizzare il valore del guadagno su
uno sfondo bianco.

2 Ruotare la manopola multifunzione per
regolare il valore.
[Informazione]

Impostare il valore di preset del guadagno in base alla
posizione del selettore ISO/GAIN (1).

Regolazione temporanea fine del
guadagno

Ruotare la manopola programmabile

(pagina 51) a cui & assegnata la funzione
ISO/Gain/El per regolare il valore di guadagno
impostato dal selettore ISO/GAIN (I).

Questa funzione e utile se si desidera
correggere l'esposizione di un passo senza
tuttavia modificare la profondita di campo.

Il valore di guadagno impostato viene
annullato spostando di nuovo il selettore ISO/
GAIN (1), cambiando la sensibilita di base,
impostando su On la funzione AGC oppure
spegnendo il camcorder.

[Informazioni]

e Questa funzione puo essere assegnata anche alla
manopola multifunzione (pagina 51).

e [ possibile anche assegnare la funzione Push AGC
a un pulsante programmabile per attivare AGC
momentaneamente mantenendo premuto tale
pulsante.

[Nota]

La funzione Push AGC non puo essere eseguita se Iris
> Bokeh Control (pagina 81) nel menu Shooting del
menu completo e impostato su On.

Regolazione automatica
dell'indice di esposizione
(Exposure Index)

Nella modalita Cine El, si presuppone il

video in uscita con MLUT impostato su

Off sia registrato come segnale principale.
Modificando la luminosita dell'immagine
con MLUT On in modo che corrisponda a un
valore El, & possibile controllare il risultato
della regolazione della sensibilita in post
produzione durante le riprese.

E possibile modificare il valore El spostando il
selettore ISO/GAIN (I) suH, Mo L.

[Informazione]

E possibile modificare il valore El delle varie posizioni
del selettore mediante 1ISO/Gain/El (pagina 14) nella
schermata Camera Status o mediante ISO/Gain/El
>Exposure Index<H>/<M>/<L> (pagina 80) nel menu
Shooting del menu completo.

Regolazione fine dell'indice di
esposizione

1 Premere il pulsante funzione ISO/GAIN (H)
per visualizzare il valore El su uno sfondo
bianco.

2 Ruotare la manopola multifunzione per
regolare il valore.
[Informazione]

Impostare il valore El di preset in base alla posizione del
selettore ISO/GAIN (1).

Regolazione dell'otturatore

E possibile regolare la luminosita regolando
I'otturatore.

Regolazione automatica dell’otturatore

Mantenere premuto il pulsante funzione
SHUTTER (F) per visualizzare il Direct Menu
(pagina 51), quindi selezionare Auto

per regolare automaticamente la velocita

o I'angolo dell'otturatore in risposta alla
luminosita dell'immagine.

[‘Im‘ormazione]

E possibile ottenere lo stesso risultato impostando su On

la voce Auto Exposure >Auto Shutter (pagina 82) del
menu Shooting nel menu completo.

Regolazione manuale dell’otturatore

1 Mantenere premuto il pulsante funzione
SHUTTER (F) per visualizzare il Direct Menu
(pagina 51), quindi selezionare Speed o
Angle.

2 Premere il pulsante funzione SHUTTER (F)
per visualizzare il valore dell’'otturatore su
uno sfondo bianco.

3 Ruotare la manopola multifunzione per
regolare la velocita dell'otturatore.

[Informazioni]

e Perregolare il tempo di esposizione in modo che
corrisponda all’intervallo fotogrammi, selezionare Off
al passo 1.

e E anche possibile impostare I'angolazione e regolare
la frequenza (pagina 80).
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Regolazione del livello di luce
(filtro ND)

In condizioni di illuminazione troppo intensa,
e possibile ottenere la luminosita corretta
utilizzando un filtro ND.

Il camcorder offre due modalita di filtro ND.
Per passare da una modalita all‘altra, utilizzare
il selettore ND PRESET/VARIABLE.

Regolazione in modalita Preset

Spostare il selettore ND PRESET/VARIABLE
(A) sulla posizione PRESET e quindi utilizzare
i pulsanti su/giu ND FILTER POSITION (B) per
configurare una delle impostazioni indicate di
seguito.

Clear: Nessun filtro ND

1: Trasmittanza specificata da ND Filter
>Preset1 (pagina 80) nel menu Shooting del
menu completo.

2: Trasmittanza specificata da ND Filter
>Preset2 (pagina 80) nel menu Shooting del
menu completo.

3: Trasmittanza specificata da ND Filter
>Preset3 (pagina 80) nel menu Shooting del
menu completo.

Regolazione in modalita variabile

Spostare il selettore ND PRESET/VARIABLE (A)
sulla posizione VARIABLE. Usando i pulsanti
su/giu ND FILTER POSITION (B) passare da
CLEAR a On.

Regolazione automatica del livello di luce
Attivando la funzione Auto ND Filter
viene abilitata la regolazione automatica
dell'esposizione mediante il filtro ND.

1 Premere il pulsante [+] dei pulsanti su/giu
ND FILTER POSITION (B) per attivare il filtro
ND.

2 Mantenere premuto il pulsante ND
VARIABLE AUTO (C) fino a selezionare
Auto.

Regolazione manuale del livello di luce

1 Premere il pulsante [+] dei pulsanti su/giu
ND FILTER POSITION (B) per attivare il filtro
ND.

2 Mantenere premuto il pulsante ND
VARIABLE AUTO (C) fino a selezionare
Manual.

3 Utilizzare la manopola ND VARIABLE (D)
per regolare la trasmittanza del filtro.

[Informazione]
La funzione ND Filter puo essere assegnata anche a una
manopola programmabile (pagina 51).

Regolazione automatica temporanea

E possibile anche assegnare Push Auto ND a
un pulsante programmabile (pagina 51) per
attivare momentaneamente la funzione Auto
ND Filter mantenendo premuto tale pulsante.
Al rilascio del pulsante, la funzione Auto ND
Filter viene nuovamente disattivata.

Premere il pulsante [+] dei pulsanti su/giu ND
FILTER POSITION (B) per attivare il filtro ND.

[Note]

e Se il filtro ND entra o esce dalla posizione CLEAR
durante la ripresa, il riquadro del filtro ND viene
visualizzato sull'immagine e il suono generato
dall'operazione viene catturato nell'audio.

e La funzione Push Auto ND non pud essere eseguita se
Iris > Bokeh Control (pagina 81) nel menu Shooting
€ impostato su On.

[Informazioni]

e E possibile impostare su CLEAR ruotando verso il
basso la manopola ND VARIABLE (D) dalla posizione
ND1/4. Ruotando verso l'alto la manopola dalla
posizione CLEAR si imposta ND1/4. E possibile
disabilitare questa azione mediante ND Dial >CLEAR
with Dial (pagina 103) nel menu Technical del menu
completo.

e [ possibile anche assegnare ND Filter Position a un
pulsante programmabile (pagina 51) e premere
tale pulsante invece di usare i pulsanti su/git ND
FILTER POSITION per modificare I'impostazione.
Modalita Preset: Clear — Preset1 — Preset2 —
Preset3 — Clear...

Modalita Variable: Clear — On — Clear...

o E possibile anche assegnare Auto ND Filter a un
pulsante programmabile (pagina 51) per attivare e
disattivare la funzione Auto ND Filter premendo tale
pulsante.

e Nella ripresa di soggetti fortemente illuminati, la
chiusura eccessiva del diaframma pud dar luogo a
sfocature per diffrazione. Questo € un fenomeno
tipico nelle videocamere. E possibile eliminare questo
fenomeno ed ottenere risultati migliori utilizzando il
filtro ND.
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Come ottenere colori naturali (bilanciamento del bianco)

IRIS

CANCEL/ THUMBNAIL =FULL MENU DISPLAY

BAC(K]@
ISO/GAIN WHT BAL SHUTTER

G =

) L 8 (.. @
g

E possibile selezionare la modalita di regolazione
pil adatta per le condizioni di ripresa.

Modalita ATW (bilanciamento
automatico del bianco)

Questa funzione regola automaticamente il
bilanciamento del bianco a un livello ottimale.
Il valore di bilanciamento del bianco viene
automaticamente regolato quando cambia la
temperatura di colore della sorgente luminosa.
Mantenere premuto il pulsante funzione

WHT BAL (G) per visualizzare il Direct Menu
(pagina 51), quindi selezionare ATW.

E possibile selezionare la velocita di
regolazione (cinque livelli) con I'opzione White
Setting >ATW Speed (pagina 83) del menu
Shooting del menu completo.

[Informazione]

E possibile “congelare” il valore di bilanciamento del bianco
corrente assegnando la funzione ATW Hold a un pulsante
programmabile (pagina 51) e premendo tale pulsante

per sospendere temporaneamente la modalita ATW.

[Note]
e La funzione ATW non e utilizzabile in modalita Cine El.
e A seconda delle condizioni di illuminazione e del
soggetto, la funzione ATW puo non essere in grado di
ottimizzare sempre il colore.
Esempi:
- Quando il soggetto € dominato da un unico colore,
ad esempio cielo, mare, prati o fiori.
- Quando la temperatura di colore € estremamente
alta o bassa.
Se non é possibile ottenere I'effetto opportuno
perché la velocita di regolazione automatica ATW e
insufficiente o per altri motivi, esequire la funzione di
bilanciamento automatico del bianco.

Regolazione manuale del
bilanciamento del bianco

1 Quando il bilanciamento del bianco &

impostato sulla modalita ATW, mantenere
premuto il pulsante funzione WHT BAL (G)
per visualizzare il Direct Menu

(pagina 51) e quindi selezionare W:P,

W:A o W:B.

2 Selezionare B, A o PRESET con il selettore
WHT BAL (J).
B: Modalita memoria B
A: Modalita memoria A
PRESET: Modalita preset

[Informazione]

Per abilitare ATW per la memoria B impostare su ATW
I'opzione White Setting >White Switch<B> (pagina 83)
nel menu Shooting del menu completo.

Modalita memoria A / memoria B

Questa modalita imposta il bilanciamento del
bianco sul valore salvato rispettivamente nella
memoria A o B.

Modalita Preset

Questa modalita regola la temperatura di
colore su un valore preimpostato (valore
predefinito: 3200K).

Modifica del valore di preset predefinito

In modalita Preset, & possibile impostare
direttamente un valore di preset esistente.
Premere e mantenere premuto il pulsante
WHT BAL (G) e selezionare una delle seguenti
voci nel Direct Menu:
Modalita Custom: — 3200K, — 4300K,
— 5600K, — 6300K
Modalita Cine El: — 3200K, — 4300K, —
5500K

[Informazione]

E possibile anche assegnare Preset White Select a un

pulsante programmabile (pagina 51) per modificare

I'impostazione premendo tale pulsante.

Modalita Custom: 3200K — 4300K — 5600K — 6300K
— 3200K...

Modalita Cine El: 3200K — 4300K — 5500K — 3200K...

Selezione della temperatura di colore

1 Premere il pulsante funzione WHT BAL (G)
per visualizzare il valore della temperatura
di colore su sfondo bianco.

2 Ruotare la manopola multifunzione per
regolare il valore.

[Informazioni]

e In modalita Preset e possibile impostare il valore in
unita di 100K.

e |In modalita memoria & possibile impostare il valore
in incrementi di 20K nel campo da 2000K a 5600K.
Valori superiori a 5600K possono essere impostati a
intervalli uguali alla quantita di variazione di colore (in
mired) da 5580K a 5600K. E possibile anche regolare
il tono di colore (Tint) mediante la voce White
(pagina 82) >Tint nel menu Shooting del menu
completo.

Esecuzione del bilanciamento
automatico del bianco

Il bilanciamento del bianco da salvare nella
modalita Memory A / Memory B viene
configurato automaticamente.

1 Selezionare la modalita Memory Ao la
modalita Memory B.

2 Collocare un foglio o un altro oggetto
bianco in una posizione con la stessa
sorgente di luce e le stesse condizioni di
illuminazione del soggetto, quindi
zoomare sul foglio fino a riempire lo
schermo di bianco.

3 Regolare la luminosita.
Regolare il diaframma servendosi della
procedura descritta in “Regolazione
manuale del diaframma” (pagina 45).

4 Premere il pulsante WB SET (pagina 4).

e Se il bilanciamento automatico del
bianco viene eseguito in modalita di
memoria, il risultato della regolazione
automatica viene salvato nella memoria
A o B selezionata al punto 1.

e Se il bilanciamento automatico del
bianco viene eseguito in modalita
ATW, il risultato viene ereditato e la
modalita ATW riprende al termine
della regolazione automatica. Cio
e utile quando si desidera regolare
il bilanciamento del bianco molto
rapidamente, indipendentemente
dall'impostazione di ATW Speed.

[Nota]

Se la regolazione non puo essere eseguita
correttamente, viene visualizzato un messaggio di errore
sullo schermo per circa tre secondi. Se il messaggio

di errore persiste anche dopo ripetuti tentativi di
impostazione del bilanciamento del bianco, rivolgersi al
servizio di assistenza tecnica Sony.



3. Ripresa

Impostazione dell'audio da registrare

E possibile specificare I'audio da registrare
scegliendo opportunamente i connettori di
ingresso e utilizzando i selettori e le manopole

2 Selezionare la sorgente di ingresso audio.
Impostare i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) in base ai dispositivi

Selezione del dispositivo di
ingresso audio

Regolazione manuale del livello di
registrazione audio

del camcorder. L. . . .
connessi rispettivamente ai connettori

INFUTT/INFUT2. La seguente procedura consente di regolare il

livello di registrazione audio per i canali CH1/CH2.

Connettori e selettori di ingresso audio T impostare ringresso audio con CH1/CH2/

Dispositivo collegato Posizione

esterno CH3/CH4 >Source (pagina 14) nella selettare

schermata Audio Status oppure con le - 1 Spostare su MAN i selettori CH1/CH2
Connettore INPUT1 (pagina 7) opzioni da Audio Input >CH1 Input Select a Sorge_nte audio esterna (ad LINE (AUTO/MAN) dei canali da regolare
Connettore INPUT2 (pagina 7) Audio Input >CH4 Input Select es. mixer) manualmente.
Slitta Multi-interface (pagina 7) (pagina 100) nel menu Audio del menu Microfono dinamico, MIC
Selet_tore INPUTT (LINE/MIC/MIC+48V) completo. m.lcrofono a batteria 2 Durante la ripresa o lo standby, ruotare le
(pagina7) Se si utilizza un microfono o un adattatore Microfono con MIC+48V

Selettore INPUT2 (LINE/MIC/MIC+48V)
(pagina 7)

Selettori per I'impostazione del livello

audio

Selettore CH1 (AUTO/MAN) (pagina 6)
Selettore CH2 (AUTO/MAN) (pagina 6)
Manopola AUDIO LEVEL (CH1) (pagina 6)
Manopola AUDIO LEVEL (CH2) (pagina 6)

Schermata Audio Status

D Audio

i INPUT1

I““ H 5o i MIC +48V

> i INPUT2
I““ 3 3 i MIC +48V

m “l“ i Int MIC 0dB

i INPUT1
ol P ) JRPET | -s0d8 off

Audio Input Level |[HDMI Output CH |[Volume
99 CH1/CH2

Monitor CH
CH1/CH2

XLR collegato alla slitta Multi-interface,
specificare Shoe CH1 o Shoe CH2. Per
informazioni dettagliate sull’adattatore
XLR, vedere “Aggiunta di connettori di
ingresso audio” (pagina 50).

[Note]

e L'audio non viene registrato nelle modalita
Interval Rec e Slow & Quick Motion.

e |l camcorder € dotato di un microfono
incorporato da narrazione per la registrazione
dell'audio ambientale. Puo essere utilizzato
per la sincronizzazione dei tempi con altre
apparecchiature. In tal caso, specificare Internal
MIC.

e Quando & montata la maniglia, viene attivato
per la registrazione dell'audio solo il microfono
interno (pagina 7) della maniglia. Se la
maniglia non € montata, potra essere utilizzato
il microfono di narrazione (pagina 6) per la
registrazione dell’audio ambientale.

e Quando CH1 Input Select e CH2 Input Select sono
impostati su Internal MIC, il livello di registrazione
audio dei due canali CH1 e CH2 puo essere
regolato con la manopola AUDIO LEVEL(CH1)
(pagina 6). Quando CH3 Input Select e CH4
Input Select sono impostati su Internal MIC, il
livello di registrazione audio dei due canali CH3
e CH4 puo essere regolato con la voce CH3 Input
Level (pagina 100).

alimentazione phantom
+48 'V

e Se si seleziona MIC+48YV, assicurarsi che
il microfono connesso sia compatibile
con una sorgente a +48V per evitare
di danneggiarlo. Controllare questa
impostazione prima di procedere con il
collegamento.

e Se e necessario limitare I'eventuale
rumore sui connettori ai quali non e
connesso nessun dispositivo, impostare
su LINE i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) corrispondenti.

Regolazione automatica del livello
di registrazione audio

Spostare su AUTO i selettori CH1/CH2 (AUTO/
MAN) dei canali da regolare automaticamente.
Per CH3 e CH4, impostare su Auto

(pagina 100) il controllo di livello audio

nella schermata Audio Status (pagina 14)

o le voci Audio Input >CH3 Level Control e

CH4 Level Control del menu Audio nel menu
completo.

manopole AUDIO LEVEL (CH1)/(CH2) per
regolare il livello audio del canale
corrispondente.

e Per CH3/CH4, impostare su Manual il
controllo di livello audio mediante CH3/
CH4 (pagina 14) nella schermata
Audio Status oppure mediante la voce
Audio Input >CH3 Level Control o CH4
Level Control nel menu Audio del menu
completo, quindi regolare il livello di
registrazione audio utilizzando CH3
Input Level o CH4 Input Level.

e E possibile regolare i livelli dei canali
da CH1 a CH4 collettivamente in
gruppo. Il livello di registrazione pud
essere regolato con la manopola
programmabile (pagina 51)
assegnata alla funzione Audio Input
Level, nella schermata Audio Status,
oppure mediante Audio Input >Audio
Input Level nel menu Audio del menu
completo.

[Informazione]
La schermata Audio Status consente di controllare il
livello di ingresso audio facilmente (pagina 14).

[Note]

Con determinate combinazioni di impostazioni

del menu Audio, I'impostazione Audio Input Level
potrebbe essere disabilitata. Per informazioni
dettagliate, vedere il diagramma a pagina 140.

I camcorder supporta combinazioni di varie
impostazioni. Per informazioni dettagliate, vedere il
diagramma a pagina 140.
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Aggiunta di connettori di ingresso
audio

E possibile collegare contemporaneamente al
camcorder fino a quattro canali di dispositivi
audio XLR utilizzando un adattatore XLR
modello XLR-K2M o XLR-K3M (non in
dotazione).

Montare |'adattatore XLR sulla slitta Multi-
interface e quindi, nella schermata Audio
Status (pagina 14), impostare CH3 >Source

su Shoe CH1 e CH4 >Source su Shoe CH2. In
alternativa, impostare Audio Input >CH3 Input
Select su Shoe CH1 e CH4 Input Select su Shoe
CH2 nel menu Audio del menu completo.

Le funzioni del camcorder che si
sovrappongono verranno disabilitate peri
canali per i quali & selezionato come ingresso
I'adattatore XLR. Eseguire le regolazioni
necessarie servendosi dei pulsanti e delle
manopole dell'adattatore XLR.

[Note]

e |l camcorder supporta l'interfaccia audio digitale 2ch
dell’adattatore XLR-K3M.

e Se Audio Input >CH3 Level e CH4 Level nel menu
Audio sono impostati su Audio Input Level, il valore
di Audio Input Level del camcorder verra moltiplicato
per il valore di livello impostato sull’adattatore XLR.
Audio Input Level viene abilitato anche quando il
selettore dell’adattatore XLR & impostato su AUTO.
Se é specificato “Through”, I'audio verra registrato al
livello impostato con I'adattatore XLR (pagina 141).



51

Funzioni utili

Utilizzo del Direct Menu

Il camcorder consente di visualizzare e
controllare sullo schermo del mirino lo
stato e le sue impostazioni. Le impostazioni
visualizzate possono essere selezionate e
modificate direttamente.

Possono essere configurate le impostazioni
elencate di seguito.

Face/Eye Detection AF

SteadyShot

White Mode

Color Temp

Scene File

ND Filter Position / Auto ND Filter

ND Filter Value

Auto Iris

Iris Value

AGC

Gain Value

ISO Value

Exposure Index Value

Auto Shutter / ECS

Shutter Value

Auto Exposure Mode

Auto Exposure Level

S&Q Motion Frame Rate

—_—) @ @& @ o 0 0 O o o o o o o o o ¢ o o

Premere la manopola multifunzione o un
pulsante programmabile a cui &
assegnata la funzione Direct Menu.

Le voci sullo schermo che possono essere
configurate tramite Direct Menu sono
selezionabili mediante un cursore di
colore arancione.

2 Ruotare la manopola multifunzione per
spostare il cursore sulla voce di menu da
impostare, quindi premere la manopola
multifunzione.

Appare un menu, oppure la voce viene
visualizzata su uno sfondo bianco.

3 Ruotare la manopola multifunzione per
selezionare I'impostazione desiderata
quindi premere la manopola multifunzione.
Il menu o lo sfondo bianco scompaiono e
il nuovo valore appare visualizzato con un
cursore arancione.

Per uscire da Direct Menu, premere
nuovamente il pulsante programmabile a
cui € assegnata la funzione oppure
attendere 3 secondi senza esequire
nessuna operazione.

[Informazioni]

e [ possibile configurare direttamente le
impostazioni anche mantenendo premuto
per alcuni istanti il relativo pulsante funzione
(pagina 5).

e Quando le voci sono visualizzate su uno sfondo
bianco, la manopola multifunzione puo essere
utilizzata come una manopola programmabile.

e La selezione puo essere eseguita anche
mediante il selettore multiplo (pagina 9).

Pulsanti e manopole programmabili

Il camcorder € dotato di nove pulsanti
programmabili (pagina 6,7,9) a

Cui possono essere assegnate varie funzioni.
E possibile assegnare funzioni anche alla
manopola multifunzione del camcorder
(pagina 5), alla manopola programmabile
della maniglia (pagina 7) e alla manopola
programmabile dell'impugnatura di
telecomando (pagina 9).

Modifica della funzione assegnata al
pulsante

Utilizzare Assignable Button (pagina 89) nel
menu Project del menu completo.

Le funzioni assegnate sono visualizzate
nella schermata Assignable Button Status
(pagina 15).

Funzioni predefinite assegnate ai vari pulsanti
programmabili al momento dell'acquisto

Pulsante 1 S&Q Motion

Pulsante 2 AF Speed/Sens.
Pulsante 3 Focus Setting
Pulsante 4 Focus Magnifier x3/x6
Pulsante 5 Direct Menu

Pulsante 6 Off

Pulsante 7 Focus Magnifier x3/x6
Pulsante 8 Direct Menu

Pulsante 9 Video Signal Monitor

Pulsante Focus Hold Focus Hold

Funzioni assegnabili
Off

Base ISO/Sensitivity
AGC

Push AGC

ND Filter Position
Auto ND Filter

Push Auto ND

Auto lIris

Push Auto Iris
Bokeh Control

Auto Shutter

Auto Exposure Level
Backlight

Spotlight

Preset White Select
ATW

ATW Hold

AF Speed/Sens.
Focus Setting

Focus Area

Focus Area(AF-S)
Face/Eye Detection AF
Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

® Rec

e Picture Cache Rec

e Rec Review

e Clip Flag OK

e Clip Flag NG

e Clip Flag Keep

e Color Bars

e Tally [Front]

e DURATION/TC/U-BIT
e Display

e Lens Info

e Video Signal Monitor
e Marker

® VF Adjust

* \VVF Mode

e Gamma Display Assist
e Peaking

e Zebra

e \olume

e Thumbnail

e Touch Operation

e Handle Zoom

e NFC

e Auto Upload (Proxy)
e Direct Menu

e User Menu

e Menu

Modifica della funzione assegnata alla
manopola

Le funzioni assegnate alla manopola
multifunzione del camcorder, alla manopola
programmabile della maniglia e alla manopola
programmabile dell'impugnatura possono
essere scelte secondo le proprie esigenze.

Per la manopola multifunzione, utilizzare
la voce Multi Function Dial (pagina 92)
>Default Function del menu Project.
L'impostazione predefinita e Off.
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Funzioni assegnabili alla manopola
multifunzione

e Off

ISO/Gain/El

IRIS

Auto Exposure Level

Audio Input Level

[Nota]
L'impostazione ¢ disabilitata mentre & visualizzato il
menu.

Impostare la manopola programmabile
mediante la voce Assignable Dial

(pagina 91) del menu Project nel menu
completo.

Per impostazione predefinita € assegnata la
funzione IRIS.

[Informazione]

La manopola programmabile del telecomando RM-30BP
(opzionale) segue I'impostazione di Grip/Remote Dial.

Funzioni assegnabili alla manopola
programmabile della maniglia o
dell'impugnatura

e Off

1ISO/Gain/El

ND Filter

IRIS

Auto Exposure Level

Audio Input Level

Multi Function Dial

Le funzioni assegnate sono visualizzate
nella schermata Assignable Button Status
(pagina 15).

Slow & Quick Motion

Quando il formato di registrazione (pagina 86) & impostato su uno dei valori elencati
di seqguito, & possibile specificare valori diversi per le frequenze fotogrammi di ripresa e di

riproduzione.

Registrazione di video a intervalli
(Interval Rec)

Il camcorder e dotato della funzione Interval
Rec che consente di catturare video in time-

Formato di registrazione Frequenza lapse nella sua memoria interna. Questa
Frequenza di Modalita di Codec Formato video fotogrammi funzione & efficace per riprendere soggetti che
sistema scansione imager cambiano molto lentamente.
59.94/50/29.97/ FF RAW 3840x2160P 1-60, 100, 120 Quando si avvia la registrazione in
25/23.98 RAW & XAVC-| 3840x2160P 1-60, 100, 120 questa modalita, il camcorder registra
XAVC-| 4096x2160P 1-60 automaticamente un numero specificato di
3840x2160P 1-60, 100, 120 fotogrammi a in.te.rvalli specificati..
19201080P 1260, 100, 120, 150, Intervallo di ripresa (Interval Time)
180, 200, 240 ’—‘—‘
XAVC-L 3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
S35 XAVC-| 1920x1080P 1-60, 100, 120
XAVC-L 1920x1080P 1-60, 100, 120
24 FF XAVC-I 4096x2160P 1-60

E possibile attivare e disattivare la modalita
Slow & Quick Motion premendo un pulsante
programmabile (pagina 51) a cui & stata
assegnata la funzione S&Q Motion.

Premere e mantenere premuto il pulsante per
impostare la frequenza fotogrammi di ripresa.

[Informazione]

E possibile anche impostare la modalitd mediante S&Q
Frame Rate nella schermata Main Status, Rec Function
nella schermata di stato Project e S&Q Motion nel menu
Shooting del menu completo.

[Note]

e La funzione Slow & Quick Motion non pud essere
impostata durante la registrazione, la riproduzione o
mentre & visualizzata la schermata delle miniature.

e La modalita Slow & Quick Motion non consente la
registrazione di audio.

e Nella modalita Slow & Quick Motion, le funzioni di
messa a fuoco automatica, diaframma automatico
e otturatore automatico sono disabilitate. E tuttavia
possibile utilizzare la funzione di messa a fuoco
automatica quando la frequenza fotogrammi e
impostata sui valori indicati di seguito.

Frequenza di sistema Frequenza fotogrammi

59.94/29.97/23.98 30, 60, 120, 240

50/25 25,50, 100, 200

e Perinformazioni dettagliate sull'uso di output RAW,
vedere pagina 61.

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Quando ¢ attiva la modalita Interval Rec, la
luce video HVL-LBPC (opzionale) si accende
automaticamente prima dell’avvio della
registrazione per consentire la ripresa di
immagini in stabili condizioni di illuminazione
e di temperatura di colore (funzione di
preilluminazione Pre-Lighting).

[Note]

e E possibile utilizzare una sola funzione di
registrazione speciale (ad esempio Interval Rec) alla
volta.

e Se durante l'utilizzo di Interval Rec viene attivata
un‘altra modalita di registrazione speciale, il
camcorder esce dalla modalita Interval Rec.
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e |l camcorder esce automaticamente dalla modalita
Interval Rec se vengono modificate le impostazioni di
sistema, ad esempio il formato video.

e e impostazioni della modalita Interval Rec non
possono essere modificate durante la registrazione,
la riproduzione o mentre é visualizzata la schermata
delle miniature.

Impostazione di Interval Rec

Selezionare Rec Function >Interval Rec nella
schermata di stato Project e configurare le
impostazioni di Number of Frames e Interval
Time.

Se si utilizza la luce video HVL-LBPC
(opzionale), I'opzione Interval Rec >Pre-
Lighting del menu Project consente di
specificare secondo le proprie esigenze con
che anticipo dovra accendersi la luce video
prima dell’avvio della registrazione.

[Informazione]

E possibile impostare la modalita anche mediante
Interval Rec (pagina 88) nel menu Project del menu
completo.

[Note]

e Se si desidera accendere la luce video prima dell'avvio
della registrazione, spostare il selettore della luce
video su AUTO. La luce video si accendera e spegnera
automaticamente secondo |'impostazione dell'opzione
Video Light Set (pagina 105) nel menu Technical.

e Spostando su ON il selettore della luce video, la luce
rimane sempre accesa (non si accende e spegne
automaticamente).

e Laluce video non si spegne se e configurata per
spegnersi per 5 secondi 0 meno.

Allo spegnimento, il camcorder esce dalla
modalita Interval Rec, ma i valori impostati

in Number of Frames, Interval Time e Pre-
Lighting sono mantenuti. Non € necessario
impostarli nuovamente la volta successiva che
si utilizza la funzione Interval Rec.

Ripresa in modalita Interval Rec

Premere il pulsante START/STOP registrazione
per avviare la registrazione. Il mirino visualizza,
alternativamente, le indicazioni “Int @Rec” e
“Int @Stby".

Se si utilizza la funzione di preilluminazione, la luce
video si illumina prima dell'avvio della registrazione.

Arresto della ripresa

Arrestare la registrazione.

Al termine della ripresa, i dati video memorizzati
fino a quel momento nella memoria vengono
salvati sul supporto di registrazione.

Uscire dalla modalita Interval Rec

Eseqguire una delle operazioni indicate di seguito.

e Spostare il selettore POWER su Off.

e Nella modalita standby di registrazione,
impostare Rec Function su un valore diverso
da Interval Rec nella schermata di stato
Project.

Il camcorder esce automaticamente dalla modalita

Interval Rec anche quando viene riavviato.

Limitazioni durante la registrazione

e Non viene registrato audio.
e Non ¢ possibile rivedere la registrazione
(Rec Review).

Se il camcorder viene spento durante la
registrazione

e Se il selettore POWER del camcorder si trova
nella posizione Off, il camcorder accede per
alcuni secondi al supporto di registrazione
per salvare le immagini contenute in
memoria fino al quel momento, quindi si
spegne automaticamente.

e Se l'alimentazione si interrompe perché &
stata rimossa la batteria, & stato scollegato
il cavo di alimentazione CC oppure ¢ stata
interrotta 'alimentazione all'adattatore CA,
tutti i dati video ed audio registrati fino a
guel momento andranno persi (max. 10
secondi). Prestare attenzione durante la
sostituzione la batteria.

Registrazione di immagini
preregistrate nella cache
(Picture Cache Rec)

Mantenendo una memoria cache interna

di una durata specificata durante le riprese,

la funzione Picture Cache Rec consente di
catturare video “retroattivamente” all'avvio
della registrazione.

Impostare Picture Cache Rec su On nella
schermata di stato Project e quindi impostare
le dimensioni della cache.

Impostazione Tempo cache

Cache Size (approssimativo)
Short 5 secondi
Medium 10 secondi
Long 20 secondi
Max Valore massimo per
ciascun formato di
registrazione
[Informazioni]

e A seconda della frequenza fotogrammi di ripresa
e del formato di registrazione, il tempo di cache
potrebbe essere piu breve. Controllare I'indicazione
in basso a destra nella schermata di configurazione
delle dimensioni della cache.

e [ possibile impostare la modalita anche mediante
Picture Cache Rec (pagina 88) nel menu Project del
menu completo.

e E possibile attivare e disattivare la funzione
Picture Cache Rec anche utilizzando un pulsante
programmabile (pagina 51).

[Note]

e Picture Cache Rec non puo essere utilizzata
contemporaneamente a Interval Rec, registrazione
simultanea su 2 slot o registrazione proxy. Quando
viene impostata su On la funzione Picture Cache
Rec, queste altre funzioni di registrazione vengono
automaticamente impostate su Off.

® Non é possibile selezionare la modalita Picture Cache
Rec durante la registrazione o Rec Review.
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e Mentre Picture Cache Rec & impostata su On, il
codice temporale viene sempre registrato in modalita
Free Run anche se impostato su Regen o Rec Run
(pagina 95).

e L'impostazione Output Format potrebbe non essere
configurabile nella modalita Picture Cache Rec. In tal
caso, impostare provvisoriamente Picture Cache Rec
su Off e modificare le impostazioni desiderate.

Awvio di Picture Cache Rec

Quando Picture Cache Rec & impostata su On,
I'indicazione “@Cache” (@ & verde) appare sul
mirino.

Quando viene premuto il pulsante START/
STOP registrazione, la registrazione si avvia e il
video viene registrato sulle schede di memoria
a partire dal video contenuto nella memoria
cache.

Per annullare Picture Cache Rec

Impostare Picture Cache Rec su Off nella
schermata di stato Project, oppure premere il
pulsante programmabile a cui & assegnata la
funzione Picture Cache Rec.

[Note]

e Se si cambia il formato di registrazione o il Look di
base, il video gia esistente nella memoria cache
viene eliminato e la memoria cache inizia a registrare
nuovo video. Di conseguenza, non & possibile
registrare le immagini presenti nella cache prima del
cambiamento del formato anche se la registrazione
viene avviata immediatamente dopo il cambiamento
del formato.

e Se Picture Cache Rec viene impostata su On o Off
immediatamente dopo l'inserimento di una scheda
di memoria, & possibile che i dati della cache non
vengano registrati sulla scheda.

e |l video viene memorizzato nella memoria cache
a partire dal momento in cui la funzione di
Picture Cache Rec viene impostata su On. Prima
dell'impostazione su On della funzione il video non
viene memorizzato.

e |a cache non memorizza video durante I'accesso
a una scheda di memoria, ad esempio durante
riproduzione, Rec Review o visualizzazione delle
miniature. Durante tale periodo non & possibile
registrare immagini nella cache.

Registrazione simultanea sulle
schede dimemoriaAeB
(Simul Rec su 2 slot)

E possibile registrare simultaneamente sia
sulla scheda di memoria A che sulla scheda
di memoria B impostando su On la voce
Simul Rec (pagina 15) nella schermata

di stato Project, oppure Simul Rec >Setting
(pagina 88) nel menu Project del menu
completo.

Registrazione separata sulle schede di
memoriaAeB

Il camcorder consente di avviare ed arrestare
la registrazione su ciascuna scheda di
memoria indipendentemente I'una dall‘altra
utilizzando i pulsanti di START/STOP
registrazione del camcorder e della maniglia.
Per impostazione predefinita, entrambi i
pulsanti sono impostati per avviare e arrestare
la registrazione simultaneamente su entrambe
le schede memoria A e B.
e “Rec Button:[SlotA SlotB] Handle Rec
Button:[SlotA SlotB]"
Quando i pulsanti sono impostati per
comandare la registrazione su schede di
memoria diverse, la funzione di controllo
dell'avvio e arresto della registrazione SDI/
HDMI Rec Control (pagina 89) segue lo
stato di registrazione dello slot A.

Per modificare I'impostazione

Selezionare Simul Rec >Rec Button Set
(pagina 88) nel menu Project.

Pulsanti e schede di
memoria

Rec Button Set

Avvia/arresta la
registrazione
simultanea su
entrambe le schede di
memoriaAeB
premendo uno
qualsiasi dei pulsanti.

“Rec Button:[SIotA
SlotB] Handle Rec
Button:[SlotA SlotB]"

“Rec Button:[SlotA]
Handle Rec Button:
[SlotB]"

Il pulsante START/
STOP avvia/arresta la
registrazione sulla
scheda di memoria A
mentre il pulsante
START/STOP della
maniglia avvia/arresta
la registrazione sulla
scheda di memoria B.

“Rec Button:[SlotB]
Handle Rec
Button:[SlotA]”

Il pulsante START/
STOP avvia/arresta la
registrazione sulla
scheda di memoria B
mentre il pulsante
START/STOP della
maniglia avvia/arresta
la registrazione sulla
scheda di memoria A.

[Informazione]

Il pulsante di registrazione del telecomando
dell'impugnatura o del telecomando LANC funziona allo
stesso modo del pulsante START/STOP di registrazione
dell'unita.

Come evitare I'azionamento accidentale
del pulsante START/STOP registrazione
della maniglia

Spostare il selettore HOLD della maniglia sulla
posizione HOLD.

[Nota]

Il funzionamento del selettore HOLD della maniglia &
disabilitato quando HOLD Switch Setting (pagina 103)
>with Rec Button e impostato su Off nel menu Technical
del menu completo. Se impostato su On, impostare
Handle HOLD Switch su Rec Button Only.

Per abilitare il funzionamento della levetta
dello zoom e degli altri comandi (diversi dal
pulsante START/STOP di registrazione della
maniglia), impostare HOLD Switch Setting
>Handle HOLD Switch su Rec Button Only.

Video Signal Monitor

La voce Display On/Off >Video Signal Monitor
(pagina 98) del menu Monitoring consente

di specificare se visualizzare il segnale video
sullo schermo del mirino come forma d’onda,
vettorscopio o istogramma.

La linea arancione indica il valore impostato
del livello zebra.

La funzione Video Signal Monitor pud

essere assegnata anche a un pulsante
programmabile (pagina 51).

Indicazione dell'oggetto del
monitoraggio

In modalita Cine El, I'angolo superiore destro
del monitor del segnale video visualizza
informazioni relative alle impostazioni dello
spazio colore (pagina 25) o della LUT
monitor (pagina 84) per indicare I'oggetto
del monitoraggio.

LUT $709)

78001284667820123456

ND Cleer ANEH0.78 A
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Funzione Gamma Display Assist

Quando Target Display € impostato

su HDR(HLG) nella modalita Custom

(pagina 25), impostare Gamma Display

Assist* nella schermata Monitoring Status su
On per visualizzare sul mirino una versione
assistita dell'immagine, concepita per facilitare
la ripresa in HDR.

* E possibile impostare la funzione anche mediante
Gamma Display Assist >Setting (pagina 99) nel
menu Monitoring del menu completo.

Selezione della visualizzazione sul
mirino quando € attiva la funzione di
assistenza di visualizzazione gamma

Sono disponibili due metodi per la
visualizzazione sul mirino delle immagini HDR
quando é attiva la funzione di assistenza di
visualizzazione gamma.

Visualizzazione di immagini HDR mantenendo
il contrasto fra aree ad alta luminanza ed aree

a bassa luminanza

Questo metodo sfrutta la potenza espressiva
della modalita HDR per visualizzare
I'immagine sul mirino senza “chiudere” le
ombre o “sparare” le alteluci, anche nelle
riprese con esposizioni ai due estremi della
scala. In questo caso, tuttavia, il contrasto
viene leggermente ridotto.

Per utilizzare questo metodo di
visualizzazione, impostare HDR Setting >VF
SDR Preview (pagina 87) su Off nel menu
Project del menu completo.

Visualizzazione di immagini SDR tramite una

semplice conversione da HDR a SDR

Questo metodo consente di utilizzare il
camcorder con lo stesso “feel” della modalita
SDR convenzionale.

E possibile regolare la luminosita
dell'immagine HDR impostando la differenza
di guadagno tra HDR e SDR tramite la voce
SDR Gain.

Per utilizzare questo metodo di
visualizzazione, eseguire la configurazione
utilizzando la procedura seguente.

1 Impostare HDR Setting >VF SDR Preview
(pagina 87) su On nel menu Project del
menu completo.

2 Regolare il valore del guadagno SDR in
modalita HDR tramite HDR Setting >SDR
Gain (pagina 88) nel menu Project del
menu completo.

[Informazione]

Nella conversione a SDR di un‘immagine HDR
utilizzando SR Live Metadata dopo la ripresa, viene
applicato alla conversione il valore di SDR Gain in modo
che la visualizzazione dell'immagine SDR abbia la stessa
esposizione visualizzata sul mirino al momento della
ripresa.

Flag dei clip

Per aggiungere al clip un flag OK premere il
pulsante Clip Flag (pagina 5) e selezionare
Add OK.

Per eliminare un flag OK dal clip premere il

pulsante due volte e selezionare Delete Clip

Flag.

[Informazioni]

o E possibile aggiungere flag ai clip anche mediante un
pulsante programmabile a cui € assegnata la funzione
di aggiunta di flag dei clip (pagina 51).

e [ possibile aggiungere flag ai clip anche mediante la
voce Set Clip Flag (pagina 102) del menu Thumbnail
nel menu completo (pagina 73).

e La schermata delle miniature puo essere visualizzata
ordinando le miniature in base al tipo di flag dei
clip (schermata delle miniature di clip filtrata). Per
informazioni dettagliate, vedere “Operazioni con i
clip” (pagina 73).

Compensazione dell’effetto
breathing

E possibile specificare se realizzare o0 meno
la compensazione dell’effetto breathing
dell’'obiettivo mediante la voce Lens
>Breathing Compensation (pagina 105) nel
menu Technical del menu completo.

Questa funzione corregge il fenomeno per il
quale si verificano cambiamenti nell'angolo
di visuale al cambiamento della posizione di
messa a fuoco.

Quando la compensazione dell'effetto
breathing € attiva, una porzione dell'immagine
viene ritagliata elettronicamente per
mantenere un angolo di visuale costante e
compensare cosi questo fenomeno.

[Note]

e Quando la compensazione dell’effetto breathing
attiva potrebbero aver luogo piccoli cambiamenti
nell’angolo di visuale e nella qualita dell'immagine.

e In base all'obiettivo, la funzione di compensazione
dell’effetto breathing potrebbe non essere in grado di
correggere i cambiamenti all’angolo di visuale.

e La compensazione dell’effetto breathing non &
possibile se I'obiettivo montato non supporta tale
funzionalita.

e Questa funzione e fissata su Off nei casi indicati di
seguito.

- Quando Lens >Distortion Comp. nel menu Technical
€ impostata su Off.

- Quando S&Q Motion >Setting nel menu Shooting
impostato su On

- Quando Rec Format >Codec nel menu Project &
impostato su RAW o su un’opzione che include
RAW.

Regolazione del Bokeh (funzione
di controllo Bokeh)

E possibile regolare facilmente il livello di
bokeh collegando al valore di diaframma il
filtro ND e il guadagno.

Attivazione e disattivazione della
funzione di controllo del bokeh

Questa funzione puo essere abilitata solo se
attiva la regolazione manuale dell’'esposizione.
Impostare il filtro ND sulla modalita variabile,
quindi impostare diaframma, guadagno,
otturatore e filtro ND sulla regolazione
manuale.

E possibile attivare e disattivare la funzione di
controllo del bokeh tramite la voce Iris >Bokeh
Control (pagina 81) nel menu Shooting del
menu completo.

Quando la funzione di controllo del bokeh &
impostata su On, I'icona viene visualizzata
sugli indicatori del filtro ND e del guadagno.
[Informazione]

Assegnando la funzione Bokeh Control a un pulsante
programmabile (pagina 51) & possibile impostare

su On o Off tale funzione di controllo semplicemente
premendo il pulsante a cui e stata assegnata.
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Regolazione del livello di bokeh

1 Impostare la funzione di controllo del

bokeh su On.

2 Regolare il filtro ND e il guadagno per
determinare I'esposizione.

3 Regolare il diaframma.
Questo cambia il livello del bokeh.

[Informazioni]

e Quando la funzione di controllo del bokeh &
impostata su On, il filtro ND e il guadagno operano
insieme per compensare le variazioni di esposizione
dovute alla regolazione del diaframma, consentendo
di modificare il livello di bokeh.

e |l controllo del bokeh viene prima collegata al filtro ND
in risposta al cambiamento del valore di diaframma.
Quando non é piu possibile agire sul filtro ND, viene
collegato il guadagno.

e In modalita MF, si consiglia di aprire prima il
diaframma e quindi regolare la messa a fuoco.

e Se si utilizza il filtro ND automatico invece della
funzione di controllo del bokeh, il filtro ND segue il
cambiamento di luminosita del soggetto.

Visualizzazione durante il funzionamento

in collegamento di guadagno

Quando la funzione di controllo del bokeh e
impostata su On, il cambiamento del valore di
diaframma potrebbe causare il cambiamento
del guadagno.

Quando ¢ attivo il collegamento con il

guadagno, viene visualizzato un messaggio

nella parte superiore dello schermo e I'icona
sull'indicatore di guadagno lampeggia.

[Note]

e Questa funzione ¢ abilitata solo con obiettivi E-mount
in grado di comunicare con l'unita.

o L'effetto massimo di questa funzione puo essere
ottenuto utilizzando la ghiera del diaframma su un
obiettivo Sony E-mount.

e L'aspetto potra variare a seconda della velocita
operativa, dell’'obiettivo, delle impostazioni di ripresa
e del soggetto. Potra variare anche la luminosita.

Si consiglia vivamente di eseguire un test con il

camcorder prima delle riprese effettive.

La luminosita potra variare anche con il cambiamento

della direzione del funzionamento del diaframma, ad

esempio quando si apre il diaframma dopo averlo

chiuso o quando si chiude il diaframma dopo averlo

aperto. In questo caso, € consigliabile effettuare una

regolazione leggermente superiore al necessario,

tornare un po’ indietro, controllare la luminosita e

quindi iniziare la ripresa.

Ad esempio, se si desidera aprire il diaframma

all'apertura F8 e sfocare lo sfondo, chiudere prima

I'apertura superando F8, tornare quindi a F8,

controllare la luminosita e iniziare la ripresa.

Eseguire le operazioni di controllo del bokeh

lentamente. Se & necessario eseguire un cambiamento

rapido, cercare di eseguire la regolazione

gradualmente controllando sempre, allo stesso tempo,

i cambiamenti apportati all'immagine.

Non & possibile garantire la qualita dell'immagine

durante il controllo del bokeh in tutte le condizioni di

ripresa.

La funzione di controllo del bokeh viene disattivata

(impostata su Off) nei casi indicati di seguito.

- Se il camcorder viene spento

- Se viene impostato su Auto il diaframma, il
guadagno, I'otturatore oppure il filtro ND

- Quando viene selezionata una modalita di ripresa
diversa.

- Quando il filtro ND viene impostato su Clear o su
una modalita Preset.

- Quando viene rimosso l'obiettivo

- Quando l'unita si riavvia, ad esempio, dopo aver
cambiato la frequenza.
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Registrazione proxy

Questa funzione consente di registrare
contemporaneamente dati proxy a bassa
risoluzione insieme ai dati video originali ad
alta risoluzione.

E possibile inoltre suddividere
automaticamente in blocchi (chunk) a intervalli
di breve durata, per trasferire tali file prima
della fine della registrazione.

Per informazioni dettagliate sulle schede di memoria
supportate, sulla formattazione delle schede di memoria

e sul controllo della capacita rimanente, fare riferimento a
“Utilizzo di schede di memoria” (pagina 27).

Configurazione prima della ripresa

1 Impostare su On la voce Proxy Rec
(pagina 15) nella schermata di stato
Project oppure la voce Proxy Rec >Setting
(pagina 88) nel menu Project del menu
completo.

2 Inserire una scheda di memoria nello slot
per schede CFexpress Type A/SD
(pagina 6).
e Per le schede CFexpress, I'etichetta e
rivolta a sinistra.
® Per le schede SD, I'etichetta ¢ rivolta a
destra con I'angolo tagliato in basso.
[Nota]
La modalita Proxy Rec non pu0 essere impostata su
On contemporaneamente a S&Q Motion o Interval
Rec. Quando Proxy Rec & impostata su On, queste altre
modalita di registrazione vengono automaticamente
impostate su Off.

Registrazione di proxy

Premere il pulsante START/STOP registrazione
per avviare la registrazione dopo aver
completato le impostazioni necessarie per la
ripresa.

[Note]

e Se il camcorder viene spento o la scheda viene
rimossa durante l'accesso alla scheda, non &
possibile garantire I'integrita dei dati contenuti sulla
scheda. Tutti i dati registrati sulla scheda di memoria
potrebbero essere eliminati. Assicurarsi sempre che
I'indicatore di accesso alla scheda di memoria sia
spento prima di spegnere il camcorder o rimuovere la
scheda di memoria stessa.

e Assicurarsi che la scheda di memoria non salti
fuori dallo slot al momento dell'inserimento o
dell’'estrazione.

Per uscire, arrestare la registrazione.

Impostazione del canale audio per
la registrazione proxy

Selezionare Proxy Rec >Audio Channel
(pagina 88) nel menu Project del menu
completo e impostare il canale audio per la
registrazione dei dati proxy.

Registrazione e upload di file
proxy in blocchi

Quando la modalita di upload automatico e
impostata su Chunk e si sta registrando un file
proxy in blocchi (chunk), il camcorder potra
eseguire I'upload del file proxy mentre & in
corso la registrazione.

Per informazioni dettagliate sull’'upload di file
proxy registrati in blocchi, fare riferimento a
“Upload automatico dei file” (pagina 69) e
“Utilizzo di C3 Portal App” (pagina 70).

1 Selezionare Proxy Rec >Chunk
(pagina 88) nel menu Project e
selezionare l'intervallo di registrazione di
ciascun blocco.
30s: Registra file proxy in blocchi di 30
secondi (impostazione predefinita).
Tmin: Registra file proxy in blocchi di1
minuto.
2min: Registra file proxy in blocchi di 2
minuti.

2 Impostare File Transfer >Auto Upload
(Proxy) (pagina 109) nel menu Network
su Chunk.

Il file originale viene registrato sulla
scheda nello slot A mentre il file proxy
viene registrato in blocchi sulla scheda
nello slot B.

3 Avwviare la registrazione proxy.
Il file proxy viene registrato in blocchi con
I'intervallo specificato e ogni blocco viene
registrato nell’elenco dei processi come
processo di trasferimento.

[Note]

e Se Auto Upload (Proxy) non & impostato su Chunk, la
registrazione proxy in blocchi non ha luogo.

e Lascheda nello slot B & dedicata alla registrazione di
file proxy in blocchi e, per questo motivo, non sono
disponibili la registrazione relay e la registrazione
simultanea su due slot.

Informazioni sul file registrato

L'estensione del nome del file & “mp4”.
Anche il timecode viene registrato
simultaneamente.

Destinazione di salvataggio del
file registrato

Il file registrato viene salvato nella directory
indicata di seguito.

Supporto di Percorso cartella

registrazione

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

Informazioni sul nome dei file

I nome del file consiste del nome del clip
registrato sulla scheda di memoria piu il
suffisso “S03". Il nome del file proxy registrato
in blocchi per I'upload consiste nel nome del
file originale, pil il numero del blocco, piu il
suffisso “S03".

Per informazioni dettagliate sul nome dei
clip, fare riferimento a Clip Name Format
(pagina 96) nel menu TC/Media del menu
completo.
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Ripresa con il Look desiderato

Impostando il camcorder nella modalita
Custom, & possibile regolare i valori di nero,
matrice ed altri parametri per creare “look”
personalizzati basati sul look di base.

Matrice

Nero

Look —

Look di base

Salvando diverse combinazioni di
impostazioni in file di scena diventa quindi
possibile selezionare rapidamente look diversi
secondo le proprie esigenze.

Il camcorder & fornito con sei look
preconfigurati.

Selezione di un look

1 Mentre & visualizzata la schermata di
ripresa, premere la manopola
multifunzione.

2 Selezionare l'icona (file di scena).
3 Premere la manopola multifunzione.

4 Selezionare il look desiderato nel menu e
quindi premere la manopola
multifunzione.

[Informazioni]
e Nelle impostazioni predefinite sono preconfigurati i
seguenti preset:

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

File di scena1 S-Cinetone HLG Live

File di scena 2 Standard HLG Natural

File di scena 3 Still (Non
registrato)

File di scena 4 ITU709 (Non

registrato)

File di scena
da5a16

(Non registrato) (Non
registrato)

e [ possibile selezionare un look utilizzando la voce
Scene File (pagina 14) nella schermata Main Status
oppure la voce Scene File >Recall (pagina 93)
nel menu Paint/Look del menu completo. Utilizzare
Scene File >Preset Recall per richiamare un look
preconfigurato.

Importazione del look di base
desiderato

E possibile importare da una scheda di

memoria o da un servizio cloud un file 3D LUT

creato con un computer o un altro dispositivo

e utilizzarlo come look di base. Possono essere

importati fino a 16 file.

e Formato di File: File CUBE (*.cube) per una
3D LUT a 17 o 33 punti creata con Catalyst
Browse, RAW Viewer o DaVinci Resolve* (di

Blackmagic Design Pty. Ltd.).
* Verificato con Resolve V9.0, V10.0 e V11.0.

e Spazio colore di ingresso/gamma:
S-Gamut3.Cine/S-Log3 o S-Gamut3/S-Log3

Importazione da una scheda di memoria

E possibile importare un file 3D LUT da una
scheda di memoria.

1 Sul computer o altro dispositivo, salvare il
file 3D LUT nella cartella specificata del
supporto di registrazione.

Supporto di  Percorso cartella
registrazione

SDXC /PRIVATE/SONY/PRO/LUT/
CFexpress /SONY/PRO/LUT/

Type A

2 Inserire il supporto di registrazione su cui
sono salvati i file 3D LUT nello slot per
schede di memoria CFexpress Type A/SD

(B).

3 Selezionare Base Look >Import from
Media(B) (pagina 93) nel menu Paint/
Look del menu completo.

4 Selezionare la destinazione di
importazione.

5 Selezionare il file 3D LUT da importare.
Sequire le istruzioni indicate a schermo. Il
camcorder puo gestire il file 3D LUT come
look di base.

6 Selezionare il file 3D LUT importato con la
voce Base Look >Select (pagina 93) nel
menu Paint/Look del menu completo.

7 Configurare Base Look >Input e Output
(pagina 93) nel menu Paint/Look del
menu completo per riflettere gli attributi
del file 3D LUT importato.

Importazione da un servizio cloud

E possibile importare un file 3D LUT da un
servizio cloud.

1 Collegarsi all'unita dall’'app per
smartphone “C3 Portal App”
(pagina 70).

2 Selezionare Base Look >Import from
Cloud(Private) oppure Import from
Cloud(Share) (pagina 93) nel menu
Paint/Look del menu completo.

3 Selezionare la destinazione di
importazione.

4 Selezionare il file 3D LUT da importare.
Segquire le istruzioni indicate a schermo. Il
camcorder pud gestire il file 3D LUT come
look di base.

5 Selezionare il file 3D LUT importato con la
voce Base Look >Select (pagina 93) nel
menu Paint/Look del menu completo.
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6 Configurare Base Look >Input e Output
(pagina 93) nel menu Paint/Look del
menu completo per riflettere gli attributi
del file 3D LUT importato.

Gestione della sottoesposizione

Qualora si rilevi una tendenza alla
sottoesposizione quando é selezionata
I'esposizione automatica durante I'uso di un
look di base importato, correggere secondo
le esigenze Base Look >AE Level Offset
(pagina 93) nel menu Paint/Look.

[Note]

e Lasolaimportazione di un file 3D LUT non ha alcun
effetto sull'immagine. Caricare il file 3D LUT importato
mediante Base Look >Select (pagina 93) nel menu
Paint/Look del menu completo.

e Se Input non e impostato correttamente, non sara

possibile ottenere il look desiderato.

Le impostazioni delle voci di menu Input, Output

e AE Level Offset sono applicate al menu di base

selezionato con Select. Se é stato importato piu

di un file 3D LUT, & necessario selezionare Select

e configurare Input, Output e AE Level Offset

individualmente per ciascuno di tali file 3D LUT.

Le impostazioni configurate di Input, Output e

AE Level Offset sono salvate individualmente per

ciascuno dei file 3D LUT.

Le opzioni di selezione del look di base e della LUT

per i file 3D LUT importati sono comuni alle modalita

SDR(BT.709), HDR(HLG) e Cine El, ma la conversione di

gamma e spazio colore non viene eseguita in base a

tali modalita.

L'esecuzione di All Reset >Reset nel menu

Maintenance del menu completo non elimina i file

3D LUT.

Personalizzazione di un look

E possibile personalizzare il look partendo
dal look di base utilizzando Matrix e altre voci
di impostazione presenti nel menu Paint/
Look del menu completo. Per informazioni
dettagliate sulle varie voci di impostazione,
fare riferimento a pagina 93.

Collegare il camcorder a un televisore 0 a un
monitor e regolare la qualita dell'immagine
osservandola sullo schermo.

[Nota]

Quando si importa e si applica all'immagine un file

3D LUT, non sara possibile ottenere il look desiderato

e definito in tale file se sono state modificate le
impostazioni di Matrix e altre impostazioni diverse

da quelle del look di base nel menu Paint/Look. E
possibile resettare tutte le impostazioni personalizzate
mediante Reset Paint Settings >Reset without Base Look
(pagina 93) nel menu Paint/Look del menu completo.

Salvataggio di un look

Il look corrente pud essere salvato come file
di scena nella memoria interna del camcorder
utilizzando la voce Scene File >Store

(pagina 93) nel menu Paint/Look del menu
completo.

E possibile eseguire rapidamente il
salvataggio tramite le funzionalita del Direct
Menu nella schermata di ripresa.

[Note]

e Seviene selezionato un altro look senza aver prima
salvato il look corrente, il look corrente andra perso.

e L'esecuzione di All Reset >Reset (pagina 111) nel
menu Maintenance del menu completo non elimina i
file di scena.

[Informazione]

| file di scena preconfigurati possono essere sovrascritti.
Per ripristinare un file di scena preconfigurato, caricare il
look da ripristinare mediante la voce Scene File >Preset
Recall (pagina 93) nel menu Paint/Look del menu
completo, quindi salvare il file di scena con Scene File
>Store.

Eliminazione di un look salvato

E possibile eliminare file di scena salvati nella
memoria interna del camcorder utilizzando
la voce Scene File >Delete (pagina 93) nel
menu Paint/Look del menu completo.
[Informazione]

| file di scena eliminati, non sono pil visualizzati nel
Direct Menu.

Eliminazione di un look di base

E possibile eliminare un file 3D LUT
precedentemente importato utilizzando Base
Look >Delete (pagina 93) nel menu Paint/
Look del menu completo.

E possibile eliminare tutti file 3D LUT
precedentemente importati utilizzando Base
Look >Delete All (pagina 93) nel menu
Paint/Look del menu completo.

[Note]

e Prima dell’eliminazione, controllare che il look di base
non sia utilizzato in nessun file di scena. Se viene
eliminato un look di base utilizzato in file di scena,

il look dei file di scena che lo utilizzano non sara
corretto.

La selezione di All Reset >Reset (pagina 111) nel
menu Maintenance del menu completo non elimina i
file 3D LUT importati.

I look di base eliminati non possono essere utilizzati
come LUT in modalita Cine El (pagina 60).
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Ripresa con regolazione del look in post-produzione

Utilizzando il camcorder in modalita Cine El
e registrando con una gradazione uniforme
dell'intero campo dalle ombre alle alte luci,
sara possibile effettuare regolazioni fini

in sede di post produzione, ad esempio,
ripristinando la gradazione delle alte luci e
delle ombre solo localmente.

In questo caso, tuttavia, se visualizzate su un
monitor convenzionale, le immagini registrate
avranno un contrasto generale piuttosto
basso, rendendo piu difficoltoso il controllo
della messa a fuoco e dell’'esposizione.

E possibile applicare una LUT al monitor
utilizzato con il camcorder per facilitare
varie regolazioni durante le riprese. E
possibile applicare una LUT anche al video di
riproduzione per verificare il risultato finito.
Le LUT sono applicate dai sistemi indicati di
sequito. Potra essere applicata una sola LUT
alla volta.

e Uscita SDI e uscita HDMI

e Mirino e immagini proxy, streaming

e Video registrato su supporti di registrazione

Applicazione di una LUT
all'immagine del mirino

1 Premere il pulsante MENU per visualizzare
la schermata Monitoring Status.

2 Selezionare la colonna Gamut/Gamma
nella riga VF.

=2 Monitoring 5/13]
Signal Info.Disp. Gamut/Gamma

sbi [1920x1080P(LvI A) |[Off [SG3C/SLog3

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist

s709

3 Selezionare On o Off.

[Note]

e L'impostazione On o Off della LUT di VF viene
applicata anche al file proxy e al video in streaming.

e Mentre ¢ attiva la funzione di ingrandimento della
messa a fuoco ¢ disponibile anche la funzione di
assistenza alla visualizzazione gamma.

[Informazioni]

e E possibile anche eseguire I'impostazione mediante
LUT On/Off >VF/Proxy/Stream (pagina 84) nel
menu Shooting del menu completo.

e SDI e HDMI possono essere impostati in maniera
analoga a VF.

e Per il video registrato su supporti di registrazione, &
possibile eseguire I'impostazione mediante LUT On/
Off >Internal Rec (pagina 84) nel menu Shooting
del menu completo.

Modifica di una LUT

1 Premere il pulsante MENU per visualizzare
la schermata Monitoring Status.

2 Selezionare il campo Base Look/LUT.

@ Monitoring 5/13]
Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SGBC/SLog3

HDMI |1920x1080P On SG3C/SLog3

Stream Off [MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist
(0)i

s709

3 Selezionare la LUT da applicare nell’'elenco
dei look di base.

[Informazioni]

e Sull’'unita sono disponibili, come LUT preimpostate, le
LUT s709, 709(800%) e S-Log3.

e [ possibile anche importare ed applicare un
file 3D LUT. Per informazioni dettagliate, vedere
“Importazione del look di base desiderato”
(pagina 58) e “Eliminazione di un look di base”
(pagina 59).

o |l look di base puo essere impostato anche mediante
Base Look >Select (pagina 93) nel menu Paint/Look
del menu completo.

Modifica della distribuzione delle
ombre e delle alte luci nel video
registrato

La distribuzione delle ombre e delle alte luci
puo essere modificata secondo le proprie
esigenze, ad esempio se si desidera dare una
priorita alle tonalita delle ombre rispetto alle
alte luci. Per farlo, impostare Exposure Index
su un valore diverso dalla sensibilita di base.

1 Applicare una LUT all'immagine del mirino
(pagina 60).

2 Premere il pulsante MENU per visualizzare
la schermata Camera Status.

3 Impostare i campi L/M/H di Exposure
Index.
| valori impostati sono assegnati alle
rispettive posizioni L/M/H del selettore
ISO/GAIN (pagina 5).

4 Selezionare il valore di Exposure Index da
applicare mediante il selettore ISO/GAIN.

5 Regolare I'esposizione dell'immagine del
mirino secondo le proprie esigenze.

[Nota]

Mentre ¢ attiva la funzione di ingrandimento della
messa a fuoco é disponibile anche la funzione di
assistenza alla visualizzazione gamma. L'impostazione
di Exposure Index non viene applicata all’assistenza di
visualizzazione gamma.

[Informazioni]

e L'esposizione pud essere regolata anche mediante
1SO/Gain/El >Exposure Index (pagina 80) nel menu
Shooting del menu completo.

e |l secondo valore numerico dell'impostazione indica
quanti passi di informazioni di luminosita sono
assegnati alle alte luci (aree con luminosita superiore
al 18% di grigio). Le aree con luminosita superiore
sono sovraesposte.

Esempio: In “400EI/5.0E” sono assegnati alla
luminosita 5,0 passi.

e Questo puo essere utilizzato come guida per
controllare il tono delle ombre e delle alte luci
durante la ripresa. Ad esempio, se la posizione M &
la sensibilita di base, la posizione L € meno 2 passi
e la posizione H & piu 2 passi, & possibile eseguire il
controllo spostando il selettore ISO/GAIN. Ricordarsi
di tornare sempre sulla posizione M dopo il controllo
dell'esposizione.
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Registrazione di video RAW

Il segnale video RAW in uscita sul connettore
SDI OUT o sul connettore HDMI OUT del
camcorder puo essere registrato su un
registratore esterno supportato.

Registrazione dal connettore SDI
ouT

1 Collegare un registratore RAW esterno al
connettore SDI OUT del camcorder.

2 Impostare la modalita di ripresa su Cine El
utilizzando la schermata di stato Project
(pagina 15) oppure Base Setting
>Shooting Mode (pagina 86) nel menu
Project del menu completo.

3 Impostare la modalita di scansione (solo
FF) utilizzando Imager Scan nella
schermata di stato Project oppure Rec
Format >Imager Scan Mode (pagina 86)
nel menu Project del menu completo.

4 Impostare il codec su un codec che
includa RAW nella schermata di stato
Project oppure utilizzando Rec Format
>Codec (pagina 86) nel menu Project
del menu completo.

Selezionando RAW & XAVC-I e possibile
registrare contemporaneamente video sia
sul registratore RAW esterno che sulle
schede di memoria del camcorder.

5 Impostare la risoluzione utilizzando la
schermata di stato Project oppure Rec
Format >RAW Output Format
(pagina 86) nel menu Project del menu
completo.

6 Controllare che il registratore esterno sia
acceso, quindi premere il pulsante START/
STOP registrazione del camcorder.

[Nota]
Se viene avviata la registrazione sul registratore
esterno ma non viene premuto il pulsante START/
STOP registrazione del camcorder, i clip potrebbero
non venire registrati correttamente.

| formati di uscita RAW supportati sono

indicati di sequito.

Frequenza Codec RAW Output
di sistema Format
59.94/ RAW 4096x%2160
50/ 3840x2160
29.91/ RAW & XAVC-l 40962160
52(98 3840x2160
24 RAW 4096x%2160
RAW & XAVC-I 4096x%2160

Registrazione dal connettore
HDMI OUT

1 Collegare un registratore RAW esterno al
connettore HDMI OUT del camcorder.

2 Impostare la modalita di ripresa su Cine El
utilizzando la schermata di stato Project
(pagina 15) oppure Base Setting
>Shooting Mode (pagina 86) nel menu
Project del menu completo.

3 Impostare la modalita di scansione (solo
FF) utilizzando Imager Scan nella
schermata di stato Project oppure Rec
Format >Imager Scan Mode (pagina 86)
nel menu Project del menu completo.

4 Impostare il codec su RAW(HDMI) nella
schermata di stato Project oppure
utilizzando Rec Format >Codec
(pagina 86) nel menu Project del menu
completo.

Selezionando RAW(HDMI) & XAVC-1 &
possibile registrare contemporaneamente
video sia sul registratore RAW esterno che
sulle schede di memoria del camcorder.

5 Controllare che il registratore esterno sia
acceso, quindi premere il pulsante START/
STOP registrazione del camcorder.

[Nota]

Se viene avviata la registrazione sul registratore

esterno ma non viene premuto il pulsante START/STOP
registrazione del camcorder, i clip potrebbero non venire
registrati correttamente.

| formati di uscita RAW supportati sono
indicati di sequito.

Frequenza Codec RAW Output
di sistema Format
59.94/ RAW(HDMI) 4240%2392
50/ RAW(HDMI) & 4240%2392
29.97/ XAVC-|

25/

23.98

Indicatore dello stato della
registrazione

Quando Display On/Off (pagina 97) >RAW
Output Control Status nel menu Monitoring
del menu completo € impostato su On, lo
stato della registrazione RAW viene segnalato
da un’icona visualizzata sullo schermo del
mirino.

[Nota]

Il segnale di controllo della registrazione viene emesso
sul connettore SDI OUT del camcorder. Non & pero
possibile ottenere lo stato del registratore esterno.

Per questo motivo € possibile che il camcorder indichi
che la registrazione video RAW sia in corso anche se il
registratore esterno non sta effettivamente registrando.
Controllare I'effettivo stato operativo servendosi sempre
dell'indicatore del registratore esterno.

[Informazione]
Viene visualizzato anche il valore dell'impostazione RAW
Output Format.

Registrazione Slow & Quick
Motion

Se S&Q Motion >Setting del menu Shooting
impostata su On, il video RAW viene registrato
in modalita Slow & Quick Motion.

Per informazioni dettagliate sulle frequenze
fotogrammi supportate per le riprese, fare
riferimento a pagina 52.

[Nota]

La registrazione Slow & Quick Motion dal connettore
HDMI OUT non & supportata.
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Connessione ad altri dispositivi tramite LAN

Il camcorder & in grado di collegarsi a
smartphone, tablet e altri dispositivi tramite
una connessione LAN.
Collegando il camcorder a un dispositivo
tramite una rete LAN, e possibile utilizzare la
applicazione “Content Browser Mobile"” per
eseqguire le operazioni descritte di seguito.
e Comando a distanza
E possibile comandare a distanza il
camcorder mediante uno smartphone o un
tablet connesso al camcorder tramite LAN.
e Trasferimento di file
Se si utilizza possibile trasferire a un server
file proxy (bassa risoluzione) e/o file
originali (alta risoluzione) registrato sulla
scheda di memoria della camcorder al
server tramite una LAN.
e Monitoraggio video
E possibile monitorare I'immagine del
camcorder o riprodurre video del camcorder
mediante I'applicazione “Content Browser
Mobile” su un dispositivo.

[Nota]

Il monitoraggio del video non & supportato con le
impostazioni indicate di seguito.

- Modalita Slow & Quick Motion

- Frequenza di sistema 24

- Modalita Interval Rec

Applicazione “Content Browser Mobile”

L'applicazione “Content Browser Mobile”
consente di utilizzare lo schermo di un
dispositivo per azionare il camcorder a
distanza, monitorarne il video e configurarne
impostazioni.

Per informazioni dettagliate sull'applicazione “Content

Browser Mobile” rivolgersi al proprio rappresentante
commerciale o di assistenza tecnica Sony.

Impostazione del nome utente e
della password

Per poter utilizzare le funzionalita di rete
necessario impostare il nome utente e la
password.

1 Impostare Access Authentication >User
Name (pagina 106) nel menu Network
del menu completo.

2 Impostare Access Authentication >Input
Password (pagina 106) nel menu
Network del menu completo.

[Informazioni]

e E possibile anche generare una password
automaticamente. Eseguire Generate Password
invece di Input Password.

e Nome utente, password, testo e codice QR
possono essere resi visibili utilizzando Show
Settings.

[Nota]
Assicurarsi che il codice QR e la password non
possano essere visti da altre persone.

Connessione tramite la modalita
Punto di accesso LAN wireless
Il camcorder funziona come un punto di

accesso e si connette a un dispositivo tramite
LAN wireless.

Smartphone/tablet

Connessione a un dispositivo NFC
compatibile con un‘operazione One-touch

| dispositivi che supportano la funzione NFC
possono essere collegati tramite tale funzione
(connessione “One-Touch”).

1 Aprire [Settings] sul dispositivo,
selezionare [More] e contrassegnare con
un segno di spunta la casella di controllo
NFC.

E’

NFC

e 2

2 Accendere il camcorder.

3 Attivare la funzione NFC.
Mantenere premuto per 3 secondi il
pulsante programmabile a cui & stata
assegnata la funzione NFC oppure
selezionare Wireless LAN >NFC nel menu
Network per attivare la modalita di
connessione NFC.
La funzione NFC é disponibile solo
quando sullo schermo é visualizzato N

4 Toccare il camcorder con il dispositivo.
Il dispositivo si connette al camcorder ed
awvia “Content Bro

[Note]

e Disabilitare in anticipo le modalita sleep e di
blocco schermo.

e Toccare e mantenere fermo il dispositivo fino
a quando non si avvia I'applicazione “Content
Browser Mobile” (1 0 2 secondi).
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Connessione a un dispositivo WPS
compatibile

E possibile utilizzare la funzione di
collegamento WPS con i dispositivi che la
supportano.

1

Selezionare Wireless LAN >Setting >Access
Point Mode nel menu Network del menu
completo.

Selezionare Wireless LAN >WPS >Execute
nel menu Network del menu completo.

Aprire le impostazioni di rete o Wi-Fi del
dispositivo ed attivare Wi-Fi.

Per esequire il collegamento, selezionare
il SSID del camcorder nell’elenco dei SSID
in Wi-Fi Network sul dispositivo, quindi
selezionare WPS Push Button in Option
sul dispositivo.

[Note]

e |l metodo di funzionamento dipende dal
dispositivo.

e Per informazioni su SSID e password del
camcorder, vedere AP Mode Settings >Camera
SSID & Password (pagina 106) nel menu
Network del menu completo.

5 Eseguire il collegamento tramite

I'applicazione Content Browser Mobile.

[Informazione]

E possibile controllare le informazioni hecessarie
per la connessione all’'unita mediante Access
Authentication >Show Settings (pagina 106) nel
menu Network del menu completo.

Connessione mediante inserimento di
SSID e password su un dispositivo

E possibile connettere il camcorder a un
dispositivo immettendo sul dispositivo SSID e
password dell’'unita corrispondenti.

Selezionare Wireless LAN >Setting >Access
Point Mode nel menu Network del menu
completo.

Aprire le impostazioni di rete o Wi-Fi del
dispositivo ed attivare Wi-Fi.

Collegare il dispositivo al camcorder
selezionando il SSID del camcorder
nell’elenco dei SSID in Wi-Fi Network e
immettendo la password.

Per informazioni su SSID e password del
camcorder, vedere AP Mode Settings
>Camera SSID & Password (pagina 106)
nel menu Network.

[Nota]
I metodo di funzionamento dipende dal
dispositivo.

Eseguire il collegamento tramite
I'applicazione Content Browser Mobile.

[Informazione]

E possibile controllare le informazioni necessarie
per la connessione all’'unita mediante Access
Authentication >Show Settings (pagina 106) nel
menu Network del menu completo.

Connessione tramite la modalita
Wireless LAN Station

Il camcorder si connette a un punto di accesso

esistente nella LAN wireless come client.

Il camcorder e il dispositivo si connettono
attraverso il punto di accesso.

La cronologia mostra gli ultimi 10 punti di
accesso a cui ¢i si & collegati.

La cronologia viene salvata nel file ALL, ma

le password di accesso non vengono salvate.

E sempre necessario immettere la password
la prima volta che si esegue la connessione
dopo aver caricato un file ALL.

Smartphone/
tablet

lg e — )\

Computer

Punto di accesso

[

Connessione a un punto di accesso
mediante WPS

Se il punto di accesso € compatibile con la
funzione WPS, ¢ possibile connettersi al punto
di accesso con impostazioni semplificate.

1 Accendere il punto di accesso.
2 Accendere il camcorder.

3 Selezionare Wireless LAN >Setting >
Station Mode nel menu Network del menu
completo.

4 Selezionare ST Mode Settings >Camera
Remote Control (pagina 107) >Enable
nel menu Network del menu completo.

5 Selezionare Wireless LAN >WPS >Execute
nel menu Network del menu completo.

6 Premere il pulsante WPS del punto di
accesso.
Per informazioni dettagliate sull’'uso del
pulsante WPS, consultare le istruzioni per
I'uso del punto di accesso.
Una volta realizzata correttamente la
connessione, I'icona di indicazione dello
stato della rete visualizzata sullo schermo
del mirino indichera un livello di intensita
del segnale di almeno 1.
[Nota]

Se la connessione non riesce, ripetere la procedura
dal punto 1.

7 Connettere il dispositivo al punto di
accesso.
Per informazioni dettagliate sulla
connessione, consultare le istruzioni per
I'uso del dispositivo.
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8 Awviare |'applicazione “Content Browser

Mobile” su un dispositivo e selezionare
I"'unita.
[Informazione]
E possibile controllare le informazioni necessarie
per la connessione all’'unita mediante Access
Authentication >Show Settings (pagina 106) nel
menu Network del menu completo.

Connessione tramite la funzione di
rilevamento automatico del punto di
accesso

1

Esequire i passi da 1 a 3 descritti in
“Connessione a un punto di accesso
mediante WPS” (pagina 63).

Selezionare ST Mode Settings >Scan
Networks (pagina 107) >Execute nel
menu Network del menu completo.

Il camcorder avvia la ricerca di
destinazioni di connessione.

Le possibili destinazioni trovate vengono
visualizzate in un elenco.

Selezionare la destinazione desiderata

nell’elenco.

Appare la schermata dei dettagli della

rete (punto di accesso). La connessione
selezionata e visualizzata in SSID.

Selezionare Password e immettere la
password del punto di accesso per la
connessione nella schermata di
immissione della password.

La selezione di un SSID nella cronologia
delle connessioni ne configura
automaticamente le impostazioni,
compresa la password.

Impostare la password per tornare alla
schermata dei dettagli di rete (punto di
accesso).

5 Configurare le impostazioni di
connessione indicate di seguito.
e DHCP

Configurare I'impostazione DHCP.
Quando e impostato su On, I'indirizzo
IP viene assegnato al camcorder
automaticamente.

Per assegnare manualmente l'indirizzo
IP al camcorder, impostare su Off.

IP Address

Immettere I'indirizzo IP dell’unita.
Questa impostazione ¢ disponibile solo
quando DHCP & impostato su Off.
Subnet Mask

Immettere la subnet mask dell’unita.
Questa impostazione & disponibile solo
quando DHCP & impostato su Off.
Gateway

Immettere il gateway del punto di accesso.

Questa impostazione & disponibile solo
quando DHCP & impostato su Off.

DNS Auto

Specifica se acquisire I'indirizzo DNS
automaticamente o meno.

Quando impostato su On, l'indirizzo
del server DNS viene acquisito
automaticamente. Questa impostazione
e disponibile solo quando DHCP e
impostato su On.

Primary DNS Server

Immettere I'indirizzo del server DNS
primario del punto di accesso.

Questa impostazione ¢ disponibile solo
quando DNS Auto € impostato su Off.
Secondary DNS Server

Immettere I'indirizzo del server DNS
secondario del punto di accesso.
Questa impostazione & disponibile solo
quando DNS Auto e impostato su Off.

6 Al termine, selezionare Connect per
connettersi al punto di accesso.

7 Connettere il dispositivo al punto di

accesso.
Per informazioni dettagliate sulla
connessione, consultare le istruzioni per
I'uso del dispositivo.

8 Awviare I'applicazione “Content Browser

Mobile” su un dispositivo e selezionare
I"unita.
[Informazione]

E possibile controllare le informazioni necessarie
per la connessione all’'unita mediante Access

Authentication >Show Settings (pagina 106) nel

menu Network del menu completo.

Connessione manuale tramite
I'immissione di informazioni del punto
di accesso

1

Eseguire i passi da 1a 3 descritti in
“Connessione a un punto di accesso
mediante WPS” (pagina 63).

Selezionare ST Mode Settings >Manual
Register (pagina 108) >Execute nel

menu Network del menu completo.
Appare momentaneamente la schermata
dei dettagli della rete (punto di accesso).

Configurare le impostazioni di
connessione indicate di seguito.
e SSID
Immettere il SSID del punto di accesso
della connessione.
e Security
Selezionare il metodo di crittografia.
e Password
Immettere la password del punto di
accesso.
e DHCP
Configurare I'impostazione DHCP.
Quando e impostato su On, I'indirizzo

IP viene assegnato al camcorder
automaticamente.

Per assegnare manualmente l'indirizzo
IP al camcorder, impostare su Off.

e |P Address

Immettere I'indirizzo IP dell'unita.
Questa impostazione & disponibile solo
quando DHCP & impostato su Off.

e Subnet Mask

Immettere la subnet mask dell’unita.
Questa impostazione & disponibile solo
quando DHCP & impostato su Off.

e Gateway

Immettere I'indirizzo del gateway.
Questa impostazione & disponibile solo
guando DHCP ¢ impostato su Off.

® DNS Auto

Specifica se acquisire I'indirizzo DNS
automaticamente o meno.

Quando impostato su On, l'indirizzo

del server DNS viene acquisito
automaticamente. Questa impostazione
¢ disponibile solo quando DHCP e
impostato su On.

e Primary DNS Server

Immettere I'indirizzo del server DNS
primario.

Questa impostazione & disponibile solo
quando DNS Auto e impostato su Off.

e Secondary DNS Server

Immettere I'indirizzo del server DNS
secondario.

Questa impostazione & disponibile solo
quando DNS Auto € impostato su Off.

4 Al termine, selezionare Connect per

5

connettersi al punto di accesso.

Connettere il dispositivo al punto di
accesso.

Per informazioni dettagliate sulla
connessione, consultare le istruzioni per
I'uso del dispositivo.
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6 Awviare |'applicazione “Content Browser
Mobile” su un dispositivo e selezionare
I"'unita.

[Informazione]

E possibile controllare le informazioni necessarie
per la connessione all’'unita mediante Access
Authentication >Show Settings (pagina 106) nel
menu Network del menu completo.
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Connessione a Internet

E possibile collegare il camcorder a Internet
tramite tethering USB, una LAN cablata o una
LAN wireless.

Impostare in anticipo il nome utente e la
password del camcorder (pagina 62).

Collegamento tramite tethering USB

E possibile collegare I'unita a uno smartphone
tramite un cavo USB e quindi connettersi a
Internet tramite lo smartphone.

Configurazione della comunicazione
tramite smartphone

Abilitare la funzione di tethering sullo
smartphone.

Per ulteriori informazioni, consultare il
manuale per |'uso dello smartphone.

Collegamento del smartphone al camcorder

Collegare un cavo USB al connettore USB-C
(pagina 7) del camcorder, quindi collegare
lo smartphone.

[Note]

e (Collegare o scollegare lo smartphone solo con il
camcorder spento.

e La funzione di tethering USB non puo essere utilizzata
se lo smartphone é connesso tramite un hub USB.

e La funzione di tethering USB non é utilizzabile se
un computer ¢ collegato al connettore USB/Multi

(pagina 7).

Connessione a una rete
1 Accendere il camcorder.

2 Impostare su On la voce Modem >Setting
(pagina 108) nel menu Network del
menu completo.

Abilitazione del comando tramite uno
smartphone

E possibile comandare a distanza il camcorder
mediante l'applicazione Content Browser
Mobile su uno smartphone connesso con cavo
USB.

1 Impostare Modem >Camera Remote
Control (pagina 108) su Enable nel menu
Network del menu completo.

2 Avviare l'applicazione “Content Browser
Mobile” su uno smartphone e selezionare
I"'unita.

[Informazione]

E possibile controllare le informazioni necessarie per
la connessione all'unita dall'applicazione Content
Browser Mobile mediante Access Authentication

>Show Settings (pagina 106) nel menu Network
del menu completo.

Connessione tramite la modalita
Station LAN wireless (modalita
Wi-Fi Station)

E possibile connettere il camcorder a Internet
nella modalita Wi-Fi Station tramite un router
Wi-Fi opzionale o tramite tethering Wi-Fi su
uno smartphone.

Eseguire il collegamento al router Wi-Fi o al
dispositivo come descritto in “Connessione
tramite la modalita Wireless LAN Station”
(pagina 63).

Smartphone/

tablet

Computer

f=———\
-

Router Wi-Fi

L]

Smartphone/
tablet

Internet

Internet

Connessione con cavo LAN

E possibile collegare il camcorder a Internet
utilizzando un adattatore per LAN cablata
(opzionale) collegato al connettore USB-C
(pagina 7) del camcorder stesso, il cui
connettore per LAN cablata é a sua volta
collegato mediante un cavo LAN a un router
Wi-Fi (opzionale).

Smartphone/ Computer
tablet
Router Wi-Fi

&

Internet

Adattatore per
LAN cablata
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Connessioni cavo LAN e impostazioni
LAN cablata

1

Collegare un adattatore per LAN cablata al
connettore USB-C del camcorder.

Collegare il connettore della LAN cablata
dell’adattatore per LAN cablata a un
router Wi-Fi tramite un cavo LAN.

Accendere il camcorder.

Impostare su On la voce Wired LAN
>Setting (pagina 108) nel menu Network
del menu completo.

Configurare le impostazioni di

connessione mediante la voce Wired LAN

>Detail Settings (pagina 108) del menu

Network.

e DHCP
Configurare I'impostazione DHCP.
Quando e impostato su On, l'indirizzo
IP viene assegnato al camcorder
automaticamente.
Per assegnare manualmente l'indirizzo
IP al camcorder, impostare su Off.

e |P Address
Immettere I'indirizzo IP dell’unita.
Questa impostazione & disponibile solo
quando DHCP & impostato su Off.

e Subnet Mask
Immettere la subnet mask dell’unita.
Questa impostazione & disponibile solo
quando DHCP é impostato su Off.

e Gateway
Immettere I'indirizzo del gateway.
Questa impostazione ¢ disponibile solo
quando DHCP e impostato su Off.

e DNS Auto
Specifica se acquisire I'indirizzo DNS
automaticamente o meno.

Quando impostato su On, l'indirizzo
del server DNS viene acquisito
automaticamente. Questa impostazione
e disponibile solo quando DHCP &
impostato su On.

e Primary DNS Server
Immettere l'indirizzo del server DNS
primario.
Questa impostazione ¢ disponibile solo
quando DNS Auto € impostato su Off.

e Secondary DNS Server
Immettere I'indirizzo del server DNS
secondario.
Questa impostazione & disponibile solo
quando DNS Auto ¢ impostato su Off.

6 Al termine, selezionare Set per applicare
le impostazioni.

[Note]

e Selezionare sempre Set dopo aver modificato le
impostazioni di connessione. Le impostazioni non
sono applicate fino a quando non viene selezionato
Set.

e Utilizzare un adattatore per LAN cablata USB Type C.
Si consiglia I'uso di un adattatore compatibile con
Gigabit Ethernet. Non & tuttavia possibile garantire il
funzionamento con tutti i dispositivi.

e Non é possibile utilizzare un adattatore USB per LAN
cablata (opzionale) se un computer & collegato al
connettore USB/Multi (pagina 7).

e La funzione di comunicazione Wi-Fi incorporata del
camcorder potrebbe essere influenzata dal tipo di
adattatore per LAN cablata (opzionale) utilizzato.

Abilitazione del comando tramite uno
smartphone mediante LAN cablata

Il camcorder puo essere azionato a distanza
utilizzando I'applicazione Content Browser
Mobile su uno smartphone connesso tramite
Wi-Fi a un router Wi-Fi a sua volta connesso
mediante LAN cablata. Per farlo, impostare su
Enable la voce Wired LAN >Camera Remote
Control (pagina 108) nel menu Network del
menu completo.
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Caricamento di file

| file proxy e i file originali registrati sul
camcorder possono essere caricati su un server
Internet o un server sulla rete locale tramite
uno smartphone o un punto di accesso.

Operazioni di preparazione

Connessione a una rete

Collegare il camcorder a Internet o alla rete
locale come descritto in “Connessione a
Internet” (pagina 66) o “Connessione ad
altri dispositivi tramite LAN" (pagina 62).

Registrazione di una destinazione di
trasferimento file

Registrare anticipatamente il server per il
caricamento.

1 Selezionare File Transfer >Server Settings1
(oppure Server Settings2, Server Settings3)
nel menu Network del menu completo.
Appare la schermata di configurazione
della destinazione di trasferimento.

2 Impostare le varie opzioni nella schermata
di configurazione della destinazione di
trasferimento.

Display Name

Immettere il nome del server da
visualizzare nell'elenco delle destinazioni
di trasferimento.

Service

Visualizza il tipo di server.

“FTP": server FTP

Host Name

Immettere I'indirizzo del server.

Port

Immettere il numero di porta del server a
Cui connettersi.

User Name

Immettere il nome utente.

Password

Immettere la password.

Passive Mode

Attivare o disattivare la modalita Passive.
Destination Directory

Immettere il nome della directory sul
server di destinazione.

[Note]

e | file originali sono caricati nella cartella “Main”
della directory specificata come destinazione del
trasferimento.

e Durante la modifica, “O0" indica caratteri che non
possono essere cambiati. Non & possibile garantire
il funzionamento corretto se si modificano nomi di
directory che contengono tali caratteri.

Se € necessario eseguire una modifica, eliminare
tutti i caratteri ed immettere nuovamente il valore
desiderato.

e Se vengono immessi in Destination Directory
caratteri non validi per il server di destinazione,

i file saranno trasferiti alla directory Home
dell’'utente. | caratteri validi e non validi variano a
seconda del server.

Using Secure Protocol

Specifica se utilizzare o meno il protocollo
di upload Secure FTP.

Root Certificate

Caricamento o annullamento di un certificato.

e Load
Selezionare Set al passo 3 per importare
un certificato CA.

* |l certificato da caricare deve essere in formato
PEM e il suo file deve avere il nome “certification.
pem” ed essere contenuto nella directory
principale della scheda di memoria inserita nello
slot per schede CFexpress Type A/SD (B).

e Clear
Selezionare Set al passo 3 per annullare
un certificato CA.

e None
Non carica né annulla nessun certificato.

3

[Note]
e Impostare 'orologio del camcorder sull'ora
corretta prima di importare un certificato CA.
Durante la registrazione in modalita XAVC-I
4096%2160P/3840x2160P 59.94/50P, non &
possibile selezionare Load.
e In condizioni di bassa tensione, non & possibile
selezionare Load o Clear per un certificato CA.

Root Certificate Status

Visualizza lo stato di caricamento del
certificato.

Reset

Ripristina sui valori predefiniti le
impostazioni di Server Settings.

Al termine, selezionare Set per applicare
le impostazioni.

Selezionare sempre Set dopo aver
modificato le impostazioni. Le
impostazioni non sono applicate fino a
quando non viene selezionato Set.

Selezione di file e upload

E possibile selezionare e trasferire su un server i file
proxy e i file originali registrati su schede di memoria.

[Nota]

| file proxy registrati in blocchi sono file dedicati
all'upload automatico. Non possono essere selezionati
per eseguirne |'upload manualmente.

Caricamento dalla schermata delle
miniature di un file proxy contenuto in
una scheda di memoria

1 Collegare il camcorder al dispositivo tramite
una connessione LAN (pagina 62).

2 Selezionare Transfer Clip (Proxy) >Select Clip
nel menu Thumbnail del menu completo.
Il display passa dal menu completo alla
schermata delle miniature.
Il trasferimento dei clip pud essere
effettuato sia dalla schermata delle
miniature che dalla schermata filtrata
delle miniature dei clip.

3 Selezionare il clip da trasferire, quindi
premere il pulsante MENU.
Viene visualizzata una schermata di
conferma del trasferimento.

4 Selezionare Execute.
Il file proxy corrispondente al file selezionato
viene registrato come operazione di
trasferimento e I'upload ha inizio.
Non appena l'operazione di trasferimento
viene registrata, appare la schermata dei
risultati del trasferimento.

5 Selezionare OK.
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Upload di tutti i file

Per esequire il trasferimento dei file proxy di
tutti i file, selezionare All Clips invece di Select
Clip al passo 2.

[Nota]
Possono essere trasferiti fino a 200 file.

Caricamento dalla schermata delle
miniature di un file originale contenuto
in una scheda di memoria

[Nota]

| file originali sono caricati nella cartella “Main”
della directory specificata come destinazione del
trasferimento.

1 Collegare il camcorder al dispositivo
tramite una connessione LAN
(pagina 62).

2 Selezionare Transfer Clip >Select Clip nel
menu Thumbnail del menu completo.
Il display passa dal menu completo alla
schermata delle miniature.
Il trasferimento dei clip puo essere
effettuato sia dalla schermata delle
miniature che dalla schermata filtrata
delle miniature dei clip.

3 Selezionare il clip da trasferire, quindi
premere il pulsante MENU.
Viene visualizzata una schermata di
conferma del trasferimento.

4 Selezionare Execute.
Il file selezionato viene registrato come
operazione di trasferimento e l'upload ha
inizio.
Non appena l'operazione di trasferimento
viene registrata, appare la schermata dei
risultati del trasferimento.

5 Selezionare OK.

Upload di tutti i file

Per esequire il trasferimento di tutti i file,
selezionare All Clips invece di Select Clip al
passo 2.

[Nota]
Possono essere trasferiti fino a 200 file.

Controllo del trasferimento del file

E possibile controllare lo stato del
trasferimento dei file selezionando File
Transfer >View Job List (pagina 109) nel
menu Network del menu completo.

E possibile controllare lo stato del
trasferimento dei file anche nella schermata
dell’applicazione Content Browser Mobile.

[Informazione]

Se File Transfer >Auto Upload (pagina 109) oppure

Auto Upload (Proxy) (pagina 109) nel menu Network

del menu completo € impostato su On ed & presente
una connessione di rete, i file originali e i file proxy
vengono automaticamente caricati sul server specificato
in Default Upload Server (pagina 109) al termine della
registrazione. Se & stato configurato I'upload automatico
sia di file originali che di file proxy, avra la precedenza
'upload automatico dei file proxy.

[Note]

e Possono essere registrati fino a 200 trasferimenti.

e |'elenco dei trasferimenti permane anche dopo lo
spegnimento del camcorder, tuttavia potrebbero
andare persi fino a 10 minuti di informazioni
sull'avanzamento dell'operazione qualora venga
rimosso il pacco batteria oppure venga interrotta
I'alimentazione del camcorder senza aver prima
spostato il selettore di alimentazione POWER su
STANDBY.

e | trasferimenti aggiunti dopo I'entrata in stato di bassa
tensione non sono salvati nell’elenco delle operazioni.

e Qualora si verificasse un errore durante il
trasferimento di un file, il trasferimento di un clip con
lo stesso nome di un clip trasferito potrebbe non
venire ripreso, in base alle impostazioni e allo stato
del server di destinazione del trasferimento. In tal
caso, controllare le impostazioni e lo stato del server
di destinazione del trasferimento.

Upload automatico dei file

Upload automatico di file originali

Al termine della registrazione, i file originali
possono essere caricati sul server specificato.
Per abilitare questa funzione, impostare File
Transfer >Auto Upload (pagina 109) su On

nel menu Network del menu completo.

Upload automatico di file proxy

Al termine della registrazione, i file proxy
possono essere caricati sul server specificato.
Per abilitare questa funzione, impostare File
Transfer >Auto Upload (Proxy) (pagina 109)

su On nel menu Network del menu completo.

In alternativa, quando Auto Upload (Proxy) &
impostato su Chunk, € possibile registrare in
blocchi (o chunk) un file proxy ed effettuarne,
durante la registrazione stessa, I'upload dei
blocchi sul server specificato in precedenza.
L'upload di file proxy registrati in blocchi ha
la precedenza rispetto ad altri processi di
trasferimento di file.

Per informazioni dettagliate sulla
configurazione, fare riferimento a
"Registrazione e upload di file proxy in
blocchi” (pagina 57).

Upload tramite Secure FTP

Per proteggere con crittografia I'upload di
file, & possibile utilizzare il protocollo FTPS

in modalita Explicit (FTPES) per realizzare la
connessione con il file server di destinazione.

Configurazione del trasferimento in
modalita Secure FTP

Per utilizzare il protocollo Secure FTP,
impostare su ON I'opzione Using Secure
Protocol sul file server di destinazione ed
importare il relativo certificato.

Per informazioni dettagliate sulla
configurazione, fare riferimento a
"Registrazione di una destinazione di
trasferimento file" (pagina 68).
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4. Funzioni di rete

Utilizzo di C3 Portal App

Collegando l'unita con l'applicazione per
smartphone “C3 Portal App” & semplicissimo
trasferire file sul servizio cloud C3 Portal.
Innanzitutto, ottenere un account C3 Portal e
installare C3 Portal App su uno smartphone.
Per informazioni dettagliate su come ottenere
un account del servizio cloud C3 Portal,
rivolgersi all'amministratore della propria
organizzazione.

[Note]

e Questo servizio puo non essere disponibile in tutte le
regioni geografiche.

e Per informazioni dettagliate sull’utilizzo di C3 Portal
App, fare riferimento alla guida di tale app.

Upload di file su (3 Portal

1 Selezionare Setup for Mobile App >Setup

(pagina 106) nel menu Network.

Viene visualizzata una schermata di

conferma per gli elementi che verranno

aggiornati automaticamente.

Le seguenti impostazioni del menu

Network sono selezionate

automaticamente.

e Wired LAN >Setting: Off

e Modem >Setting: On

e Modem >Camera Remote Control:
Enable

e Access Authentication >Input Password:
(generata automaticamente se non
specificata)

2 Controllare le impostazioni e selezionare
OK.
La procedura di configurazione si avvia.
Mentre & in corso la configurazione, viene

visualizzato il messaggio “Now changing”.

Al completamento della configurazione,
viene visualizzata sul mirino la seguente
schermata.

Setup for Mobile App

User Name
admin

Password
ac2ac2Ch

Model Name
ILME-FX6V

Serial Number

0000000000

Fingerprint
Vengono visualizzate le seguenti
informazioni per l'autenticazione
dell’accesso.
Nome utente, password, impronta
digitale, nome del modello del camcorder,
numero di serie

[Informazione]
Questa schermata non viene emessa sull’uscita
video.

[Nota]
Evitare che la password possa essere vista e che il
codice QR possa essere copiato da altri.

3 Avviare C3 Portal App sullo smartphone e
accedere al servizio cloud.

4 Collegare lo smartphone al connettore
USB-C dell’'unita tramite un cavetto USB.

5 Abilitare il tethering USB sullo schermo
dello smartphone.
Per informazioni dettagliate sulla
configurazione, fare riferimento a
"Collegamento tramite tethering USB”
(pagina 66).
Le operazioni richieste potranno variare a
seconda dello smartphone. Fare
riferimento al manuale per I'uso dello
smartphone.

6 Eseguire la scansione del codice QR
visualizzato sul mirino seqguendo le
istruzioni visualizzate nella schermata di
C3 Portal App.

Le informazioni di configurazione del
trasferimento file vengono inviate dallo
smartphone all’'unita e viene visualizzato
il messaggio riportato di sequito.

Network File received.
Load File?

|_Cancel JERNCIN

7 Selezionare OK.
Ha inizio il caricamento delle informazioni
di configurazione.
Al termine del caricamento della
configurazione, viene visualizzato il
messaggio “Network File loaded.".

[Note]

e (3 Portal App sovrascrive le impostazioni di File
Transfer (pagina 109) nel menu Network dell’unita.

o || certificato radice non puo essere impostato
automaticamente. Deve essere configurato
manualmente.

Upload di file originali

Impostare File Transfer >Auto Upload

(pagina 109) nel menu Network su On per
abilitare I'upload dei file originali su C3 Portal.
Al termine di ciascuna registrazione, il file
viene caricato sull’'ubicazione associata
all'account C3 Portal.

Upload di file proxy

Impostare File Transfer >Auto Upload (Proxy)
(pagina 109) nel menu Network su On per
abilitare I'upload dei file proxy su C3 Portal.

Al termine di ciascuna registrazione, il file
viene caricato sull’'ubicazione associata
all'account C3 Portal.

Quando Auto Upload (Proxy) & impostatato su
Chunk, il file proxy viene suddiviso in blocchi
(chunk) e caricato a intervalli regolari sin
dall’inizio della registrazione. Per informazioni
dettagliate sulla configurazione, fare

riferimento a “Registrazione e upload di file
proxy in blocchi” (pagina 57).

Upload di file generici

Vedere “Selezione di file e upload”
(pagina 68).

[Informazioni]

o | file inviati dall’'unita vengono memorizzati nella
cache di C3 Portal App e quindi trasferiti a C3 Portal.
L'indicazione dello stato del trasferimento di file
sull’unita indica lo stato del trasferimento a C3 Portal
App.

Al termine del trasferimento dei file dall’'unita a C3
Portal App sullo smartphone, & possibile spegnere
I'unita. Si osservi tuttavia che il trasferimento dei file
dallo smartphone potrebbe essere ancora in corso.
Tenere sotto controllo la carica rimanente della
batteria dello smartphone.

Altre funzioni che utilizzano (3
Portal

Gestione dei file 3D LUT

E possibile importare sull'unita i file 3D
LUT memorizzati su C3 Portal. Vedere
“Importazione da un servizio cloud”
(pagina 58).

Gestione dei file ALL

| file ALL creati sull'unita possono essere
salvati su C3 Portal. Analogamente, € possibile
caricare sull’unita file ALL memorizzati su

C3 Portal. Vedere “Salvataggio di un file

ALL su un servizio cloud” (pagina 117) e
“Caricamento di un file ALL da un servizio
cloud” (pagina 118).
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Schermata delle miniature

Quando si preme il pulsante THUMBNAIL (pagina 5), i clip registrati sulla scheda di memoria vengono visualizzati come miniature sullo schermo.

La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. La riproduzione puo essere visualizzata nel mirino e su un monitor esterno.
Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare all'immagine del camcorder.

[Nota]

La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un clip registrato che avrebbe dovuto essere presente non e visualizzato, controllare il formato di registrazione. Prestare
attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.

Elementi dello schermo

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui € posizionato il cursore.

Indicatore della scheda di memoria correntemente selezionata
(se la scheda é protetta, viene visualizzata l'icona del lucchetto).

Numero del clip/Numero totale di clip
I
EO) )

Cursore (giallo) — el .

TCR00:00:00:12  TCR00:00:00:15  TCR 00:00:00:34

_

vy -

TCR 00:00:01:56 :00:02: TCR 00:00:02:35

( | ) ( | ) ( | )
3 4 5
1. Miniatura (immagine indice) (pagina 102) >Thumbnail Caption nel menu 4. Informazioni sulla registrazione speciale
Visualizza I'immagine indice del clip. Quando Thumbnail del menu completo. Se il clip & stato registrato con una modalita di

si registra un clip, il primo fotogramma viene
impostato automaticamente come immagine

registrazione speciale, ne indica la modalita.

2. Nome del clip Seil clip & registrato in modalita Slow &

Visualizza il nome del clip selezionato.

indice. Quick Motion, ne viene indicata la frequenza
Sotto la miniatura vengono visualizzate 3. Formato di registrazione video fotogrammi sulla destra.
informazioni sul clip e sul fotogramma. E Visualizza il formato del file del clip

. : - o ) 5. Durata del clip
possibile scegliere le informazioni visualizzate selezionato.

utilizzando la voce Customize View 6. Data di creazione
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5. Schermata delle miniature

Riproduzione di clip

Riproduzione dei clip registrati

E possibile riprodurre i clip registrati mentre il
camcorder si trova in modalita standby (Stby)
di registrazione.

Inserire la scheda di memoria da
riprodurre.

2 Premere il pulsante THUMBNAIL.

3 Utilizzare il selettore multiplo
(pagina 7) o la manopola
multifunzione (pagina 5) per spostare
il cursore sulla miniatura del clip da
riprodurre.

4 Premere il pulsante di conferma del
selettore multiplo o la manopola
multifunzione.

La riproduzione si avvia dall’inizio del clip
selezionato.

E possibile comandare la riproduzione con i

seguenti pulsanti:

Premere il pulsante di conferma del selettore
multiplo o la manopola multifunzione:

La riproduzione entra in pausa.
Premere una seconda volta per tornare alla
riproduzione normale.

Premere i pulsanti freccia sinistra o freccia
destra del selettore multiplo:

Salta all’inizio del clip o al clip precedente
0 successivo.

Premere e mantenere premuto il pulsante
freccia sinistra o il pulsante freccia destra
del selettore multiplo:

Ritorno e avanzamento veloce.
Torna alla riproduzione normale quando si
rilascia il pulsante.

Pulsante CANCEL/BACK:

Arresta la riproduzione e torna alla
modalita standby di registrazione.

[Note]

e Nel passaggio da un clip a un altro la visualizzazione
dell'immagine potrebbe momentaneamente
frazionarsi o arrestarsi. Durante questo periodo non &
possibile azionare il camcorder.

e Quando si seleziona un clip nella schermata delle
miniature e ha inizio la riproduzione, potrebbero
verificarsi temporanei frazionamenti dell'immagine
all'inizio del clip. Per visualizzare I'inizio del clip senza
frazionamenti, avviare la modalita di riproduzione,
mettere in pausa, quindi utilizzare i pulsanti freccia
sinistra o freccia destra del selettore multiplo
per tornare all'inizio del clip, quindi riavviare la
riproduzione.



73

5. Schermata delle miniature

Operazioni con i clip

Nella schermata delle miniature e possibile
eseguire operazioni di gestione dei clip e
controllarne le proprieta tramite il menu
Thumbnail del menu completo.

Per visualizzare il menu Thumbnail

(pagina 102), mantenere premuto il pulsante
MENU e selezionare Thumbnail.

Utilizzo del menu Thumbnail

Utilizzare il selettore multiplo (pagina 7)

o la manopola multifunzione (pagina 5)

per selezionare la funzione desiderata, quindi
premere il pulsante di conferma del selettore
multiplo o la manopola multifunzione.
Premere il pulsante CANCEL/BACK

(pagina 5) per ritornare alla schermata
precedente.

[Nota]

A seconda dello stato operativo del camcorder quando
viene visualizzato il menu, alcune voci potrebbero non
essere selezionabili.

Voci di menu per le operazioni sui
clip

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip

Transfer Clip

Transfer Clip (Proxy)
Filter Clips

Customize View

Per informazioni dettagliate sulle voci di menu
per le operazioni sui clip, fare riferimento al
menu Thumbnail (pagina 102).

Displaying clip properties

Selezionare Display Clip Properties

(pagina 102) nel menu Thumbnail per
visualizzare la schermata delle proprieta dei
clip.

Premere il pulsante sinistro o destro del
selettore multiplo per passare rispettivamente
al clip precedente o successivo.

Aggiunta di flag ai clip

E possibile aggiungere flag (ovvero
contrassegni OK, NG o KP) ai clip per poterne
in sequito filtrare la visualizzazione in base ad
essi.

Selezionare la miniatura del clip a cui
aggiungere il flag, quindi selezionare il tipo

di flag desiderato mediante Set Clip Flag
(pagina 102) nel menu Thumbnail del menu
completo.

Impostazione Flag di clip aggiunto

Add OK OK
Add NG NG
Add KEEP KP

[Informazioni]

e [ possibile aggiungere flag ai clip anche mediante
un pulsante programmabile a cui & assegnata la
funzione di aggiunta di flag dei clip (pagina 51).

e Per aggiungere un flag OK (pagina 55) alla
miniatura del clip selezionato premere il pulsante Clip
Flag (pagina 5).

Visualizzazione filtrata della schermata
delle miniature dei clip

Selezionare Filter Clips (pagina 102) nel
menu Thumbnail del menu completo, quindi
selezionare il tipo di flag desiderato per
visualizzare solo i clip che lo contengono.
Per visualizzare tutti i clip, selezionare All.
[Informazione]

E possibile passare da un filtro all‘altro in sequenza
anche premendo il pulsante DISPLAY.

Eliminazione di clip

| clip contenuti nelle schede di memoria
possono essere eliminati secondo le proprie
esigenze.
Selezionare Delete Clip >Select Clip o All Clips
nel menu Thumbnail del menu completo.
Select Clip:

Elimina il clip selezionato. E possibile

selezionare piu clip contemporaneamente.
All Clips:

Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate
nella schermata delle miniature

E possibile scegliere le informazioni sui clip o
sui fotogrammi visualizzate sotto la miniatura.
Selezionare Customize View >Thumbnail
Caption nel menu Thumbnail del menu
completo, quindi selezionare le informazioni
da visualizzare.
Date Time:
Visualizza la data e I'ora di creazione e
dell’'ultima modifica del clip.

Time Code:
Visualizza il codice temporale.
Duration:
Visualizza la durata del clip.
Sequential Number:
Visualizza un numero sequenziale su ogni
miniatura.
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6. Menu visualizzati e impostazioni

Configurazione e struttura del menu completo

Premere e mantenere premuto il pulsante MENU
per visualizzare nel mirino il menu completo che
consente di specificare le opzioni necessarie

per la ripresa, la registrazione e la riproduzione
(il menu puo essere visualizzato anche su un
monitor esterno). Il menu completo comprende i
menu indicati di sequito:

Configurazione dei menu

Menu User
Contiene voci di menu configurate

dall’'utente tramite la voce Edit User Menu.

Menu Edit User
Contiene comandi per la modifica del
menu User.
Menu Shooting
Contiene opzioni relative alla ripresa.
Menu Project
Contiene le impostazioni di base del
progetto.
Menu Paint/Look
Contiene opzioni relative alla qualita
dell'immagine.
Menu TC/Media
Contiene impostazioni relative ai codici
temporali e ai supporti di registrazione.
Menu Monitoring
Contiene impostazioni relative all’'uscita
video e alla visualizzazione sul mirino.
Menu Audio
Contiene opzioni relative all'audio.
Menu Thumbnail
Contiene opzioni relative alla
visualizzazione delle miniature.
Menu Technical
Contiene le impostazioni relative agli
elementi tecnici.
Menu Network
Contiene opzioni relative alle reti.
Menu Maintenance
Contiene le impostazioni del dispositivo
stesso, ad esempio l'orologio e la lingua.

Struttura del menu completo

User
(impostazioni di
fabbrica)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu

Add Item

Customize Reset

Shooting

ISO/Gain/El

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Project Base Setting Monitoring Output On/Off
Rec Format Output Format
Cine El Setting Output Display
HDR Setting Display On/Off
Simul Rec Marker
Proxy Rec VF Setting
Interval Rec Gamma Display Assist
Picture Cache Rec Peaking
SDI/HDMI Rec Control Zebra
Assignable Button Audio Audio Input
Assignable Dial Audio Output
Multi Function Dial Thumbnail Display Clip Properties
User File Set Clip Flag
All File Lock/Unlock Clip
Paint/Look Scene File Delete Clip
Base Look Transfer Clip
Reset Paint Settings Transfer Clip (Proxy)
Black Filter Clips
Knee Customize View
Detail Technical Color Bars
Matrix ND Dial
Multi Matrix Tally
TC/Media Timecode HOLD Switch Setting
TC Display Touch Operation
User Bits Rec Review
HDMI TC Out Zoom

Clip Name Format

Update Media

Format Media

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DCIN Alarm
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6. Menu visualizzati e impostazioni: Configurazione e struttura del menu completo

Network

Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance

Language

Clock Set

All Reset

Hours Meter

Version
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6. Menu visualizzati e impostazioni

Utilizzo del menu completo

Premere e mantenere premuto il pulsante
MENU per visualizzare nel mirino il menu
completo che consente di specificare nel
dettaglio le varie impostazioni (il menu puo
essere visualizzato anche su un monitor
esterno).

Impostazione delle voci dei menu

Immissione di una stringa di caratteri

Blocco e sblocco del menu

Comandi del menu

Pulsante MENU (pagina 5)
Premere e mantenere premuto per
visualizzare il menu completo. Premere di
nuovo mentre ¢ visualizzato il menu
completo per chiudere il menu.

Selettore multiplo (pulsante direzionale

D-Pad a 8 posizioni e pulsante di conferma)

(pagina 7)
Utilizzare i pulsanti direzionali del D-Pad a
8 posizioni per spostare il cursore verso
|'alto, il basso, sinistra o destra e
selezionare voci o impostazioni del menu.
Premere il pulsante di conferma del
selettore multiplo per applicare la voce
selezionata.

Manopola multifunzione (pagina 5)
Ruotare la manopola multifunzione per
spostare il cursore verso l'alto o il basso e
selezionare voci o impostazioni del menu.
Premere la manopola multifunzione per
applicare la voce selezionata.

Pulsante CANCEL/BACK (pagina 5)
Premere per tornare al menu precedente.
Le modifiche non completate vengono
annullate.

[Note]

e |l menu completo non puo essere utilizzato quando il
camcorder si trova in modalita di ingrandimento della
messa a fuoco (pagina 38).

e A seconda dello stato operativo del camcorder
quando viene visualizzato il menu, alcune voci
potrebbero non essere selezionabili.

Premere i pulsanti direzionali del D-pad a

8 posizioni oppure ruotare la manopola
multifunzione per spostare il cursore sulla
voce di menu da impostare, quindi premere il
pulsante di conferma del selettore multiplo o
la manopola multifunzione per selezionare la
voce.

e Nell'area di selezione delle voci del menu

vengono visualizzate un massimo di otto
righe. Se non possono essere visualizzate
contemporaneamente tutte le opzioni
disponibili per una determinata voce,
scorrere le opzioni spostando il cursore
verso l'alto o verso il basso.

Se la gamma di opzioni disponibili per una
voce secondaria & molto ampia (ad esempio
da -99 a + 99), I'area di selezione non viene
visualizzata. Viene invece evidenziato il
valore corrente per indicare che tale valore
puod essere modificato.

Per esequire una funzione, selezionare
[Execute].

Se si seleziona una voce che richiede
conferma prima dell’esecuzione, il menu
verra momentaneamente nascosto e verra
visualizzato un messaggio di conferma.
Controllare il messaggio e quindi scegliere
se eseguire o annullare la funzione.

Quando si seleziona una voce che richiede
I'immissione di caratteri, viene visualizzata la
schermata di inserimento caratteri.

All File:File ID

Kurokawa_Scene_001 a

Premere i pulsanti direzionali del D-pad a
8 posizioni oppure ruotare la manopola
multifunzione per selezionare un tipo di
caratteri, quindi applicare I'impostazione.
ABC: caratteri alfabetici maiuscoli

abc: caratteri alfabetici minuscoli

123: caratteri numerici

1#$: caratteri speciali

2 Selezionare il carattere desiderato nel tipo
di caratteri specificato, quindi applicare
I'impostazione.

Il cursore si sposta sul campo successivo.

Space: inserisce uno spazio in
corrispondenza della posizione del
cursore.

+—/—: sposta la posizione del cursore.

BS: elimina il carattere alla sinistra del
cursore (backspace).

3 Al termine, selezionare [Done] ed
applicare I'impostazione.
La stringa di caratteri viene confermata e
la schermata di inserimento dei caratteri si
chiude.

E possibile bloccare il menu completo in modo
che venga visualizzato solo il menu User.

In questo stato, non e possibile modificare le
impostazioni mediante le schermate di stato.

Blocco del menu

1 Premere e mantenere premuta la
manopola multifunzione, quindi premere
e mantenere premuto il pulsante MENU.

2 Selezionare Menu Settings >User Menu
with Lock nel menu Technical.

[Nota]

Quando viene mantenuto premuto solo il pulsante
MENU per visualizzare il normale menu completo,
I'indicazione User Menu Only ¢ visualizzata sotto
Menu Settings nel menu Technical. Premere e
mantenere premuta la manopola multifunzione e
quindi premere e mantenere premuto il pulsante
MENU per visualizzare User Menu with Lock.

3 Impostare su On e premere il pulsante di
conferma o la manopola multifunzione.
Lo schermo del mirino visualizza la
schermata di immissione del numero di
codice di accesso (PIN).

4 Immettere un numero arbitrario.

Immettere un numero di 4 cifre compreso
fra 0000 e 9999. Il valore predefinito € 0000.
Immettere un numero e premere il pulsante
di conferma o la manopola multifunzione
per spostare il cursore sulla cifra successiva.
Dopo aver immesso tutte le cifre, spostare
il cursore su SET.

5 Premere il pulsante di conferma o la
manopola multifunzione.
Il valore immesso viene applicato.
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Viene visualizzato un messaggio di
conferma e la schermata passa alla
visualizzazione del menu User.

Sblocco del menu

1 Premere e mantenere premuta la
manopola multifunzione, quindi premere
e mantenere premuto il pulsante MENU.

2 Selezionare Menu Settings >User Menu
with Lock nel menu User.

[Nota]

Quando viene mantenuto premuto solo il pulsante
MENU per visualizzare il normale menu completo,
I'indicazione User Menu Only é visualizzata sotto
Menu Settings nel menu Technical. Premere e
mantenere premuta la manopola multifunzione e
quindi premere e mantenere premuto il pulsante
MENU per visualizzare User Menu with Lock.

3 Impostare su Off e premere il pulsante di
conferma o la manopola multifunzione.
Lo schermo del mirino visualizza la
schermata di immissione del numero di
codice di accesso (PIN).

4 Immettere il numero PIN usato per
bloccare il menu.
Immettere un numero e premere il
pulsante di conferma o la manopola
multifunzione per spostare il cursore sulla
cifra successiva.
Dopo aver immesso tutte le cifre, spostare
il cursore su Set.

5 Premere il pulsante di conferma o la
manopola multifunzione.
Il valore immesso viene applicato.
Se il numero PIN immesso corrisponde al
numero PIN utilizzato per bloccare il
menu, il menu viene sbloccato e viene
visualizzato.

[Note]

e Se il numero PIN immesso non corrisponde al numero
PIN utilizzato per bloccare il menu, il menu non verra
sbloccato.

e Si consiglia di annotare il numero PIN per evitare di
dimenticarlo. Se si dimentica il numero PIN, contattare
il rappresentante dell'assistenza tecnica Sony.

e Se il menu viene bloccato senza aver registrato le voci
del menu completo elencate nelle seguenti tabelle
del menu User, tali funzioni non potranno essere
assegnate a pulsanti programmabili.

e Se tali funzioni erano gia assegnate a pulsanti
programmabili, la loro assegnazione viene disabilitata
automaticamente al momento del blocco del menu.

Voci del menu
completo

Selezione per
pulsanti
programmabili

Voci del menu
completo

Selezione per
pulsanti
programmabili

Shooting >Focus >
Face/Eye Detection AF

Face/Eye Detection
AF

Technical >Handle
Zoom >Setting

Handle Zoom

Shooting >Focus >
Push AF Mode

Push AF Mode

Network >Wireless LAN
>NFC

NFC

Shooting >S&Q Motion S&Q Motion Network >File Transfer ~ Auto Upload (Proxy)
>Setting >Auto Upload (Proxy)
Shooting >SteadyShot ~ SteadyShot User User Menu

>Setting

Voci del menu
completo

Selezione per
pulsanti
programmabili

Project >Picture Cache
Rec >Setting

Picture Cache Rec

Shooting >ISO/Gain/El
>Base Sensitivity,
Shooting >ISO/Gain/El
>Base ISO

Base ISO/Sensitivity

Shooting >Auto AGC
Exposure >AGC

- Auto ND Filter

Shooting >Iris >Bokeh Bokeh Control

Control

Shooting >Auto Auto Shutter

Exposure >Auto Shutter

Shooting >Auto
Exposure >Level

Auto Exposure Level

Shooting >Auto Backlight
Exposure >Mode
Shooting >Auto Spotlight

Exposure >Mode

Shooting >White >
Preset White

Preset White Select

Technical >Rec Review  Rec Review
>Setting

Thumbnail >Set Clip Clip Flag OK
Flag >Add OK

Thumbnail >Set Clip Clip Flag NG
Flag >Add NG

Thumbnail >Set Clip Clip Flag Keep
Flag >Add KEEP

Technical >Color Bars Color Bars
>Setting

Monitoring >Display Lens Info
On/Off >Lens Info

Monitoring >Display Video Signal
On/Off >Video Signal Monitor
Monitor

Monitoring >Marker Marker
>Setting

Monitoring >VF Setting VF Mode

>Color Mode

Monitoring >Gamma
Display Assist >Setting

Gamma Display
Assist

Shooting >Focus > AF Speed/Sens.
AF Transition Speed,

Shooting >Focus >

AF Subj. Shift Sens.

Shooting >Focus > Focus Area

Focus Area

Shooting >Focus >
Focus Area(AF-S)

Focus Area(AF-S)

Monitoring >Peaking Peaking
>Setting

Monitoring >Zebra Zebra
>Setting

Audio >Audio Output Volume

>Volume

Technical >Touch
Operation >Setting

Touch Operation
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Menu User

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.

User

Voce

Descrizione

Base Setting

Voce di menu Project >Base Setting

Focus Voce di menu Shooting >Focus

S&Q Motion Voce di menu Shooting >S&Q Motion
LUT On/Off Voce di menu Shooting >LUT On/Off
Simul Rec Voce di menu Project >Simul Rec
Proxy Rec Voce di menu Project >Proxy Rec
Interval Rec Voce di menu Project >Interval Rec

Assignable Button

Voce di menu Project >Assignable Button

Assignable Dial

Voce di menu Project >Assignable Dial

Multi Function Dial

Voce di menu Project >Multi Function Dial

All File

Voce di menu Project >All File

Clip Name Format

Voce di menu TC/Media >Clip Name Format

Format Media

Voce di menu TC/Media >Format Media

VF Setting Voce di menu Monitoring >VF Setting
Zebra Voce di menu Monitoring >Zebra
Zoom Voce di menu Technical >Zoom

Menu Settings

Voce di menu Technical >Menu Settings

Edit User Menu

Visualizza la schermata del menu Edit User.

[Nota]

I menu Edit User consente di aggiungere o rimuovere voci del menu User. Possono essere configurate fino a 20 voci.
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Menu Edit User

Selezionando Edit User Menu nel menu User, viene visualizzato il menu Edit User al livello piu

alto.

Edit User

Voce Impostazione della voce Descrizione
secondaria

Add Item Aggiunge una voce al menu User.

Aggiunge una voce al

menu User

Customize Reset Ripristina I'impostazione predefinita

Ripristina le voci del delle voci del menu User.

menu User

Voce di menu Delete Rimuove dal menu User la voce di

selezionata durante la menu registrata.

modifica Move Cambia I'ordine delle voci registrate

del menu User.

Edit Sub Item Modifica (aggiunge o elimina) le voci

secondarie registrate nel menu User.
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Menu Shooting

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Shooting >ISO/Gain/El
Consente di specificare le impostazioni relative al guadagno.

Shooting >ISO/Gain/El
Consente di specificare le impostazioni relative al guadagno.

Voce Impostazione della voce secondaria Descrizione
Mode ISO/dB Seleziona la modalita di impostazione del
guadagno.

ISO/Gain<H> Per informazioni dettagliate su queste Imposta il valore di preset del guadagno
impostazioni, vedere “Impostazioni e valori <H>.
predefiniti di ISO/Gain" (pagina 112).

ISO/Gain<M> Per informazioni dettagliate su queste Imposta il valore di preset del guadagno
impostazioni, vedere “Impostazioni e valori <M>.
predefiniti di ISO/Gain" (pagina 112).

ISO/Gain<L> Per informazioni dettagliate su queste Imposta il valore di preset del guadagno
impostazioni, vedere “Impostazioni e valori <L>.
predefiniti di ISO/Gain" (pagina 112).

Exposure Quando Base ISO & impostata su ISO 800: Imposta il valore dell’indice di

Index<H> 200El / 4.0E esposizione <H>.

250El /7 4.3E
320El / 4.7E
400EI / 5.0E
500EI / 5.3E
640El / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250El / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI 7 8.0E
Quando Base ISO & impostata su ISO
12800:

3200El / 4.0E
4000EI 7 4.3E
5000El 7 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Disponibile solo in modalita Cine El.

Voce Impostazione della voce secondaria Descrizione
Exposure (Stesse impostazioni di Exposure Imposta il valore dell'indice di
Index<M> Index<H>) esposizione <M>.
Quando Base ISO & impostata su ISO 800:
1000EI / 6.3E
Quando Base ISO e impostata su ISO 12800:
16000EI / 6.3E
Exposure (Stesse impostazioni di Exposure Imposta il valore dell'indice di
Index<L> Index<H>) esposizione <L>.
Quando Base ISO & impostata su ISO 800:
800EI / 6.0E
Quando Base ISO e impostata su ISO 12800:
12800EI / 6.0E
Shockless On / Off Attiva o disattiva la funzione di guadagno
Gain fluido.
Base High / Low Imposta la sensibilita di base per la
Sensitivity modalita Custom.
Base ISO 1SO 12800 / ISO 800 Imposta la sensibilita ISO di base per la

modalita Cine El.

Shooting >ND Filter
Imposta i valori di preset del filtro ND.

Voce Impostazione della voce secondaria Descrizione

Presetl 1/4/1/8 /1/16 /1/32 /1/64 /1/128 Imposta il valore Preset 1 del filtro ND.
Preset2 1/4/1/8/1/16 /1/32 /1/64 / 1/128 Imposta il valore Preset 2 del filtro ND.
Preset3 1/4/1/8/1/16 /1/32/1/64 /1/128 Imposta il valore Preset 3 del filtro ND.

Shooting >Shutter
Consente di specificare le impostazioni relative al funzionamento dell'otturatore elettronico.

Voce Impostazione della voce secondaria Descrizione

Mode Speed / Angle Seleziona la modalita operativa
dell’'otturatore elettronico.
Consente di eseqguire riprese nitide di
soggetti in rapido movimento. Seleziona
la modalita di impostazione della velocita
dell'otturatore in secondi (Speed) o in
gradi (Angle).

Shutter On / Off Specifica se il tempo di esposizione,

Speed quando é selezionata la modalita Speed,

On/Off deve seqguire il valore di Shutter Speed o

deve essere impostato sulla massima
esposizione.
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Shooting >Shutter
Consente di specificare le impostazioni relative al funzionamento dell'otturatore elettronico.

Shooting >Shutter

Consente di specificare le impostazioni relative al funzionamento dell'otturatore elettronico.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Shutter Da 64F a 1/8000 Imposta la velocita dell’otturatore ECS Da 23.99 a 8000 Imposta la frequenza ECS quando Mode
Speed Le impostazioni disponibili variano a quando Mode & impostato su Speed. Frequency Le impostazioni disponibili variano a e impostato su ECS.
seconda della frequenza di sistema del seconda della frequenza di sistema del
formato di registrazione selezionato. formato di registrazione selezionato.
59.94P: Di sequito si indicano i valori predefiniti.
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F / 59.94P: 60.00
3F/2F/1/50/1/60 /1/100 /1/120 / 50P: 50.00
1/125 /7 1/250 7/ 1/500 /7 1/1000 / 29.97P: 30.00
1/2000 / 1/4000 / 1/8000 23.98P: 23.99
50P: 25P: 25.02
64F / 32F /16F / 8F / TF / 6F / 5F / 4F / 24P: 24.02
3F;2F/12/50/1/60/1/’100/1/120/ Shooting >Iris
17125 /1/250 /1/500 /171000 / Configura le impostazioni della funzione di controllo del bokeh.
1/2000 / 1/4000 / 1/8000
29.97p: Voce Impostazione della voce secondaria Descrizione
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F / Bokeh On / Off Attiva o disattiva la funzione di controllo
3F/2F /1/30/1/40 /1/50 / 1/60 / Control del bokeh.
1/100 /1/120 / 1/125 7/ 1/250 /7 1/500 / -
1/1000 /1/2000 / 1/4000 / 1/8000 Shooting >Auto Exposure o _ _ o
25p- Consente di specificare le impostazioni della correzione automatica dell’esposizione.
64F / 32F /16F / 8F / TF / 6F / 5F / 4F / Voce Impostazione della voce secondaria Descrizione
3F/2F/1/25/1/33/1/50/1/60 / Level +3.0/ 4275/ +2.5/+2.25/+2.0/+1.75/  Imposta i livelli di luminosita per il valore
17100 /1/120 /1/125 /1/250 /1/500 / +1.5/+1.25/+1.0 / +0.75 / +0.5 / +0.25 /  di esposizione rilevato automaticamente.
1/1000 /7 1/2000 / 1/4000 / 1/8000 +0/-025/-05/-075/-1.0/-125/
24pP/23.98P: -1.5/-175/-2.0/-225/-25/-275/
64F / 32F /16F / 8F / TF / 6F / 5F / 4F / -3.0
3F/2F/1/24/1/32/1/48 /1/50 / Mode Backlight / Standard / Spotlight Specifica la modalita operativa della
1760 71796 /17100 /1/120 /17125 / regolazione dell'esposizione automatica.
1/250 /1/500 /171000 / 1/2000 / Backlight:
174000 /178000 Modalita controluce (i soggetti ripresi
Shutter Angle 64F / 32F /16F / 8F / 7F / 6F / 5F / 4F / Imposta I'angolo dell'otturatore quando in controluce appaiono meno scuri)
3F / 2F 7/ 360.0° / 300.0° / Mode & impostato su Angle. Standard:
270.0° /7 240.0° / 216.0° / 210.0° / Modalita standard
180.0° / 172.8° / 150.0° / 144.0° / Spotlight:
120.0° 7/ 90.0° /7 86.4° / 72.0° / 45.0° / Modalita riflettore (limita il clipping
30.0°/22.5°/11.25° / 5.6° dei bianchi quando il soggetto e
ECSOn/Off  On/ Off Attiva o disattiva la funzione ECS illuminato da riflettori)
(Extended Clear Scan). Speed Da -99 a +99 (x0) Imposta la velocita di regolazione della
regolazione dell'esposizione automatica.
AGC On / Off Attiva o disattiva la funzione AGC

(controllo del guadagno automatico).




82

6. Menu visualizzati e impostazioni: Menu Shooting

Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Shooting >White
Specifica le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria

Descrizione

Preset White Da 2000K a 15000K (3200K)

Imposta il valore di preset del
bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

AGC Limit Per informazioni dettagliate su queste Imposta il guadagno massimo della
impostazioni, vedere “Impostazioni e valori funzione AGC.
predefiniti di AGC Limit” (pagina 114).

AGC Point F2.8 /F4/F5.6 Imposta il valore di apertura (F-stop) del

diaframma a cui ha inizio il
funzionamento della funzione AGC
quando la funzione AGC e On.

Auto Shutter

On / Off

Attiva o disattiva la funzione di otturatore
automatico.

Color Temp Da 2000K a 15000K (3200K)

<A>

Imposta la temperatura di colore di
bilanciamento del bianco salvata nella
memoria A.

[Nota]

Poiché Color Temp € soggetto a clipping a
2000K e 15000K mentre é attiva la funzione
R/B Gain, potrebbe non essere visualizzato il
valore di Color Temp corretto per il valore di
R/B Gain.

Tint<A> Da -99 a +99 (x0)

Imposta il valore del tono di colore (Tint)
salvato nella memoria del bianco A.

[Nota]

Poiché Tint & soggetto a clipping a +99 mentre
¢ attiva la funzione R/B Gain, potrebbe non
essere visualizzato il valore di Tint corretto per
il valore di R/B Gain.

A.SHT Limit  1/100 /1/150 /1/200 / 1/250 / 1/2000 Imposta la velocita massima della
funzione di otturatore automatico.

A.SHT Point  F5.6/F8/F11/F16 Imposta il valore di apertura (F-stop) del
diaframma a cui ha inizio il
funzionamento della funzione di
otturatore automatico.

Clip High On / Off Attiva o disattiva la funzione che ignora

light le zone piu luminose per dare una
risposta piu piatta alle luminanze elevate.

Detect 1/2/3/4/5/6/ Custom Imposta il campo di misurazione della

Window luce per la regolazione automatica della

luce secondo la luminosita del soggetto.
(Non disponibile quando I'esposizione
viene regolata manualmente)

R Gain <A> Da -99.0 a +99.0 (x0.0)

Imposta il valore di guadagno R del
bilanciamento del bianco salvato nella
memoria A.

Detect Window

On / Off

Attiva o disattiva l'indicazione il campo di

B Gain <A> Da -99.0 a +99.0 (x0.0)

Imposta il valore di guadagno B del
bilanciamento del bianco salvato nella
memoria A.

Color Temp
<B>

Da 2000K a 15000K (3200K)

Imposta la temperatura di colore del
bilanciamento del bianco salvata nella
memoria B.

[Nota]

Poiché Color Temp & soggetto a clipping a
2000K e 15000K mentre ¢ attiva la funzione R/B
Gain, potrebbe non essere visualizzato il valore
di Color Temp corretto per il valore di R/B Gain.

Indication misurazione della luce.

Custom Da 40 a 999 (500) Imposta la larghezza del campo di
Width misurazione della luce.

Custom Da 70 a 999 (500) Imposta l'altezza del campo di

Height misurazione della luce.

Custom H Da -479 a +479 (x0) Imposta la posizione orizzontale del
Position campo di misurazione della luce.
Custom V Da -464 a +464 (+0) Imposta la posizione verticale del campo
Position di misurazione della luce.

Tint<B> Da -99 a +99 (x0)

Imposta il valore del tono di colore (Tint)
salvato nella memoria del bianco B.

[Nota]

Poiché Tint & soggetto a clipping a +99 mentre
¢ attiva la funzione R/B Gain, potrebbe non
essere visualizzato il valore di Tint corretto per
il valore di R/B Gain.

RGain<B>  Da-99.0 a +99.0 (x0.0)

Imposta il valore del guadagno R del
bilanciamento del bianco salvato nella
memoria B.
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Shooting >White

Specifica le impostazioni del bilanciamento del bianco.

Shooting >Offset White
Specifica le impostazioni di correzione (offset) del bilanciamento del bianco.

Voce

Impostazione della voce secondaria

Descrizione

B Gain <B>

Da -99.0 a +99.0 (x0.0)

Imposta il valore del guadagno B del
bilanciamento del bianco salvato nella
memoria B.

Shooting >White Setting

Regola le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione
Offset White  On / Off Seleziona se aggiungere (On) o non
<A> aggiungere (Off) un valore di correzione

al valore di bilanciamento del bianco
della memoria A.

Offset Color

Da -99 a +99 (0)

Imposta la correzione della temperatura

Temp<A> di colore da aggiungere al bilanciamento
del bianco della memoria A quando
Offset White <A> & impostato su On.

Offset Da -99 a +99 (+0) Imposta la correzione del valore del tono di

Tint<A> colore Tint da aggiungere al bilanciamento
del bianco della memoria A quando Offset
White <A> & impostato su On.

Offset White  On / Off Seleziona se aggiungere (On) o non

<B> aggiungere (Off) un valore di correzione

al valore di bilanciamento del bianco
della memoria B.

Offset Color

Da -99 a +99 (+0)

Imposta la correzione della temperatura

Voce Impostazione della voce secondaria Descrizione

Shockless off/1/2/3 Imposta la velocita di risposta del

White bilanciamento del bianco quando si
cambia la modalita di bilanciamento del
bianco.

Off: Commutazione istantanea.

Da1a 3: Il passaggio avviene piu
lentamente (velocita minore con
numero piu alto).

ATW Speed 1/2/3/4/5 Imposta la velocita di risposta in modalita ATW.

1: Piul alta velocita di risposta

White Memory / ATW Seleziona la modalita di regolazione del
Switch<B> bilanciamento del bianco che viene
selezionata quando il selettore WHT BAL

€ impostato su B.

Filter White On / Off Attiva o disattiva la funzione che imposta
Memory I'area di memoria del bilanciamento del

bianco per ciascun filtro ND.

On: Imposta una memoria del
bilanciamento del bianco per ciascun
filtro ND.

[Informazione]
In modalita Preset, sono disponibili
quattro impostazioni (CLEAR/1/2/3). In
modalita variabile, sono disponibili due
impostazioni (CLEAR/On).

Off: Imposta una memoria del
bilanciamento del bianco comune a
tutti i filtri ND.

Temp<B> di colore da aggiungere al bilanciamento
del bianco della memoria B quando
Offset White <B> € impostato su On.

Offset Da -99 a +99 (+0) Imposta la correzione del valore del tono di

Tint<B> colore Tint da aggiungere al bilanciamento
del bianco della memoria B quando Offset
White <B> e impostato su On.

Offset White  On / Off Specifica se aggiungere (On) o non

<ATW> aggiungere (Off) un valore di correzione

al bilanciamento del bianco ATW.

Offset Color

Da -99 a +99 (x0)

Imposta la correzione della temperatura

Temp<ATW> di colore da aggiungere al bilanciamento
del bianco ATW quando Offset White
<ATW> & impostato su On.

Offset Da -99 a +99 (+0) Imposta la correzione del valore del tono

Tint<ATW> di colore Tint da aggiungere al

bilanciamento del bianco ATW quando
Offset White <ATW> & impostato su On.
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Shooting >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Shooting >S&Q Motion

Consente di specificare le impostazioni relative alla modalita Slow & Quick Motion (pagina 52).

Voce Impostazione della voce secondaria Descrizione
AF Transition 1(Slow)/2/3/4/5/6/7(Fast) Specifica la velocita dell'azionamento del
Speed sistema di messa a fuoco quando il

soggetto cambia durante la messa a
fuoco automatica.

Voce Impostazione della voce secondaria

Descrizione

AF Subj. Shift 1(Locked On)/ 2/ 3/ 4 /5(Responsive) Imposta la sensibilita al cambiamento del

Setting On / Off

Attiva o disattiva la modalita Slow &
Quick Motion.

Quando € impostato su On, le seguenti
funzioni sono disabilitate:

® Auto Iris

® Auto Focus

Sens. soggetto durante la messa a fuoco
automatica.
Focus Area Wide / Zone / Flexible Spot Specifica la zona di messa a fuoco per le

funzioni di messa a fuoco automatica e

Push Auto Focus (AF) (pagina 39).

Wide:
Cerca il soggetto su un ampio angolo
dell'immagine durante la messa a
fuoco.

Zone:
Cerca automaticamente una punto di
messa a fuoco all'interno della zona
specificata.

Flexible Spot:
Mette a fuoco una posizione
specificata dell'immagine.

Frame Rate Da 1fps a 60fps / 100fps / 120fps / 150fps /
180fps / 200fps / 240fps

Imposta la frequenza fotogrammi per le
riprese in modalita Slow & Quick Motion.

[Nota]

I valori disponibili variano a seconda di
frequenza di sistema, codec e formato video
selezionati.

Shooting >LUT On/Off
Consente di specificare le impostazioni relative alla LUT.

Voce Impostazione della voce secondaria

Descrizione

SDI/HDMI MLUT On / MLUT Off

Seleziona se applicare la LUT monitor al
video in uscita su SDI e HDMII.

VF/Proxy/ MLUT On / MLUT Off
Stream

Seleziona se applicare la LUT monitor al
video in uscita su mirino, proxy e in
streaming.

Internal Rec  MLUT On / MLUT Off

Seleziona se applicare la LUT monitor al
video in registrazione interna.

Shooting >Noise Suppression

Consente di specificare le impostazioni relative alla soppressione del rumore.

[Informazione]

Le impostazioni di Setting(Custom) e Level(Custom) sono riflesse nell'impostazione Target Display

(pagina 116).

Focus Area Flexible Spot Specifica la zona di messa a fuoco per la

(AF-S) funzione Push Auto Focus (AF-S).

Face/Eye Face/Eye Only AF / Face/Eye Priority AF /  Abilita o disabilita la modalita AF con

Detection AF  Off rilevamento del viso.

Push AF AF / Single-shot AF(AF-S) Imposta la modalita di messa a fuoco

Mode automatica Push durante la messa a
fuoco manuale.

Touch Tracking AF / Spot Focus Specifica I'azione eseguita toccando il

Function in touchscreen durante la messa a fuoco

MF manuale.

AF Assist On / Off Quando & impostato su On, consente di

ignorare momentaneamente la funzione
di messa a fuoco automatica ed eseqguire
la messa a fuoco manualmente.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la soppressione del
(Custom) rumore in modalita Custom.

Level Low / Mid / High Imposta il livello di soppressione del
(Custom) rumore in modalita Custom.

Setting On / Off Attiva o disattiva la soppressione del
(Cine EI) rumore in modalita Cine El.

Level Low / Mid / High Imposta il livello di soppressione del

(Cine EI)

rumore in modalita Cine EI.
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Shooting >Flicker Reduce
Consente di specificare le impostazioni relative alla correzione dello sfarfallio.

Voce Impostazione della voce secondaria Descrizione

Mode Auto / On / Off Imposta la modalita di correzione dello
sfarfallio.

Frequency 50Hz / 60Hz Consente di specificare la frequenza della

sorgente di alimentazione del dispositivo
di illuminazione che causa lo sfarfallio.

Shooting >SteadyShot
Consente di specificare le impostazioni relative alla stabilizzazione dell'immagine.

Voce Impostazione della voce secondaria Descrizione

Setting Active / Standard / Off Imposta la funzione di stabilizzazione
dell'immagine.
[Nota]

Disponibile quando € montato un obiettivo
compatibile.
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Menu Project

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Project >Base Setting
Consente di specificare le impostazioni di base.

Voce

Impostazione della voce secondaria

Descrizione

Voce Impostazione della voce secondaria Descrizione

Shooting Custom / Cine El Imposta la modalita di ripresa
Mode (pagina 25).

Target SDR(BT.709) / HDR(HLG) Imposta lo spazio colore della
Display registrazione o uscita in modalita

Custom.

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

Frequency 59.94 /50 /29.97 /25 /24 /23.98 Seleziona la frequenza di sistema.

Imager Scan  FF / S35 Seleziona le dimensioni dell'imager.

Mode

Codec RAW / RAW & XAVC-I / RAW(HDMI) / Imposta la modalita di registrazione e
RAW(HDMI) & XAVC-1 / XAVC-I / XAVC-L riproduzione dei clip.

RAW Output  Le opzioni di impostazione disponibili Imposta le dimensioni di immagine

Format variano a seconda delle impostazioni di dell’'uscita RAW.

Frequency e Codec.

Frequency Codec Opzioni
selezionabili

59.94/ RAW 4096x2160

50/ 3840%2160

29.97/

25/ RAW & 4096x2160

23.98 XAVC 3840x2160
RAW(HDMI) 4240x2392
RAW(HDMI) 4240x2392
& XAVC-|

24 RAW 4096x2160
RAW & 4096x2160

XAVC-|

[Nota]

Quando Codec é impostato su RAW & XAVC-|, il
valore di Video Format cambia in sincronia con
I'impostazione di RAW Output Format.

Video Format

Le opzioni di impostazione disponibili
variano a seconda delle impostazioni di
Frequency e Codec.

Frequency Codec Opzioni
selezionabili
59.94 RAW/ -
RAW(HDMI)
RAW & 4096x2160P
XAVC 3840x2160P
RAW(HDMI)  3840x2160P
& XAVC-|
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
50 RAW/ -
RAW(HDMI)
RAW & 4096x2160P
XAVC 3840x2160P
RAW(HDMI)  3840x2160P
& XAVC-I
XAVC-I| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

Imposta il bit rate e le dimensioni
dell'immagine.
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Project >Rec Format Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione. Consente di specificare le impostazioni relative al formato di registrazione.
Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Video Format 29.97 RAW/ - Video Format 23.98 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVC 3840x2160P XAVCH 3840x2160P
RAW(HDMI)  3840x2160P RAW(HDMI)  3840x2160P
& XAVC-| & XAVC-I
XAVC-I 4096x2160P XAVC-I 4096x2160P
3840x2160P 3840x2160P
1920x1080P 1920x1080P
XAVC-L 3840x2160P XAVC-L 3840x2160P
1920x1080P 50 1920x1080P 50
1920x1080P 35 1920x1080P 35
25 RAW/ - 24 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVC-| '3840x2160P XAVC-|
RAW(HDMI) 3840x2160P RAW(HDMI) 3840x2160P
& XAVC-I & XAVC-|
XAVC-| 4096x2160P XAVC-| 4096x2160P
3840x2160P Project >Cine El Setting
1920x1080P Specifica le impostazioni della modalita Cine EI.
XAVC-L 3840x2160P Voce Impostazione della voce secondaria Descrizione
1920x1080P 50 Color Gamut  S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta lo spazio colore della modalita
1920x1080P 35 Cine El.

Project >HDR Setting
Configura le impostazioni della modalita HDR.

Voce Impostazione della voce secondaria Descrizione
VF SDR On / Off Nella modalita HDR, questa opzione
Preview attiva o disattiva la funzione che converte

da HDR a SDR I'immagine del mirino
quando é attiva l'assistenza
visualizzazione gamma.

[Informazione]
Se impostata su On, viene applicato il valore di
SDR Gain all'immagine del mirino.
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Project >HDR Setting
Configura le impostazioni della modalita HDR.

Project >Interval Rec
Configura le impostazioni della modalita di registrazione a intervalli (pagina 52).

Voce

Impostazione della voce secondaria

Descrizione

SDR Gain

Da 0dB a -15dB (-6dB)

In modalita HDR, imposta il valore di SDR
Gain applicato al mirino quando VF SDR
Preview & impostato su On.

Project >Simul Rec
Configura le impostazioni della modalita di registrazione simultanea (pagina 54).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di
registrazione simultanea e specifica il
supporto di destinazione della
registrazione.

Rec Button Rec Button:[SlotA SlotB] Handle Rec Seleziona i pulsanti utilizzati per

Set Button:[SlotA SlotB] / Rec Button:[SIotA]  controllare la registrazione sui vari

Handle Rec Button:[SlotB] / Rec
Button:[SlotB] Handle Rec Button:[SlotA]

supporti di registrazione.

Project >Proxy Rec
Configura le impostazioni della modalita di registrazione proxy.

Voce Impostazione della voce secondaria Descrizione
Number of 1frame / 2frames / 3frames / 6frames / Imposta il numero di fotogrammi per
Frames 9frames / 12frames ciascuna ripresa nella modalita di
I valori disponibili variano a seconda della  registrazione Interval Rec (Interval Rec
frequenza fotogrammi del formato video impostata su On).
selezionato.
59.94P/50P:
2frames / 6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames / 6frames / 9frames
Pre-Lighting Off/2s/5s/10s Specifica con che anticipo in secondi si

deve accendere la luce video prima
dell'avvio della registrazione in modalita
Interval Rec.

[Informazione]
Disponibile solo se viene utilizzata la luce video
HVL-LBPC (opzionale).

Project >Picture Cache Rec
Configura le impostazioni della modalita di registrazione cache immagine (pagina 53).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalita di
registrazione proxy.

Audio CH1/CH2 / CH3/CH4 Seleziona il canale audio da registrare sui

Channel dati proxy.

Chunk 30s / Tmin / 2min Seleziona I'intervallo dei blocchi di

registrazione per i file proxy.

Project >Interval Rec
Configura le impostazioni della modalita di registrazione a intervalli (pagina 52).

Voce

Impostazione della voce secondaria

Descrizione

Setting

On / Off

Attiva o disattiva la modalita di
registrazione a intervalli. (Attivando
questa modalita, si disattivano tutte le
altre modalita speciali).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalita di
registrazione cache immagine.

Cache Size Short / Medium / Long / Max Specifica il tempo di accumulo delle
immagini nella memoria cache immagine
(il tempo di registrazione della cache
immagine).

Cache Rec Indica il tempo di accumulo delle

Time immagini nella memoria cache immagine

(il tempo di registrazione della cache
immagine).

Interval Time 1/2/3/4/5/6/7/8/9/10/15/

20/30/40/50(s)

Imposta I'intervallo fra registrazioni nella
modalita di registrazione Interval Rec

1/2/3/4/5/6/7/8/9/10/15/720/ (Interval Rec impostata su On).

30 / 40 / 50 (min)
1/2/3/74/6/12/24(h)
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Project >SDI/HDMI Rec Control
Consente di specificare le impostazioni relative alla registrazione SDI/HDMI.

Project >Assignable Button

Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Voce Impostazione della voce secondaria

Descrizione

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Configura l'avvio e l'arresto della
registrazione su un dispositivo esterno
tramite i segnali di uscita SDI/HDMI.
Off:
Comando a distanza disabilitato.

SDI/HDMI Remote I/F:
Comando di avvio e arresto
registrazione di un dispositivo
esterno collegato, quando non &
presente nessun supporto di
memoria sul camcorder. Non
sincronizzato con precisione di
fotogramma con i supporti di
memoria del camcorder.

Parallel Rec:
Comando di avvio e arresto
registrazione di un dispositivo
esterno collegato, quando ¢ presente
un supporto di memoria sul
camcorder. Sincronizzato con
precisione di fotogramma con i
supporti di memoria del camcorder.

[Nota]

Per il comando tramite il segnale di uscita
HDMI, impostare HDMI TC Out >Setting
(pagina 95) nel menu TC/Media del menu
completo su On.

Da <1>a<9>, Off/ Base ISO/Sensitivity / AGC / Push

Focus Hold AGC / ND Filter Position / Auto ND Filter /

Button Push Auto ND / Auto Iris / Push Auto Iris /
Bokeh Control / Auto Shutter / Auto
Exposure Level / Backlight / Spotlight /
Preset White Select / ATW / ATW Hold / AF
Speed/Sens. / Focus Setting / Focus Area /
Focus Area(AF-S) / Face/Eye Detection AF /
Push AF Mode / Push AF/Push MF / Focus
Hold / Focus Magnifier x3/x6 / Focus
Magnifier x3 / Focus Magnifier x6 / S&Q
Motion / SteadyShot / Rec / Picture Cache
Rec / Rec Review / Clip Flag OK / Clip Flag
NG / Clip Flag Keep / Color Bars / Tally
[Front] / DURATION/TC/U-BIT / Display /
Lens Info / Video Signal Monitor / Marker /
VF Adjust / VF Mode / Gamma Display
Assist / Peaking / Zebra / Volume /
Thumbnail / Touch Operation / Handle
Zoom / NFC / Auto Upload (Proxy) / Direct
Menu / User Menu / Menu

Assegna funzioni ai pulsanti
programmabili.
Base I1SO/Sensitivity:
Commuta la sensibilita di base del
sensore immagine.
AGC:
Attiva o disattiva la funzione AGC.
Push AGC:
Attiva la funzione AGC mentre si
tiene premuto il pulsante.
ND Filter Position:
Consente di scegliere il filtro ND.
Auto ND Filter:
Attiva o disattiva la funzione di filtro
ND automatico.
Push Auto ND:
Attiva la funzione di filtro ND
automatico mentre si tiene premuto
il pulsante.
Auto Iris:
Attiva o disattiva la funzione diaframma.
Push Auto Iris:
Abilita la funzione di diaframma
automatico mentre si tiene premuto
il pulsante.
Bokeh Control:
Attiva o disattiva la modalita di
controllo del bokeh.
Auto Shutter:
Attiva o disattiva la funzione di
otturatore automatico.
Auto Exposure Level:
Apre o chiude il Direct Menu relativo
al livello di esposizione automatica.
Backlight:
Alterna fra Backlight e Standard.
Spotlight:
Alterna fra Spotlight e Standard.
Preset White Select:
Specifica il valore della modalita di
preset del bilanciamento del bianco.
ATW:
Attiva o disattiva la funzione ATW.
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Project >Assignable Button

Assegna le funzioni desiderate ai pulsanti programmabili.

Project >Assignable Button

Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, ATW Hold: Da <1> a <9>, Rec:

Focus Hold Sospende la funzione ATW. Focus Hold Awvia o arresta la registrazione.
Button AF Speed/Sens.: Button Picture Cache Rec:

Selezione della velocita di transizione
AF e della sensibilita al cambiamento
del soggetto AF.
Focus Setting:
Configura l'area di messa a fuoco.
Focus Area:
Configura I'area di messa a fuoco per
AF e Push AF.
Focus Area(AF-S):
Configura I'area di messa a fuoco per
Push AF (AF-S).
Face/Eye Detection AF:
Selezione delle impostazioni di
messa a fuoco automatica con
rilevamento del viso o degli occhi.
Push AF Mode:
Selezione dell'impostazione della
modalita Push AF.
Push AF/Push MF:
In modalita messa a fuoco MF, attiva
la modalita AF mentre il pulsante
viene mantenuto premuto.
In modalita messa a fuoco AF, attiva
la modalita MF mentre il pulsante
viene mantenuto premuto.
Focus Hold:
In modalita messa a fuoco AF, fissa la
messa a fuoco mentre il pulsante
viene mantenuto premuto.
Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6:
Attiva o disattiva la funzione di
ingrandimento per la messa a fuoco.
S&Q Motion:
Attiva o disattiva la modalita Slow &
Quick Motion.
Se mantenuto premuto, imposta la
frequenza fotogrammi di ripresa.
SteadyShot:
Consente di selezionare Active,
Standard o Off.

Attiva o disattiva la modalita di
registrazione cache immagine

Rec Review:
Attiva o disattiva la funzione Rec Review.

Clip Flag OK:
Esegue la funzione Add OK.
Premere due volte per eseguire
Delete Clip Flag.

Clip Flag NG:
Esegue la funzione Add NG.
Premere due volte per eseguire
Delete Clip Flag.

Clip Flag Keep:
Esegue la funzione Add Keep.
Premere due volte per eseguire
Delete Clip Flag.

Color Bars:
Attiva o disattiva la visualizzazione
della barra colori.

Tally [Front]:
Attiva o disattiva l'illuminazione o il
lampeggio della spia di
registrazione/tally.

DURATION/TC/U-BIT:
Alterna fra Time Code, Users Bit e
Duration.

Display:
Attiva o disattiva la visualizzazione
degli indicatori a schermo.

Lens Info:
Specifica la modalita dell'indicatore
della profondita di campo.

Video Signal Monitor:
Attiva una modalita di monitor del
segnale video (ad esempio il monitor
della forma d'onda).

Marker:
Attiva o disattiva la funzione Marker.
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Project >Assignable Button

Assegna le funzioni desiderate ai pulsanti programmabili.

Project >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di

rotazione.

Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, VF Adjust:

Focus Hold Visualizza le barre di livello per la
Button regolazione della luminosita dello

schermo del mirino.
VF Mode:
Consente di scegliere se visualizzare
I'immagine del mirino a colori o in
bianco e nero.
Gamma Display Assist:
Commuta la funzione di assistenza
per la visualizzazione gamma.
Peaking:
Attiva o disattiva la funzione Peaking.
Zebra:
Attiva o disattiva la funzione Zebra.
Volume:
Regola il livello di uscita dell’audio di
monitoraggio su jack cuffie e
altoparlante incorporato.
Thumbnail:
Apre o chiude la schermata delle
miniature.
Touch Operation:
Attiva o disattiva la funzionalita del
touchscreen.
Handle Zoom:
Specifica la modalita di funzionamento
dello zoom della maniglia.
NFC:
Esegue la funzione NFC.
Auto Upload (Proxy):
Attiva o disattiva I'upload automatico
dei file proxy o imposta la modalita
Chunk.
Direct Menu:
Visualizza o chiude il Direct Menu.
User Menu:
Visualizza o chiude il menu User.
Menu:
Visualizza o chiude il menu completo.

Voce

Impostazione della voce secondaria

Descrizione

Grip/Remote
Dial

Off / 1SO/Gain/El / ND Filter / IRIS /
Auto Exposure Level / Audio Input Level /
Multi Function Dial

Assegna funzioni alla manopola
programmabile dell'impugnatura.
ISO/Gain/El:
Regola il guadagno o I'El.
ND Filter:
Regola il filtro ND.
IRIS:
Regola il diaframma.
Auto Exposure Level:
Regola il livello di esposizione
automatica.
Audio Input Level:
Regola il livello di registrazione audio.
Multi Function Dial:
Agisce come manopola
multifunzione.

Grip Dial
Direction

Normal / Opposite

Specifica la direzione di rotazione della
manopola programmabile
dell'impugnatura.

Normal: Ruota nella direzione normale.
Opposite: Ruota in senso inverso.

Handle Dial

Off / 1SO/Gain/El / ND Filter / IRIS / Auto
Exposure Level / Audio Input Level / Multi
Function Dial

Assegna funzioni alla manopola
programmabile della maniglia.
ISO/Gain/El:
Regola il guadagno o I'El.
ND Filter:
Regola il filtro ND.
IRIS:
Regola il diaframma.
Auto Exposure Level:
Regola il livello di esposizione
automatica.
Audio Input Level:
Regola il livello di registrazione audio.
Multi Function Dial:
Agisce come manopola
multifunzione.

Handle Dial
Direction

Normal / Opposite

Specifica la direzione di rotazione della
manopola programmabile della maniglia.
Normal: Ruota nella direzione normale.
Opposite: Ruota in senso inverso.
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Project >Multi Function Dial
Assegna funzioni alla manopola multifunzione.

Project >All File

Consente di specificare le impostazioni relative ai file ALL.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Default Off / IRIS / ISO/Gain/El / Auto Exposure Assegna la funzione di default alla Load from Execute / Cancel Carica le impostazioni di un file ALL da
Function Level / Audio Input Level manopola multifunzione. Media(B) una scheda di memoria inserita nello slot
IRIS: per schede CFexpress Type A/SD (B).
Regola il diaframma. Execute: Esegue la funzione.
ISO/Gain/El: Load from Execute / Cancel Carica dal servizio cloud C3 Portal
Regola il guadagno o I'El. Cloud(Private) (privato) un file ALL caricato su di esso
Auto EXpOSW? Level:. N Execute: Esegue la funzione.
Regola |I.I|veI|o di esposizione Load from Execute / Cancel Carica dal servizio cloud C3 Portal
A .auTomat:_ca. : Cloud(Share) (condiviso) un file ALL caricato su di esso
udio nput. gve T . . . Execute: Esegue la funzione.
Regola il livello di registrazione audio. - — -
Save to Execute / Cancel Salva le impostazioni di un file ALL su
Project >User File Media(B) una scheda di memoria inserita nello slot
Specifica impostazioni relative alla gestione dei file utente. per schede CFexpress Type A/SD (B).
Voce Impostazione della voce secondaria Descrizione Execute: Esegue la funzione.
Load from Execute / Cancel Carica le impostazioni di file utente da Saveto Execute / Cancel Salva un file di impostazioni ALL sul
Media(B) una scheda di memoria inserita nello slot Cloud(Private) servizio cloud C3 Portal (privato).
per schede CFexpress Type A/SD (B). Execute: Esegue la funzione.
Execute: Esegue la funzione. Save to Execute / Cancel Salva un file di impostazioni ALL sul
Save to Execute / Cancel Salva le impostazioni di file utente su una Cloud(Share) servmo.cloud C3 Portal .(COHdIVISO).
Media(B) scheda di memoria inserita nello slot per _ Execute: Esegue |a fur.12|one.
schede CFexpress Type A/SD (B). File ID Assegna un nome al file.
Execute: Esegue la funzione. Load Network On / Off Specifica se caricare 0 meno le
File ID Visualizza una schermata che mostra e Data impostazioni del menu Network quando
consente di modificare I'ID dei file utente. vengono eseguiti Load from Media(B),
Load On / Off Specifica se caricare le informazioni Load from Cloud(Private) oppure Load
Customize personalizzate del menu User quando from Cloud(Share).
Data viene eseguito Load from Media(B).
Load White On / Off Specifica se caricare le informazioni
Data relative al bilanciamento del bianco

quando viene eseguito Load from
Media(B).
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Menu Paint/Look

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Paint/Look >Scene File
Consente di specificare le impostazioni relative ai file di scena.

Voce

Impostazione della voce secondaria

Descrizione

Recall

Carica un file di scena memorizzato nella
memoria interna e ne applica le
impostazioni come impostazioni attive
per la qualita dell'immagine.

Store

Salva in un file di scena nella memoria
interna lo stato corrente delle impostazioni
relative alla qualita dell'immagine.

Voce Impostazione della voce secondaria Descrizione

Import from  Execute / Cancel Importa un file di look di base da una

Media(B) scheda di memoria inserita nello slot per
schede CFexpress Type A/SD (B).
Execute: Esegue la funzione.

Import from  Execute / Cancel Importa dal servizio cloud C3 Portal

Cloud(Private) (privato) un file di look di base caricato su
di esso.

Execute: Esegue la funzione.

Delete

Elimina un file di scena memorizzato
nella memoria interna.

Import from  Execute / Cancel

Cloud(Share)

Importa dal servizio cloud C3 Portal
(condiviso) un file di look di base caricato
su di esso.

Execute: Esegue la funzione.

Preset Recall

Quando Shooting Mode & impostata su
Custom e Target Display & impostato su
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Quando Shooting Mode & impostata su
Custom e Target Display & impostato su
HDR(HLG):

HLG Live / HLG Natural

Applica valori preconfigurati delle
impostazioni di qualita dell'immagine
(non riscrivibili) alle impostazioni di
qualita dell'immagine correnti.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta la gamma di ingresso del look di
base selezionato.

Output BT.709 / HLG Imposta la gamma di colore di uscita del
look di base selezionato.

AE Level OEV /1/3EV / 2/3EV /1EV / 4/3EV / Imposta il valore di riferimento per

Offset 5/3EV / 2EV I'esposizione del look di base

selezionato.

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Paint/Look >Reset Paint Settings
Resetta le impostazioni del menu Paint/Look, con I'esclusione del look di base.

Voce Impostazione della voce secondaria Descrizione

Voce

Impostazione della voce secondaria

Descrizione

Select

Quando Shooting Mode e impostata su
Custom e Target Display & impostato su
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 /

da User1 a User16
Quando Shooting Mode & impostata su
Custom e Target Display & impostato su
HDR(HLG):
HLG Live / HLG Natural / da User1 a
User16
Quando Shooting Mode & impostata su
Cine El:
s709 / 709(800) / S-Log3 / da Userl a
User16

Seleziona un look di base.

Reset without Execute / Cancel
Base Look

Resetta le impostazioni del menu Paint/
Look, con I'esclusione del look di base.
Execute: Esegue la funzione.

Paint/Look >Black
Consente di specificare le impostazioni relative al nero.

Voce Impostazione della voce secondaria Descrizione

Master Black Da-99.0 a +99.0 (x0.0) Imposta il livello del nero master.
R Black Da -99.0 a +99.0 (x0.0) Imposta il livello R del nero.

B Black Da -99.0 a +99.0 (x0.0) Imposta il livello B del nero.

Delete

Elimina il look di base selezionato.

Delete All

Elimina tutti i look di base.
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Paint/Look >Knee
Consente di specificare le impostazioni relative alla correzione del knee.

Paint/Look >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce Impostazione della voce secondaria Descrizione
Setting Quando Target Display € impostato su Attiva o disattiva la funzione di
SDR(BT.709): correzione del knee.
On / Off / --- )
) . [Informazione]
Quando Target Display & impostato su Abilitato solo se Base Look >Select & impostato
HDR(HLG): su Standard, ITU709, HLG Live o HLG Natural.
On/ Off / ---
Auto Knee Quando Target Display € impostato su Attiva o disattiva la funzione di
SDR(BT.709): correzione del knee automatica.
On / Off / --- )
) . [Informazione]
Quando Target Display e impostato su Abilitato solo se I'impostazione della
HDR(HLG): correzione del knee é configurata su On e Base
On/ Off / --- Look >Select € impostato su Standard o ITU7009.
Point Da 75% a 109% (90%) Imposta il punto knee.
Slope Da -99 a +99 (x0) Imposta la pendenza del knee.

Paint/Look >Detail

Specifica le impostazioni di regolazione del dettaglio.

Voce Impostazione della voce secondaria Descrizione

User Matrix On / Off Attiva o disattiva la funzione di matrice
dell’'utente.

User Matrix Da -99 a +99 (+0) Regola la saturazione del colore

Level dell'intera immagine.

User Matrix ~ Da-99 a +99 (+0) Regola il tono di colore (la fase)

Phase dell'intera immagine.

User Matrix ~ Da-99 a +99 (+0) Imposta una matrice R-G definita

R-G dall’utente.

User Matrix ~ Da-99 a +99 (x0) Imposta una matrice R-B definita

R-B dall’'utente.

User Matrix Da -99 a +99 (x0) Imposta una matrice G-R definita

G-R dall’'utente.

User Matrix ~ Da-99 a +99 (x0) Imposta una matrice G-B definita

G-B dall’'utente.

User Matrix ~ Da-99 a +99 (+0) Imposta una matrice B-R definita

B-R dall’'utente.

User Matrix Da -99 a +99 (x0) Imposta una matrice B-G definita

B-G dall’'utente.

Paint/Look >Multi Matrix
Consente di specificare le impostazioni relative alla correzione multimatrice.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione
multimatrice.

Reset Execute / Cancel Ripristina i valori di default di tonalita
(hue) e saturazione del colore di ciascun
asse.

Axis B/B+/MG-/MG/MG+/R/R+/YL-/  Seleziona I'asse.

YL/YL+/G-/G/G+/CY/CY+/B-

Hue Da -99 a +99 (+0) Imposta la tonalita (hue) del colore per la
correzione multimatrice.

Saturation Da -99 a +99 (+0) Imposta la saturazione del colore

utilizzato per la correzione multimatrice.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di
regolazione del dettaglio.

Level Da -7 a +7 (x0) Imposta il livello del dettaglio.

Manual On / Off / --- Attiva o disattiva la funzione di

Setting regolazione manuale del dettaglio.

V/H Balance Da-2a+2(x0) Imposta il bilanciamento tra verticale (V)
e orizzontale (H) per la regolazione
manuale del dettaglio.

B/W Balance Typel/ Type2 / Type3 / Typed / Type5 Imposta il bilanciamento tra il dettaglio
del nero (B) per le zone a bassa
luminanza e il dettaglio del bianco (W)
per le zone ad alta luminanza nella
regolazione manuale del dettaglio.

Limit DaOa?7 Imposta il livello di limite del dettaglio
per la regolazione manuale del dettaglio.

Crispening DaOa7 Imposta il livello di miglioramento della
nitidezza per la regolazione manuale del
dettaglio.

High Light Da0Oa4 Imposta il livello di dettaglio per le zone

Detail ad alta luminanza nella regolazione

manuale del dettaglio.
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Menu TC/Media

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Setting Imposta i bit utente su un valore

arbitrario.

TC/Media >Timecode
Consente di specificare le impostazioni relative al codice temporale.

Voce Impostazione della voce secondaria Descrizione

Mode Preset / Regen / Clock Imposta la modalita di avanzamento del
codice temporale.
Preset:

Si avvia da un valore preimpostato.

Regen:

Prosegue dal codice temporale della
fine del clip precedente.

Clock:
Utilizza I'orologio interno come
codice temporale.

TC/Media >HDMI TC Out

Consente di specificare le impostazioni relative all'uscita del codice temporale quando si utilizza
HDMI.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Consente di selezionare se emettere il
codice temporale ad altri dispositivi per

altri scopi, tramite HDMI.

Run Rec Run / Free Run Rec Run: Avanza solo durante la
registrazione.

Free Run: Avanzamento costante,
indipendentemente dall’accensione
del camcorder.

Setting Imposta il codice temporale su un valore
arbitrario.

SET: Imposta il valore.

Reset Execute / Cancel Azzera il codice temporale (00:00:00:00).

Execute: Esegue la funzione.

TC Format DF / NDF Imposta il formato del codice temporale.
DF: Drop Frame

NDF: Non-Drop Frame

TC/Media >TC Display
Consente di specificare le impostazioni di visualizzazione dei dati temporali.

Voce Impostazione della voce secondaria Descrizione

Display Select Timecode / Users Bit / Duration Consente di scegliere quali dati temporali

devono essere visualizzati.

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Mode Fix / Time Imposta la modalita del bit utente.

Fix: Utilizza per i bit utente un valore fisso
arbitrario.

Time: Utilizza ora, minuto e secondo

attuali nei bit utente.
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TC/Media >Clip Name Format

Configura impostazioni relative al nome e all’eliminazione di clip.

TC/Media >Clip Name Format

Configura impostazioni relative al nome e all’eliminazione di clip.

Voce Impostazione della voce secondaria

Descrizione

Voce Impostazione della voce secondaria

Descrizione

Title Prefix nnn_ (nnn = le ultime 3 cifre del numero di

serie)

Imposta la sezione del titolo (da 4 a 46
caratteri) del nome del clip.

Apre una schermata per l'immissione di
una stringa di caratteri.

Struttura della schermata di

immissione delle stringhe di caratteri
Area di selezione del carattere (3 righe):
Consente di selezionare i caratteri da
inserire alla posizione del cursore
nell’area Title Prefix.
1#$%()+.-.;=@| ]*_~0123456789
abcdefghijkimnopqgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
Area di operativita del cursore (1 riga):
Spazio: Inserisce uno spazio in
corrispondenza della posizione del
cursore.
<«—: Sposta il cursore a sinistra.
—: Sposta il cursore a destra.
BS: Elimina il carattere alla sinistra del
cursore.
Area Title Prefix (1riga):
Area per I'immissione del titolo.

Impostazione del titolo

1. Utilizzando il selettore multiplo
(pagina 7), selezionare il carattere
da immettere alla posizione del
cursore nell'area Title Prefix
scegliendolo nell'area di selezione
caratteri, quindi premere il pulsante
di conferma del selettore multiplo. (I
carattere selezionato viene inserito e
il cursore si sposta verso destra).

2. Ripetere il punto 1 per impostare il
titolo. (utilizzare BS secondo
necessita).

3. Dopo aver impostato il titolo,
selezionare Done per chiudere la
schermata di immissione dei caratteri.

Number Set  Da 0001 a 9999

Imposta il suffisso di 4 cifre aggiunto al
nome del clip.

TC/Media >Update Media
Aggiorna il file di gestione delle schede di memoria.

Voce Impostazione della voce secondaria Descrizione

Media(A) Execute / Cancel Aggiorna il file di gestione della scheda
di memoria nello slot A.
Execute: Esegue la funzione.

Media(B) Execute / Cancel Aggiorna il file di gestione della scheda

di memoria nello slot B.
Execute: Esegue la funzione.

TC/Media >Format Media
Inizializza le schede di memoria.

Voce Impostazione della voce secondaria Descrizione
Media(A) Full Format / Quick Format / Cancel Formatta la scheda di memoria nello slot A.
Media(B) Full Format / Quick Format / Cancel Formatta la scheda di memoria nello slot B.
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Menu Monitoring

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Monitoring >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Monitoring >Output On/Off Voce Impostazione della voce secondaria Descrizione
Consente di specificare le impostazioni relative all'uscita video. Network On / Off Seleziona gli elementi da visualizzare nel
Voce Impostazione della voce secondaria Descrizione Status mirino.
File Transf On / Off
SDI On / Off Attiva o disattiva I'uscita SDI. Sltaetursans er o
HDMI On / Off Attiva o disattiva I'uscita HDMI. Rec/Play On / Off
Monitoring >Output Format Status
Consente di specificare le impostazioni relative al formato di uscita. RAW Output  On / Off
Voce Impostazione della voce secondaria Descrizione (S:;:Hsl
SDI Per informazioni dettagliate su queste Imposta la risoluzione delle uscite SDI e Tally On / Off
HDMI impostazioni, vedere “Formati di uscita e HDMI.
limitazioni” (pagina 124). Battery On / Off
Remain
Monitoring >Output Display Focus Mode On / Off
Configura le impostazioni di uscita visualizzazione schermata.
= = = Focus On / Off
Voce Impostazione della voce secondaria Descrizione Position
SDI On / Off Configura se menu, stato e Focus Area On / Off
visualizzazione della schermata sono Indicator
incorporati nel segnale di uscita SDI. Focus Area On / Off
HDMI On / Off Configura se menu, stato e Ind.(AF-S)
visualizzazione della schermata sono Face/Eye On / Off
incorporati nel segnale di uscita HDMI. Detection
Frame
Lens Info On / Off
Imager Scan  On / Off
Mode
Rec Format On / Off
Frame Rate On / Off
Zoom On / Off
Position
UWP RF Level On / Off
SteadyShot On / Off
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Monitoring >Display On/Off

Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Monitoring >Marker

Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Base Look/ On / Off Setting On / Off Attiva o disattiva la visualizzazione di
LUT tutti gli indicatori.
SDI/HDMI On / Off Color White / Yellow / Cyan / Green / Magenta / Seleziona il colore del segnale
Rec Control Red / Blue dell'indicatore.
Gamma On / Off Center Maker 1/2/3/4/ Off Seleziona I'indicatore del centro
Display Assist immagine.
Proxy Status  On / Off Safety Zone  On/ Off Attiva o disattiva la visualizzazione
Base I1SO/ On / Off dell'indicatore della zona di sicurezza.
Sensitivity Safety Area 80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore
Media Status On / Off della zona di sicurezza come percentuale
- - - delle dimensioni totali dello schermo.
Video Signal  Off / Waveform / Vector / Histogram - - — . -
Monitor Aspect Line / Mask / Off Seleziona il tipo di indicatore di aspetto.
- Marker
Clip Name On / Off — -
- Aspect Mask Da 0a15(12) Imposta il livello del segnale video
White On / Off all'esterno dell'indicatore.
Balance. Aspect Safety On / Off Attiva o disattiva la visualizzazione della
Scene File On / Off Zone zona di sicurezza di aspetto.
Focus On / Off Aspect Safety 80% / 90% / 92.5% / 95% Seleziona le dimensioni dell'indicatore
Indicator Area della zona di sicurezza di aspetto come
Auto On / Off percentuale delle dimensioni totali dello
Exposure schermo.
Mode Aspect Select 1:1/4:3/13:9/14:9/15:9/16:9/17:9/ Imposta la modalita di visualizzazione
Auto On / Off 1.66:1/1.85:1/ 2.35:1/ 2.39:1 / Custom dell'indicatore di aspetto.
Exposure Custom Consente di immettere un valore arbitrario Imposta il rapporto di aspetto su un
Level Aspect Ratio  (01.00:01.00) valore arbitrario.
Timecode On / Off [Nota]
ND Filter On / Off Questa impostazione ¢ disponibile solo
Iris on / Off : qua.ndo AsPect .Select e.lmpo.stato .su Custom.
- Guide Frame On / Off Attiva o disattiva la visualizzazione del
ISO/Gain/El  On / Off riquadro di guida.
Shutter On / Off 100% Marker On / Off Attiva o disattiva la visualizzazione
Level Gauge On / Off dell'indicatore 100%.
Audio Level On / Off User Box On / Off Attiva o disattiva la visualizzazione del
Meter riquadro utente.
Video Level On / Off User Box Da 3 a 479 (240) Specifica la larghezza del riquadro utente
Warning Width (distanza dal centro ai bordi destro e
Clip Number  On / Off sinistro).
Notice On / Off

Message
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Monitoring >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Monitoring >Zebra
Consente di specificare le impostazioni del motivo zebra.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
User Box Da 3 a 269 (135) Specifica I'altezza del riquadro utente ZebrallLevel Da 0% a109% (70%) Imposta il livello di visualizzazione del
Height (distanza dal centro ai bordi superiore e motivo Zebra 1.

inferiore). Zebral Da 2% a 20% (10%) Imposta il livello di apertura del motivo
User Box H Da -476 a +476 (0) Specifica la posizione orizzontale del Aperture Zebra 1.
Position centro del riquadro utente. Level
User Box V Da -266 a +266 (0) Specifica la posizione verticale del centro Zebra2 Level Da 0% a109% (100%) Imposta il livello di visualizzazione del
Position del riquadro utente. motivo Zebra 2.

Monitoring >VF Setting
Consente di specificare le impostazioni relative al mirino.

Voce Impostazione della voce secondaria Descrizione

Brightness Da1a15(8) Regola la luminosita dell'immagine del
mirino.

Color Mode Color / B&W Seleziona la modalita di visualizzazione

del mirino in modalita di registrazione o
E-E.

Monitoring >Gamma Display Assist
Configura le impostazioni di assistenza visualizzazione gamma.

Voce Impostazione della voce secondaria Descrizione

Attiva o disattiva la funzione di
assistenza alla visualizzazione gamma
nella modalita Custom quando Target
Display & impostato su HDR(HLG).

Setting On / Off

Monitoring >Peaking
Consente di specificare le impostazioni relative al peaking.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione Peaking.

Peaking Level High / Mid / Low Imposta il livello di segnale del peaking
del colore.

Color B&W / Red / Yellow / Blue Seleziona il colore del segnale di peaking
colore.

Monitoring >Zebra

Consente di specificare le impostazioni del motivo zebra.
Voce Impostazione della voce secondaria Descrizione
Setting Off / Zebral / Zebra2 Seleziona il tipo di motivo zebra (Off,

Zebra 1, Zebra 2).
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Menu Audio

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).
Fare riferimento a “Diagrammi a blocchi” (pagina 140).

Audio >Audio Input
Consente di specificare le impostazioni relative all'ingresso audio.

Voce Impostazione della voce secondaria Descrizione
Audio >Audio Input CHS3 Level Auto / Manual Seleziona la regolazione del livello di
Consente di specificare le impostazioni relative all'ingresso audio. Control ingresso audio automatica o manuale
Voce Impostazione della voce secondaria Descrizione per la registrazione sul canale 3.
- . [Nota]
CHI1 Input INPUT1 / Internal MIC / Shoe CH1 SeIgzmng la sorgljente Id|1|ngresso perla Se CH3 Input Select e CH4 Input Select sono
Select registrazione sul canale 1. entrambi impostati su Internal MIC, CH4 viene
CH2 Input INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Seleziona la sorgente di ingresso per la impostato su automatico o manuale in accordo
Select registrazione sul canale 2. con questa impostazione.
CH3 Input Off / INPUT1 / Internal MIC / Shoe CH1 Seleziona la sorgente di ingresso per la CH4 Level Auto / Manual Seleziona la regolazione del livello di
Select registrazione sul canale 3. Control ingresso audio automatica o manuale
CH4 Input  Off / INPUT1 / INPUT2 / Internal MIC / Seleziona la sorgente di ingresso per la per la registrazione sul canale 4.
Select Shoe CH2 registrazione sul canale 4. [Nota]
INPUTIMIC  -80dB / —70dB / -60dB / -50dB / -40dB / Imposta il livello di riferimento di Se CH3 Input Select e CH4 Input Select sono
Reference -30dB registrazione dell'ingresso microfono XLR entrambi impostati su Internal MIC, CH4 viene
impostato su automatico o manuale in accordo
su INPUTT. I'impostazione di CH3 Level Control.
INPUT2 MIC  -80dB / -70dB / -60dB / -50dB / -40dB / Imposta il livello di riferimento di CH3 Input Da 0 a 99 (49) Imposta il livello di ingresso per la
Reference -30dB registrazione dell’'ingresso microfono XLR Level - registrazione sul canale 3.
- su INEUTZ: - — - CH4 Input Da 0 a99(49) Imposta il livello di ingresso per la
Line Input +4dB / 0dB / -3dB / EBUL Seleziona il livello di riferimento di Level registrazione sul canale 4.
Reference mgresso‘ quando Il selettore INPUT1/ Audio Input  Da0a99 Imposta il livello di ingresso audio.
INPUT2 e impostato su LINE. o .
Level Utilizzabile come volume master secondo
Reference -20dB / -18dB / -16dB / -12dB / EBUL Seleziona il livello di registrazione del le impostazioni delle opzioni CH Level da
Level segnale di tono di riferimento a 1 kHz. 1a4.
CHT Wind On / Off Abilita o disabilita il filtro di riduzione del Limiter Mode Off / -6dB / -9dB / -12dB / -15dB / -17dB  Seleziona la caratteristica di limitazione
Filter rumore del vento per la registrazione del per i segnali di ingresso di livello elevato
canale 1. quando il livello di ingresso audio viene
CH2 Wind On / Off Abilita o disabilita il filtro di riduzione del regolato manualmente.
Filter rumore del vento per la registrazione del CH1&2 AGC  Mono / Stereo Imposta la modalita di regolazione livello
canale 2. Mode automatica per la registrazione sui canali
CH3 Wind On / Off Abilita o disabilita il filtro di riduzione del 1e 2. Quando é selezionato Stereo, la
Filter rumore del vento per la registrazione del regolazione AGC agisce
canale 3. contemporaneamente sui due canali.
CH4 Wind On / Off Abilita o disabilita il filtro di riduzione del CH3&4 AGC  Mono / Stereo Imposta la modalita di regolazione livello
Filter rumore del vento per la registrazione del Mode automatica per la registrazione sui canali

canale 4.

3 e 4. Quando é selezionato Stereo, la
regolazione AGC agisce
contemporaneamente sui due canali.

AGC Spec

-6dB / -9dB / -12dB / -15dB / -17dB

Seleziona la caratteristica AGC.
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Audio >Audio Input
Consente di specificare le impostazioni relative all'ingresso audio.

Audio >Audio Output
Consente di specificare le impostazioni relative all’'uscita audio.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
1kHz Tone on On / Off Attiva o disattiva I'emissione del segnale Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1/ Seleziona I'uscita del canale audio sul
Color Bars di tono di riferimento a 1 kHz durante la CH2 / CH3 / CH4 jack cuffie e I'altoparlante incorporato.
visualizzazione delle barre colore. [Nota]
[Nota] Se I'audio & impostato per |'uscita simultanea
Se impostato su On, viene impostato il su pil di un canale, il livello di uscita di ciascun
segnale di tono di riferimento a 1 kHz per la canale viene ridotto per evitare il clipping.
registrazione sui canali 3 e 4, anche seCH3 Volume Da0a50 Regola il livello di uscita dell'audio di
'S‘ijg]tcfse'ed e CH4 Input Select sono impostati monitoraggio su jack cuffie e altoparlante
: — incorporato.
CH1 Level Ingressg senza adattatorg XLR . Impostz.a Ia.comtl)lna2|or.1.e delle . Headphone  Mono / Stereo Specifica se l'uscita del jack cuffie deve
Audio Input Level / Side / Level+Side  regolazioni del livello di ingresso audio
NSO - . . Out essere mono o stereo.
Ingresso con adattatore XLR (pagina 50) abilitate per la registrazione del canale 1. - -
Audio Input Level / Through INota] Alarm Level Da0Oa7(4) Regola il volume dell‘allarme.
"Side” indica la manopola AUDIO LEVEL (CH1) HDMI Output CH1/CH2 / CH3/CH4 Imposta la combinazione dei canali audio
sul lato del camcorder. Se & selezionato CH sull’'uscita HDMI.
Level+Side, il livello di registrazione audio &
determinato dalla combinazione di Audio
Input Level e la posizione della manopola
(pagina 140).
CH2 Level Ingresso senza adattatore XLR Imposta la combinazione delle
Audio Input Level / Side / Level+Side  regolazioni del livello di ingresso audio
Ingresso con adattatore XLR (pagina 50) abilitate per la registrazione del canale 2.
Audio Input Level / Through [Nota]
“Side” indica la manopola AUDIO LEVEL (CH2)
sul lato del camcorder. Se € selezionato
Level+Side, il livello di registrazione audio &
determinato dalla combinazione di Audio
Input Level e la posizione della manopola
(pagina 140).
CH3 Level Ingresso senza adattatore XLR Imposta la combinazione delle
Audio Input Level / CH3 Input Level / regolazioni del livello di ingresso audio
Level+CH3 Input Level abilitate per la registrazione del canale 3.
Ingresso con adattatore XLR (pagina 50)
Audio Input Level / Through
CH4 Level Ingresso senza adattatore XLR Imposta la combinazione delle

Audio Input Level / CH4 Input Level /
Level+CH4 Input Level

Ingresso con adattatore XLR (pagina 50)
Audio Input Level / Through

regolazioni del livello di ingresso audio

abilitate per la registrazione del canale 4.
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Menu Thumbnail

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Thumbnail >Transfer Clip (Proxy)

Trasferisce clip proxy.

[Nota]
Non e possibile configurare Transfer Clip (Proxy) se non é stata configurata una password mediante Access
Authentication nel menu Network.

Thumbnail

Voce Impostazione della voce secondaria Descrizione

Display Clip Visualizza la schermata delle proprieta
Properties dei clip.

Thumbnail >Set Clip Flag
Consente di specificare le impostazioni relative ai flag dei clip.

Voce Impostazione della voce secondaria Descrizione

Select Clip Trasferisce i clip proxy corrispondenti ai
clip selezionati.

All Clips Trasferisce i clip proxy corrispondenti a
tuttii clip.
[Nota]

E possibile trasferire fino a 200 clip.

Voce Impostazione della voce secondaria Descrizione

Add OK Aggiunge un flag OK.
Add NG Aggiunge un flag NG.
Add KEEP Aggiunge un flag Keep.
Delete Clip Elimina tutti i flag.

Flag

Thumbnail >Filter Clips

Consente di specificare le impostazioni relative ai clip da visualizzare.

Thumbnail >Lock/Unlock Clip
Consente di specificare le impostazioni relative alla protezione dei clip.

Voce Impostazione della voce secondaria Descrizione

oK Visualizza solo i clip che contengono un
flag OK.

NG Visualizza solo i clip che contengono un
flag NG.

KEEP Visualizza solo i clip che contengono un
flag Keep.

None Visualizza solo i clip che non contengono
nessun flag.

All Visualizza tutti i clip, indipendentemente

dalla presenza o meno di flag.

Thumbnail >Customize View

Consente di scegliere la visualizzazione delle miniature.

Voce Impostazione della voce secondaria Descrizione
Select Clip Seleziona e blocca/sblocca un clip.
Lock All Clips Blocca tutti i clip.
Unlock All Sblocca tutti i clip.
Clips
Thumbnail >Delete Clip
Elimina clip.
Voce Impostazione della voce secondaria Descrizione
Select Clip Elimina il clip selezionato.
All Clips Elimina tutti i clip.

Thumbnail >Transfer Clip
Trasferisce clip.

[Nota]
Non e possibile configurare Transfer Clip se non é stata configurata una password mediante Access
Authentication nel menu Network.

Voce Impostazione della voce secondaria Descrizione
Thumbnail Date Time / Time Code / Duration / Seleziona le informazioni visualizzate
Caption Sequential Number sotto le miniature.

Voce Impostazione della voce secondaria Descrizione
Select Clip Trasferisce i clip selezionati.
All Clips Trasferisce tuttii clip.

[Nota]
E possibile trasferire fino a 200 clip.
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Menu Technical

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Technical >HOLD Switch Setting
Consente di specificare le impostazioni relative al selettore HOLD.

Technical >Color Bars
Consente di specificare le impostazioni della barra colori.

Voce Impostazione della voce secondaria Descrizione

Voce Impostazione della voce secondaria Descrizione
Setting On / Off Attiva o disattiva la barra colori.
Type ARIB 7 100% / 75% / SMPTE Seleziona il tipo di barra colori.

Technical >ND Dial
Consente di specificare le impostazioni relative al funzionamento della manopola ND VARIABLE.

Voce Impostazione della voce secondaria Descrizione

CLEAR with On / Off Specifica se abilitare o meno l'attivazione
Dial del filtro ND (CLEAR <=> On) tramite la
manopola ND VARIABLE.

Technical >Tally
Configura impostazioni per la spia di registrazione/tally.

Handle HOLD Normal / Rec Button Only
Switch

Specifica se il selettore HOLD della
maniglia deve agire solamente sul
pulsante START/STOP registrazione della
maniglia.
Normal:
Il selettore HOLD impedisce
I'azionamento di tutti i comandi della
maniglia.
Il pulsante START/STOP di
registrazione della maniglia, tuttavia,
segue I'impostazione dell'opzione
“with Rec Button”.
Rec Button Only:
Il selettore HOLD agisce solo sul
pulsante START/STOP registrazione

Voce Impostazione della voce secondaria Descrizione della maniglia.
Front On / Off Accende o spegne la spia di Technical >Touch Operation
registrazione/tally (anteriore). Configura impostazioni relative al funzionamento del touchscreen.
Rear On / Off Accende o spegne la spia di Voce Impostazione della voce secondaria Descrizione
registrazione/tally (posteriore). Setting On / Off Attiva o disattiva la funzionalita del

Technical >HOLD Switch Setting
Consente di specificare le impostazioni relative al selettore HOLD.

touchscreen.

Technical >Rec Review
Consente di specificare impostazioni relative alla revisione della registrazione.

Voce Impostazione della voce secondaria Descrizione

Voce Impostazione della voce secondaria Descrizione

with Rec On / Off Consente di scegliere se bloccare il

Button funzionamento del pulsante START/STOP
registrazione.

with Hand On / Off Consente di scegliere se bloccare il

Grip Remote funzionamento dell'impugnatura di

telecomando.

Setting 3s/10s/ Clip Seleziona la durata della riproduzione dei

clip appena registrati per la loro revisione.

Technical >Zoom
Consente di specificare impostazioni relative allo zoom.

Voce Impostazione della voce secondaria Descrizione

Zoom Type Optical Zoom Only / On(Clear Image

Zoom)

Imposta il tipo di zoom.

Optical Zoom Only:
Lo zoom ottico viene regolato
azionando l'obiettivo.

On(Clear Image Zoom):
Zoom elettronico con scarso o
nessun deterioramento della qualita
dell'immagine.
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Technical >Handle Zoom
Consente di specificare le impostazioni relative allo zoom della maniglia.

Technical >Menu Page On/Off
Configura impostazioni relative alla visualizzazione della schermata di stato.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Setting Off / Low / High / Variable Imposta la velocita dello zoom della Assignable On / Off Attiva o disattiva la visualizzazione della
maniglia. Button schermata Assignable Button Status.
High Dala8(8) Imposta la velocita dello zoom della Battery On / Off Attiva o disattiva la visualizzazione della
maniglia quando ¢ selezionata la velocita schermata Battery Status.
High. Media On / Off Attiva o disattiva la visualizzazione della
Low Dal1a8(3) Imposta la velocita dello zoom della schermata Media Status.
maniglia quando é selezionata la velocita Network On / Off Attiva o disattiva la visualizzazione della
Low. schermata Network Status.
[Nota] File Transfer  On / Off Attiva o disattiva la visualizzazione della

Valori molto bassi di velocita dello zoom
potrebbero influire negativamente
sull’uniformita dell’azione di zoom.

schermata File Transfer Status.

Technical >Menu Settings
Consente di specificare impostazioni relative alle voci del menu.

Technical >Fan Control
Consente di specificare le impostazioni di comando della ventola.

Voce Impostazione della voce secondaria Descrizione

Voce Impostazione della voce secondaria Descrizione

User Menu On / Off Specifica se visualizzare solo il menu User
Only (On) o I'elenco dei menu (Off) quando il
camcorder visualizza il menu.

User Menu On / Off

with Lock

Specifica se bloccare o meno la
visualizzazione del menu, mostrando
solo il menu User.

[Nota]
Nella visualizzazione normale del menu, questa
voce non e visualizzata. Per informazioni

Setting Auto / Minimum / Off in Rec Imposta la modalita di controllo della

ventola del camcorder.

[Nota]

Anche se é selezionata 'opzione Off in

Rec, il ventilatore si attiva ugualmente se la
temperatura interna del camcorder raggiunge
un determinato valore.

Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce Impostazione della voce secondaria Descrizione

dettagliate sulla visualizzazione dei menu, Zoom Ring Left(W)/Right(T) / Right(W)/Left(T) Imposta la direzione della ghiera dello
vedere pagina 76. Direction zoom
Technical >Menu Page On/Off [Nota]
Configura impostazioni relative alla visualizzazione della schermata di stato. Abilitato solo quando si utilizza un obiettivo
Voce Impostazione della voce secondaria Descrizione con innesto E-mount che consente la scelta
della direzione di azionamento della ghiera
Main On / Off Attiva o disattiva la visualizzazione della dello zoom.
schermata Main Status. Shading Auto / Off Imposta la compensazione automatica
Camera On / Off Attiva o disattiva la visualizzazione della Compensation dello shading.
schermata Camera Status. Chroma Auto / Off Imposta la compensazione automatica
Audio On / Off Attiva o disattiva la visualizzazione della Aberration dell'aberrazione cromatica.
schermata Audio Status. Comp.
Project On / Off Attiva o disattiva la visualizzazione della Distortion Auto / Off Imposta la compensazione automatica
schermata di stato Project. Comp. della distorsione.
Monitoring On / Off Attiva o disattiva la visualizzazione della

schermata Monitoring Status.
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Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Technical >Camera Battery Alarm
Consente di specificare le impostazioni relative all'allarme per bassa tensione batteria.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione

Breathing Auto / Off Imposta la compensazione dell'effetto Low Battery 5% /10% /15% / .../ 45% / 50% Imposta il livello di carica rimanente della
Compensation breathing dell'obiettivo. batteria per la visualizzazione

Distance Meter / Feet Specifica le unita di misura visualizzate dell'allarme di bassa tensione batteria (in

Display per informazioni sull’'obiettivo e sulla
posizione di messa a fuoco.

incrementi del 5%).

Zoom Focal Length / Number / Bar Specifica il formato di visualizzazione
Position della posizione dello zoom.
Display

Battery Da3%a7% Imposta il livello di carica rimanente della
Empty batteria per la visualizzazione
dell’allarme batteria scarica.

Technical >Video Light Set
Specifica il metodo di illuminazione della luce video. Disponibile solo se viene utilizzata la luce
video HVL-LBPC (opzionale).

Technical >Camera DC IN Alarm
Consente di specificare le impostazioni relative all'allarme della tensione di ingresso.

Voce Impostazione della voce secondaria Descrizione

Video Light Power Link / Rec Link / Rec Link + Stby Imposta il metodo di controllo

Set dell'illuminazione per la luce video
montata sulla slitta Multi-interface.
Power Link:

Accende e spegne la luce video in
sincronia con l'accensione o
spegnimento del camcorder.

Rec Link:
Accende e spegne la luce video in
sincronia con l'avvio e I'arresto della
registrazione.

Rec Link + Stby:
Accende e mette in standby la luce
video in sincronia con l'avvio e
I'arresto della registrazione.

Voce Impostazione della voce secondaria Descrizione

DC Low Da 16.0V a 19.0V (16.5V) Imposta la tensione alla quale

Voltagel visualizzare I'allarme di bassa tensione su
ingresso DCIN.

DC Low Da 15.5V a 18.5V Imposta la tensione alla quale

Voltage2 visualizzare I'allarme di tensione su

ingresso DC IN insufficiente.

Technical >APR
Esegue la funzione APR.

Voce Impostazione della voce secondaria Descrizione

APR Execute / Cancel Esegue la funzione APR di ricostruzione
automatica pixel per la regolazione
automatica del sensore di immagine.

Execute: Esegue la funzione.

[Nota]
Montare sempre il coperchietto dell'obiettivo
prima di eseguire la funzione APR.
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Menu Network

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Network >Wireless LAN

Consente di specificare le impostazioni relative alle connessioni su LAN wireless.

Network >Setup for Mobile App

Esegue lo strumento di assistenza alla configurazione di rete.

Voce Impostazione della voce secondaria

Descrizione

Setup

Awvia lo strumento di assistenza alla
configurazione di rete.

Network >Access Authentication

Consente di specificare impostazioni relative all'autenticazione di accesso.

Voce Impostazione della voce secondaria Descrizione

NFC Execute / Cancel Stabilisce una connessione tramite NFC
(Near Field Communication).
Execute: Esegue la funzione.

MAC Address Visualizza I'indirizzo MAC dell’interfaccia

LAN wireless del camcorder.

Network >AP Mode Settings

Consente di specificare le impostazioni relative alle connessioni in modalita punto di accesso.

Voce Impostazione della voce secondaria Descrizione

Channel Auto(5GHz) / Auto / CH1/ CH2 / Imposta il canale della LAN wireless.
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / L'opzione Auto(5GHz) & disponibile solo
CH10 /7 CHNM sul modello ILME-FX6V/VK.

Camera SSID Visualizza SSID e password del

& Password camcorder.

Regenerate  Execute / Cancel Crea una nuova password.

Password Execute: Esegue la funzione.

IP Address Visualizza I'indirizzo IP del camcorder in

modalita punto di accesso.

Subnet Mask

Visualizza la subnet mask del camcorder
in modalita punto di accesso.

Voce Impostazione della voce secondaria Descrizione
User Name Specifica il nome utente per
I'autenticazione di accesso.
Input Specifica la password per I'autenticazione
Password di accesso.
[Nota]
Per maggior sicurezza, si consiglia di impostare
una password di lunghezza sufficiente e che
non possa essere indovinata facilmente da
altri, quindi conservarla in maniera sicura.
Generate Execute / Cancel Genera automaticamente una password
Password per l'autenticazione di accesso.
Execute: Esegue la funzione.
Show Visualizza le informazioni per
Settings I'autenticazione di accesso.

Visualizza il nome utente, la password,
I'impronta digitale, il numero di serie e il
nome di modello come testo e codice
QR.

[Nota]
Evitare che la password possa essere vista e
che il codice QR possa essere copiato da altri.

Network >Wireless LAN

Consente di specificare le impostazioni relative alle connessioni su LAN wireless.

Voce Impostazione della voce secondaria Descrizione

Setting Access Point Mode / Station Mode / Off Seleziona la modalita di funzionamento
della connessione LAN wireless.

WPS Execute / Cancel Stabilisce una connessione tramite WPS

(Wi-Fi Protected Setup).
Execute: Esegue la funzione.
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Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalita stazione.

Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalita stazione.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Camera Enable / Disable Specifica se abilitare 0 meno il comando Scan Rileva e visualizza un elenco delle reti
Remote a distanza da un dispositivo connesso al Networks LAN wireless (punto di accesso).
Control camcorder tramite LAN wireless in Seleziona nell’elenco la destinazione del
modalita Station. collegamento.
Connected Visualizza la rete LAN wireless collegata SSID Visualizza il SSID del punto di accesso a
Network (punto di accesso). cui connettersi.
SSID Visualizza il SSID del punto di accesso a Security Visualizza il tipo di protezione della
Cui connettersi. connessione al punto di accesso.
Security Visualizza il tipo di protezione della Password Immettere la password per la
connessione al punto di accesso. connessione al punto di accesso.
Password Visualizza la password della connessione DHCP Attiva o disattiva DHCP.
al punto di accesso. On / Off
Quando Security &€ impostata su WEP o IP Address Consente di immettere I'indirizzo IP del
WPA: e camcorder quando DHCP é impostato su
Quando Security € impostata su None: Off.
'(VUOtO) _ Subnet Mask Consente di immettere la subnet mask
DHCP Indica se DHCP e attivo o no. del camcorder quando DHCP & impostato
IP Address Visualizza I'indirizzo IP del camcorder su Off.

quando DHCP é impostato su Off.

Subnet Mask

Visualizza la subnet mask del camcorder
quando DHCP é impostato su Off.

Gateway Visualizza il default gateway del
camcorder quando DHCP e impostato su
Off.

DNS Auto Indica se I'acquisizione del DNS ¢ attiva o

no.

Primary DNS Server

Visualizza il server DNS primario del
camcorder quando DNS Auto & impostata
su Off.

Gateway Consente di immettere il default gateway
del camcorder quando DHCP ¢ impostato
su Off.

DNS Auto Attiva o disattiva la funzione di

On / Off acquisizione automatica del DNS.

Primary DNS Server

Consente di immettere il server DNS
primario del camcorder quando DNS
Auto e impostata su Off.

Secondary DNS Server

Consente di immettere il server DNS
secondario del camcorder quando DNS
Auto e impostata su Off.

Secondary DNS Server

Visualizza il server DNS secondario del
camcorder quando DNS Auto e impostata
su Off.
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Network >ST Mode Settings

Consente di specificare impostazioni relative alle connessioni in modalita stazione.

Network >Wired LAN

Consente di specificare le impostazioni relative alle connessioni su LAN cablata.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Manual Registra le impostazioni per la Setting On / Off Attiva o disattiva la funzione LAN cablata.
Register connessione manuale a un punto di Camera Enable / Disable Specifica se abilitare o meno il comando
accesso. Remote a distanza da un dispositivo connesso al
SSID Consente di immettere il SSID del punto Control camcorder tramite LAN cablata.
di accesso a cui connettersi. Detail Configura le proprieta della connessione
Security Consente di scegliere il tipo di protezione Settings LAN cablata.
None / WEP / WPA della connessione al punto di accesso. DHCP Attiva o disattiva DHCP.
Selezionare WPA se il tipo di protezione On / Off
del punto di accesso di destinazione IP Address Consente di immettere I'indirizzo IP del

WPA o WPA2.

Password Immettere la password per la
connessione al punto di accesso.
DHCP Attiva o disattiva DHCP.
On / Off
IP Address Consente di immettere I'indirizzo IP del

camcorder quando DHCP e impostato su
Off.

Subnet Mask

Consente di immettere la subnet mask
del camcorder quando DHCP e impostato
su Off.

Gateway Consente di immettere il default gateway
del camcorder quando DHCP e impostato
su Off.

DNS Auto Attiva o disattiva la funzione di

On / Off acquisizione automatica del DNS.

Primary DNS Server

Consente di immettere il server DNS
primario quando DNS Auto € impostata
su Off.

camcorder quando DHCP & impostato su
Off.

Subnet Mask

Consente di immettere la subnet mask
del camcorder quando DHCP é impostato
su Off.

Gateway Consente di immettere il default gateway
del camcorder quando DHCP & impostato
su Off.

DNS Auto Attiva o disattiva la funzione di

On / Off acquisizione automatica del DNS.

Primary DNS Server

Consente di immettere il server DNS
primario quando DNS Auto e impostata
su Off.

Secondary DNS Server

Consente di immettere il server DNS
secondario quando DNS Auto &
impostata su Off.

Network >Modem

Consente di specificare impostazioni relative al tethering USB.

Secondary DNS Server

Consente di immettere il server DNS
secondario quando DNS Auto e
impostata su Off.

Voce Impostazione della voce secondaria

Descrizione

Setting On / Off

Attiva o disattiva la connessione tramite
smartphone.

Camera Enable / Disable Imposta l'autorizzazione per il comando

Remote a distanza tramite tethering USB

Control mediante un’app per smartphone, ad
esempio CBM (Content Browser Mobile)
o C3 Portal App.

Device Name Visualizza il nome di dispositivo dello
smartphone.

IP Address Visualizza I'indirizzo IP dello smartphone.
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Network >Modem

Consente di specificare impostazioni relative al tethering USB.

Network >File Transfer
Consente di specificare impostazioni relative al trasferimento di file.

Voce Impostazione della voce secondaria Descrizione Voce Impostazione della voce secondaria Descrizione
Subnet Mask Visualizza la subnet mask dello View Job List Visualizza I'elenco dei file da trasferire.
smartphone. Server Display Name Imposta il nome di visualizzazione
Network >File Transfer Settings1 mostrato nel menu di configurazione
Consente di specificare impostazioni relative al trasferimento di file. della destinazione di trasferimento.
- - . Service Visualizza il tipo di server.
Voce Impostazione della voce secondaria Descrizione FTP
Auto Upload On / Off Attiva o disattiva I'upload automatico dei Host Name Imposta il nome host del server di
file originali. destinazione del trasferimento.
[Nota] Port (da 1 a 65535 (21)) Imposta il numero della porta del server
Quando Simul Rec >Setting (pagina 88) di destinazione del trasferimento.
nel menu Projgct .é imp.ostat.o su On, I'upload User Name Imposta il nome utente per
automatico _del clip reg_lstratl sulla scheda dello |'autenticazione della connessione con il
slot B non viene eseguito. server di destinazione del trasferimento.
Auto Upload  On / Off / Chunk On: _ - Password Imposta la password per l'autenticazione
(Proxy) Attiva I'upload automatico dei file della connessione con il server di
proxy. destinazione del trasferimento.
oft. o Passive Mode Attiva o disattiva la modalita PASV.
Disattiva I'upload automatico dei file On / Off
pr(?xy. Destination Directory Immettere il nome della directory di
ChurE1k. comati e Fubload i destinazione del trasferimento.
segue automaticamente |'upload di - - -
filegrox reqistrati in blocchip Using Secure Protocol Specifica se utilizzare (On) o non
proxy reg : On / Off utilizzare (Off) la modalita di
[Nota] trasferimento Secure FTP (FTPS Explicit
Quando Simul Rec >Setting (pagina 88) Mode: FTPES).
nel menu Project & impostato su On, I'upload Root Certificate Carica un certificato radice per il
automatico dei dlip registrati sulla scheda Load / Clear / None trasferimento in modalita Secure FTP ed
dello slot B non viene eseguito. Inoltre, annulla le impostazioni
I'opzione Chunk é disattivata e non puo essere .
selezionata. Root Certificate Status Visualizza lo stato del caricamento del
Default Seleziona il server per I'upload dei file. Il Loaded / No Certificate certificato radice per il trasferimento in
: . ’ m lita re FTP.
Upload server selezionato qui diventa la _°d_a_ a Sec.u € - —
Server destinazione per I'upload automatico dei Reset Ripristina sui valori predefiniti le
file originali e dei file proxy, nonché la Execute / Cancel impostazioni di Server Settings.
destinazione per I'upload dei file dalla - Execute: Esegue la funzione.
schermata delle miniature. Server Come Server Settings1.
Mostra il nome di visualizzazione Settings2 -
configurato in Server Settings da1a 3. gerv_er R Come Server Settings?.
- - - - ettings
Clear Execute / Cancel Rimuove dall'elenco i trasferimenti 9
Completed completati.
Jobs Execute: Esegue la funzione.

Clear All Jobs  Execute / Cancel

Rimuove tutti i trasferimenti dall’'elenco.
Execute: Esegue la funzione.




10 | 6.Menu visualizzati e impostazioni: Menu Network

Network >Network Reset
Ripristina le impostazioni di rete.

Voce Impostazione della voce secondaria

Descrizione

Reset Execute / Cancel

Ripristina le impostazioni di rete.
Execute: Esegue la funzione.
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Menu Maintenance

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Maintenance >Hours Meter
Visualizza il tempo cumulativo di funzionamento.

Maintenance >Language
Imposta la lingua di visualizzazione.

Voce Impostazione della voce secondaria

Descrizione

Select

Imposta la lingua di visualizzazione.
SET: Imposta la lingua.

Maintenance >Clock Set

Consente di specificare le impostazioni relative all’'orologio interno.

Voce Impostazione della voce secondaria Descrizione

Hours Visualizza le ore d'uso totali (non puo

(System) essere azzerato).

Hours(Reset) Visualizza le ore d'uso totali (puo essere
azzerato).

Reset Execute / Cancel Azzera l'indicazione Hours(Reset) a 0.

Execute: Esegue la funzione.

Voce Impostazione della voce secondaria

Descrizione

Time Zone Da UTC -12:00 a UTC +14:00

Imposta la differenza rispetto all'ora UTC
in passi di 30 minuti.

Maintenance >Version
Visualizza informazioni sulla versione.

Date Mode YYMMDD / MMDDYY / DDMMYY

Seleziona il formato di visualizzazione
della data.

YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12h/24h 12h 7 24h

Seleziona il formato di visualizzazione
dell’ora.

12h: Orologio a 12 ore

24h: Orologio a 24 ore

Voce Impostazione della voce secondaria Descrizione

Version VXXX Visualizza la versione del software del
Number camcorder.

Version Up Execute / Cancel Aggiorna il camcorder.”

Execute: Esegue la funzione.
* Questa funzione aggiorna il software del
camcorder.

Lens Version  Vxx
Number

Visualizza la versione del software
dell'obiettivo E-mount.

Date

Imposta la data corrente.
SET: Imposta il valore.

Time

Imposta I'ora corrente.
SET: Imposta il valore.

Maintenance >All Reset

Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Voce Impostazione della voce secondaria

Descrizione

Reset Execute / Cancel

Ripristina i valori predefiniti di fabbrica di

tutte le impostazioni.
Execute: Esegue la funzione.

[Nota]

Il file 3D LUT file importato tramite Base
Look >Import from Media(B), Import

from Cloud(Private), oppure Import from
Cloud(Share) (pagina 93) nel menu Paint/
Look non pud essere eliminato. Per eliminare
tutti i file 3D LUT, selezionare Base Look
>Delete All nel menu Paint/Look (pagina 93).

Reset without Execute / Cancel
Network

Ripristina le impostazioni predefinite di
fabbrica dei menu, eccetto le
impostazioni del menu Network.
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Impostazioni e valori predefiniti del menu Shooting

Impostazioni e valori predefiniti di ISO/Gain

Il campo di valori configurabili e i valori predefiniti di ISO/Gain (pagina 80) variano in base alle impostazioni di Mode, Target Display, Base Look >Select e Base Sensitivity. Le opzioni disponibili

sono evidenziate in grigio.

Quando Mode & impostato su ISO

Target Display

SDR(BT.709)

HDR(HLG)

Comuni a SDR(BT.709) e HDR(HLG)

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

Da User1 a User16

Base Sensitivity

Low

High

Low

High

Low

High

1SO 320

Impostaz. predef. ISO/Gain<L>

ISO 400

I1SO 500

ISO 640

Impostaz. predef. ISO/Gain<M>

ISO 800

Impostaz. predef. ISO/Gain<L>

Impostaz. predef. ISO/Gain<L>

1SO 1000

1SO 1250

Impostaz. predef. ISO/Gain<H>

1SO 1600

Impostaz. predef. ISO/Gain<M>

Impostaz. predef. ISO/Gain<M>

1SO 2000

1SO 2500

1SO 3200

Impostaz. predef. ISO/Gain<H>

Impostaz. predef. ISO/Gain<H>

1SO 4000

I1SO 5000

Impostaz. predef. ISO/Gain<L>

ISO 6400

1SO 8000

1SO 10000

Impostaz. predef. ISO/Gain<M>

1SO 12800

Impostaz. predef. ISO/Gain<L>

Impostaz. predef. ISO/Gain<L>

1SO 16000

1SO 20000

Impostaz. predef. ISO/Gain<H>

1SO 25600

Impostaz. predef. ISO/Gain<M>

Impostaz. predef. ISO/Gain<M>

1SO 32000

I1SO 40000

1SO 51200

Impostaz. predef. ISO/Gain<H>

Impostaz. predef. ISO/Gain<H>

ISO 64000

I1SO 80000

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600




13 6. Menu visualizzati e impostazioni: Impostazioni e valori predefiniti del menu Shooting

Quando Mode & impostato su dB

Impostazioni disponibili
-3dB

-2dB

-1dB

0dB Impostaz. predef. ISO/Gain<L>
1dB

2dB

3dB

4dB

5dB

6dB Impostaz. predef. ISO/Gain<M>
7dB

8dB

9dB

10dB

11dB

12dB Impostaz. predef. ISO/Gain<H>
13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Impostazioni e valori predefiniti di AGC Limit

Il campo di valori configurabili e i valori predefiniti di AGC Limit (pagina 82) variano in base alle impostazioni di Mode, Target Display, Base Look >Select e Base Sensitivity. Le opzioni disponibili

sono evidenziate in grigio.

Quando Mode & impostato su ISO

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

Comuni a SDR(BT.709) e HDR(HLG)

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

Da User1 a User16

Base Sensitivity

Low High

Low

High

Low

High

Low High

1SO 400

1SO 500

1SO 640

1SO 800

1SO 1000

1SO 1250

1SO 1600

1SO 2000

Impostazione predefinita

1SO 2500

1SO 3200

1SO 4000

I1SO 5000

Impostazione predefinita

Impostazione predefinita

Impostazione predefinita

ISO 6400

ISO 8000

1SO 10000

1SO 12800

1SO 16000

1SO 20000

1SO 25600

1SO 32000

Impostazione predefinita

ISO 40000

1SO 51200

ISO 64000

I1SO 80000

Impostazione predefinita

Impostazione predefinita

Impostazione predefinita

1SO 102400

1SO 128000

1SO 160000

I1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Quando Mode & impostato su dB

Impostazioni disponibili
3dB

6dB

9dB

12dB

15dB Impostazione predefinita
18dB

21dB

24dB

27dB

30dB
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Impostazioni di qualita dell'immagine salvate per ciascuna modalita di ripresa

In questa sezione si indica in che modo viene salvato lo stato corrente delle voci di configurazione relative alla qualita dell'immagine nelle modalita di ripresa elencate di seguito (pagina 25). Al
cambiamento della modalita di ripresa, le impostazioni salvate corrispondenti vengono applicate alla nuova modalita di ripresa.

e Modalita personalizzata SDR(BT.709)

e Modalita personalizzata HDR(HLG)

e Modalita Cine El

Di sequito si indicano quali voci di configurazione relative alla qualita dell'immagine sono salvate per le varie modalita di ripresa.

Si: impostazione salvata.

No: impostazione non salvata.

Voce di configurazione Modalita di ripresa
Modalita Custom Modalita Cine El
SDR(BT.709) | HDR(HLG)
Menu Shooting ISO/Gain/El ISO/Gain Siv No
Exposure Index No Si
Base Sensitivity Si No
Base ISO No Si
White Preset White Si Si
Tutte le altre voci Si
White Setting Si
Offset White Si No
LUT On/Off No Si
Noise Suppression Setting(Custom) Si Si No
Level(Custom) Si Si No
Setting(Cine El) No Si
Level(Cine El) No Si
Menu Paint/Look Base Look Select Si Si Si
Input? Si
Output? Si
AE Level Offset? Si
Black Si Si No
Knee Auto Knee Si No No
Tutte le altre voci Si Si No
Detail Si Si No
Matrix Si Si No
Multi Matrix Si Si No

1) Per le due modalita Custom SDR(BT.709) e HDR(HLG) vengono salvati valori di sensibilita ISO separati.
2) Le impostazioni vengono salvate per ciascun Base Look e non dipendono dalla modalita di ripresa.
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Salvataggio e caricamento dei dati di configurazione

Dati di configurazione

Le impostazioni del menu completo possono
essere salvate su una scheda di memoria
inserita nello slot per schede CFexpress Type
A/SD (B). Il file ALL pu0 essere salvato anche
su un servizio cloud. Questo consente di
richiamare rapidamente un set di impostazioni

precedentemente ottimizzato per la situazione

attuale.
| dati di configurazione sono salvati nelle
categorie indicate di sequito.

File utente

| file utente consentono di salvare le
impostazioni e i dati del menu User
personalizzabile.

E possibile salvare su ciascuna scheda di
memoria fino a 64 file.

Caricando questo file nella memoria del
camcorder, & possibile personalizzare la
configurazione del menu User.

File ALL (tutte le impostazioni)

| file ALL salvano i dati di configurazione di
tutti i menu. E possibile salvare su ciascuna
scheda di memoria fino a 64 file. E possibile
salvare su C3 Portal (servizio cloud) fino a 120
file, di cui 60 privati e 60 condivisi.

[Nota]

Per informazioni dettagliate sui contenuti salvati in un

file ALL, fare riferimento a “Impostazioni salvate in file”
(pagina 132).

Salvataggio di file utente o file
ALL

Salvataggio su una scheda di memoria

1 Inserire una scheda di memoria nello slot
per schede CFexpress Type A/SD (B)
(pagina 6).

e Per |le schede CFexpress, I'etichetta e
rivolta a sinistra.

e Perle schede SD, I'etichetta ¢ rivolta a
destra con I'angolo tagliato in basso.

2 Per un file utente, selezionare User File
>Save to Media(B) (pagina 92) >Execute
nel menu Project del menu completo.
Per un file ALL, selezionare All File >Save
to Media(B) (pagina 92) >Execute nel
menu Project del menu completo.
Viene visualizzata la schermata di
destinazione per il salvataggio del file.

3 Selezionare una riga con l'indicazione “No
File" nella schermata della destinazione
del salvataggio.

Se la riga selezionata contiene gia un File
ID, il file selezionato viene sovrascritto.
L'identificativo File ID assegnato al
momento del salvataggio puo essere
modificato tramite il menu. Per
informazioni dettagliate sulla
configurazione, fare riferimento a
“Modifica del File ID" (pagina 118).

4 Selezionare Execute nella schermata di
conferma.

Salvataggio di un file ALL su un servizio
cloud

1 Collegarsi all'unita dall’'app per
smartphone “C3 Portal App”
(pagina 70).

2 Selezionare All File >Save to Cloud(Private)
oppure Save to Cloud(Share)
(pagina 92) >Execute nel menu Project
del menu completo.
Viene visualizzata la schermata di
destinazione per il salvataggio del file.

3 Selezionare una riga con I'indicazione “No
File" nella schermata della destinazione
del salvataggio.

Se la riga selezionata contiene gia un File
ID, il file selezionato viene sovrascritto.
L'identificativo File ID assegnato al
momento del salvataggio puo essere
modificato tramite il menu. Per
informazioni dettagliate sulla
configurazione, fare riferimento a
“Modifica del File ID" (pagina 118).

4 Selezionare Execute nella schermata di
conferma.

Caricamento di file utente o file
ALL

Caricamento da una scheda di memoria

1 Inserire la scheda di memoria su cui €
salvato il file nello slot per schede
CFexpress Type A/SD (B) (pagina 6).
® Per le schede CFexpress, I'etichetta e

rivolta a sinistra.
e Per le schede SD, I'etichetta & rivolta a
destra con I'angolo tagliato in basso.

2 Per un file utente, selezionare User File
>Load from Media(B) (pagina 92)
>Execute nel menu Project del menu
completo.

Per un file ALL, selezionare All File >Load
from Media(B) (pagina 92) >Execute nel
menu Project del menu completo.
Viene visualizzato un elenco dei file.

3 Selezionare un file da caricare.
Viene visualizzata una schermata di
conferma.

4 Selezionare Execute.

[Note]

e Al termine del caricamento dei dati di configurazione
I'unita si riavvia automaticamente.

e Quando All File >Load Network Data nel menu Project
del menu completo € impostato su Off, saranno
caricate tutte le impostazioni contenute nel file ALL,
eccetto le impostazioni del menu Network.
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Caricamento di un file ALL da un servizio

cloud

1 Collegarsi all'unita dall’'app per
smartphone “C3 Portal App”
(pagina 70).

2 Selezionare All File >Load from
Cloud(Private) oppure Load from
Cloud(Share) (pagina 92) >Execute nel
menu Project del menu completo.
Viene visualizzato un elenco dei file.

3 Selezionare un file da caricare.
Viene visualizzata una schermata di
conferma.

4 Selezionare Execute.
[Note]

e Al termine del caricamento dei dati di configurazione

I'unita si riavvia automaticamente.

e Quando All File >Load Network Data nel menu Project

del menu completo & impostato su Off, saranno

caricate tutte le impostazioni contenute nel file ALL,

eccetto le impostazioni del menu Network.

Modifica del File ID

Per un file utente, selezionare User File
>File ID (pagina 92) nel menu Project

del menu completo.

Per un file ALL, selezionare All File >File ID
(pagina 92) nel menu Project del menu
completo.

Viene visualizzata una schermata per la
modifica del File ID.

Utilizzare il selettore multiplo

(pagina 7) o la manopola

multifunzione (pagina 5) per

selezionare il carattere desiderato, quindi
premere il pulsante di conferma del
selettore multiplo o la manopola
multifunzione.

Ripetere il passo 2 tutte le volte
necessarie.

Al termine dell'immissione dei caratteri,
selezionare Done.
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Connessione di monitor e dispositivi di registrazione esterni

Per visualizzare le immagini di registrazione

e riproduzione del camcorder su un monitor
esterno, selezionare il segnale di uscita del
camcorder e utilizzare il cavo appropriato per il
monitor esterno da collegare.

E possibile anche collegare dispositivi di
registrazione, ad esempio un VTR, e registrare
il segnale in uscita dal camcorder.

E possibile visualizzare sul monitor esterno

le stesse informazioni che sono visibili nel
mirino, ad esempio informazioni di stato e
menu. Impostare su On la voce Info. Disp.
(pagina 15) nella schermata Monitoring
Status oppure le opzioni della voce Output
Display (pagina 97) nel menu Monitoring

del menu completo in base al segnale da
emettere in uscita sul monitor.

[Nota]

Osservare sempre le seguenti precauzioni per il

collegamento all’'unita di monitor o dispositivi di

registrazione esterni. La mancata osservanza potrebbe

danneggiare i circuiti interni dell’unita.

- Collegare il monitor o il dispositivo di registrazione
esterno mediante un cavo CC con bassa impedenza
dilinea GND.

- Prima di procedere al collegamento di un cavo HDMI
0 un cavo coassiale da 75 Q, verificare che non vi sia
alcuna differenza di potenziale tra I'unita e lo chassis
del monitor o del dispositivo di registrazione esterno.

- Assicurarsi sempre che i dispositivi di registrazione
e monitor esterni siano spenti prima di procedere al
loro collegamento tramite cavo HDMI o cavo coassiale
da 75 Q. Collegare tutti i cavi e quindi accendere
ciascun dispositivo.

Per informazioni dettagliate, rivolgersi a un

rappresentante di assistenza Sony.

Connettore SDI OUT (tipo BNC)

Attivare o disattivare I'uscita e configurare
il formato di uscita nel menu Monitoring
(pagina 97).

Per il collegamento, utilizzare un cavo
coassiale da 75 Q disponibile in commercio.

Per avviare la registrazione
simultaneamente sul camcorder e sul
dispositivo esterno

Con l'uscita segnale SDI abilitata, impostare
SDI/HDMI Rec Control (pagina 89) >Setting
nel menu Project del menu completo su SDI/
HDMI Remote I/F o Parallel Rec per abilitare
I'emissione di un segnale di trigger REC diretto
al dispositivo esterno connesso al connettore
SDI OUT. Questo sincronizzera la registrazione
sul dispositivo esterno con il camcorder.
[Note]
e Se il dispositivo esterno connesso non &€ compatibile
con il segnale di trigger REC, il dispositivo non puo
essere comandato.

e Se non € inserito un supporto, viene solamente
emesso il segnale di trigger REC.

Connettore HDMI OUT (tipo A)

Attivare o disattivare I'uscita e configurare
il formato di uscita nel menu Monitoring
(pagina 97) del menu completo.

Per avviare la registrazione
simultaneamente sul camcorder e sul
dispositivo esterno

Con l'uscita segnale HDMI abilitata, impostare
HDMI TC Out >Setting (pagina 95) nel menu
TC/Media del menu completo su On, quindi
impostare SDI/HDMI Rec Control >Setting
(pagina 89) nel menu Project su SDI/

HDMI Remote I/F o Parallel Rec per abilitare
I'emissione in uscita di un segnale di trigger
REC diretto al dispositivo esterno connesso al
connettore HDMI OUT. Questo sincronizzera
la registrazione sul dispositivo esterno con il
camcorder.

[Note]

e Se il dispositivo esterno connesso non & compatibile
con il segnale di trigger REC, il dispositivo non puo
essere comandato.

e Se impostato su SDI/HDMI Remote I/F, viene emesso
solo il segnale di trigger REC nel caso in cui non sia
inserito nessun supporto di registrazione.
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Sincronizzazione dei codici temporali

Il codice temporale dell’'unita puo essere [Note] ‘| Impostare il codice temporale del

sincronizzato con quello di altri dispositivi. ¢ Durante il funzionamento in modalita di .
sincronizzazione esterna, il codice temporale camcorder con la voce Timecode
acquisisce istantaneamente la sincronizzazione (pagina 95) del menu TC/Media del
con il codice temporale esterno e nella sezione di menu completo.
visualizzazione dei dati viene visualizzato il valore

H H H H del codice temporale esterno. Tuttavia, non avviare
S|ncr0n|zza2|0ne del COdlce immediatamente la registrazione. Prima di avviare la 2 Controllare che il selettore TC IN/OUT

tempora|e con altri d|Sp0$|t|V| registrazione & necessario attendere alcuni secondi la (pagina 4) si trovi sulla posizione OUT,

stabilizzazione del generatore del codice temporale. T .
e Se la frequenza del codice temporale di riferimento quindi collegare il connettore TC IN/TC

AR . . . e la frequenza fotogrammi del camcorder non OUT al connettore di ingresso del codice
Impostare I'unita che fornisce il codice sono identiche, non sara possibile ottenere la temporale del dispositivo che si desidera
temporale su una modalita in cui il codice sincronizzazione e il camcorder non potra funzionare sincronizzare.
temporale continui ad avanzare (es. Free Run correttamente. In questo caso, il codice temporale
o Clock). non potra sincronizzarsi correttamente con il codice
temporale esterno.

1 Impostare I’opzione Timecode e E possibile che il codice temporale si scosti di un

(pagina 95) del menu TC/Media del :ic;te?ignr]aengga all’ora rispetto al codice temporale di

menu completo come indicato di seguito.
Mode: Preset

Run: Free Run Per rilasciare la sincronizzazione esterna

Cambiare I'impostazione di Timecode nel
2 Premere il pulsante programmabile menu TC/Media del menu completo.
(pagina 51) a cui e assegnata la La sincronizzazione esterna viene annullata
funzione DURATION/TC/U-BIT per anche quando si cambia frequenza di sistema
visualizzare il codice temporale sullo o quando si avvia la registrazione in una
schermo. modalita di registrazione speciale (Slow &

Quick Motion o Interval Rec).

3 Controllare che il selettore TC IN/OUT
(pagina 4) si trovi sulla posizione IN,
quindi fornire un codice temporale di
riferimento per la sincronizzazione della Sincronizzazione del codice

frequenza di sistema del camcorder con il . . .
connettore TC IN/TC OUT. temporale di un altro dispositivo

. con il codice temporale del
Il generatore del codice temporale del

camcorder si sincronizza con il codice camcorder
temporale di riferimento e sullo schermo
appare l'indicazione “EXT-LK".

Una volta trascorsi dieci secondi circa
dall’acquisizione della sincronizzazione,

lo stato di sincronizzazione esterno viene
mantenuto anche se la sorgente di riferimento
esterna del codice temporale viene scollegata.

Impostare 'unita che fornisce il codice
temporale su una modalita in cui il codice
temporale continui ad avanzare (es. Free Run
o Clock).
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Gestione ed editing di clip con un computer

Connessione con cavo USB

Utilizzo di un lettore di schede (opzione)

Collegare un lettore di schede CFexpress o

SD a un computer mediante un cavo USB ed
inserire una scheda di memoria nello slot del
lettore di schede. La scheda di memoria viene
riconosciuta come un’unita di estensione del
computer. Sui computer supportati, € possibile
importare clip ad alta velocita utilizzando la
modalita di memorizzazione di massa del
camcorder.

Utilizzo della modalita di
memorizzazione di massa

[Nota]

La modalita di archiviazione di massa non puo essere
utilizzata quando é impostata su On la voce Modem
>Setting nel menu Network del menu completo, oppure
quando e impostata su On la voce Wired LAN >Setting
nel menu Network del menu completo. Impostare le due
voci su Off.

Collegare il camcorder mediante un cavo
USB, quindi inserire una scheda di memoria
nello slot A o nello slot B. La scheda di
memoria viene riconosciuta come un’unita di
estensione del computer.

1 Servendosi di un cavo USB, collegare il
connettore USB-C (pagina 7)
connettore USB/multi (pagina 7) al
computer.

2 Spostare il selettore POWER del
camcorder su ON.
Sullo schermo del mirino viene
visualizzato un messaggio di conferma
della connessione USB.

[Nota]

I messaggio di conferma della connessione

USB non viene visualizzato se ¢ gia visualizzato
un altro messaggio di conferma o un indicatore
di avanzamento, ad esempio durante la
formattazione o il recupero di una scheda di
memoria.

I messaggio di conferma verra visualizzato al
termine della formattazione o del recupero. Il
messaggio di conferma USB non é visualizzato
neanche quando e visualizzata la schermata delle
proprieta del clip. Il messaggio verra visualizzato
al termine dell'operazione o quando si ritorna alla
schermata delle miniature.

3 Ruotare la manopola multifunzione e
selezionare Execute.

4 Su Windows, controllare che la scheda sia
aggiunta come disco rimovibile nella
finestra “My Computer”.

Su Mac, controllare che sia stata creata sul
Desktop una cartella con il nome “NO
NAME" o “Untitled” (modificabile).

[Note]
e Non eseguire le seguenti operazioni se l'indicatore di
accesso ¢ illuminato in rosso.
- Spegnere lI'apparecchio o scollegare il cavo di
alimentazione
- Rimuovere una scheda di memoria
- Scollegare il cavo USB
e |l funzionamento non € garantito con tutti i computer.

Utilizzo di un sistema di editing
non lineare

In un sistema di editing non lineare,
necessario utilizzare un software di editing
(opzione) che supporti i formati registrati dal
camcorder.

Utilizzare un software applicativo dedicato
per salvare in anticipo sul disco rigido del
computer i clip di cui eseguire I'editing.
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Precauzioni per |'uso

Condensazione

Qualora l'unita venga spostata rapidamente

da un ambiente freddo a uno caldo, oppure se

la temperatura ambiente dovesse aumentare
improvvisamente, & possibile che si formi umidita

sulle superfici esterne dell’'unita e/o al suo interno.

Questo fenomeno € denominato condensazione.
In tal caso, spegnere |'unita ed attendere la
scomparsa della condensazione prima di
riavviarla. L'utilizzo dell’'unita mentre & presente
condensazione pud causare danni all'unita stessa.

Pannelli LCD

Il pannello LCD di cui € dotato I'apparecchio &
prodotto con tecnologia ad alta precisione che
consente di ottenere una percentuale di pixel
funzionanti minima di ben 99,99%. E quindi possibile
che una piccolissima percentuale dei pixel possa
rimanere “bloccata’, sempre disattivata (nera), sempre
attivata (rossa, verde o blu) oppure lampeggiante. E
inoltre possibile che, dopo un lungo periodo d'uso,
alcuni pixel si “blocchino” spontaneamente a causa
delle caratteristiche fisiche del display a cristalli
liquidi. Tali fenomeni non sono il risultato di guasti e
non hanno alcun effetto sui dati registrati.

Fenomeni intrinsechi al sensore
immagini (MOS della telecamera

[Nota]

Di seqguito si descrivono alcuni fenomeni che potrebbero
apparire nelle immagini. Tali fenomeni sono intrinsechi
dei sensori di immagine. Non possono esser considerati
malfunzionamenti.

Macchiette bianche

| sensori di immagine sono prodotti con
tecnologie di elevatissima precisione.
Ciononostante possono presentarsi sullo
schermo in alcuni rari casi piccole macchiette
bianche, causate da raggi cosmici ecc.

Questo fenomeno ¢ intrinseco al principio di
funzionamento dei sensori immagine e non
indica la presenza di guasti.

Le macchiette bianche tendono ad apparire
principalmente nei seguenti casi:

® in caso di elevate temperature ambiente

® se ¢ stato aumentato il guadagno (sensibilita)

Sfarfallio

Nelle riprese effettuate con illuminazione
prodotta da lampade fluorescenti o LED o

ai vapori di sodio o di mercurio, lo schermo
potrebbe presentare fenomeni di sfarfallio e i
colori potrebbero apparire alterati.

Componenti di consumo

e La ventola e la batteria sono considerate
componenti di consumo che dovranno
essere sostituite periodicamente.

Se lI'apparecchio viene utilizzato a
temperatura ambiente, il ciclo normale

di sostituzione ¢ di circa 5 anni. Tuttavia,
cid ha un valore puramente indicativo e
non implica alcuna garanzia sulla durata
di vita prevista di questi componenti. Per
ulteriori informazioni sulla sostituzione dei

componenti, rivolgersi al proprio rivenditore.

e | avita utile prevista dell’adattatore CA e
del condensatore elettrolitico & di circa 5
anni a temperature normali e in condizioni
di utilizzo normale (8 ore al giorno per 25
giorni al mese). Se le condizioni di utilizzo
eccedono i valori normali sopra indicati, la
vita prevista si ridurra proporzionalmente.

e || morsetto della batteria dell'apparecchio (il
connettore per pacchi batteria e adattatori
CA) & un prodotto di consumo.

Se i piedini del morsetto sono piegati

e deformati a causa di urti o vibrazioni,

0 se vengono corrosi a causa di un uso
prolungato all’aria aperta, I'alimentazione
potrebbe non essere fornita correttamente.
Si consiglia di eseguire dei controlli

periodici per assicurare il funzionamento
corretto dell'apparecchio e prolungarne

la vita utile. Per ulteriori informazioni sui
controlli, contattare il servizio tecnico o un
rappresentante Sony.

Batteria ricaricabile incorporata

Il camcorder & dotato di una batteria
ricaricabile interna che consente la
memorizzazione di data, ora e altre
impostazioni anche quando é spento.

La batteria interna si ricarica mentre il
camcorder rimane collegato a una presa di
corrente di rete tramite I'adattatore CAo a

un pacco batteria completamente carico. La
ricarica richiede 24 ore indipendentemente
dal fatto che il camcorder sia acceso o
spento. Se non € connesso un adattatore

CA o il camcorder viene utilizzato senza
pacco batteria, la batteria ricaricabile si
scarichera completamente dopo circa 2 mesi.
Utilizzare il camcorder dopo aver ricaricato la
batteria. In ogni caso, il camcorder funziona
correttamente anche se la batteria € scarica,
con l'eccezione della registrazione della data.

Ambienti d'impiego e conservazione

Conservare su una superficie piana in un

ambiente ben ventilato.

Evitare di usare o conservare |'apparecchio

negli ambienti indicati di seqguito.

® |n presenza di temperature eccessivamente
alte o basse (temperatura di funzionamento
permessa compresa fra 0 °C e 40 °C)
Ricordare che in estate, in climi caldi, la
temperatura all'interno di un‘auto con i

finestrini chiusi puo facilmente superare i 50 °C.

® |n ambienti umidi o polverosi. In ambienti in
cui I'apparecchio potrebbe essere esposto
alla pioggia.

e |n ambienti soggetti a forti vibrazioni.

e |n prossimita di intensi campi magnetici.

e |In prossimita di impianti di trasmissione
radio o TV che producono forti campi
elettromagnetici.

® |n esposizione alla luce solare diretta o in
prossimita di fonti di riscaldamento per
periodi prolungati.

Nota sui raggi laser

| raggi laser possono danneggiare il sensore
immagine CMOS. Qualora vengano riprese
scene in cui sono presenti raggi laser, evitare
che tali raggi colpiscano I'obiettivo dell’unita.

| particolare, i fasci laser ad alta potenza
generati da dispositivi medicali o di altro tipo
possono causare danni anche se riflessi o diffusi.

Prevenzione delle interferenze
elettromagnetiche causate da dispositivi
di comunicazione portatili

L'uso di telefoni portatili e di altri

dispositivi di comunicazione in prossimita

di questa telecamera potrebbe causare
malfunzionamenti ed interferenze con i
segnali audio e video. Si consiglia di spegnere
eventuali dispositivi di comunicazione portatili
nelle vicinanze di questa telecamera.

Precauzioni per la sicurezza

e SONY NON SARA RESPONSABILE PER DANNI
DI QUALSIASI TIPO RISULTANTI DALLA
MANCATA IMPLEMENTAZIONE DI ADEGUATE
MISURE DI SICUREZZA SUI DISPOSITIVI DI
TRASMISSIONE, DA INEVITABILI PERDITE
O FUGHE DI DATI RISULTANTI DALLE
SPECIFICHE TECNICHE DELLA TRASMISSIONE
O DA PROBLEMATICHE RELATIVE ALLA
SICUREZZA DI QUALSIASI TIPO.

e A seconda dell'ambiente operativo, il
sistema potrebbe risultare accessibile in rete
a terzi non autorizzati. Prima di collegare
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I'apparecchio in rete, assicurarsi che la rete
sia protetta in modo sicuro.

Il contenuto trasmesso pud essere
intercettato da terze parti non autorizzate
che si trovano in prossimita dei segnali
senza la conoscenza dell’'utente. Quando si
utilizza la modalita di comunicazione LAN
wireless, implementare adeguate misure di
sicurezza per proteggere il contenuto della
comunicazione.

Il collegamento del prodotto a una rete
deve essere realizzato mediante un sistema
in grado di fornire funzioni di protezione,
ad esempio un router o un firewall. In caso
di collegamento senza tale protezione si
potrebbero verificare problemi di sicurezza.
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Formati di uscita e limitazioni

Le impostazioni predefinite sono indicate in grassetto (ad esempio, 1920x1080P (Level A)).

[Note]

e Larisoluzione del formato di uscita é limitata dalle impostazioni delle voci Rec Format >Frequency, Codec e Video
Format nel menu Project del menu completo (pagina 86).

e Larisoluzione del formato di uscita & limitata anche dalla combinazione con la frequenza fotogrammi S&Q. Oltre
a quanto indicato nella seguente tabella dei formati di uscita per il connettore SDI OUT/HDMI OUT, I'uscita HDMI
passa a Full HD o inferiore anche nei casi indicati di seguito.

- S&Q Motion >Setting nel menu Shooting & impostato su On.

- S&Q Motion >Frame Rate nel menu Shooting & superiore a 60fps.

- Rec Format >Codec nel menu Project € impostato su RAW o RAW & XAVC-1, oppure Output On/Off >SDI nel
menu Monitoring € impostato su On.

® |n questi casi, le opzioni di uscita HDMI 4096x2160P e 3840x2160P di Output Format >SDI/HDMI (pagina 97) nel
menu Monitoring sono disattivate e non possono essere selezionate.

e ['immagine non viene emessa in uscita se € configurata una risoluzione superiore a quella dell'immagine di
riproduzione.

Formati di uscita per il connettore SDI OUT/HDMI OUT

Impostazione
della frequenza di

Impostazione del
codec

Impostazioni del
formato RAW/di

Formato di uscita (Output Format nel
menu Monitoring)

Impostazione Impostazione del  Impostazioni del Formato di uscita (Output Format nel
della frequenza di codec formato RAW/di menu Monitoring)
sistema (Rec Format registrazione SDI HDMI
(Rec Format >Codec nel menu  (Rec Format >RAW
>Frequency nel Project) Output Format/Video
menu Project) Format nel menu
Project)
50/59.94Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
RAW & XAVC 3840x2160P
1920x1080P
1920x1080i
3840%2160(RAW) (3840x2160 RAW) 3840x2160P
1920x1080P
1920x1080i
RAW(HDMI) 4240x2392(RAW) 1920x1080P (42402392 HDMI
RAW(HDMI) & (Level A) RAW)
XAVC-| 1920x1080P
(Level B)

1920x1080i

sistema (Rec Format registrazione SDI HDMI
(Rec Format >Codec nel menu  (Rec Format >RAW
>Frequency nel Project) Output Format/Video
menu Project) Format nel menu
Project)
50/59.94Hz XAVC- 4096x2160(Video) 4096x2160P" 4096x2160P
XAVC-L 4096x2160P 1920x1080P
4096x2160P 1920x1080i
3840x2160P 3840x2160P
3840x2160P 1920x1080P
3840x2160P 1920x1080i
1920x1080P 1920x1080P
(Level A)
1920x1080P 1920x1080i
(Level A)
1920x1080P 1920x1080P
(Level B)
1920x1080P 1920x1080i
(Level B)
1920x1080i 1920x1080i
3840%2160(Video) 3840x2160P 3840x2160P
3840x2160P 1920x1080P
3840x2160P 1920x1080i
1920x1080P 1920x1080P
(Level A)
1920x1080P 1920x1080i
(Level A)
1920x1080P 1920x1080P
(Level B)
1920x1080P 1920x1080i
(Level B)
1920x1080i 1920x1080i
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Impostazione

della frequenza di

Impostazione del
codec

Impostazioni del
formato RAW/di

Formato di uscita (Output Format nel
menu Monitoring)

Impostazione
della frequenza di

Impostazione del

codec

Impostazioni del
formato RAW/di

Formato di uscita (Output Format nel

menu Monitoring)

sistema (Rec Format registrazione SDI HDMI sistema (Rec Format registrazione SDI HDMI
(Rec Format >Codec nel menu  (Rec Format >RAW (Rec Format >Codec nel menu  (Rec Format >RAW
>Frequency nel Project) Output Format/Video >Frequency nel Project) Output Format/Video
menu Project) Format nel menu menu Project) Format nel menu
Project) Project)
50/59.94Hz XAVC-I 1920x1080(Video) 1920x1080P 1920x1080P 25/29.97Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096%2160P
XAVC-L (Level A) RAW & XAVC-| 3840x2160P
1920x1080P 1920x1080i 1920x1080P
(Level A) 1920x10801
2353;1§$0P 1920x1080P 3840x2160(RAW) (3840x2160 RAW) 3840x2160P
- 1920x1080P
23;5);13)80P 1920x1080i —1920><1080i
1920x1080i 1920x1080i 2ﬁwé:gm:; . 4240%2392(RAW) 1920x1080P (;:\jlv())x2392 HDMI
(Uscita arrestata) 720x480P"? XAVC-| 1920x1080PsF
720x576P"? XAVC-| 4096x2160(Video) ~ 4096x2160P"  4096x2160P
XAVC-L 4096x2160P 1920x1080P
3840x2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
3840x2160(Video) 3840x2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
1920x1080(Video) 1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
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Impostazione Impostazione del  Impostazioni del Formato di uscita (Output Format nel
della frequenza di codec formato RAW/di menu Monitoring)
sistema (Rec Format registrazione SDI HDMI
(Rec Format >Codec nel menu  (Rec Format >RAW
>Frequency nel Project) Output Format/Video
menu Project) Format nel menu
Project)
23.98Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
RAW & XAVC- 3840x2160P
1920x1080P
3840x2160(RAW) (3840%2160 RAW) 3840x2160P
1920x1080P
RAW(HDMI) 4240%2392(RAW) 1920x1080P (42402392 HDMI
RAW(HDMI) & RAW)
XAVC-I
XAVC-I 4096x2160(Video) 4096x2160P" 4096x2160P
XAVC-L 4096x2160P 1920x1080P
3840x2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
3840x2160(Video) 3840x2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080(Video) 1920x1080P 1920x1080P
24Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
RAW & XAVC 1920x1080P
XAVC-I 4096x2160(Video) 4096x2160P" 4096x2160P
1920x1080P 1920x1080P

1) La visualizzazione della schermata non pu0 essere incorporata.
2) Quando la frequenza di sistema & 59.94.
3) Quando la frequenza di sistema & 50.
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Ricerca e risoluzione dei problemi

Alimentazione

Problema

Causa

Soluzione

Problema

Causa

Soluzione

Il camcorder non si accende.

Non € montata una batteria
e non viene fornita
alimentazione al connettore
DCIN.

Montare una batteria (pagina 18) o
collegare alla rete elettrica mediante un
adattatore CA (pagina 19).

Nell'audio registrato e
presente un alto livello di
rumore.

Il livello audio & troppo
basso.

Regolare i livelli di registrazione audio
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 49).

Quando é selezionato un microfono
esterno, regolare anche I'impostazione
INPUT MIC Reference sotto Audio Input
nel menu Audio (pagina 100).

La batteria € completamente
scarica.

Sostituire la batteria con una
completamente carica (pagina 18).

L'alimentazione si
interrompe durante il
funzionamento.

La batteria si € scaricata
completamente.

Sostituire la batteria con una
completamente carica (pagina 18).

La batteria si scarica
velocemente.

La temperatura ambiente e
molto bassa.

Tale condizione e dovuta alle
caratteristiche della batteria e non € un
difetto.

La batteria non & caricata
correttamente.

Ricaricare la batteria (pagina 18).

Se la batteria si scarica rapidamente
anche dopo esser stata caricata
completamente, potrebbe aver
raggiunto la fine della sua vita utile.
Sostituirla con una nuova.

Non & possibile riprodurre
clip.

E in corso I'editing di un clip.

Non e possibile riprodurre clip se sono
stati modificati i nomi di file o delle
cartelle oppure se il clip € in uso su un
computer. Questo non indica la
presenza di guasti.

E in corso la registrazione del
clip su un altro dispositivo.

Potrebbe non essere possibile
riprodurre clip registrati con altri
dispositivi, oppure potrebbero essere
visualizzati con dimensioni errate.
Questo non indica la presenza di guasti.

Registrazione/riproduzione

Dispositivi esterni

Problema

Soluzione

Problema

Causa

Soluzione

La registrazione non si avvia
quando si preme il pulsante

di registrazione START/STOP.

La scheda di memoria &
piena.

Sostituire la scheda di memoria con
un‘altra che disponga di spazio
sufficiente.

Il computer non riconosce il
camcorder.

Scollegare il cavo USB dal computer, quindi collegarlo di nuovo

saldamente.

Scollegare il cavo USB dal computer, riavviare il computer e
ripetere nuovamente la procedura nell’'ordine corretto.

Collegare il computer e il camcorder inserendo un cavo USB nel
connettore USB-C o nel connettore USB/multi.

La scheda di memoria deve
essere ripristinata.

Ripristinare la scheda di memoria
(pagina 34).

La registrazione audio non &
possibile.

Le manopole di regolazione
AUDIO LEVEL (CH1/CH2) sono
impostate sul livello minimo.

Regolare i livelli di registrazione audio
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 49).

Non é possibile caricare clip sul

computer.

Scollegare il cavo USB dal computer, riavviare il camcorder e quindi

ricollegarlo.

Un apposito software applicativo deve essere installato per poter
caricare clip sul computer (pagina 121).

Il suono registrato & distorto.

Il livello audio & troppo
elevato.

Regolare i livelli di registrazione audio
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 49).
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Connessione LAN wireless 3 Inserire un piccolo cacciavite nel foro e ruotarlo in senso antiorario.
e || filtro ND si sposta sulla posizione Clear ruotando in senso antiorario. Continuare a ruotare
il cacciavite fino a raggiungere la posizione Clear.

[Nota] e Utilizzare un cacciavite con diametro massimo di 2,4 mm. La profondita di inserimento del
La presenza di ostruzioni o interferenze elettromagnetiche fra il camcorder e il punto di accesso LAN wireless oppure cacciavite e di circa 3,0 cm.

la configurazione dell’ambiente (ad esempio il materiale delle pareti), potrebbe ridurre il campo di comunicazione

possibile o addirittura impedire completamente la connessione. Qualora si rilevino tali problemi, controllare lo stato “

della connessione o della comunicazione spostando il camcorder in un altro luogo oppure avvicinando il camcorder al
punto di accesso o dispositivo terminale utilizzato.

Problema Soluzione

Un dispositivo terminale non ® Controllare la connessione LAN wireless (indirizzo IP, ecc.).

puod accedere al camcorder. ® | e impostazioni di comunicazione tra il punto di accesso e il
client potrebbero non essere valide. Per informazioni dettagliate,
fare riferimento alle istruzioni per I'uso del punto di accesso.

000000000000

Non é possibile eseguire il login  Verificare il nome utente e la password impostati.
sul camcorder.

:

Foro per cacciavite
(con coperchietto rimosso)

Connessione Internet

4 Spostare il selettore ND PRESET/VARIABLE (pagina 5) sulla posizione PRESET, quindi
spostare i pulsanti su/git ND FILTER POSITION (pagina 5) sulla posizione CLEAR.

Problema Soluzione [ |
s ) - Note
L'upload del file non avviene I nom? utente e la password del server potrebbero non essere e Non utilizzare questa procedura durante il normale funzionamento dell’apparecchio. Utilizzare questa procedura
correttamente. corretti. solo se il filtro ND non si muove. Il filtro ND potrebbe danneggiarsi se questa procedura viene utilizzata durante il
Immettere nome utente e password corretti. normale funzionamento.
La funzione di upload di file Le condizioni del segnale potrebbero essere insufficienti. e Dopo aver utilizzato questa procedura, rivolgersi a un centro di assistenza Sony per la riparazione del camcorder.
potrebbe non essere disponibile. Spostare il camcorder in un luogo diverso e riprovare. o E::g:)eI esecuzione di questa procedura, sara possibile eseguire riprese anche se viene visualizzato un messaggio di

Durante I'utilizzo del filtro ND

Problema Soluzione

Il filtro ND non si muove. Spostare manualmente il filtro sulla posizione Clear utilizzando la
procedura descritta di seguito.

1 Spostare il selettore POWER del camcorder su Off.

2 Rimuovere il coperchietto rotondo sul lato inferiore.
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Messaggi di errore e avvisi

Qualora si verifichino awvisi, avvertenze o condizioni che richiedono una conferma, il mirino del
camcorder visualizza un messaggio, la spia di registrazione/tally inizia a lampeggiare e viene

emesso un segnale acustico.
Il segnale acustico di avvertimento viene emesso sulle cuffie connesse al connettore cuffie.

Messaggi di errore

Il camcorder si arrestera nel caso abbia luogo una condizione che causa la visualizzazione di un
messaggio del tipo seguente.

Messaggio sul mirino

Segnale
acustico di
avvertimento

Spia di
registrazione/
tally

Causa e soluzione

Battery End

Continuo

Lampeggia
rapidamente

Il pacco batteria & scarico. La registrazione &
disabilitata.

Arrestare le operazioni e sostituire il pacco
batteria.

Temperature High

Intermittente

Lampeggiante

La temperatura interna é elevata.
Spegnere il camcorder e lasciarlo raffreddare
prima di utilizzarlo nuovamente.

Media Temperature
High

Intermittente

Lampeggiante

La temperatura della scheda CFexpress risulta
elevata.

Sostituire la scheda o lasciarla raffreddare prima
di utilizzarla nuovamente.

Messaggio sul mirino  Segnale Spia di Causa e soluzione
acustico di registrazione/
avvertimento tally
E + codice d'errore Continuo Lampeggia Indica un‘anomalia del camcorder. La

rapidamente

registrazione si arresta, anche se il mirino
continua a visualizzare @REC.

Spegnere il camcorder e verificare eventuali
problemi nei dispositivi collegati, cavi o supporti di
memorizzazione. Se il messaggio d'errore persiste
dopo aver riacceso il camcorder, rivolgersi al
proprio rappresentante di assistenza tecnica Sony.
(Se il camcorder non si spegne spostando su OFF
il selettore di alimentazione POWER, rimuovere la
batteria o scollegare I'alimentazione dal
connettore DCIN).

In base allo stato, il camcorder potrebbe emettere
un avvertimento acustico o visualizzare un
messaggio di errore.

Voltage Low

Intermittente

Lampeggiante

La tensione sul connettore DC IN & bassa (livello 1).
Controllare la sorgente di alimentazione.

Insufficient Voltage

Continuo

Lampeggia
rapidamente

La tensione sul connettore DCIN ¢ insufficiente
(livello 2). La registrazione & disabilitata.
Collegare un‘altra sorgente di alimentazione.

Media Near Full

Intermittente

Lampeggiante

La capacita rimanente sulla scheda di memoria si
sta esaurendo.
Sostituire non appena possibile.

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Media Full Continuo Lampeggia  Non e possibile registrare o copiare clip perché la
rapidamente capacita rimanente sulla scheda di memoria &
insufficiente.
Sostituire immediatamente.

Clips Near Full Intermittente Lampeggiante Ci si sta avvicinando al numero massimo di clip
che possono essere registrati sulla scheda di
memoria.

Sostituire non appena possibile.
Clips Full Continuo Lampeggia  E stato raggiunto il numero massimo di clip che

rapidamente

possono essere registrati sulla scheda di memoria.
Non & possibile registrare o copiare altri clip.
Sostituire immediatamente.

Messaggio sul mirino Segnale

Spia di
acustico di
avvertimento tally

registrazione/

Causa e soluzione

Last Clip Recording

Intermittente

Lampeggiante

Il clip in corso di registrazione & I'ultimo clip che
puo essere registrato in quanto e stato raggiunto
il numero massimo di clip consentito.

Preparare una nuova scheda di memoria.

Media(A)" Life Near
End

Intermittente

Lampeggiante

La scheda di memoria si sta avvicinando alla fine
della sua vita utile. Sostituire non appena possibile.

Battery Near End

Intermittente Lampeggiante

La carica rimanente del pacco batteria si sta
esaurendo.
Ricaricare non appena possibile.

Media(A)" Life End

Continuo

Lampeggia
rapidamente

La scheda di memoria ha raggiunto la fine della
sua vita utile. Sostituire immediatamente.

Media(A)" Near Full

Intermittente

Lampeggiante

Quando si utilizza la funzione Simul Rec
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Messaggio sul display

Causa e soluzione

Messaggio sul mirino  Segnale Spia di Causa e soluzione
acustico di registrazione/
avvertimento tally
Media(A)" Full Continuo Lampeggia  Quando si utilizza la funzione Simul Rec

rapidamente

Media Error
Media (A) " Needs to be Restored

Si e verificato un errore sulla scheda di memoria e la scheda
deve essere ripristinata.
Ripristinare la scheda di memoria.

Media(A)" Clips Near Full - Intermittente

Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A)" Clips Full Continuo

Lampeggia  Quando si utilizza la funzione Simul Rec

rapidamente

Media Error
Cannot Record to Media (A) "

La scheda di memoria potrebbe essere danneggiata e non
puo essere utilizzata per la registrazione.

La riproduzione ¢ possibile, & consigliabile quindi eseguire
una copia e sostituire la scheda di memoria.

Media(A)" Last Clip Rec Intermittente

Lampeggiante Quando si utilizza la funzione Simul Rec

Transfer Jobs Near -
Full

- Si sta raggiungendo il numero massimo di

processi di trasferimento file FTP consentito.

Transfer Jobs Full -

- E stato raggiunto il numero massimo di processi di

trasferimento file FTP consentito. Prima di
aggiungere un altro processo, eliminare quelli non
pil necessari.?

Media Error
Cannot Use Media (A)"

La scheda di memoria potrebbe essere danneggiata e non
puo essere utilizzata per la registrazione o la riproduzione.
La scheda non puo essere utilizzata nel camcorder e deve
essere sostituita.

Media (A) " Error
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa
di un errore durante I'utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

1) Per la scheda dello slot B & visualizzato “(B)".
2) E possibile selezionare ed eliminare i processi utilizzando File Transfer >View Job List (pagina 109) nel menu
Network del menu completo. E possibile eliminare processi anche dall’elenco dei processi CBM.

Messaggi di avwviso e operativi

Al centro dello schermo potranno essere visualizzati i sequenti messaggi di avviso e
operativi. Seguire le istruzioni fornite per risolvere il problema.

Media Reached Rewriting Limit
Change Media (A)"

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente.
Se si continua a utilizzare la scheda & possibile che la scheda
non consenta piu I'esecuzione di registrazioni o riproduzioni.
Per ulteriori informazioni, consultare le istruzioni per I'uso
della scheda di memoria.

The specified address is invalid.

L'indirizzo specificato non ¢é valido.
Controllare che I'impostazione sia corretta.

Cannot Use Specified Port Number

Il numero di porta specificato non & valido.
Controllare che I'impostazione sia corretta.

Messaggio sul display

Causa e soluzione

Battery Error
Please Change Battery

E stata rilevata un'anomalia nel pacco batteria.
Sostituire con un pacco batteria normale.

Fan Stopped

La ventola di raffreddamento si € arrestata.

Evitare I'utilizzo a temperature elevate. Scollegare
I'alimentazione e contattare il rappresentante di assistenza
tecnica Sony.

Backup Battery End
Please Change

La carica della batteria di backup & insufficiente.
Caricare la batteria di backup.

Unknown Media (A)"
Please Change

E stata inserita una scheda di memoria che & stata
partizionata oppure che contiene un numero di clip superiore
al massimo gestibile da questo camcorder.

La scheda non puo essere utilizzata nel camcorder e deve
essere sostituita.

Lens I/F Error(xx:xx)

E stato rilevato un errore dell’obiettivo durante la
comunicazione I/F dell'obiettivo E-mount montato.
Controllare lo stato della connessione con I'obiettivo E-mount.
Se il problema persiste, rivolgersi al servizio di assistenza Sony
riferendo il codice d'errore visualizzato (cinque caratteri fra
parentesi).

Cannot Use Media (A)"
Unsupported File System

E stata inserita una scheda con un file system diverso oppure
non formattata.

La scheda non puo essere utilizzata nel camcorder e deve
essere sostituita oppure formattata con il camcorder.

This Multi Term. acc is not supported
by the device and cannot be used.
Please verify the compatibility.

E stato rilevato un accessorio incompatibile.
L'unico accessorio Multi Terminal supportato dall’'unita &
I'impugnatura di telecomando fornita in dotazione.

Failed

Questo errore potrebbe apparire se non & possibile ottenere
un indirizzo con DHCP impostato su On.
Controllare le impostazioni del server DHCP.
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Messaggio sul display Causa e soluzione
Addition of auto upload job failed. E stato raggiunto il numero massimo di trasferimenti
consentito.

Eliminare i trasferimenti non piu necessari. Potrebbero essere
errate anche le impostazioni della destinazione dell’'upload
automatico per i file originali o i file proxy. Controllare che
I'impostazione sia corretta.

<SSID>Not found. Non & stato possibile trovare una rete (punto di accesso) con il
<SSID> specificato.
Controllare che I'impostazione sia corretta.

<SSID>Authentication Failed L'autenticazione della connessione sulla rete (punto di
accesso) con il <SSID> specificato non é riuscita.
Controllare che la password e le altre impostazioni siano
corrette.

An IP address conflict has occurred. E presente un conflitto tra gli indirizzi di rete della LAN

Please check the network settings. wireless, della rete LAN cablata o del tethering USB.
Modificare I'indirizzo manualmente o modificare le
impostazioni del router di rete.

The IP address of the Wireless LAN L'indirizzo IP della modalita punto di accesso LAN wireless &

Access Point Mode has been stato cambiato a causa di un conflitto fra gli indirizzi di rete
changed due to an IP address della modalita punto di accesso LAN wireless, LAN cablata o
conflict. tethering USB.

Verificare I'impostazione dell'indirizzo IP.

1) Per la scheda dello slot B & visualizzato “(B)".
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Impostazioni salvate in file

Voci impostate nel menu completo

Si: Impostazione salvata.

No: Impostazione non salvata.
-: Non salvata (impostazione temporanea)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/El Mode Si No
ISO/Gain<H> Si No

ISO/Gain<M> Si No

ISO/Gain<L> Si No

Exposure Index<H> Si No

Exposure Index<M> Si No

Exposure Index<L> Si No

Shockless Gain Si No

Base Sensitivity Si No

Base I1SO Si No

ND Filter Preset1 Si No
Preset2 Si No

Preset3 Si No

Shutter Mode Si No
Shutter Speed On/Off Si No

Shutter Speed Si No

Shutter Angle Si No

ECS On/Off Si No

ECS Frequency Si No

Iris Bokeh Control No No

LEVEL1 LEVEL 2 LEVEL 3 All File  Scene File

Shooting Auto Exposure Level Si No
Mode Si No

Speed Si No

AGC Si No

AGC Limit Si No

AGC Point Si No

Auto Shutter Si No

A.SHT Limit Si No

A.SHT Point Si No

Clip High light Si No

Detect Window Si No

Detect Window Indication Si No

Custom Width Si No

Custom Height Si No

Custom H Position Si No

Custom V Position Si No

White Preset White Si No
Color Temp <A> Si No

Tint<A> Si No

R Gain <A> Si No

B Gain <A> Si No

Color Temp <B> Si No

Tint<B> Si No

R Gain <B> Si No

B Gain <B> Si No

White Setting Shockless White Si No
ATW Speed Si No

White Switch<B> Si No

Filter White Memory Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Si No Project Base Setting Shooting Mode Si -
Offset Color Temp<A> Si No Target Display Si -

Offset Tint<A> Si No Rec Format Frequency Si No

Offset White <B> Si No Imager Scan Mode Si No

Offset Color Temp<B> Si No Codec Si No

Offset Tint<B> Si No RAW Output Format Si No

Offset White<ATW> Si No Video Format Si No
Offset Color Temp<ATW> Si No Cine El Setting Color Gamut Si -

Offset Tint<ATW> Si No HDR Setting VF SDR Preview Si No

Focus AF Transition Speed Si No SDR Gain Si No

AF Subj. Shift Sens. Si No Simul Rec Setting Si No

Focus Area Si No Rec Button Set Si No

Focus Area (AF-S) Si No Proxy Rec Setting Si No

Face/Eye Detection AF Si No Audio Channel Si No

Push AF Mode Si No Chunk Si No

Touch Function in MF Si No Interval Rec Setting No No

AF Assist Si No Interval Time Si No

S&Q Motion Setting Si No Number of Frames Si No

Frame Rate Si No Pre-Lighting Si No

LUT On/Off SDI/HDMI Si No Picture Cache Rec Setting Si No

VF/Proxy/Stream Si No Cache Size Si No
Internal Rec Si No Cache Rec Time - -

Noise Suppression Setting(Custom) Si No SDI/HDMI Rec Control Setting Si No

Level(Custom) Si No Assignable Button <1> Si No

Setting(Cine El) Si - <2> Si No

Level(Cine El) Si - <3> Si No

Flicker Reduce Mode Si No <4> Si No

Frequency Si No <5> Si No

SteadyShot Setting Si No <6> Si No

<7> Si No

<8> Si No

<9> Si No

Focus Hold Button Si No

Assignable Dial Grip/Remote Dial Si No

Grip Dial Direction Si No

Handle Dial Si No

Handle Dial Direction Si No

Multi Function Dial Default Function Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Project User File Load from Media(B) - - Paint/Look Detail Setting Si Si
Save to Media(B) - - Level Si Si
File ID No No Manual Setting Si Si
Load Customize Data Si No V/H Balance Si Si
Load White Data Si No B/W Balance Si Si
All File Load from Media(B) - - Limit Si Si
Load from Cloud(Private) - - Crispening Si Si
Load from Cloud(Share) - - High Light Detail Si Si
Save to Media(B) - - Matrix User Matrix Si Si
Save to Cloud(Private) - - User Matrix Level Si Si
Save to Cloud(Share) - - User Matrix Phase Si Si
File ID Si No User Matrix R-G Si Si
Load Network Data No No User Matrix R-B Si Si
Paint/Look Scene File Recall - - User Matrix G-R Si Si
Store - - User Matrix G-B Si Si
Delete - - User Matrix B-R Si Si
Preset Recall - - User Matrix B-G Si Si
Base Look Select Si Si Multi Matrix Setting Si Si
Delete - - Reset - -
Delete All - - Axis No Si
Import from Media(B) - - Hue Si Si
Import from Cloud(Private) - - Saturation Si Si
Import from Cloud(Share) - - TC/Media Timecode Mode Si No
Input Si Si Run Si No
Output Si Si Setting No No
AE Level Offset Si Si Reset - -
Reset Paint Settings Reset without Base Look - - TC Format Si No
Black Master Black Si Si TC Display Display Select Si No
R Black Si Si User Bits Mode Si No
B Black Si Si Setting No No
Knee Setting Si Si HDMI TC Out Setting Si No
Auto Knee Si Si Clip Name Format Title Prefix Si No
Point Si Si Number Set No No
Slope Si Si Update Media Media(A) - -
Media(B - -

Format Media

(B)
Media(A)
Media(B)
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Monitoring Output On/Off SDI Si No Monitoring Display On/Off ND Filter Si No
HDMI Si No Iris Si No
Output Format SDI Si No ISO/Gain/El Si No
HDMI Si No Shutter Si No
Output Display SDI Si No Level Gauge Si No
HDMI Si No Audio Level Meter Si No
Display On/Off Network Status Si No Video Level Warning Si No
File Transfer Status Si No Clip Number Si No
Rec/Play Status Si No Notice Message Si No
RAW Output Control Status Si No Marker Setting Si No
Tally Si No Color Si No
Battery Remain Si No Center Maker Si No
Focus Mode Si No Safety Zone Si No
Focus Position Si No Safety Area Si No
Focus Area Indicator Si No Aspect Marker Si No
Focus Area Ind.(AF-S) Si No Aspect Mask Si No
Face/Eye Detection Frame Si No Aspect Safety Zone Si No
Lens Info Si No Aspect Safety Area Si No
Imager Scan Mode Si No Aspect Select Si No
Rec Format Si No Custom Aspect Ratio Si No
Frame Rate Si No Guide Frame Si No
Zoom Position Si No 100% Marker Si No
UWP RF Level Si No User Box Si No
SteadyShot Si No User Box Width Si No
Base Look/LUT Si No User Box Height Si No
SDI/HDMI Rec Control Si No User Box H Position Si No
Gamma Display Assist Si No User Box V Position Si No
Proxy Status Si No VF Setting Brightness Si No
Base ISO/Sensitivity Si No Color Mode Si No
Media Status Si No Gamma Display Assist  Setting Si No
Video Signal Monitor Si No Peaking Setting Si No
Clip Name Si No Peaking Level Si No
White Balance Si No Color Si No
Scene File Si No Zebra Setting Si No
Focus Indicator Si No Zebral Level Si No
Auto Exposure Mode Si No Zebral Aperture Level Si No
Auto Exposure Level Si No Zebra2 Level Si No
Timecode Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene File LEVEL1 LEVEL 2 LEVEL 3 All File  Scene File

Audio Audio Input CH1 Input Select Si No Thumbnail Display Clip Properties - -
CH2 Input Select Si No Set Clip Flag Add OK - -
CH3 Input Select Si No Add NG - -
CH4 Input Select Si No Add KEEP - -
INPUT1 MIC Reference Si No Delete Clip Flag - -
INPUT2 MIC Reference Si No Lock/Unlock Clip Select Clip - -
Line Input Reference Si No Lock All Clips - -
Reference Level Si No Unlock All Clips - -
CH1 Wind Filter Si No Delete Clip Select Clip - -
CH2 Wind Filter Si No All Clips - -
CH3 Wind Filter Si No Transfer Clip Select Clip - -
CH4 Wind Filter Si No All Clips - -
CH3 Level Control Si No Transfer Clip (Proxy) Select Clip - -
CH4 Level Control Si No All Clips - -
CH3 Input Level Si No Filter Clips OK - -
CH4 Input Level Si No NG - -
Audio Input Level Si No KEEP - -
Limiter Mode Si No None - -
CH1&2 AGC Mode Si No All - -
CH3&4 AGC Mode Si No Customize View Thumbnail Caption Si -

AGC Spec Si No Technical Color Bars Setting No No

1kHz Tone on Color Bars Si No Type Si No

CH1 Level Si No ND Dial CLEAR with Dial Si No

CH2 Level Si No Tally Front Si No

CH3 Level Si No Rear Si No

CH4 Level Si No HOLD Switch Setting with Rec Button Si No

Audio Output Monitor CH Si No with Hand Grip Remote Si No

Volume No No Handle HOLD Switch Si No

Headphone Out Si No Touch Operation Setting Si No

Alarm Level Si No Rec Review Setting Si No

HDMI Output CH Si No Zoom Zoom Type Si No

Handle Zoom Setting Si No

High Si No

Low Si No

Menu Settings User Menu Only Si No

User Menu with Lock No No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 3 All File Scene File
Technical Menu Page On/Off Main Si No ST Mode Settings Camera Remote Control Si No
Camera Si No Connected Network
Audio Si No SSID - -
Project Si No Security - -
Monitoring Si No Password - -
Assignable Button Si No DHCP - -
Battery Si No IP Address - -
Media Si No Subnet Mask - -
Network Si No Gateway - -
File Transfer Si No DNS Auto - -
Fan Control Setting Si No Primary DNS Server - -
Lens Zoom Ring Direction Si No Secondary DNS Server - -
Shading Compensation Si No Scan Networks
Chroma Aberration Comp. Si No SSID - -
Distortion Comp. Si No Security - -
Breathing Compensation Si No Password No No
Distance Display Si No DHCP Si No
Zoom Position Display Si No IP Address Si No
Video Light Set Video Light Set Si No Subnet Mask Si No
APR APR - - Gateway Si No
Camera Battery Alarm  Low Battery Si No DNS Auto Si No
Battery Empty Si No Primary DNS Server Si No
Camera DCIN Alarm DC Low Voltagel Si No Secondary DNS Server Si No
DC Low Voltage2 Si No Manual Register
Network Setup for Mobile App Setup - - SSID Si No
Access Authentication  User Name No No Security Si No
Input Password No No Password No No
Generate Password - - DHCP Si No
Show Settings - - IP Address Si No
Wireless LAN Setting Si No Subnet Mask Si No
WPS - - Gateway Si No
NFC - - DNS Auto Si No
MAC Address - - Primary DNS Server Si No
AP Mode Settings Channel Si No Secondary DNS Server Si No

Camera SSID & Password

Regenerate Password

IP Address

Subnet Mask




138 | 8.Appendice: Impostazioni salvate in file

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Network Wired LAN Setting Si No Maintenance Language Select Si No
Camera Remote Control Si No Clock Set Time Zone Si No
Detail Settings Date Mode Si No
DHCP Si No 12h/24h Si No
IP Address Si No Date No No
Subnet Mask Si No Time No No
Gateway Si No All Reset Reset - -
DNS Auto Si No Reset without Network - -
Primary DNS Server Si No Hours Meter Hours(System) - -
Secondary DNS Server Si No Hours(Reset) - -
Modem Setting Si No Reset - -
Camera Remote Control Si No Version Version Number - -
Device Name - - Version Up - -
IP Address - - Lens Version Number - -
Subnet Mask - -
File Transfer Auto Upload Si No
Auto Upload (Proxy) Si No
Default Upload Server Si No
Clear Completed Jobs - -
Clear All Jobs - -
View Job List - -
Server Settings1/Server Settings2/Server Settings3
Display Name Si No
Service Si No
Host Name Si No
Port Si No
User Name No No
Password No No
Passive Mode Si No
Destination Directory Si No
Using Secure Protocol Si No

Root Certificate

Root Certificate Status

Reset

Network Reset

Reset
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Voci configurate con pulsanti programmabili

Si: Impostazione salvata.
No: Impostazione non salvata.
-: Non salvata (impostazione temporanea)

Selezione per pulsanti programmabili  All File Scene File
ND Filter Position Si No

Auto lIris Si No

ATW Si No

Focus Setting Si No
Display Si -

VF Adjust Si -

Voci configurate con la manopola programmabile

Si: Impostazione salvata.
No: Impostazione non salvata.
-: Non salvata (impostazione temporanea)

Selezione della manopola All File Scene File
programmabile

IRIS Si No

ND Filter Si No

Audio Input Level Si No
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Diagrammi a blocchi

Fare riferimento alle voci relative in “Impostazione dell'audio da registrare” (pagina 49) e “Menu User” (pagina 78).

Audio Input (CH1&CH2)

Di seguito e riportato il diagramma a blocchi con la maniglia montata.

* Impostare su Manual con ingresso audio da adattatore XLR.
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Audio Input (CH3&CH4)

Di seguito e riportato il diagramma a blocchi con la maniglia montata.
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* Impostare su Manual con ingresso audio da adattatore XLR.
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Audio Output

CH1

CH2
CH3
CH4

[HDMI Output CH]
CH1/CH2, CH3/CH4

N e e e e e

/

- ———

CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

V4 N\

g SDI OUT

' J

- 4 \
HDMI OUT

"\ J

[Alarm Level] [VOLUME]
0~7 0~50

\ 4

Internal Speaker

Headphone
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Aggiornamento del software di un obiettivo con innesto E-mount

Il camcorder consente di aggiornare il
software di obiettivi con innesto E-mount.
Fare riferimento al sito Web dell'obiettivo
per informazioni sugli obiettivi che possono
essere aggiornati e per ottenere il necessario
software.

Verifica della versione

1 Montare un obiettivo con innesto
E-mount sul camcorder (pagina 23).

2 Selezionare Version nel menu
Maintenance del menu completo per
visualizzare Lens Version Number
(pagina 111).

Il numero della versione software
dell’'obiettivo E-mount viene visualizzato
sul lato.

Aggiornamento del software

Impostare il camcorder sulla modalita
memorizzazione di massa (pagina 121).
Aggiornare il software sequendo la procedura
fornita con il software dell’'obiettivo.
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Licenze

Licenza MPEG-4 AVC Patent
Portfolio

QUESTO PRODOTTO E SOGGETTO A LICENZA
AVC PATENT PORTFOLIO PER USO PERSONALE
E NON COMMERCIALE DEL CLIENTE O ALTRI USI
PER | QUALI NON SI RICEVE ALCUN COMPENSO
PER
(i) CODIFICARE VIDEO IN CONFORMITA ALLO
STANDARD AVC (“AVC VIDEO") E/O
(i) DECODIFICARE VIDEO AVC CODIFICATO
DA UN CLIENTE IMPEGNATO IN ATTIVITA
PERSONALE E/O OTTENUTO DA UN
PROVIDER VIDEO CON LICENZA PER
FORNIRE VIDEO AVC.

NESSUNA LICENZA E CONCESSA O E DA
RITENERSI IMPLICITA PER ALTRO USO.
ULTERIORI INFORMAZIONI SONO DISPONIBILI
PRESSO MPEG LA, L.L.C. VISITARE IL SITO
HTTP://WWW.MPEGLA.COM

Ottenere software sotto licenza
GPL/LGPL

Questo prodotto utilizza software a cui si
applicano le licenze GPL/LGPL. Questa nota ha
lo scopo di informare |'utente del suo diritto di
accesso, modifica e ridistribuzione del codice
sorgente per tali programmi software secondo
le condizioni stabilite dalle licenze GPL/LGPL.
Il codice sorgente e fornito su Internet. Per il
download, utilizzare il sequente URL e seguire
le istruzioni.
https://0ss.sony.net/Products/Linux/

Preferiremmo non essere contattati
relativamente al contenuto del codice
sorgente.

Le licenze (in inglese) sono registrate nella
memoria interna del prodotto.

Stabilire una connessione di tipo dispositivo di
memorizzazione fra il prodotto e un computer
per leggere le licenze contenute nella cartella
“PMHOME" - “LICENSE".

Se si utilizza un Mac, la cartella “PMHOME" -
"LICENSE" potrebbe non essere accessibile.
Per visualizzare i file, utilizzare un computer
diverso da un Mac o visitare il sequente URL:
https://0ss.sony.net/License/ILME-FX6/

CONTRATTO DI LICENZA PER
L'UTENTE FINALE

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS
END USER LICENSE AGREEMENT ("EULA") CAREFULLY. BY
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony
Corporation ("SONY"). This EULA governs your rights

and obligations regarding the software of SONY and/or
its third party licensors (including SONY's affiliates) and
their respective affiliates (collectively, the “THIRD-PARTY
SUPPLIERS") contained in the wireless adapter, together
with any updates/ upgrades provided by SONY, any
printed, on-line or other electronic documentation for
such software, and any data files created by operation of
such software (collectively, the “SOFTWARE").

Notwithstanding the foregoing, any software in

the SOFTWARE having a separate end user license
agreement (including, but not limited to, GNU General
Public license and Lesser/Library General Public License)
shall be covered by such applicable separate end user
license agreement in lieu of the terms of this EULA to

the extent required by such separate end user license
agreement (“EXCLUDED SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE is
protected by copyright and other intellectual property
laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs, animation,
video, audio, music, text and “applets” incorporated into
the SOFTWARE) is owned by SONY or one or more of the
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the SOFTWARE
solely in connection with the wireless adapter and only
for your individual use. SONY and the THIRD-PARTY
SUPPLIERS expressly reserve all rights, title and interest
(including, but not limited to, all intellectual property
rights) in and to the SOFTWARE that this EULA does not
specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute, attempt
to derive source code, modify, reverse engineer,
decompile, or disassemble any of the SOFTWARE,
whether in whole or in part, or create any derivative
works from or of the SOFTWARE unless such derivative
works are intentionally facilitated by the SOFTWARE.
You may not modify or tamper with any digital rights
management functionality of the SOFTWARE. You
may not bypass, modify, defeat or circumvent any of
the functions or protections of the SOFTWARE or any
mechanisms operatively linked to the SOFTWARE. You
may not separate any individual component of the
SOFTWARE for use on more than one wireless adapter
unless expressly authorized to do so by SONY. You
may not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not share,
distribute, rent, lease, sublicense, assign, transfer or
sell the SOFTWARE. The software, network services

or other products other than SOFTWARE upon which
the SOFTWARE'S performance depends might be
interrupted or discontinued at the discretion of the
suppliers (software suppliers, service suppliers, or

SONY). SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other products
will continue to be available, or will operate without
interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license grant,
you acknowledge that the SOFTWARE may include
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE
may be covered by open source software licenses
("Open Source Components”), which means any
software licenses approved as open source licenses by
the Open Source Initiative or any substantially similar
licenses, including but not limited to any license that,
as a condition of distribution of the software licensed
under such license, requires that the distributor make
the software available in source code format. If and to
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list
of applicable OPEN SOURCE COMPONENTS included in
the SOFTWARE from time to time, and the applicable
terms and conditions governing its use. Such terms
and conditions may be changed by the applicable
third party at any time without liability to you. To the
extent required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will apply in lieu
of the terms of this EULA. To the extent the terms of the
licenses applicable to EXCLUDED SOFTWARE prohibit
any of the restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will not apply
to such EXCLUDED SOFTWARE. To the extent the terms
of the licenses applicable to Open Source Components
require SONY to make an offer to provide source code
in connection with the SOFTWARE, such offer is hereby
made.

USE OF SOFTWARE WITH COPYRIGHTED
MATERIALS

The SOFTWARE may be capable of being used by you

to view, store, process and/or use content created by
you and/or third parties. Such content may be protected
by copyright, other intellectual property laws, and/

or agreements. You agree to use the SOFTWARE only

in compliance with all such laws and agreements that
apply to such content. You acknowledge and agree

that SONY may take appropriate measures to protect


HTTP://WWW.MPEGLA.COM
https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/

145

8. Appendice: Licenze

the copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup and
restoration through certain SOFTWARE features, refusal
to accept your request to enable restoration of data, and
termination of this EULA in the event of your illegitimate
use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES
("CONTENT SERVICE"). USE OF THE SERVICE AND THAT
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL

BE LIMITED. You acknowledge and agree that certain
content and services available through the SOFTWARE
may be provided by third parties over which SONY has
no control. USE OF THE CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet connection
for which you are solely responsible. Further, you are
solely responsible for payment of any third party fees
associated with your Internet connection, including

but not limited to Internet service provider or airtime
charges. Operation of the SOFTWARE may be limited

or restricted depending on the capabilities, bandwidth
or technical limitations of your Internet connection

and service. The provision, quality and security of such
Internet connectivity are the sole responsibility of the
third party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country
in which you reside, and not to transfer, or authorize

the transfer, of the SOFTWARE to a prohibited country

or otherwise in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed,
manufactured or intended for use or resale as on-

line control equipment in hazardous environments
requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life
support machines, or weapons systems, in which the
failure of the SOFTWARE could lead to death, personal
injury, or severe physical or environmental damage
("HIGH RISK ACTIVITIES"). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates
specifically disclaim any express or implied warranty,
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE
is at your sole risk and that you are responsible for use
of the SOFTWARE. The SOFTWARE is provided “AS IS,”
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SONY

DOES NOT WARRANT OR MAKE ANY CONDITIONS

OR REPRESENTATIONS (A) THAT THE FUNCTIONS
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B)
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE'S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND

(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE

GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE
OF SONY SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF
THIS WARRANTY. SHOULD THE SOFTWARE PROVE
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT
APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") SHALL NOT BE LIABLE FOR ANY INCIDENTAL
OR CONSEQUENTIAL DAMAGES FOR BREACH OF

ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE,
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE,
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE,
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information
collected from the SOFTWARE, including but not
limited to information about (i) the SOFTWARE and
(ii) the software applications, contents and peripheral
devices that interact with your wireless adapter and the
SOFTWARE (“Information”). Information includes, but
is not limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2) performance

of the wireless adapter, the SOFTWARE and their
components; (3) configurations of your wireless adapter,
the SOFTWARE and the software applications, contents
and peripheral devices that interact with the wireless
adapter and the SOFTWARE; (4) use and frequency of
use of the functions of (x) the SOFTWARE, and (y) the
software applications, contents and peripheral devices
that interact with the SOFTWARE; and (5) location data,
as indicated below. SONY and its affiliates, partners

and agents may use and disclose Information subject
to applicable laws in order to improve its products and
services or to provide products or services to you. Such
uses include, but are not limited to: (a) administering
the functionalities of the SOFTWARE; (b) to improve,
service, update or upgrade the SOFTWARE; (c)
improving, developing and enhancing the current and
future products and services of SONY and other parties;
(d) to provide you with information about the products
and services offered by SONY and other parties; (e)
complying with applicable laws or regulations; and (f)
to the extent offered, providing you with location-based
services of SONY and other parties, as indicated below.
In addition, SONY retains the right to use Information
to protect itself and third parties from illegal, criminal or
harmful conduct.

Certain services available through the SOFTWARE may
rely upon location information, including, but not limited
to, the geographic location of the wireless adapter. You
acknowledge that for the purpose of providing such
services, SONY, the THIRDPARTY SUPPLIERS or their
partners may collect, archive, process and use such
location data, and that such services are governed by
the privacy policies of SONY or such third party. By
reviewed the privacy policies applicable to such services
and consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify

the owner or user of the SOFTWARE without your
knowledge or consent. Any use of Information will be

in accordance with the privacy policies of SONY or such
third party.

Please contact applicable contact address of each area or
country for SONY's current privacy policy. Please contact
applicable third parties for privacy policies relating

to personally identifiable and other information you
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provide when you use or access third party software or
services.

Information may be processed, stored or transferred

to SONY, its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection

as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical and
organizational steps to prevent unauthorized access to
or disclosure of Information, but does not warrant it will
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY SUPPLIERS
may automatically update or otherwise modify the
SOFTWARE, including, but not limited to, for purposes
of enhancement of security functions, error correction
and improvement of functions, at such time as you
interact with SONY's or third parties’ servers, or
otherwise. Such updates or modifications may delete
or change the nature of features or other aspects of the
SOFTWARE, including, but not limited to, functions you
may rely upon. You acknowledge and agree that such
activities may occur at SONY's sole discretion and that
SONY may condition continued use of the SOFTWARE
upon your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part of, the
SOFTWARE for purposes of this EULA. By acceptance of
this EULA, you consent to such update/maodification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended
and modified from time to time, together constitute the
entire agreement between you and SONY with respect
to the SOFTWARE. The failure of SONY to exercise or
enforce any right or provision of this EULA shall not
constitute a waiver of such right or provision. If any part
of this EULA is held invalid, illegal, or unenforceable,
that provision shall be enforced to the maximum extent
permissible so as to maintain the intent of this EULA,
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this EULA.
This EULA shall be governed by the laws of Japan,
without regards to conflict of laws provisions. Any
dispute arising out of this EULA shall be subject to the
exclusive venue of the Tokyo District Court in Japan, and
the parties hereby consent to the venue and jurisdiction
of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA to the
contrary, you acknowledge and agree that any violation
of or noncompliance with this EULA by you will cause
irreparable harm to SONY, for which monetary damages
would be inadequate, and you consent to SONY
obtaining any injunctive or equitable relief that SONY
deems necessary or appropriate in such circumstances.
SONY may also take any legal and technical remedies
to prevent violation of and/or to enforce this EULA,
including, but not limited to, immediate termination of
your use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate

this EULA. These remedies are in addition to any other
remedies SONY may have at law, in equity or under
contract.

TERMINATION

Without prejudice to any of its other rights, SONY may
terminate this EULA if you fail to comply with any of its
terms. In case of such termination, you must: (i) cease
all use, and destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section below
entitled "Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED
BY YOU, BY PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment, you
should promptly contact SONY for instructions. Your
continued use of the SOFTWARE after the effective date

of any such notice shall be deemed your agreement to
be bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express intended
thirdparty beneficiary of, and shall have the right to
enforce, each provision of this EULA with respect to the
SOFTWARE of such party.

Should you have any questions concerning this EULA,
you may contact SONY by writing to SONY at applicable
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licenze software Open Source

Sulla base degli accordi di licenza fra Sony e i
detentori dei diritti di copyright del software,
questo prodotto utilizza software aperto.

Per soddisfare i requisiti stabiliti dai detentori
dei diritti di copyright sul software, Sony e
tenuta a informare gli utenti del contenuto di
dette licenze.

Le licenze (in inglese) sono registrate nella
memoria interna del prodotto.

Stabilire una connessione di tipo dispositivo di
memorizzazione fra il prodotto e un computer
per leggere le licenze contenute nella cartella
“PMHOME" - “LICENSE".

Se si utilizza un Mac, la cartella “PMHOME" -
"LICENSE" potrebbe non essere accessibile.
Per visualizzare i file, utilizzare un computer
diverso da un Mac o visitare il sequente URL:
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/
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Specifiche tecniche

Generale

Peso

Circa 890 g (solo corpo principale)

Circa 2,59 kg (compreso obiettivo SEL24105G,
paraluce, batteria (BP-U35),
mirino, maniglia, impugnatura)

Dimensioni

Vedere pagina 150.
Alimentazione

19,5 Ve (da18,0V a 20,5 V)
Potenza assorbita

Circa 18,0 W (corpo, obiettivo, registrazione
XAVC-1 QFHD 59.94P, mirino
acceso, nessun dispositivo
esterno connesso)

Circa 36,0 W (corpo, obiettivo, registrazione
XAVC-1 QFHD 59.94P (S&Q
120 fps), mirino acceso, HDMI, SDI,
dispositivo esterno connesso)

Temperatura di funzionamento

Da0°Cad0°C

Temperatura di conservazione
Da -20 °Ca +60 °C
Tempo di funzionamento continuato

Circa 105 minuti (con pacco batteria BP-U35)
(corpo, obiettivo, registrazione
XAVC-1 QFHD 59.94P, mirino
acceso, nessun dispositivo
esterno connesso)

Formato di registrazione video
XAVC Intra

Modalita XAVC-1 4K/QFHD:
VBR, vel. fotog. 600 Mbps (max),
MPEG-4 AVC/H.264

Modalita XAVC-I HD:
CBG, vel. fotog. 223 Mbps (max),
MPEG-4 AVC/H.264

XAVC Long
Modalita XAVC-L QFHD:
VBR, vel. fotog. 150 Mbps (max),
MPEG-4 H.264/AVC
Modalita XAVC-L HD 50:
VBR, vel. fotog. 50 Mbps (max),
MPEG-4 H.264/AVC
Modalita XAVC-L HD 35:
VBR, vel. fotog. 35 Mbps (max),
MPEG-4 H.264/AVC
Formato di registrazione audio
LPCM 24 bit, 48 kHz, 4 canali
Frequenza di fotogrammi di registrazione
XAVC Intra
Modalita XAVC-| 4K:
4096x2160/59.94P, 50P, 29.97P,
25P, 24P, 23.98P
Modalita XAVC-1 QFHD:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
Modalita XAVC-1 HD :
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC Long
Modalita XAVC-L QFHD:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
Modalita XAVC-L HD 50:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Modalita XAVC-L HD 35:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Tempo di registrazione e/o riproduzione
XAVC Intra
Modalita XAVC-1 QFHD:
59.94P
Circa 30 minuti
(con CEA-G160T)
Modalita XAVC-I HD:
59.94P

Circa 78 minuti
(con CEA-G160T)
XAVC Long
Modalita XAVC-L QFHD:
59.94p
Circa 115 minuti
(con CEA-G160T)
Modalita XAVC-L HD 50:
59.94p
Circa 155 minuti
(con CEA-G80T)
Modalita XAVC-L HD 35:
59.94p
Circa 210 minuti
(con CEA-G80T)
[Nota]
| tempi di registrazione e riproduzione potrebbero
variare a seconda delle condizioni di utilizzo e delle
caratteristiche della memoria. | tempi di registrazione e
di riproduzione si riferiscono alla registrazione continua

di un unico clip. | tempi effettivi potrebbero essere
inferiori a seconda del numero di clip registrati.

Sezione videocamera

Dispositivo di generazione immagine (tipo)
Sensore di immagine CMOS a singolo chip,
equivalente 35 mm full frame
Numero di pixel
12,9M (totali)
10,2M (effettivi)
Auto Focus
Metodo di rilevamento: Rilevamento di fase/
rilevamento del contrasto
Filtri ND interni
CLEAR: OFF
1: 1/4ND
2:1/16ND
3:1/64ND
ND a variazione lineare: Da 1/4ND a 1/128ND

Sensibilita ISO
ISO 800/12800 (modalita Cine El, sorgente di
illuminazione D55)
Innesto obiettivo
E-mount
Latitudine
15+ stop
Velocita otturatore
Da 64F a 1/8000 sec. (23.98P)
Angolo otturatore
Da 5,6° a 360°, da 2 a 64 fotogrammi
Slow & Quick Motion
XAVC QFHD: Da 1 fps a 120 fps
XAVC HD: Da 1 fps a 240 fps
XAVC 4K: Da 1 fps a 60 fps
XAVC HD (S35): Da 1 fps a 120 fps
Bilanciamento del bianco
Da 2000 K a 15000 K
Guadagno
Da -3 dB a +30 dB (in incrementi di 1 dB)
Base look
S-Cinetone, Standard, Still, ITU709, s709,
709(800%), S-Log3, HLG Live,
HLG Natural

Sezione audio

Frequenza di campionamento
48 kHz
Quantizzazione
24 bit
Risposta di frequenza
Modalita MIC ingresso XLR: Da 20 Hz a 20 kHz
(£3 dB o inferiore)
Modalita LINE ingresso XLR: Da 20 Hz a
20 kHz (+3 dB o inferiore)
Gamma dinamica
Modalita MIC ingresso XLR: 80 dB (tipico)
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Modalita LINE ingresso XLR: 90 dB (tipico)
Distorsione
Modalita MIC ingresso XLR: 0,08% o inferiore
(livello di ingresso -40 dBu)
Modalita LINE ingresso XLR: 0,08% o inferiore
(livello di ingresso +14 dBu)
Altoparlante incorporato
Mono
Microfono interno
Mono
Microfono interno della maniglia
Microfono a condensatore electret stereo
omnidirezionale
[Nota]

Mentre & montata la maniglia, & attivo solo il microfono
interno della maniglia.

Sezione ingressi/uscite

Ingressi
INPUT 1/2:
Tipo XLR, 3 pin, femmina
Selezionabile LINE / MIC / MIC+48V
MIC: Riferimento da -30 dBu a -80 dBu
TCIN:
Tipo BNC

Uscite
SDI OUT:
Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B),
HD-SDI
Cuffie (mini jack stereo):
-16 dBu (livello di uscita di riferimento,
volume di monitoraggio massimo,
impedenza 16 Q)
HDMI:
Tipo A, 19 pin

TC OUT:
Tipo BNC

Altro
DCIN:
Conforme a EIAJ, da 18 Vcc a 20,5 Vcc
Slitta Multi-interface:
Tipo proprietario (21 pin)
REMOTE:
Tipo sub mini, dia. 2,5 mm, 3 poli
Connettore impugnatura di telecomando:
Mini jack stereo a 4 poli da 3,5 mm
(connettore in dotazione per
I'impugnatura di telecomando)
USB-C:
USB3.2Gen1
Connettore USB/Multi:
Compatibile con lo standard USB 2.0, tipo
micro B per l'archiviazione di
massa (1)
VF:
Tipo proprietario (40 pin)

Sezione display

Mirino (LCD)
Dimensione schermo
8,8 cm (3,5 pollici) in diagonale
Rapporto di aspetto
16:9
Numero di pixel
1280 (orizz.) x 720 (vert.)

Sezione slot supporti di memoria

Slot per schede CFexpress Type A/SD (2)

LAN wireless

Standard supportati
IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)
IEEE 802.11 b/g/n (ILME-FX6T/TK)
Banda di frequenza
2,4 GHz
5 GHz (solo ILME-FX6V/VK)
Protocolli di sicurezza supportati
WEP/WPA-PSK/WPA2-PSK
Metodo di connessione
WPS (Wi-Fi Protected Setup™) / Manuale
Metodo di accesso
Modalita infrastruttura

Caricabatterie (BC-CU1)

Peso
Circa60g
Dimensioni
Circa 57 x 26 x 101 mm
(larghezza / altezza / profondita)
Ingresso
19,5 Vce, 26 W
Uscita
16,4 Vcc, 1,4 A
Temperatura di funzionamento
Da0°Ca40°C
Temperatura di conservazione
Da -20°Ca +60 °C

Accessori forniti

Adattatore CA (1)

Cavo di alimentazione (1)

Caricabatterie (1)

Pacco batteria (1)

Maniglia (1)

Monitor LCD (1)

Cavo USB-C (1)

Impugnatura di telecomando (1)

Paraluce LCD (1)

Kit slitta fredda (1)

(Slitta fredda (1), molla della slitta (1), viti (4))

Coperchietto di protezione innesto obiettivo (1)

Coperchietto di protezione del connettore della
maniglia (1)

Prima di usare I'apparecchio (1)

Libretto di garanzia (1)

Design e caratteristiche tecniche sono soggetti
a modifiche senza preavviso.
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Note

e Eseguire sempre una registrazione di
prova, e verificare che il contenuto sia stato
registrato correttamente. SONY NON SARA
RESPONSABILE DI DANNI DI QUALSIASI
TIPO, COMPRESI, MA SENZA LIMITAZIONE
A, RISARCIMENTI O RIMBORSI A CAUSA
DI GUASTI DI QUESTO APPARECCHIO O
DEI SUOI SUPPORTI DI REGISTRAZIONE O
QUALSIASI ALTRO SUPPORTO O SISTEMA
DI MEMORIZZAZIONE PER REGISTRARE
CONTENUTI DI QUALSIASI TIPO.

e Verificare sempre che I'apparecchio stia
funzionando correttamente prima di
usarlo. LA SONY NON SARA RESPONSABILE
DI DANNI DI QUALSIASI TIPO, COMPRESI,
MA SENZA LIMITAZIONE A, RISARCIMENTI
O RIMBORSI A CAUSA DELLA PERDITA DI
PROFITTI ATTUALI O PREVISTI DOVUTA
A GUASTI DI QUESTO APPARECCHIO, SIA
DURANTE IL PERIODO DI VALIDITA DELLA
GARANZIA SIA DOPO LA SCADENZA DELLA
GARANZIA, O PER QUALUNQUE ALTRA
RAGIONE.

e SONY NON SARA RESPONSABILE PER
RICHIESTE O RICORSI DI NESSUN TIPO
PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.

e SONY NON SARA RESPONSABILE PER LA
PERDITA, RIPARAZIONE O RIPRODUZIONE
DEI DATI REGISTRATI SUL SISTEMA DI
MEMORIZZAZIONE INTERNO, SU SUPPORTI
DI REGISTRAZIONE O SU QUALSIASI
ALTRO TIPO DI SUPPORTO O SISTEMA DI
MEMORIZZAZIONE.

e SONY NON SARA RESPONSABILE PER
LA CANCELLAZIONE O LA MANCATA
CONTINUAZIONE PER QUALSIASI CAUSA
O CIRCOSTANZA DI SERVIZI CORRELATI A
QUESTO APPARATO.
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Dimensioni esterne
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Marchi di fabbrica

e O & un marchio di fabbrica di Sony
Corporation.

e XAVC e sono marchi registrati di Sony
Corporation.

e | termini HDMI e HDMI High-Definition
Multimedia Interface e il logo HDMI sono
marchi o marchi registrati di HDMI Licensing
Administrator, Inc. negli Stati Uniti e in altri
paesi.

e Microsoft e Windows sono marchi di
fabbrica o marchi registrati di Microsoft
Corporation negli Stati Uniti e/o altri paesi.

e Mac e macOS sono marchi registrati di
Apple Inc. negli Stati Uniti e in altri paesi.

e “Catalyst Browse”, “Content Browser
Mobile"” e il logo “Content Browser Mobile”
sono marchi o marchi registrati di Sony
Corporation.

e iOS € un marchio o un marchio registrato
Cisco Systems, Inc. e/o di sue societa
affiliate negli Stati Uniti e in certi altri paesi.

e Android, Google Play sono marchi di Google
Inc.

e Wi-Fi, il logo Wi-Fi e Wi-Fi PROTECTED
SETUP sono marchi o marchi registrati di
Wi-Fi Alliance.

e [l simbolo N Mark € un marchio o un
marchio registrato di NFC Forum, Inc. negli
Stati Uniti e in altri paesi.

e |l logo SDXC & un marchio di SD-3C, LLC.

® CFexpress e il logo CFexpress Type A
sono marchi registrati di CompactFlash
Association.

e QR Code & un marchio di fabbrica di Denso
Wave Inc.

Altri nomi di societa o prodotto sono marchi

o marchi registrati dei rispettivi detentori. E N

In questo documento i marchi non sono EMDE’;’;'HE,!!- K XAVC C?
contrassegnati dai simboli ™ o ©. express
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